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CHAPTER 1

Introdução ao Curso

1.1 Prefácio

1.1.1 Antencedentes

In 2008 we launched the Gentle Introduction to GIS, a completely free, open content resource for people who
want to learn about GIS without being overloaded with jargon and new terminology. It was sponsored by the
South African government and has been a phenomenal success, with people all over the world writing to us to
tell us how they are using the materials to run University Training Courses, teach themselves GIS and so on. The
Gentle Introduction is not a software tutorial, but rather aims to be a generic text (although we used QGIS in all
examples) for someone learning about GIS. There is also the QGIS manual which provides a detailed functional
overview of the QGIS application. However, it is not structured as a tutorial, but rather as a reference guide. At
Linfiniti Consulting CC. we frequently run training courses and have realised that a third resource is needed - one
that leads the reader sequentially through learning the key aspects of QGIS in a trainer-trainee format - which
prompted us to produce this work.

Este manual de capacitación pretende proveer todos los materiales necesarios para un curso de 5 dias sobre QGIS,
PostgreSQL y PostGIS. El curso está estructurado en contenidos para ajustarse a usuarios con nivel principiante,
intermedio y avanzado, y tiene muchos ejercicios con respuestas comentadas a lo largo del texto.

1.1.2 Licença

The Free Quantum GIS Training Manual by Linfiniti Consulting CC. is based on an earlier version from Linfiniti
and is licensed under a Creative Commons Attribution 4.0 International. Permissions beyond the scope of this
license may be available at below.

Hemos publicado este manual de capacitación para QGIS bajo una licencia liberal que te permite copiar, modificar
y redistribuir libremente esta obra. Una versión completa de la licencia está disponible al final de este documento.
En simples términos, las directrices de uso son las siguientes:

• No puedes presentar esta obra como tuya, o eliminar ninguno de los textos o créditos de autoria de esta obra.

• No puedes redistribuir esta obra bajo una licencia con permisos más restrictivos que los permisos con los
que la obra se ofrece.

• Si añades partes significativas a la obra y estas revierten en el proyecto (al menos un módulo completo)
puedes añadir tu nombre al final de l lista de autores de este documento (que aparecerá en la portada).

• Si aportas cambios menores y correcciones, puedes añadirte a la lista de contribuidores más abajo.

• Si traduces este documento en su totalidad, puedes añadir tu nombre a la lista de autores en la forma de
“Traducido por Joe Bloggs”.

1
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• Si patrocinas un módulo o lección, puedes requerir al autor a incluir un reconocimiento en el comienzo de
cada lección aportada, por ej.:

Nota: Esta lección fue patrocinada por MegaCorp.

• Si no estás seguro sobre lo que puedes hacer dentro de los términos de esta licencia, por favor, ponte en
contacto con office@linfiniti.com y te aconsejaremos sobre si lo que pretendes hacer es aceptable.

• Se você publicar este trabalho em um site de auto-publicação como o http://lulu.com, pedimos que você doe
os lucros para o projeto QGIS.

• Esta obra no puede ser comercializada excepto con el permiso expreso de los autores. Para ser claros,
por comercialización nos referimos a que no puedes venderla para beneficiarte, crear obras comerciales
derivadas de esta obra (por ej. vender contenido para su uso en articulos en revistas). La única excepción
es si todos los beneficios son donados al proyecto QGIS. Sí puedes (y te animamos a ello) utilizar esta obra
como libro de texto para dar cursos de capacitación, incluso en el caso de que el curso es de naturaleza
comercial. En otras palabras, se te anima a hacer dinero organizando cursos de capacitación que utilizan
esta obra como libro de texto, pero no puedes beneficiarte de la venta del libro - cuyos beneficios deberían
ser contribuidos a QGIS:

1.1.3 Patrocinando Capítulos

Esta obra no es en ningún caso un tratado completo de todas las cosas que puedes hacer con QGIS y animamos a
otros a añadir materiales para cubrir cualquier laguna. Linfiniti Consulting CC. puede crear materiales adicionales
para ti como un servicio comercial, con el entendimiento de que tales trabajos deberán convertirse en parte del
contenido principal y serán publicados bajo la misma licencia.

1.1.4 Autores

• Rüdiger Thiede (rudi@linfiniti.com) - Rudi ha escrito los materiales de instrucción de QGIS y parte de los
materiales de PostGIS.

• Tim Sutton (tim@linfiniti.com) - Tim ha supervisado y guiado el proyecto y es co-autor de las partes sobre
PostgreSQL y PostGIS. Tim es también el autor del tema spinx personalizado que es utilizado en este
manual.

• Horst Düster (horst.duester@kappasys.ch ) - Horst es co-autor de las partes sobre PostgreSQL y PostGIS.

• Marcelle Sutton (marcelle@linfiniti.com) - Marcelle se ha encargado de revisar el texto y ha proporcionado
consejo editorial durante la creación de esta obra.

1.1.5 Contribuidores Particulares

Teu nome aqui!

1.1.6 Patrocinadores

• Universidade Tecnológica da Península do Cabo

1.1.7 Dados

Nota: Los datos utilizados en el manual pueden descargarse de aquí:
http://qgis.org/downloads/data/training_manual_exercise_data.zip

Los datos de muestra que acompañan este material están disponibles gratuitamente y proceden de las siguientes
fuentes:

2 Chapter 1. Introdução ao Curso

mailto:office@linfiniti.com
http://lulu.com
mailto:rudi@linfiniti.com
mailto:tim@linfiniti.com
mailto:horst.duester@kappasys.ch
mailto:marcelle@linfiniti.com
http://qgis.org/downloads/data/training_manual_exercise_data.zip


QGIS Training Manual, Versão 2.8

• Conjuntos de datos de Calles y Lugares de OpenStreetMap (http://www.openstreetmap.org/)

• Límites de propiedades (urbanas y rurales), zonas acuáticas de NGI (http://www.ngi.gov.za/)

• SRTM DEM del CGIAR-CGI (http://srtm.csi.cgiar.org/)

1.1.8 Última Versão

Você sempre poderá obter a última versão deste documento visitando a versão online que é parte do site de
documentação do QGIS (http://docs.qgis.org).

Nota: Existem links online e versões PDF da Documentação e dos manuais de treinamento.

Tim Sutton, mayo 2012

1.2 Preparando os Dados dos Exercícios

Os dados amostrais fornecidos pelo manual referem-se à cidade de Swellendam e seus arredores. Swellendam
está localizada a 2 horas a leste de Cape Town no Western Cape do sul da África. O conjunto de dados contém
nomes de recursos em Inglês e Afrikaans.

Cualquier persona puede utilizar este conjunto de datos sin dificultad, pero puede ser que prefieras usar datos de
tu propio país o ciudad natal. Si eliges esa opción, tus datos localizados se utilizarán en todas las lecciones desde
el Módulo 3 al Módulo 7.2. Los módulos siguientes utilizan fuentes de datos más complejas que puede que estén
disponibles para tu región o puede que no.

Nota: Este procedimiento está dirigido a organizadores de cursos o a usuarios con más experiencia en QGIS
que deseen crear conjuntos de datos de muestra localizados para sus cursos. Un conjunto de datos generales
es distribuido con el Manual de Capacitación, pero puedes seguir estas instrucciones si quieres reemplazar el
conjunto de datos que viene por defecto.

Nota: Los datos de ejemplo usados a lo largo de este manual pueden ser descargados aquí:
http://qgis.org/downloads/data/training_manual_exercise_data.zip

1.2.1 Try Yourself

Nota: Estas instrucciones asumen que tienes un buen conocimiento de QGIS y no tienen la intención de ser
utilizadas como material de enseñanza.

Si deseas reemplazar el conjunto de datos con datos localizados para tu curso, esto puede hacerse fácilmente con
herramientas incluidas en QGIS. La región que elijas utilizar debería tener una buena mezcla de zonas urbanas y
rurales, incluyendo carreteras de distinto nivel, zonas delimitadas (como reservas naturales, cultivos) y elementos
acuáticos, como arroyos y ríos.

• Abre un nuevo proyecto de QGIS

• In the Vector menu dropdown, select OpenStreetMap -> Download Data. You can then manually enter the
co-ordinates of the region you wish to use, or you can use an existing layer to set the co-ordinates.

• Elige donde guardar el archivo .osm resultante y haz click en Aceptar:
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• Entonces puedes abrir el archivo .osm utilizando el botón Añadir Capa Vectorial. Puede que necesites
seleccionar Todos los archivos en la ventana del explorador. Como alternativa, puedes arrastrar el archivo
dentro de la ventana de QGIS.

• En el cuadro de diálogo que se abre, selecciona todas las capas, excepto las capas de kbd:other_relations y
multilinestrings:
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Así se cargarán cuatro capas en tu mapa que están referidas según las convenciones de nomenclatura de OSM
(puede que necesites acercar o alejar la imagen para ver los datos vectoriales).

Necesitamos extraer los datos útiles de estas capas, renombrarlas y crear los correspondientes archivos shape:

• Primero, haz doble clic en la capa multipolygons para abrir el diálogo Propiedades de la capa.

• En la pestaña General, haz clic en Constructor de Consultas para abrir la ventana del Constructor de Con-
sultas.

Esta capa contiene tres campos cuyos datos datos tendremos que extraer para utilizar durante todo el Manual de
Capacitación:

• building

• natural (especificamente, zonas acuáticas)

• landuse

1.2. Preparando os Dados dos Exercícios 5
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Puedes revisar los datos dentro de tu región para ver que tipos de resultados pueden puedes sacar de tu región. Si
encuentras que “landuse” no contiene resultados, puedes excluirla.

Necesitarás escribir expresiones de filtrado para cada campo para extraer los datos que necesitamos. Utilizaremos
el campo “building” como ejemplo aquí:

• Introduce la siguiente expresión en el área de texto: building != "NULL" y haz clic en click Probar
para ver cuantos resultados dará la consulta. Si el número de resultados es pequeño, puede ser que quieras
mirar en la Tabla de Atributos de la capa para ver que es lo que los datos OSM han producido para tu región:

• Haz clic en Aceptar y verás que los elementos de la capa que no son “buildings” (construcciones) se han
quitado del mapa.

Ahora necesitamos guardar los datos resultantes como un archivo shape para que lo puedas usar durante tu curso:

• Haz clic derecho en la capa multipolygons y selecciona Guardar como...

• Asegurate de que el tipo de archivo es ESRI Shapefile y guardalo en tu nueva carpeta
exercise_data, en una carpeta llamada “epsg4326”.

• Asegurate de que Sin simbología está seleccionado (añadiremos simbología como parte del curso más ade-
lante).

• También puedes seleccionar Añadir archivo guardado al mapa.

Una vez que la capa buildings ha sido añadida al mapa, puedes repetir el proceso para los campos natural y
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landuse utilizando las siguientes expresiones:

Nota: ¡Asegúrate de que limpias el filtro previo (en el diálogo guilabel:Propiedades de la capa) de la capa the
multipolygons layer antes de seguir con la siguiente expresión de filtro!

• natural: “natural = ‘water”’

• landuse: “landuse != ‘NULL”’

Cada uno de los conjuntos de datos resultantes debe guardarse en la carpeta “epsg4326” en tu nuevo directorio
exercise_data (es decir “water”, “landuse”).

A continuación, debes extraer y guardar en las correspondientes carpetas, los siguientes campos de las capas
lines y points:

• lines: “highway != ‘NULL”’ en roads, y “waterway != ‘NULL”’ en rivers

• points: “place != ‘NULL”’ en places

Una vez que has terminado de extraer los datos de más arriba, puedes eliminar las capas multipolygons, lines y
points.

Ahora deberías tener un mapa que sea parecido a este (la simbología seguramente será muy diferente, pero eso no
es problema):

Lo importante es que tengas 6 capas que correspondan con las mostradas arriba y que todas esas capas tengan
algunos datos.

El último paso es crear un archivo spatiallite a partir de la capa landuse para utilizar durante el curso:

• Haz clic derecho en la capa landuse y selecciona Guardar como...

• Selecciona SpatialLite como el formato y guarda el archivo como kbd:landuse en la carpeta “epsg4326”.

• Haz clic en Aceptar.

• Borra el archivo landuse.shp y otros que estén relaciondos con el (si fueron creados).
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1.2.2 Try Yourself Crear archivos SRTM DEM tiff

Para el Módulo 6 (Creación de Datos Vectoriales) y el Módulo 8 (Rasters), necesitarás tambien imágines raster
(SRTM DEM) que cubran la región que has seleccionado para tu curso.

Imágenes SRTM DEM pueden descargarse de CGIAR-CGI: http://srtm.csi.cgiar.org/

Necesitarás imágenes que cubran toda la región que has elegido usar.

Una vez que hayas descargado los archivos requeridos, debes guardar en el directorio “exercise_data” bajo
“raster/SRTM”.

En el módulo 6, lección 1.2 muestra imagenes en primer plano de las tres campos de deportes escolares que los
estudiantes pidieron digitalizar. Por lo tanto, tendrá que reproducir estas imagenes usando su nuevo archivo tiff
del SRTM DEM. No es obligatorio usar los campos de deportes escolares: cualquier tipo de uso de suelo de las
escuelas puede ser utilizado (ej. diferentes construcciones escolares, parques infantiles o estacionamientos).

Como referencia, las imágenes en los datos de ejemplo son:

8 Chapter 1. Introdução ao Curso

http://srtm.csi.cgiar.org/


QGIS Training Manual, Versão 2.8

1.2.3 Try Yourself Sustituye los Tokens

Habiendo creado tu conjunto de datos localizado, el paso final es sustituir los tokens en el archivo conf.py, de
modo que los nombres apropiados aparezcan en tu versión localizada del Manual de Capacitación.

Los tokens que tienes que sustituir son los siguientes:

• majorUrbanName: por defecto es “Swellendam”. Sustituyelo por el nombre de una ciudad importante
en tu región.

• schoolAreaType1: por defecto es “athletics field”. Sustituyelo por el nombre del tipo de zona escolar
en tu región.

• largeLandUseArea: por defecto es “Bontebok National Park”. Sustituyelo por el nombre de un polí-
gono grande de uso del suelo en tu región.

• srtmFileName: este es predeterminado a srtm_41_19.tif. Reemplazar este con el nombre de
archivo de su SRTM DEM.

• localCRS: este predeterminado WGS 84 / UTM 34S. Debe reemplazar este con el CRS correcto de su
región.

1.2. Preparando os Dados dos Exercícios 9
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CHAPTER 2

Module: A Interface

2.1 Lesson: Uma Breve Introdução

Bem-vindo ao nosso curso! Ao longo dos próximos dias, vamos mostrar-lhe como usar o QGIS de forma fácil
e eficiente. Se você é novo em SIG, vamos dizer-lhe o que você precisa para começar. Se você é um usuário
experiente, você vai ver como o QGIS cumpre todas as funções que você espera de um programa de SIG e muito
mais!

Neste módulo apresentaremos o projeto QGIS em si, bem como explicaremos a interface do usuário.

Após a conclusão desta seção, você será capaz de identificar corretamente os principais elementos da tela do
QGIS, saber o que cada um deles faz e carregar um shapefile no QGIS.

Aviso: Este curso inclui instruções sobre como adicionar, excluir e alterar conjuntos de dados SIG. Nós
fornecemos conjuntos de dados de treinamento para essa finalidade. Antes de usar as técnicas descritas aqui
em seus próprios dados, sempre garanta que você tenha backups adequados!

2.1.1 Como usar este tutorial

Qualquer texto que se parece com isso refere-se a alguma coisa na tela que você pode clicar.

O texto que parece → com → este, guia-o através dos menus.

Este tipo de texto refere-se a algo que você pode digitar, como um comando, caminho ou nome de ar-
quivo.

2.1.2 Níveis de objetivos do curso

Este curso atende a diferentes níveis de experiência do usuário. Dependendo de qual categoria você considera
estar, você deve esperar diferentes resultados do curso. Cada categoria contém informações que são essenciais
para o próximo, por isso é importante fazer todos os exercícios que estão abaixo ou no seu nível de experiência.

Básico

Nesta categoria, o curso pressupõe que você tenha pouca ou nenhuma experiência prévia com conhecimento
teórico ou funcionamento de um programa de SIG.

Um embasamento teórico limitado será fornecido para explicar o propósito de uma ação que você irá realizar no
programa, mas a ênfase está em aprender fazendo.

Quando concluir o curso, você terá uma noção melhor das possibilidades de um SIG e de como aproveitar esse
poder através do QGIS.
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Intermediário

Nesta categoria, presume-se que você possua conhecimentos profissionais e experiência cotidiana no uso de SIG.

Seguir as instruções do nível iniciante irá fornecer-lhe um terreno familiar, bem como torná-lo consciente dos
casos onde o QGIS faz as coisas de forma ligeiramente diferente da de outro software que você possa ter usado.
Você também vai aprender como usar funções de análise no QGIS.

Quando concluir o curso, você deverá estar confortável com o uso do QGIS para todas as funções que você
geralmente precisa de um GIS no uso diário.

Avançado

Nesta categoria, o pressuposto é que você tenha: experiência com SIG; conhecimento e experiência com bancos
de dados espaciais; utilizado dados em um servidor remoto; talvez, escrito scripts para fins de análise; etc.

Seguir as instruções dos outros dois níveis irá familiarizá-lo com a abordagem que a interface QGIS segue e irá
assegurar que você sabe como acessar as funções básicas que você precisa. Você também vai ser apresentado a
como fazer uso do sistema de plugins do QGIS, ao sistema de acesso de banco de dados, e assim por diante.

Quando você concluir o curso, você deverá estar bem familiarizado com a operação cotidiana do QGIS, bem como
as suas funções mais avançadas.

2.1.3 Por que QGIS?

Com a informação se tornando cada vez mais preocupada com a a espacialidade, não há falta de ferramentas
capazes de cumprir algumas ou todas as funções de SIG mais utilizadas. Por que alguém deveria estar usando
QGIS ao invés de algum outro pacote de software SIG?

Aqui estão apenas algumas das razões:

• É gratuito. A instalação e utilização do programa QGIS custa-lhe um total de zero dinheiro. Nenhuma taxa
inicial, nenhuma taxa recorrente, nada.

• É livre. Se você precisar de funcionalidades extras no QGIS, você pode fazer mais do que apenas esperar que
elas sejam incluídas na próxima versão. Você pode patrocinar o desenvolvimento de uma funcionalidade,
ou adicioná-la você mesmo se estiver familiarizado com programação.

• Está em constante desenvolvimento. Porque qualquer um pode adicionar novos recursos e melhorar os já ex-
istentes, o QGIS não estagna. O desenvolvimento de uma nova ferramenta pode acontecer tão rapidamente
quanto você precisar dela.

• Ajuda extensiva e documentação disponível. Se você empacou com alguma coisa, você pode ver a extensa
documentação, seus companheiros usuários de qgis ou até mesmo os desenvolvedores.

• Multiplataforma. O QGIS pode ser instalado em MacOS, Windows e Linux.

Agora que você sabe porque quer usar o QGIS, podemos mostrar-lhe como. A primeira lição irá guiá-lo na criação
do seu primeiro mapa QGIS.

2.2 Lesson: Adicionando sua primeira camada

Vamos iniciar a aplicação e criar um mapa básico para ser usado nos exemplos e exercícios.

O objetivo para esta lição: começar com um exemplo de mapa.

Nota: Antes de iniciar este exercício, o QGIS deve ser instalado em seu computador. Além disso, faça o download
do arquivo training_manual_exercise_data.zip da área de downloads de dados do QGIS.
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Inicie o QGIS a partir do atalho na área de trabalho, item de menu etc, dependendo de como você configurou a
sua instalação.

Nota: As capturas de tela para este curso foram tomadas no QGIS 2.0 em execução no MacOS. Dependendo da
configuração, as telas que você encontra podem muito bem ser um pouco diferentes. No entanto, todos os mesmos
botões ainda estarão disponíveis e as instruções funcionarão em qualquer sistema operacional. Você vai precisar
do QGIS 2.0 (a versão mais recente quando este manual foi feito) para este curso.

Vamos começar imediatamente!

2.2.1 Follow Along: Prepare um mapa

• Abra o QGIS. Você terá um novo mapa em branco.

• Look for the Add Vector Layer button:

• Clique nele para abrir a seguinte caixa de diálogo:

• Clique no botão Buscar e navegue até o arquivo exercise_data/epsg4326/roads.shp (em sua
pasta do curso). Com este arquivo selecionado, clique em Abrir. Você verá a caixa de diálogo original, mas
com o caminho do arquivo preenchido. Clique em Abrir aqui também. Os dados que você especificou serão
carregados agora.

Parabéns! Agora você já tem um mapa básico. Essa seria uma boa hora para salvar seu trabalho.

• Click on the Save As button:

• Salve o mapa em exercise_data/ e nomeie-o mapa_basico.qgs.

Verifique seus resultados

2.2.2 In Conclusion

Você aprendeu como adicionar uma camada e criar um mapa básico!
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2.2.3 What’s Next?

Agora você está familiarizado com a função do botão Adicionar camada vetorial, mas e os outros botões? Como
é que esta interface funciona? Antes de prosseguirmos com mais informação, vamos primeiro dar uma boa olhada
no layout geral da interface do QGIS. Este é o tema da próxima lição.

2.3 Lesson: Uma visão geral da interface

Vamos explorar a interface do usuário QGIS para que você esteja familiarizado com os menus, barras de ferra-
mentas, tela do mapa e lista de camadas que formam a estrutura básica da interface.

O objetivo desta lição: Entender os fundamentos da interface de usuário do QGIS.

2.3.1 Try Yourself: Os fundamentos

Os elementos identificados na figura superior são:

1. Lista de camadas / Buscador

2. Barra de ferramentas

3. Tela do mapa

4. Barra de estado

5. Barra de ferramentas lateral

A lista de camadas

Na lista de camadas, você pode ver uma lista, a qualquer tempo, de todas as camadas disponíveis para você.
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Expandindo os itens (clicando no símbolo de seta ou mais ao lado deles) irá fornecer-lhe mais informações sobre
a aparência atual da camada.

Clicando com o botão direito do mouse sobre uma camada vai dar-lhe um menu com várias opções extras. Você
estará usando alguns deles em pouco tempo, então dê uma olhada!

Algumas versões do QGIS tem uma caixa de seleção separada Controle da ordem de renderização logo abaixo da
lista de Camadas. Não se preocupe se você não pode vê-lo. Se ele estiver presente, verifique se ele está marcado.

Nota: Uma camada vetorial é um conjunto de dados, geralmente de um tipo específico de objeto, tais como
estradas, árvores, etc. A camada vetorial pode consistir em pontos, linhas ou polígonos.

O Buscador

O Buscador é um painel no QGIS que lhe permite navegar facilmente em seu banco de dados. Você pode ter
acesso a arquivos vetoriais comuns (por exemplo, ESRI shapefile ou arquivos MapInfo), bancos de dados (por
exemplo, PostGIS, Oracle, SpatiaLite ou MSSQL espacial) e conexões WMS/WFS. Você também pode visualizar
seus dados GRASS.

Barra de ferramentas

Your most oft-used sets of tools can be turned into toolbars for basic access. For example, the File toolbar allows
you to save, load, print, and start a new project. You can easily customize the interface to see only the tools you
use most often, adding or removing toolbars as necessary via the Settings → Toolbars menu.

Even if they are not visible in a toolbar, all of your tools will remain accessible via the menus. For example, if you
remove the File toolbar (which contains the Save button), you can still save your map by clicking on the Project
menu and then clicking on Save.

A Tela do Mapa

Este é o lugar onde o próprio mapa é exibido.

A Barra de Estado

Mostra informações sobre o mapa atual. Também permite ajustar a escala do mapa e ver as coordenadas do cursor
sobre o mapa.

2.3.2 Try Yourself 1

Tente identificar os quatro elementos listados acima em sua própria tela, sem fazer referência ao diagrama acima.
Veja se você pode identificar seus nomes e funções. Você vai se tornar mais familiarizado com esses elementos
conforme os utilizar nos próximos dias.

Verifique seus resultados
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2.3.3 Try Yourself 2

Tente encontrar cada uma dessas ferramentas na sua tela. Para que servem?

1.

2.

3.

4.

5.

Nota: Se qualquer uma dessas ferramentas não é visível na tela, tente ativar algumas barras de ferramentas que
estão atualmente ocultas. Também tenha em mente que, se não houver espaço suficiente na tela, uma barra de
ferramentas pode ser reduzida por esconder algumas de suas ferramentas. Você pode ver as ferramentas ocultas,
clicando no botão de seta para a direita duas vezes em qualquer barra de ferramentas aberta. Você pode ver uma
dica com o nome de qualquer ferramenta, segurando o mouse sobre a ferramenta por um tempo.

Verifique seus resultados

2.3.4 What’s Next?

Agora que você já viu como a interface do QGIS funciona, você pode usar as ferramentas disponíveis e começar
a melhorar seu mapa! Esse é o tema da próxima lição.
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CHAPTER 3

Module: Criando um Mapa Básico

Neste módulo, você irá criar um mapa básico que será utilizado mais tarde como base para novas demonstrações
de funcionalidade QGIS.

3.1 Lesson: Trabalhando com Dados Vetoriais

Dados vetoriais são sem dúvida o tipo mais comum de dados que você vai encontrar no uso diário de GIS. Eles
descrevem os dados geográficos em termos de pontos, que podem ser conectados em linhas e polígonos. Cada
objeto em um conjunto de dados vetorial é chamado feição e está associado a dados que descrevem essa feição.

Meta para esta lição: Aprender mais sobre a estrutura de dados vetoriais e como carregar conjuntos de dados
vetoriais em um mapa.

3.1.1 Follow Along: Visualizando Atributos da Camada

É importante saber que os dados que você estará trabalhando não representam apenas onde os objetos estão no
espaço, mas também te diz o que esses objetos são.

A partir do exercício anterior, você deve ter a camada roads carregada em seu mapa. O que você pode ver agora é
apenas a posição das vias.

Para ver todos os dados disponíveis, com a camada roads selecionada na lista de Camadas:

• Clique neste botão:

Ele vai mostrar uma tabela com mais dados sobre a camada roads. Esta informação adicional é chamada atributo.
As linhas que você vê no mapa representam onde estão as vias; esses são os dados espaciais.

Essas definições são comumente usadas em SIG, por isso é essencial lembrá-las!

• Agora você pode fechar a tabela de atributos.

Dados vetoriais representam feições em termos de pontos, linhas e polígonos em um plano de coordenadas. São
normalmente usados para armazenar feições discretas, como estradas e quadras de cidades.

3.1.2 Follow Along: Carregando Dados Vetoriais a partir de arquivos Shape

O Shapefile é um formato de arquivo específico que permite armazenar dados de SIG em um grupo associado de
arquivos. Cada camada consiste em vários arquivos com o mesmo nome, mas diferentes tipos de arquivo. Os
Shapefiles são fáceis de enviar e receber e a maioria dos softwares SIG pode lê-los.

Volte para o exercício introdutório na seção anterior para obter instruções sobre como adicionar camadas vetoriais.
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Carregue os conjuntos de dados em seu mapa seguindo o mesmo método:

• “places”

• “water”

• “rivers”

• “buildings”

Confira seus resultados

3.1.3 Follow Along: Carregando dados vetoriais a partir de um Banco de
Dados

Os bancos de dados permitem armazenar um grande volume de dados associados em um único arquivo. Você pode
já estar familiarizado com um sistema de gerenciamento de banco de dados (DBMS), como o Microsoft Access.
Aplicações SIG também podem fazer uso de bancos de dados. Os DBMSes específicos do SIG (como PostGIS)
têm funções extras, porque eles precisam lidar com dados espaciais.

• Click on this icon:

(Se você não o vê, verifique se a barra de ferramentas Gerenciar Camadas está habilitada.)

Abrirá um novo diálogo. Nesta caixa de diálogo:

• Clique no botão Novo.

• Na mesma pasta dos outros dados, você deve encontrar o arquivo land_use.db. Selecione-o e clique em
Abrir.

Você vai ver agora o primeiro diálogo novamente. Observe que o menu suspenso selecionado acima dos três
botões agora mostra “land_use.db@...”, seguido do caminho do arquivo do banco de dados em seu computador.

• Clique no botão Conectar. Você deve ver algo semelhante na caixa anteriormente vazia:

18 Chapter 3. Module: Criando um Mapa Básico



QGIS Training Manual, Versão 2.8

• Clique na camada urban para selecioná-la, depois clique em Adicionar

Nota: Lembre-se de salvar o mapa regularmente! O arquivo de mapa não contém qualquer um dos dados
diretamente, mas ele se lembra de quais são as camadas que você carregou em seu mapa.

Confira seus resultados

3.1.4 Follow Along: Reordenando as Camadas

As camadas na lista de Camadas são desenhadas no mapa em uma determinada ordem. A camada mais abaixo na
lista é desenhada em primeiro lugar e a camada na parte superior é desenhada por último. Alterando a ordem em
que são mostradas na lista, você alterará a ordem em que elas são desenhadas.

Nota: Dependendo da versão do QGIS que você está usando, você pode ter uma caixa de opção abaixo da lista
de Camadas chamada Controle da ordem de renderização. Isso precisa estar ligado para que, ao se deslocarem as
camadas para cima e para baixo na lista de Camadas, as mesmas sejam trazidas para a frente ou para trás do mapa.
Se a sua versão do QGIS não tem essa opção, então ela é ativada por padrão e você não precisa se preocupar com
isso.

A ordem em que as camadas estão carregadas no mapa está provavelmente sem lógica nesta etapa. É possível que
a camada road (via) esteja completamente escondida por que outras camadas estão sobre ela.

Por exemplo, esta ordem de camada...
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... resultaria em estradas e lugares escondidos sob áreas urbanas.

Para resolver este problema:

• Clique e arraste em uma camada na lista Camadas.

• Reordene-os para se parecer com isso:

Você verá que o mapa agora faz mais sentido visualmente, com estradas e edifícios que aparecem acima das
regiões de uso da terra.

3.1.5 In Conclusion

Agora você adicionou todas as camadas que precisa de várias fontes diferentes.

3.1.6 What’s Next?

Usando cores aleatórias atribuídas automaticamente ao carregar as camadas, o seu mapa atual possivelmente não
será fácil de ler. Seria preferível atribuir sua própria escolha de cores e símbolos. Isto é o que você vai aprender a
fazer na próxima lição.
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3.2 Lesson: Simbologia

A simbologia de uma camada é sua aparência visual no mapa. A força básica do SIG sobre outras formas de
representação de dados espaciais é que com o SIG, você pode obter uma representação visual dinâmica dos dados
com os quais está trabalhando.

Por conseguinte, o aspecto visual do mapa (que depende da simbologia das camadas individuais ) é muito impor-
tante. O usuário final dos mapas que você produz necessitará ver o que o mapa representa com facilidade.

Em outras palavras, ter simbologia adequada não é um luxo ou é apenas bom ter. Na verdade, é essencial para
você usar um SIG corretamente e produzir mapas e informações que as pessoas serão capazes de usar.

O objetivo desta lição: Ser capaz de criar qualquer simbologia que você queira para uma camada vetorial.

3.2.1 Follow Along: Mudando cores

Para alterar a simbologia de uma camada, abra Propriedades da Camada. Vamos começar mudando a cor do
camada urban.

• Clique com o botão direito do mouse em urban na lista de Camadas.

• Selecione Propriedades no menu que aparece.

Nota: Por padrão, você também pode acessar as propriedades de uma camada clicando duas vezes sobre a camada
na lista de Camadas.

Na janela Propriedades:

• Selecione a aba Estilo à esquerda:
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• Clique no botão de seleção de cor ao lado do rótulo Cor.

Uma caixa de diálogo padrão de cores aparecerá.

• Escolha a cor cinza e clique em OK.

• Clique novamente em OK na janela Propriedades da Camada e você vai ver a mudança de cor ser aplicada
à camada.

3.2.2 Try Yourself

Altere a camada water para uma cor azul clara.

Verifique seus resultados

3.2.3 Follow Along: Mudando a Estrutura do Símbolo

Está muito bom até agora, mas há mais sobre simbologia de uma camada do que apenas a sua cor. Em seguida,
queremos eliminar as linhas entre as diferentes áreas de uso da terra, de modo a fazer o mapa menos confuso
visualmente.

22 Chapter 3. Module: Criando um Mapa Básico



QGIS Training Manual, Versão 2.8

• Abra a janela Propriedades da camada para a camada urban.

Na aba Estilo, você vai ver o mesmo tipo de diálogo de antes. Desta vez, no entanto, você fará mais do que apenas
mudar a cor de forma rápida.

• No painel à esquerda, expanda Fill (se necessário) e selecione a opção Preenchimento simples:

• Clique em Estilo da borda. Nesse momento, deverá aparecer uma pequena linha e as palavras Linha sólida.

• Troque para Sem caneta.

• Clique em OK.

Agora a camada urban não terá nenhuma linha entre as áreas.

3.2.4 Try Yourself

• Troque novamente a simbologia da camada water para que tenha um contorno azul escuro.

• Altere a simbologia da camada rivers para uma representação adequada para vias navegáveis.

Verifique seus resultados
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3.2.5 Follow Along: Visibilidade Baseada na Escala

Às vezes, você vai achar que uma camada não é adequada para uma determinada escala. Por exemplo, um conjunto
de dados de todos os continentes pode apresentar baixo detalhamento e não ser muito preciso ao nível da rua.
Quando isso acontece, você quer ser capaz de esconder o conjunto de dados que esteja em escalas inadequadas.

No nosso caso, podemos decidir esconder os edifícios na exibição em pequenas escalas. Este mapa, por exemplo...

... não é muito útil. Os edifícios são difíceis de distinguir nessa escala.

Para ativar a renderização baseada em escala:

• Abra a janela Propriedades da camada para a camada buildings.

• Selecione a aba Geral.

• Enable scale-based rendering by clicking on the checkbox labeled Scale dependent visibility:
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• Change the Minimum value to 1:10,000.

• Clique em OK.

Teste os efeitos dando zoom in e out em seu mapa e observando quando a camada :guilabel: buildings desaparece
e reaparece.

Nota: Você pode usar a roda do mouse para dar zoom ou, como alternativa, usar as ferramentas de zoom para a
janela:

3.2.6 Follow Along: Adicionando Camadas de Símbolos

Agora que você já sabe como alterar simbologias simples para as camadas, o próximo passo será criar simbologias
mais complexas. O QGIS permite que você faça isso usando camadas de símbolos.

• Volte ao painel de propriedades do símbolo para a camada urban (nas propriedades da camada, na aba
Estilo, clicando em Preenchimento simples no painel a esquerda)

Neste exemplo, o símbolo atual não tem contorno (ou seja, ele usa como estilo da borda Sem caneta).
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Selecione Fill no painel de camadas de símbolos, à esquerda. Em seguida, clique no botão Adicionar uma camada
de símbolo:

• Clique nele e a janela ficará parecida como a abaixo:
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(Pode parecer um pouco diferente na cor, por exemplo, mas você vai mudar isso de qualquer maneira.)

Agora há uma segunda camada de símbolo. Sendo de uma cor sólida, ela irá naturalmente ocultar completamente
o tipo anterior de símbolo. Além disso, ela tem um estilo de borda Linha Sólida, o que não queremos. É evidente
que esse símbolo tem que ser mudado.

Nota: É importante não se confundir entre uma camada de mapa e uma camada de símbolo. Uma camada de
mapa é um vetor (ou raster) que foi carregado no mapa. Uma camada de símbolo é parte do símbolo usado para
representar uma camada de mapa. Este curso irá geralmente se referir a uma camada de mapa como apenas uma
camada, mas uma camada de símbolo será sempre chamado de uma camada de símbolo, para evitar confusão.

Com a nova camada de símbolo Preenchimento simples selecionada:

• Defina o estilo de borda para Sem caneta, como feito anteriormente.

• Mude o estilo de preenchimento para algo diferente de Sólido ou Sem pincel. Por exemplo:
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• Clique OK. Agora você pode ver seus resultados e ajustá-los conforme necessário.

Você pode até adicionar várias camadas de símbolos extras e criar, dessa maneira, uma espécie de textura para sua
camada.
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É divertido! Mas, provavelmente, você tem muitas cores para usar em um mapa real ...

3.2.7 Try Yourself

• Lembrando-se de dar zoom, se necessário, crie uma textura simples para a camada buildings usando os
métodos acima.

Verifique seus resultados

3.2.8 Follow Along: Ordenando os Níveis de Símbolos

Quando as camadas de símbolos são renderizadas, elas o são em uma sequência, semelhante à maneira como as
diferentes camadas do mapa são renderizadas. Isto significa que, em alguns casos, ter muitas camadas de símbolo
num símbolo pode causar resultados inesperados.

• Dê uma camada extra de símbolo à camada roads (usando o método para adicionar camadas de símbolos
demonstrado acima).

• Dê a linha de base uma Espessura de caneta de 0,3, uma cor branca e selecione Linha tracejada em Estilo
da caneta.

• Adicione uma nova camada de símbolo com espessura de 1,3 e garanta que ela é uma Linha sólida.

Você notará que isso acontecerá:
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Bem, com certeza, isso não é o que queremos!

Para evitar que isso aconteça, você pode classificar os níveis dos símbolos e assim controlar a ordem em que as
diferentes camadas de símbolos são renderizadas.

To change the order of the symbol layers, select the Line layer in the Symbol layers panel, then click Advanced ->
Symbol levels... in the bottom right-hand corner of the window. This will open a dialog like this:
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Selecione Habilitar nível de símbolos. Você pode então definir a ordem das camadas de cada símbolo digitando o
número do nível correspondente. 0 é a camada inferior.

No nosso caso, queremos inverter a ordenação e deixá-la dessa forma:
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Isso vai renderizar a linha branca tracejada acima da linha preta grossa.

• Clique OK duas vezes para retornar ao mapa.

Agora o mapa ficará assim:
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Observe também que os pontos de encontro das estradas agora estão “fundidos”, de modo que uma estrada não é
apresentada acima da outra.

Quando você terminar, lembre-se de salvar o próprio símbolo de modo a não perder o seu trabalho se você alterar
o símbolo novamente no futuro. Você pode salvar o seu atual estilo de símbolo clicando no botão Estilo -> Salvar
Estilo sob a aba :guilabel: Estilo do diálogo Propriedades da camada. Geralmente, você deve salvar como Arquivo
de estilo de camada do QGIS.

Salve o seu estilo em exercise_data/styles. Você pode carregar um estilo salvo anteriormente a qualquer
momento, clicando em Estilo -> Carregar Estilo.... Antes de alterar um estilo, tenha em mente que qualquer estilo
não salvo que você estiver substituindo será perdido.

3.2.9 Try Yourself

• Modifique novamente a aparência da camada roads.

The roads must be narrow and mid-gray, with a thin, pale yellow outline. Remember that you may need to change
the layer rendering order via the Advanced -> Symbol levels... dialog.
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Confira seus resultados

3.2.10 Try Yourself

Níveis de símbolo também funcionam para camadas classificadas (ou seja, camadas que tem múltiplos símbolos).
Considerando que nós não cobrimos classificação ainda, você vai trabalhar com alguns dados pré-classificados
rudimentares.

• Crie um novo mapa e adicione apenas o conjunto de dados roads.

• Aplique o estilo advanced_levels_demo.qml fornecido em exercise_data/styles.

• Amplie a área Swellendam.

• Usando camadas de símbolos, assegure-se que os contornos das camadas fluam uns dentro dos outros con-
forme a imagem abaixo:
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Verifique seus resultados

3.2.11 Follow Along: Tipos de Camadas de Símbolos

Além de definir as cores de preenchimento e usar padrões pré-definidos, você pode usar diferentes tipos de ca-
madas de símbolos. O único tipo que temos usado até agora é o tipo Preenchimento Simples. Os mais avançados
tipos de camadas de símbolos permitem que você personalize seus símbolos ainda mais.

Cada tipo de vetor (ponto, linha e polígono) tem seu próprio conjunto de tipos de símbolo. Primeiro, vamos olhar
para os tipos disponíveis para os pontos.

Tipos de Camadas de Símbolos para Pontos

• Abra seu projeto.

• Troque as propriedades de símbolo para a camada places.
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• Você pode acessar os diferentes tipos de camadas de símbolos selecionando a camada Marcador simples no
painel Camadas de símbolos, ao clicar na lista em cascata Tipo da camada símbolo:

• Investigue as várias opções disponíveis para você e escolha um símbolo com um estilo que você considera
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adequado.

• Se estiver em dúvida, utilize um Marcador simples envolto em uma borda branca, com um preenchimento
verde pálido, com um Tamanho de 3,00 e com uma Espessura da borda de 0,5.

Tipos de Camadas de Símbolos para Linhas

Para ver as várias opções disponíveis para dados lineares:

• Altere o tipo da camada símbolo do símbolo mais acima de roads para Marcador de linha:

• Selecione a camada Marcador simples no painel Camadas de símbolos à esquerda da janela. Altere as
propriedades do símbolo para corresponder ao seguinte diálogo:
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• Altere o intervalo para 1,00:
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• Ensure that the symbol levels are correct (via the Advanced -> Symbol levels dialog we used earlier) before
applying the style.

Depois de ter aplicado o estilo, dê uma olhada em seus resultados no mapa. Como você pode ver, esses símbolos
mudam de direção junto com a estrada, mas nem sempre dobram junto com ela. Isto é útil para certos fins, mas
não para outros. Se preferir, você pode mudar a camada de símbolo em questão para voltar a ser como era antes.

Tipos de Camadas de Símbolos para Polígonos

Para ver as várias opções disponíveis para dados poligonais:

• Altere o Tipo da camada símbolo para a camada water, como feito antes para as outras camadas.

• Investigue que opções diferentes na lista pode-se usar.

• Escolha uma que você considere adequada.

• Se estiver em dúvida, utilize Padrão de preenchimento de pontos com as seguintes opções:
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• Adicione uma nova camada de símbolos com Preenchimento simples.

• Use o mesmo azul claro com uma borda azul escuro.

• Mova-a para debaixo da camada de padrão de preenchimento de ponto usando o botão Mover para baixo.
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Como resultado, você tem um símbolo texturizado para a camada water, com a vantagem adicional de que você
pode mudar o tamanho, forma e distância dos pontos individuais que compõem a textura.

3.2.12 Follow Along: Criando um Preenchimento SVG Personalizado

Nota: Para fazer este exercício, você precisará ter instalado o software livre de edição de vetor Inkscape.

• Abra o programa Inkscape.

Você verá a seguinte interface:
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Você deve achar o programa familiar se você já usou outros programas de edição de imagem vetorial, como o
Corel.

Primeiro, vamos mudar a tela para um tamanho apropriado para uma pequena textura.

• Clique no item de menu Arquivo → Propriedades do Desenho. Isso fará com que seja aberta a janela
Propriedades do Desenho.

• Troque Unidades para px.

• Troque Largura e Altura para 100.

• Feche a janela quando terminar.

• Clique no item de menu Exibir → Zoom → Página para ver a página que você está trabalhando.

• Selecione a ferramenta Elipse.
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• Clique e arraste na página para desenhar uma elipse. Para fazer a elipse converter-se em um círculo, segure
a tecla ctrl enquanto estiver desenhando.

• Clique com o botão direito no círculo que você acabou de criar e abra Preenchimento e contorno:

• Change the Stroke paint to a pale grey-blue and the Stroke style to a darker color with thin stroke:
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• Desenhe uma linha utilizando a ferramenta Mão livre:

• Clique uma vez para começar a linha. Mantenha a tecla ctrl pressionada para fazer com que a linha se
mova em incrementos de 15 graus.

• Clique uma vez para acabar o segmento de linha, depois clique com o botão direito para finalizar a linha.

• Troque a cor e a espessura para coincidir com a da borda do círculo e mova se necessário de maneira que ao
final você tenha um símbolo como este:
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• Salve-o como landuse_symbol na pasta em que o curso está, em exercise_data/symbols, como um
arquivo SVG.

No QGIS:

• Abra Propriedades da camada para a camada urban.

• Troque a estrutura do símbolo para a seguinte e encontre a sua imagem SVG pelo botão Selecionar:
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Você também pode querer atualizar a borda da camada svg:
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Sua camada de área urbana agora de ter uma textura como a do mapa abaixo:
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3.2.13 In Conclusion

Alterando a simbologia para as diferentes camadas transformou uma coleção de arquivos vetoriais em um mapa
legível. Não apenas você pode ver o que está acontecendo mas é ainda agradável de olhar!

3.2.14 Further Reading

Exemplos de Mapas Bonitos

3.2.15 What’s Next?

Alterar símbolos para camadas inteiras é útil, mas a informação contida dentro de cada camada ainda não está
disponível para alguém ler esses mapas. Como se chamam as ruas? A que regiões administrativas pertencem
certas áreas? Quais são as superfícies relativas das fazendas? Toda esta informação está ainda escondida. A
próxima lição irá explicar como representar estes dados em seu mapa.

Nota: Você se lembrou de salvar seu mapa recentemente?
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CHAPTER 4

Module: Classificando Dados Vetoriais

Classificando dados vetoriais permite atribuir diferentes símbolos em feições (diferentes objetos na mesma ca-
mada), de acordo com seus atributos. Isso permite que alguém que use o mapa para visualizar facilmente deter-
minados atributos em diferentes feições.

4.1 Lesson: Atributos

Até agora, nenhuma das alterações que fizemos para o mapa foram influenciadas pelos objetos que estão sendo
mostrados. Em outras palavras, todas as áreas urbanas são parecidas, e todas as estradas parecem iguais. Ao olhar
para o mapa, os espectadores não sabem nada sobre as estradas que estão vendo; apenas que existe uma estrada
de uma determinada forma numa determinada área.

Mas a força do SIG é que todos os objetos que são visíveis no mapa também têm atributos. Mapas em um SIG
não são apenas imagens. Eles representam não apenas os objetos em locais, mas também informações sobre esses
objetos.

O objetivo desta lição: Explorar os atributos de um objeto e entender como os dados podem ser úteis.

4.1.1 Follow Along: Atributos

Abra a tabela de atributos para a camada places (veja a seção “Trabalhando com Dados Vetoriais” se necessário)
Qual seria o campo mais útil para apresentar como rótulo e por quê?

Verifique seus resultados

4.1.2 In Conclusion

Você já sabe como usar a tabela de atributos para ver o que são realmente os dados que você está usando. Qualquer
conjunto de dados só será útil para você se ele tiver atributos do seu interesse. Se você sabe quais os atributos que
você precisa, você pode decidir rapidamente se você poderá usar um determinado conjunto de dados, ou se você
precisa procurar por outro que tenha os atributos necessários.

4.1.3 What’s Next?

Atributos diferentes são úteis para diferentes objetivos. Alguns podem estar representados diretamente como texto
para ser visto pelo usuário. Você aprenderá como fazer isso na próxima lição.
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4.2 Lesson: A Ferramenta de Rótulo

Os rótulos podem ser adicionados a um mapa para mostrar qualquer informação sobre um objeto. Qualquer
camada vetorial pode ter rótulos associados. Esses rótulos tem seu conteúdo baseado nos atributos de uma camada.

Nota: O diálogo Propriedades da camada tem uma aba Rótulos que oferece a mesma função, mas para este
exemplo utilizaremos a Ferramento de rótulo, acessível via a barra de ferramentas.

O objetivo desta lição: Aplicar rótulos úteis e bonitos para uma camada.

4.2.1 Follow Along: Utilizando Rótulos

Antes de acessar a ferramenta de rótulos, você precisará se assegurar que a mesma está ativa.

• Vá para o item de menu Exibir → Barra de Ferramentas.

• Certifique-se de que o item Rótulo esteja com uma marca de seleção ao lado dele. Se não estiver, clique em
Rótulo e ele será ativado.

• Clique na camada places na Lista de camadas, para que a mesma fique destacada.

• Click on the following toolbar button:

Isso fará com que se abra o diálogo Configurações de rótulo de camada.

• Marque a opção Rotular esta camada com.

Você precisará escolher qual campo dos atributos será usado para os rótulos. Na lição anterior, você decidiu que o
campo NAME era o mais adequado para esse propósito.

• Selecione name na lista:
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• Clique OK.

Agora o mapa deve ter etiquetas como estas:
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4.2.2 Follow Along: Alterando as opções de Rótulo

Dependendo dos estilos que você escolheu para o seu mapa em lições anteriores, você pode achar que os rótulos
não estão devidamente formatados e que se sobrepõem ou que estão demasiado longe de suas marcas de ponto.

• Abra a Ferramenta de rótulo novamente clicando no respectivo botão.

• Assegure-se que a opção Texto está selecionada na lista de opções do lado esquerdo, depois, atualize as
opções de formato de texto para que coincida com o que é mostrado aqui:
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O problema da fonte está resolvido! Agora vamos olhar para o problema dos rótulos sobrepostos aos pontos, mas
antes de fazermos isso, vamos dar uma olhada na opção Buffer.

• Abra a Ferramenta de rótulo.

• Selecione Buffer na lista de opções à esquerda.

• Selecione a opção Desenhar buffer do texto, depois escolha as opções que coincidem com o que se mostra
aqui:
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• Clique em Aplicar.

Você verá que isso adiciona um buffer ou borda colorida aos rótulos de places, tornando-os mais fáceis de ver no
mapa:
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Agora, podemos resolver o posicionamento dos rótulos em relação aos seus pontos.

• Na Ferramenta de rótulo, vá à aba Posição.

• Troque o valor de Distância para 2mm e certifique-se de que Em torno do ponto esteja selecionado.
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• Clique em Aplicar.

Você verá que os rótulos já não estão sobrepostos aos pontos.

4.2.3 Follow Along: Utilizando Rótulos no lugar da Simbologia da Camada

Em muitos casos, o local de um ponto não precisa ser muito específico. Por exemplo, a maioria dos pontos da
camada places refere-se a cidades ou bairros inteiros e o ponto associado com tais características não é tão preciso
em uma escala grande. De fato, apresentando um ponto que é muito específico é muitas vezes confuso para alguém
que lê um mapa.

Para citar um exemplo: em um mapa do mundo o ponto dado para a União Europeia pode estar em algum lugar
na Polônia. Para alguém lendo o mapa, ver um ponto marcado União Europeia na Polônia, pode levar a crer que
a capital da União Europeia é na Polônia.

Então, para evitar esse tipo de mal-entendido, muitas vezes é útil desativar os símbolos de pontos e substituí-los
por completo com rótulos.

No QGIS, você pode fazer isso alterando a posição dos rótulos a serem apresentados diretamente sobre os pontos
a que se referem.

• Abra a janela Configurações de rótulo de camada para a camada places.

• Selecione a opção Posição na lista de opções.

• Clique na opção Afastado do ponto.

58 Chapter 4. Module: Classificando Dados Vetoriais



QGIS Training Manual, Versão 2.8

Isso revelará as opções para Quadrante que você pode usar para definir a posição do rótulo em relação ao ponto.
Neste caso, queremos que o rótulo esteja centralizado no ponto, então, escolha o quadrante central:

• Esconda os símbolos de ponto editando o estilo da camada, como de costume, definindo a altura e largura
do símbolo Marcador de elipse para 0:
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• Clique em OK e veja o resultado:
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Se você estava com um zoom menor no mapa, você verá que alguns dos rótulos desapareceram em escalas maiores
para evitar sobreposição. Às vezes, isso é o que você quer quando se tratar de conjuntos de dados que têm muitos
pontos, mas outras vezes você vai perder informações úteis desta forma. Há uma outra possibilidade para lidar
com casos como este, que abordaremos em um exercício mais adiante nesta lição.

4.2.4 Try Yourself Personalizar Rótulos

• Retorne as configurações de rótulo e de símbolos para ter um marcador de ponto e um rótulo deslocado em
2,00mm. Você pode querer ajustar o estilo do ponto ou dos rótulos nesta fase.

Verifique seus resultados

• Ajuste o mapa para a escala 1:100000. Você pode fazer isso escrevendo na caixa Escala na Barra de
estado.

• Modifique seus rótulos para adequá-los à visualização nessa escala.

Confira seus resultados
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4.2.5 Follow Along: Rotulando Linhas

Agora que você sabe como funciona a rotulagem, há um problema adicional. Pontos e polígonos são fáceis de
rotular, mas o que dizer sobre linhas? Se você as rotulasse da mesma forma que os pontos, o resultado ficaria
assim:

Vamos agora reformatar os rótulos da camada roads de modo que eles fiquem fáceis de entender.

• Esconda a camada Places para que não o distraia.

• Ative os rótulos da camada roads como antes.

• Ajuste o Tamanho da fonte para 10 para poder ver mais rótulos.

• Dê zoom na área da cidade de Swellendam.

• Na caixa de diálogo Configurações de rótulo de camada, faça os seguintes ajustes:
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Você provavelmente verá que o estilo do texto utilizou valores padrão e os rótulos são, consequentemente, muito
difíceis de ler. Defina o formato de texto do rótulo com uma Cor preto ou cinza-escuro e um : kbd:Buffer
amarelo-claro.

O mapa ficará parecido com esse, dependendo da escala:
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Verá que alguns dos nomes das ruas aparecem mais de uma vez e que nem sempre são necessários. Para prevenir
isso:

• Na caixa de diálogo Configurações de rótulo de camada, escolha a opção Renderizar e selecione Mesclar
linhas conectadas para evitar rótulos duplicados:
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• Clique OK.

Outra função útil é uma que previne que rótulos sejam desenhados para feições muito pequenas, difíceis de serem
notadas.

• No mesmo painel Renderizar, ajuste o valor de Omitir rotulagens de feições menores que para 5mm e veja
o resultado após clicar em Aplicar.

Experimente diferentes ajustes em Posição. Como vimos anteriormente, a opção Paralelo não é uma boa ideia
neste caso, ao invés disso, vamos tentar a opção Curvo.

• Selecione a opção Curvo no painel Posição da caixa de diálogo Configurações de rótulo de camada.

Aqui está o resultado:
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Como você pode ver, muitos dos rótulos que antes eram visíveis ficaram ocultos pela dificuldade de fazer com que
alguns sigam as curvas das ruas e continuem sendo legíveis. Você pode decidir quais opções usar dependendo do
que ache que será mais útil ou melhor de se ver.

4.2.6 Follow Along: Ajustes Definidos de Datos

• Desactiva las etiquetas de la capa Streets.

• Reactiva las etiquetas para la capa Places.

• Abre la tabla de atributos para Places a través del botón .

Tiene un campo que nos interesa ahora: place que define el tipo de área urbana para cada objeto. Podemos usar
estos datos para influir en los estilos de las etiquetas.

• Navega al panel Text en el panel Etiquetas panel.

• En el menú desplegable Italic, selecciona Editar expresión para abrir Etiqueta basada en expresión:
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En el cuadro de texto, escribe "place" = ’town’ y clic en Aceptar dos veces:
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Nota los efectos:
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4.2.7 Try Yourself Utilizando Ajustes Definidos de Datos

Nota: Estamos saltando hacia adelante un poco para demostrar algunos ajustes avanzados de las etiquetas. En el
nivel avanzado, se asume que sabrás qué significa lo siguiente. En caso contrario, eres libre de dejar esta sección
y volver cuando hayas cubierto los materiales requeridos.

• Abre la Tabla de Atributos para places.

• Entra en el modo editar haciendo clic en el botón:

• Añade una columna nueva:

• Configúrala como esta:
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• Utiliza esto para ajustar y personalizar los tamaños de fuente para cada tipo de sitio distinto (es decir, cada
tecla en el campo PLACE).

Comprueba tus resultados

4.2.8 Más Posibilidades Con Etiquetas

No podemos cubrir todas las opciones en este curso, pero date cuenta de que el Herramienta de etiquetado tiene
muchas otras funciones útiles. Puedes ajustar representación basada en escala, alterar las prioridades de repre-
sentación para las etiquetas en una capa, y ajustar cada opción de etiquetas utilizando la capa de atributos. Puedes
incluso ajustar la rotación, posición XY, y otras propiedades de una capa (si tienes diferentes campos de atributos
situados para tal fin), entonces edita las propiedades utilizando las herramientas adyacentes a la Herramienta de
etiquetado principal:

(Estas herramientas estarán activas si los campos de atributo requeridos están disponibles y el modo edición está
activado.)

Eres libre de explorar más posibilidades del sistema de etiquetas.

4.2.9 In Conclusion

Has aprendido a usar la capa de atributos para crear etiquetas dinámicas. Esto puede hacer tu mapa mucho más
informativo y estilizado.
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4.2.10 What’s Next?

Ahora que sabes cómo los atributos conllevan una diferencia visual en tu mapa, ¿Como los usamos para cambiar
la simbología de los objetos? ¡Ese es el tema de la siguiente lección!

4.3 Lesson: Clasificação

Las etiquetas son una buena forma de comunicar información como nombres de sitios individuales, pero no pueden
ser usados para todo. Por ejemplo, digamos que alguien quiere saber para qué es usada cada etiqueta landuse.
Utilizando etiquetas, obtendrías esto:

Esto dificulta la lectura el etiquetado del mapa e incluso sería abrumador si hay muchos usos diferentes del
territorio en un mapa.

El objetivo de esta lección: Aprender como clasificar los datos vectoriales efectivamente.

4.3.1 Follow Along: Clasificación de Datos Nominales

• Abrir el cuadro de diálogo Propiedades de la Capa para la capa landuse.

• Ir a la pestaña Estilo.

• Clique no menu suspenso que diz Simbologia Simples e altere-o para Categorizado:
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• En el nuevo panel, cambiar Columna por landuse y Rampa de color por Greens.

• Clic el botón etiquetado Clasificar:
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• Clic Aceptar.

Verás algo como esto:
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• Clic en la flecha (o signo de suma) siguiente a landuse en Lista de capas, verás las categorias explicadas:

Ahora nuestros polígonos de usos del territorio están correctamente coloreados y clasificados estando las áreas
con el mismo uso del territorio del mismo color. Puede que quieras quitar el borde negro de la capa landuse:
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• Abre Propiedades de la capa, ve a la pestaña Esitlo y selecciona Símbolo.

• Cambia el símbolo quitando el borde de la capa Releno sencillo y clic en Aceptar.

Verás que los contornos del polígono de usos del territorio se ha borrado, dejando solo nuestro relleno de colores
para cada clasificación.

• Si quisieras, puedes cambiar el color de relleno para cada área de uso del territorio con doble clic en el
bloque de color correspondiente.

Nota que hay una categoría vacía.
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La categoría vacía se usa para colorear cualquier objeto que no tenga un valor definido para uso del territorio
o que tiene un valor NULL. Es importante mantener esta categoría para que las áreas con un valor NULL sigan
representadas en el mapa. Puede que quieras cambiar el color a uno que represente mejor el valor en blanco o
NULL.

¡Recuerda guardar tu mapa ahora para no perder todos tus laboriosos cambios!

4.3.2 Try Yourself Más Clasificación

Si solo estás siguiendo el contenido del nivel básico, usa el conocimiento que has ganado anteriormente para
clasificar la capa buildings. Ajusta la categorización en la columna de buildings y usa la rampa de color Spectral.

Nota: Recuerda ampliar en un área urbana para ver los resultados.

4.3.3 Follow Along: Clasificación por Razones

Hay cuatro tipos de clasificación: nominal, ordinal, de intervalos y relativa.
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En clasificación nominal, las categorías en las que los objetos están clasificados están basadas en nombres; no
tienen orden. Por ejemplo; nombres de ciudades, códigos postales, etc.

En clasificación ordinal, las categorías están organizadas en cierto orden. Por ejemplo, ciudades del mundo se dan
en un rango dependiendo de la importancia para el comercio mundial, viajes, cultura, etc.

En clasificación de intervalos, los números están en una escala con valores positivos, negativos y nulos. Por
ejemplo: altura sobre/bajo el nivel del mar, temperatura sobre/bajo congelación (0 grados Centígrados), etc.

En clasificación por razones, los números están en una escala con solo valores positivos y nulos. Por ejemplo:
temperatura sobre cero absoluto (0 grados Kelvin), distancia desde un punto, cantidad media mensual de tráfico
en una calle dada, etc.

En el ejemplo anterior, usamos clasificación nominal para asignar cada granja a la ciudad que la administra. Ahora
usaremos clasificación de rango para clasificar las granjas por área.

• Guarda tu simbología de usos del territorio (si quieres conservarla) con clic en el botón Guardar estilo del
cuadro de diálogo Estilo.

Vamos a reclasificar la capa, así que las clases existentes se perderán si no están guardadas.

• Cierra el cuadro de diálogo Estilo.

• Abre la Tabla de Atributos para la capa landuse.

Queremos clasificar las áreas de usos del territorio por tamaño, pero hay un problema: no tienen un campo de
tamaño, así que tendremos que crearlo.

• Entra en el modo edición clicando en este botón:

• Añade una columna nueva con este botón:

• Ajusta el cuadro de diálogo que aparece, como este:
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• Clic Aceptar.

El nuevo campo será añadido (en el extremo derecho de la tabla; puede que necesites desplazarte horizontalmente
para verlo). Sin embargo, en este momento no está muy lleno, solo tiene muchos valores NULL.

Para solucionar este problema, necesitaremos calcular las áreas.

• Abre el campo calculadora:

Obtendrás este cuadro de diálogo:
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• Cambia los valores en la parte de arriba del cuadro de diálogo para que se vea como esto:

• En la Lista de funciones, selecciona Geometría → $area:
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• Haz doble clic en ella para que aparezca en el campo Expresión

• Clic Aceptar.

Ahora tu campo AREA está lleno de valores (puede que necesites hacer clic en el encabezado de la columna para
actualizar los datos). Guarda la edición y clic Aceptar.

Nota: Esas áreas están en grados. Luego los calcularemos en metros cuadrados.

• Abre la pestaña Estilo del cuadro de diálogo Propiedades de la capa.

• Cambia la clasificación del estilo de Categorizado a Graduado.

• Cambia la Columna a AREA:

• En Rampa de color, elige la opción Nueva rampa de color... para obtener este cuadro de diálogo:
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• Elige Gradiente (si no estaba ya seleccionada) y clic en Aceptar. Verás esto:
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Estarás usando esto para denotar áreas, con áreas pequeñas como Color 1 y áreas grandes como Color 2.

• Elige los colores apropiados.

En el ejemplo, el resultado se ve así:
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• Clic Aceptar.

• Elige un nombre adecuado para la nueva capa de rampa de color.

• Clic en Aceptar despues de nombrarlo.

Ahora tendrás algo como esto:
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Deja todo lo demás como está.

• Clic en Aceptar:
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4.3.4 Try Yourself Refinar la Clasificación

• Quita las líneas entre las clases.

• Cambia los valores de Modo y Clases hasta que obtengas una clasificación coherente.

Comprueba tus resultados

4.3.5 Follow Along: Clasificación basada en Reglas

Es común combinar múltiples criterios para una clasificación, pero desafortunadamente la clasificación normal
solo tiene en cuenta un atributo. Ahí es donde la clasificación basada en reglas entra en juego.

• Abrir el cuadro de diálogo Propiedades de la Capa para la capa landuse.

• Escoge la pestaña Estilo.

• Ve al estilo de clasificación Basado en reglas. Tendrás esto:
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• Click the Add rule button: .

• Un nuevo cuadro de diálogo aparecerá.

• Haz clic en el botón elíptico ... al lado del área de texto Filtrar.

• Uilizando el constructor de consultas que aparece, pon el criterio "landuse" = ’residential’
AND "name" != ’ |majorUrbanName| ’ , clic Aceptar y elige un azul grisáceo pálido y quita
el borde:
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• Add a new criterion "landuse" != ’residential’ AND AREA >= 0.00005 and choose a
mid-green color.

• Añade otro criterio nuevo "name" = ’ |majorUrbanName| ’ y asígnale un color azul grisáceo os-
curo para indicar la importancia de la ciudad en la región.

• Haz clic y arrastra el criterio a la parte superior de la lista.

Esos filtros son exclusivos, en ellos se excluyen algunas áreas del mapa (es decir, aquellas que son más pequeñas
que 0.00005, no son residenciales y no están en ‘Swellendam‘). Esto significa que los polígonos excluidos adop-
tarán la categoría de estilo (sin filtro) por defecto

Sabemos que los polígonos excluidos en nuestro mapa no pueden ser áreas residenciales, así que le daremos una
categoría adecuada de verde pálido por defecto.

Tu cuadro de diálogo ahora ha quedado así:
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• Aplica esta simbología.

Tu mapa se parecerá a este:
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Ahora tienes un mapa con las áreas residenciales más destacadas Swellendam y otras áreas no residenciales col-
oreadas de acuerdo con su tamaño.

4.3.6 In Conclusion

La simbología nos permite representar los atributos de una capa de una forma sencilla de entender. También
permite a los que visualicen el mapa entender el significado de las características, utilizando atributos relevantes
que hemos escogido. Dependiendo del problema al que te enfrentes, aplicarás diferentes técnicas de clasificación
para resolverlos.

4.3.7 What’s Next?

Ahora tenemos un bonito mapa, pero ¿Cómo obtendremos del QGIS un formato que se pueda imprimir o conver-
tirlo en una imagen o PDF? ¡Ese es el tema de la siguiente lección!
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Module: Criando Mapas

Neste módulo, você aprenderá como usar o Compositor de Mapa QGIS para produzir mapas de qualidade, com
todos os componentes necessários de um mapa.

5.1 Lesson: Utilización del Compositor de Mapas

Ahora que tienes un mapa, necesitas ser capaz de imprimirlo o exportarlo a un documento. Ya que el archivo de
mapa de SIG no es una imagen. Más bien guarda el estado del programa SIG, con referencias a todas las capas,
sus etiquetas, colores, etc. Así que para alguien que no tenga los datos o el mismo programa SIG (como QGIS),
el archivo del mapa será inútil. Afortunadamente, QGIS puede exportar el archivo del mapa a un formato que
cualquier ordendor pueda leer, así como imprimir el mapa si tienes una impresora conectada. Exportar y imprimir
se gestiona a través del Diseñador de Mapas.

El objetivo de esta lección: Utilizar el Diseñador de Mapas del QGIS para crear un mapa básico con todos los
ajustes requeridos.

5.1.1 Follow Along: El Administrador de Diseñadores

QGIS te permite crear múltiples mapas utilizando el mismo archivo de mapa. Por esta razón, tiene una herramienta
llamada Administrador de diseñadores.

• Haz clic en el menú Proyecto → Administrador de diseñadores para abrir esta herramienta. Verás un cuadro
de diálogo en blanco Administrador de diseñadores aparecer.

• Haz clic en el botón Añadir y da al nuevo diseñador el nombre Swellendam.

• Haz clic en Aceptar.

• Haz clic en el botón Mostrar.

(También podrías cerrar el cuadro de diálogo y navegar a un diseñador a través de los menús Proyecto → Dis-
eñadores de impresión, como en la imagen inferior.)
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Cualquier ruta que escojas te llevará ahí, verás ahora la ventana :guilabel:‘ Diseñador de impresión‘:
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5.1.2 Follow Along: Composición Básica del Mapa

En este ejemplo, la composición ya estaba de la forma en que la queremos. Asegúrate de que la tuya también está
así.

• En la ventana Diseñador de impresión, comprueba que los valores de Diseño → Papel y Calidad están
ajustados como sigue:

• Tamaño: A4 (210x297mm)

• Orientación: Landscape

• Resolución de exportación: 300dpi

Ahora tienes la disposición de la página como la querías, pero esta página todavía está en blanco. Le falta el mapa
claramente. ¡Vamos a solucionarlo!

• Click on the Add New Map button:

Con esta herramienta activada, serás capaz de situar el mapa en la página.

• Haz clic y arrastra una caja en la página en blanco:

El mapa aparecerá en la página.

• Mueve el mapa clicando y arrastrándolo:
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• Cambia el tamaño clicando y arrastrando sobre las esquinas de la caja:

Nota: Puede que tu mapa se vea muy diferente, ¡Por supuesto! Esto depende en cómo esta ajustado tu propio
proyecto. ¡Pero no te preocupes! Estas instrucciones son generales, así que funcionarán adecuándose a la forma
en que se vea el mapa.

• Asegúrate de ajustar los márgenes a lo largo de las esquinas, y dejar un espacio en la parte superior para el
título.

• Amplía y disminuye el zoom de la página (¡pero no del mapa!) utilizando esos botones:
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• Zoom and pan the map in the main QGIS window. You can also pan the map using the Move item content

tool:

Cuando amplíes, el mapa no se actualizará por sí mismo. Así que no pierdas el tiempo dibujando de nuevo el
mapa mientras amplíes la página a donde quieras, también significa que si amplías o disminuyes el zoom, el mapa
estará en una incorrecta resolución y se verá mal o será ilegible.

• Actualiza el mapa clicando el botón:

Recuerda que el tamaño y posición que te da el mapa no son la final necesariamente. Siempre puedes volver y
cambiarla si no te satisface. Por ahora, necesitas asegurarte que has guardado tu trabajo en el mapa. Como un
Diseñador en QGIS es parte de un archivo de mapa principal, necesitaras guardar tu proyecto principal. Ves a
la ventana QGIS principal (la que tiene Lista de capas y los otros elementos familiares con los que has estado
trabajando), y guarda tu proyecto desde ahí como normalmente.

5.1.3 Follow Along: Añadiendo un Título

Ahora tu mapa se ve bien en la página, pero a tus lectores/usuarios no se les ha dicho qué está pasando todavía.
Necesitan algún contexto, que les proveerás añadiendo los elementos del mapa. Primero, añadamos un título.

• Click on this button:

• Haz clic en la página, arriba del mapa, y una etiqueta aparecerá en la parte superior del mapa.

• Cambia el tamaño y sitúala en el centro superior de la página. Puede cambiarse de tamaño y ser movido de
la misma forma que el mapa.

Cuando muevas el título, notarás que aparecen líneas guía para ayudarte a posicionarlo en el centro de la página.

Sin embargo, también hay una herramienta para posicionar el título de forma relativa al mapa (no a la página):

• Haz clic en el mapa para seleccionarlo.

• Mantén pulsado shift en tu teclado y clic en la etiqueta para que queden la etiqueta y el mapa selecciona-
dos.

• Look for the Align button and click on the dropdown arrow next to it to reveal the positioning options
and click Align center:
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Para asegurarte que no mueves los elementos accidentalmente ahora que los has alineado:

• Haz clic derecho en ambos, mapa y etiqueta.

Un pequeño candado aparecerá en la esquina para decirte que el elemento no puede arrastrarse ahora. Siempre
puedes hacer clic derecho en un elemento de nuevo para desbloquearlo.

Ahora la etiqueta está centrada en el mapa, pero los contenidos no lo están. Para centrar los contenidos de la
etiqueta:

• Selecciona la etiqueta clicando en ella.

• Haz clic en la pestaña Propiedades del elemento del panel lateral de la ventana del Diseñador.

• Cambia el texto de la etiqueta a “Swellendam”:

• Utiliza la interfaz para ajustar las opciones de alineación y fuente:

• Elige una fuente grande pero discreta (por ejemplo usa la fuente por defecto con un tamaño de 36) y ajusta
la Alineación horizontal a Centro.

96 Chapter 5. Module: Criando Mapas



QGIS Training Manual, Versão 2.8

También puedes cambiar el color de la fuente, pero probablemente sea mejor mantenerla en negro como por
defecto.

Los ajustes por defecto no añaden un marco a la caja de texto del título, si quieres añadir un marco, puedes hacerlo
así:

• En la pestaña Propiedades del elemento, desplázate hacia abajo hasta que veas la opción Marco.

• Haz clic en la casilla de verificación para habilitar el marco. También puedes cambiar el color del marco y
su grosor.

En este ejemplo, no habilitaremos los marcos, así que aquí está nuestra página hasta el momento:

5.1.4 Follow Along: Añadiendo una Leyenda

El lector del mapa también necesita ser capaz de ver qué significan las cosas representadas en el mapa. En algunos
casos, como los nombres de los sitios, es muy obvio. En otros casos es mas difícil de adivinar, como los colores
de las granjas. Así que añadamos una leyenda nueva.

• Click on this button:

• Haz clic en la página para situar la leyenda, y muévela hasta donde quieras situarla.
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5.1.5 Follow Along: Personalizando Elementos de la Leyenda

No necesitamos todo lo que está en la leyenda, así que elimina los elementos no deseados.

• En la pestaña Propiedades del elemento, encontrarás el panel Elementos de la leyenda.

• Selecciona la entrada buildings.

• Delete it from the legend by clicking the minus button:

También puedes renombrar los elementos.

• Selecciona una capa de la misma lista.

• Haz clic en el botón Editar:

• Renombra las capas a Places, Roads and Streets, Surafce Water, y Rivers.

• Ajusta landuse a Oculta, luego clic en la flecha hacia abajo y edita cada categoría para nombrarlas en la
leyenda. También puedes reordenar los elementos:
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Como la leyenda cambiará de anchura con los nuevos nombres de capas, puede que desees mover y cambiar el
tamaño de la leyenda y/o el mapa. Este es el resultado:

5.1.6 Follow Along: Exportando Tu Mapa

Nota: ¿Te acordaste de guardar tu trabajo regularmente?

¡Finalmente el mapa está listo para exportarlo! Verás los botones de exportación en la esquina superior izquierda
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de la ventana Diseñador.

El botón de la izquierda es Imprimir, que se enlaza con la impresora. Las opciones de impresión cambiarán
dependiendo del modelo de impresora con la que trabajes, probablemente sea mejor consultar el manual de la
impresora o una guía general de impresión para más información sobre este tema.

Los otros tres botones te permiten exportar la página del mapa a un archivo. Hay tres formatos entre los que elegir:

• Exportar como imagen

• Exportar como SVG

• Exportar como PDF

Exportar como una imagen te dará una selección de varios formatos de imagen comunes a elegir. Es probablemente
la opción más simple, pero la imagen creada está “muerta” y es difícil de editar.

Las otras dos opciones son mas comunes.

Si vas a enviar el mapa a un cartógrafo (que pueda querer editar el mapa para publicarlo), es mejor exportarlo
como SVG. SVG se entiende como “Gráfico de Vectores Escalares”, y puede ser importado a programas como el
Inkscape o otro software de edición de imágenes.

Si vas a mandar el mapa a un cliente, es más común utilizar un PDF, ya que es más fácil de usar y de ajustar las
opciones de impresión. También algunos cartógrafos pueden preferirlo, si tienen programas que les permita editar
este formato.

Para nuestros propósitos, utilizaremos PDF.

• Click the Export as PDF button:

• Elige un destino para guardar y nombra el archivo como normalmente.

• Haz clic en Guardar.

5.1.7 In Conclusion

• Cierra la ventana Diseñador.

• Guarda tu mapa.

• Encuentra tu PDF exportado utilizando el administrador de archivos de tu sistema operativo.

• Ábrelo.

• Deléitate con su esplendor.

¡Enhorabuena por tu primer proyecto de mapa QGIS completado!

5.1.8 What’s Next?

En la siguiente página, te daremos tareas para completar. Esto te permitirá practicar con las técnicas que has
aprendido hasta ahora.

5.2 Exercício 1

Abra o projeto de mapa existente e revise-o completamente. Se você notar pequenos erros ou coisas que você não
gostou corrija antes, faça isso agora.

Ao personalizar seu mapa, faça as seguintes pergunta a si mesmo. É este mapa fácil de ler e entender para alguém
que não está familiarizado com esses dados? Se eu visse este mapa na internet, em um cartaz ou em uma revista,
ele seria capaz de captar a minha atenção? Eu gostaria de ler este mapa se ele não fosse o meu?

100 Chapter 5. Module: Criando Mapas



QGIS Training Manual, Versão 2.8

Se você estiver fazendo esse curso em um nível Básico ou Intermediário, leia sobre as técnicas de
seções mais avançadas. Se você ver algo que gostaria de fazer no seu mapa, por que não tentar implementá-lo?

Se este curso está sendo apresentado a você, o apresentador curso pode exigir que você envie uma versão final do
seu mapa, exportados para PDF, para avaliação. Se você estiver fazendo este curso por si mesmo, é recomendável
que você avalie o seu próprio mapa usando os mesmos critérios. Seu mapa será avaliado tanto pela aparência geral
e legendas do mapa em si, bem como a aparência e o layout da página do mapa e elementos. Lembre-se que a
ênfase para avaliar a aparência de seus mapas será sempre facilidade de utilização . Quanto mais bonito e fácil é
de entender à primeira vista, melhor.

Boa sorte na elaboração do seu mapa.

5.2.1 In Conclusion

Nos quatro primeiros módulos você aprendeu como criar e estilizar um mapa vetorial. Nos próximos quatro
módulos, você vai aprender como usar QGIS para uma análise GIS completa. sso inclui a criação e edição de
dados vetoriais; análise de dados vetoriais; usando e analisando dados raster; e utilizando GIS para resolver um
problema do início ao fim, usando tanto raster e fontes de dados vetoriais.
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CHAPTER 6

Module: Criação de Dados Vetoriais

A criação de mapas usando dados existentes é apenas o começo. Neste módulo, você vai aprender como modificar
dados vetoriais existentes e criar novos conjuntos de dados completo.

6.1 Lesson: Creando un Nuevo Conjunto de Datos Vectoriales

Los datos que has usado vienen de algún sitio. Para la mayoría de aplicaciones comunes, los datos ya existen;
pero cuanto más particular y especializado sea el proyecto, más difícil será encontrar datos disponibles. En estos
casos, necesitarás crear tus propios datos nuevos.

El objetivo de esta lección: Crear un nuevo conjunto de datos.

6.1.1 Follow Along: Cuadro de Diálogo de Creación de Capas

Antes de poder añadir nuevos datos vectoriales, necesitas un conjunto de datos vectoriales al que añadirlos. En
nuestro caso, empezarás creando nuevos datos por completo, en lugar de editar un conjunto de datos existente.
Además, necesitarás definir de antemano tu propio conjunto de datos nuevo.

Necesitarás abrir el cuadro de diálogo Nueva capa de archivo shape que te permitirá definir una nueva capa.

• Navega y haz clic en la entrada del menú Capa → Nueva → Nueva capa de archivo shape.

Se presentará el siguiente cuadro de diálogo:
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Es importante decidir qué tipo de conjunto de datos quieres en este punto. Cada tipo de capa vectorial esta
“construida de forma diferente” en sus bases, así que una vez hayas creado la capa, no puedes cambiar su tipo.

Para el siguiente ejercicio, crearemos nuevas características para describir áreas. Para estas características, nece-
sitarás crear un conjunto de datos poligonal.

• Haz clic en el botón de opción Polígono:
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Esto no tiene impaco en el resto del cuadro de diálogo, pero hará que se use el tipo correcto de geometría cuando
el conjunto de datos vectorial se cree.

El siguiente campo te permite especificar el Sistema de Referencia de Coordenadas, o SRC. Un SRC especifica la
descripción de un punto en la Tierra en términos de coordenadas, y como hay muchas formas de hacer esto, hay
muchos SRC diferentes. El SRC de este proyecto es WGS84, así que es el correcto por defecto.

A continuación hay una colección de campos agrupados en Nuevo atributo. Por defecto una capa tiene solo un
atributo, el campo id (que deberías ver en Lista de atributos) inferior. Sin embargo, para que los datos que crees
sean útiles, necesitas decir algo sobre las características que crearás en la nueva capa. Para tus propósitos actuales,
será suficiente añadir un campo llamado nombre.

• Replica la configuración siguiente, luego haz clic en el botón Añadir a la lista de atributos.

• Comprueba que tu cuadro de diálogo ahora tiene este aspecto:
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• Haz clic en Aceptar. Una copia del diálogo aparecerá.

• Navega al directorio exercise_data.

• Guarda tu capa nueva como propiedad_escolar.shp.

La nueva capa debería aparecer en tu Lista de capas.
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6.1.2 Follow Along: Fuentes de Datos

Cuando creas nuevos datos, obviamente deben ser sobre objetos que existen realmente en el terreno. Además,
necesitarás obtener la información de alguna parte.

Hay muchas formas posibles de obtener datos sobre objetos. Por ejemplo, podrías utilizar un GPS para capturar
puntos en el mundo real y luego importar los datos al QGIS. O podrías sondear los puntos con un teodolito e
introducir las coordenadas manualmente para crear nuevas características. También podrías digitalizar procesos
para trazar objetos desde sensores de datos remotos, como imagenes de satélite o fotografía aérea.

Para nuestro ejemplo, estarás utilizando un enfoque de digitalización. Las muestras de bases de datos raster se
proporcionan, así que necesitarás importarlas cuando sea necesario.

• Click on the Add Raster Layer button:

• Navega hasta exercise_data/raster/.

• Selecciona el archivo 3420C_2010_327_RGB_LATLNG.tif.

• Haz clic en Abrir. Una imagen se cargará en tu mapa.

• Encuentra la nueva imagen en la Lista de capas.

• Haz clic y arrástrala al final de la lista para poder seguir viendo tus otras capas

• Encuéntrala y amplía el zoom a su área:

Nota: Si la simbología de la capa buildings está cubriendo parte o la totalidad de la capa raster, puedes desactivar
la capa temporalmente deseleccionándola en el Lista de capas. También puede que quieras ocultar la simbología
de roads si te molesta.

Estarás digitalizando esos tres campos:
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Para empezar a digitalizar, necesitarás introducir modo de edición. Los software SIG normalmente lo requieren
para prevenir que edites o borres accidentalmente datos importantes. El modo edición se activa o desactiva indi-
vidualmente para cada capa.

Para introducir el modo edición para la capa propiedad_escolar:

• Haz clic en la capa en la Lista de capas para seleccionarla. (Asegúrate que seleccionas la capa correcta, ¡de
lo contrario editarás la capa incorrecta!)

• Haz clic en el botón Conmutar edición:

Si no puedes encontrar ese botón, comprueba que la barra de herramientas Digitalización está activada. Debería
haver un marcador junto a la entrada del menú Ver → Barras de herramientas → Digitalización.

Tan pronto como estés en el modo edición, verás que las herramientas de digitalización están ahora activadas:

Otros cuatro botones relevantes todavía están desactivados, pero se activarán cuando empecemos a interactuar con
nuestros nuevos datos.

De izquierda a derecha en la barra de herramientas, están:
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• Guardar cambios de la capa: guarda cambios hechos en la capa.

• Añadir objeto espacial: comienza a digitalizar un nuevo elemento.

• Mover objeto(s) espacial(es): mueve un elemento completo

• Herramienta de nodos: mueve solo una parte de un elemento

• Borrar lo seleccionado: borra el elemento seleccionado.

• Cortar objetos espaciales: corta el elemento seleccionado.

• Copiar objetos espaciales: copia el elemento seleccionado.

• Pegar objetos espaciales: pega de nuevo un elemento cortado o copiado en el mapa.

Tu quieres añadir un elemento nuevo.

• Haz clic en el botón Añadir objeto espacial para empezar a digitalizar nuestros campos escolares.

Notarás que el cursor del ratón se ha convertido en una cruz. Esto te permite situar de forma precisa los puntos que
digitalizarás. Recuerda que incluso si estas usando la herramienta de digitalización, puedes ampliar o disminuir
el zoom en tu mapa con la rueda de tu ratón, y puedes desplazarte manteniendo pulsada la rueda del ratón y
arrastrando el mapa.

El primer elemento que digitalizarás será el athletics field:

• Empieza a digitalizar clicando en un punto a lo largo del borde del campo.

• Sitúa más puntos clicando puntos adicionales en el borde, hasta que la forma que estés dibujando cubra
completamente el campo.

• Después de situar el último punto, clic derecho para acabar de dibujar el polígono. Esto finalizará el ele-
mento y te mostrará el cuadro de diálogo Atributos.

• Rellena los valores como sigue:
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• ¡Haz clic en Aceptar y habrás creado un nuevo elemento!

Recuerda, si has cometido un error cuando digitalizabas el elemento, siempre puedes editarlo después de haberlo
creado. Si has cometido un error, continúa digitalizando hasta que termines de crear el elemento como hasta ahora.
Entonces:

• Selecciona el elemento con la herramienta Seleccionar objetos espaciales individuales:

Puedes usar:

• la herramienta Mover objeto(s) espacial(es) para mover el elemento entero,

• la Herramienta de nodos para mover solo un punto que puedas haberte dejado sin seleccionar.
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• :guilabel:‘ Borrar lo seleccionado‘ para eliminar completamente el elemento para volver a probar de nuevo,
y

• el elemento del menú:menuselection:Edición –> Deshacer o el acceso directo ctrl + z en el teclado
para deshacer errores.

6.1.3 Try Yourself

• Digitaliza la propia escuela y el campo superior. Utiliza esta imagen para asistirte:

¡Recuerda que cada nuevo elemento necesita tener un valor de id único!

Nota: Cuando hayas terminado de añadir elementos a la capa, recuerda guardar tus ediciones y salir del modo
edición.

Nota: Puedes dar estilo al relleno, borde, formato y situación de la etiqueta de propiedad_escolar utilizando las
técnicas aprendidas en lecciones anteriores. En nuestro ejemplo, usaremos un borde discontinuo de púrpura claro
sin relleno.
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6.1.4 Try Yourself

• Crea una nuevo elemento lineal llamada rutas.shp con atributos id y tipo. (Utiliza la propuesta
anterior para guiarte.)

• Vamos a digitalizar dos rutas que todavía no están marcadas en la capa calles; una es una ruta de acceso, la
otra es una pista.

Nuestra ruta de acceso discurre a lo largo del borde sur del suburbio de Railton, empezando y terminando en calles
marcadas:

Nuestra pista está un poco más lejos hacia el sur:
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Uno de cada vez, digitaliza la ruta de acceso y la pista en la capa rutas. Intenta seguir las rutas tan exactamente
como puedas, utilizando puntos (clic izquierdo) en cualquier esquina o giro.

Cuando crees cada ruta, dale el tipo valor de atributo de camino o pista.

Probablemente encuentres que solo se marcan los puntos, utiliza el cuadro de diálogo Propiedades de la capa para
añadir estilo a tus rutas. Da diferentes estilos libremente a la ruta de acceso y pista.

Guarda tu edición y cambia el modo de Edición.

Comprueba tus resultados

6.1.5 In Conclusion

¡Ahora sabes cómo crear elementos! Este curso no cubre el añadir elementos de tipo puntos, esto no es realmente
necesario una vez que has trabajado con elementos más complicados (líneas y polígonos). Funciona exactamente
igual, excepto por que solo clicas una vez donde quieras que esté el punto, le das atributos como habitualmente, y
luego el elemento se crea.

Saber cómo digitalizar es importante porque es una actividad muy común en programas SIG.

6.1.6 What’s Next?

Los elementos en una capa SIG no son solo imágenes, sino objetos en el espacio. Por ejemplo, polígonos adya-
centes saben donde están en relación el uno con el otro. Esto se llama topología. En la siguiente lección verás un
ejemplo de por qué esto puede ser útil.

6.2 Lesson: Topología de los Elementos

La topología es un aspecto útil de las capas de datos vectoriales, ya que minimiza errores como la superposición
o huecos.

6.2. Lesson: Topología de los Elementos 113



QGIS Training Manual, Versão 2.8

Por ejemplo: si dos elementos comparten un borde, y editas el borde utilizando la topología, no necesitarás editar
primero un elemento y luego otro cuidadosamente para que luego coincidan. En lugar de eso puedes editar el
borde compartido y los dos elementos cambiarán al mismo tiempo.

El objetivo de esta lección: Entender la topología utilizando ejemplos.

6.2.1 Follow Along: Autoensamblado

Para facilitar la edición topológica, es mejor si habilitas el autoensamblado. Esto permitirá al cursor del ratón
ajustarse a otros objetos mientras digitalizas. Para ajustar las opciones de autoensamblado:

• Navega a la entrada del menú Configuración → Opciones de autoensamblado....

• Ajusta el cuadro de diálogo Opciones de autoensamblado y digitalización como se muestra:

• Asegúrate de que la caja en la columna Evitar int. está seleccionada (definida como verdadero).

• Haz clic en Aceptar para guardar tus cambios y cierra el cuadro de diálogo.

• Introduce el modo edición con la capa landuse seleccionada.

• Combruéba en Ver → Barras de Herramientas que tu barra de herramientas Digitalización avanzada está
habilitada.

• Amplía esa área (habilita capas y etiquetas si es necesario):
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• Digitaliza la nueva (ficticia) área de el Bontebok National Park:

• Cuando se solicite, dale un OGC_FID de 999, pero eres libre de dejar los otros valores sin cambiar.

Si eres cuidadoso cuando digitalizas y permites al cursor ajustarse a los vértices de granjas adyacentes, notarás
que no habrán vacíos entre tus granjas nuevas y las adyacentes ya existentes.

• Observa las herramientas deshacer/rehacer en la barra de herramientas Digitalización avanzada:

6.2. Lesson: Topología de los Elementos 115



QGIS Training Manual, Versão 2.8

6.2.2 Follow Along: Corrección de Elementos Topológicos

Los elementos topológicos pueden necesitar ser acutalizados a veces. En nuestro ejemplo, la capa landuse tiene
algunas áreas forestales complejas que han sido añadidas recientemente al formulario de un área:

En lugar de crear nuevos polígonos para unir las áreas forestales, vamos a usar Herramienta de nodos para editar
los polígonos ya existentes y unirlos.

• Entra en el modo de edición, si no está ya activo.

• Selecciona Herramienta de nodos.

• Escoge un área forestal, selecciona una esquina y muévela hacia una esquina adyacente para que dos sec-
ciones forestales se toquen:

116 Chapter 6. Module: Criação de Dados Vetoriais



QGIS Training Manual, Versão 2.8

• Haz clic y arrastra los nodos hasta que se ajusten.

El borde topológicamente correcto tiene este aspecto:
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Continúa y junta unas pocas áreas más utilizando Herramienta de nodos. Puedes también utilizar la herramienta
guilabel:Añadir objeto espacial si es apropiada. Si estás utilizando nuestros datos de ejemplo, deberías tener un
área forestal que se parezca a esto:

No te preocupes si has unido más, menos o diferentes áreas forestales.
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6.2.3 Follow Along: Herramienta: Simplificar Objetos Espaciales

Esta es la herramienta Simplificar objeto espacial:

• Haz clic en ella para activarla.

• Haz clic en una de las áreas que has añadido utilizando cualquiera Herramienta de nodos o Añadir objeto
espacial. Verás este cuadro de diálogo:

• Mueve el deslizador de lado a lado y mira qué ocurre:
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Eso te permite reducir la cantidad de nodos en elementos complejos.

• Haz clic en Aceptar.

Observa lo que la herramienta hace sobre la topología. Los polígonos simplificados ya no se están tocando a
los polígonos adyacentes como deberían. Esto muestra que esta herramienta es más adecuada para generalizar
elementos aislados. La ventaja que te proporciona es una simple e intuitiva interfaz para generalizar.

Antes de continuar, ajusta los polígonos a su estado original deshaciendo el último cambio.

6.2.4 Try Yourself Herramienta: Añade un Anillo

Esta es la herramienta Añadir anillo:

Esta te permite quitar un trozo de un elemento, siempre que el círculo esté completamente rodeado por el elemento.
Por ejemplo, si has digitalizado los límites de Sur África y necesitas añadir un trozo para Lesotho, tendrías que
utilizar esta herramienta.

Si experimentas con esta herramienta, observarás que las opciones de autoensamblado actuales previenen que
crees un anillo en el medio del polígono. Esto estaría bien si el área que quisieras excluir estuviera unida a los
límites del polígono.

• Deshabilita el autoensamblado para la capa de usos del territorio a través del cuadro de diálogo que utilizaste
antes.

• Agora tente usar a ferramenta Adicionar Anel para criar uma lacuna no meio do Bontebok National Park.
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• Borra tu nuevo elemento utilizando la herramienta Borrar anillo:

Nota: Necesitas seleccionar la esquina del anillo para borrarlo.

Comprueba tus resultados

6.2.5 Try Yourself Herramienta: Añade una Parte

Esta es la herramienta Añadir Parte:

Esta herramienta te permite crear una parte extra de tu elemento, no conectado directamente al elemento principal.
Por ejemplo, si has digitalizado los límites del continente de Sur África pero no has añadido todavía las islas
Prince Edward Islands, podrías usar esta herramienta para crearlas.

• Para utilizar esta herramienta, debes seleccionar primero el polígono del que quieras añadir la parte uti-
lizando la herramienta Seleccionar objetos espaciales individuales:

• Ahora intenta utilizar la herramienta Añadir Parte para añadir un área periférica a Bontebok National Park.

• Borra tu nuevo elemento utilizando la herramienta Borrar parte:

Nota: Necesitas seleccionar una esquina de la parte para borrarla.

Comprueba tus resultados

6.2.6 Follow Along: Herramienta: Remodelar Elementos

Esta es la herramienta Remodelar objetos espaciales:

Puede añadir una protuberancia a un elemento existente. Con esta herramienta seleccionada:

• Haz clic izquierdo dentro de Bontebok National Park para empezar a dibujar un polígono.

• Dibuja un polígono con tres esquinas, la última de ellas debería estar dentro del polígono original, formando
un rectángulo abierto.

• Haz clic derecho para acabar de marcar los puntos:
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Esto dará un resultado parecido a:

También puedes hacer lo contrario:

• Haz clic fuera del polígono.

• Dibuja un rectángulo dentro del polígono.

• Haz clic derecho fuera del polígono otra vez:
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El resultado de lo anterior:

6.2.7 Try Yourself Herramienta: Dividir Objetos Espaciales

La herramienta Dividir objetos espaciales es similar a cómo quitabas parte de la granja, excepto que esto no borra
ninguna de las dos partes. En lugar de ello mantiene ambas.
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• Primero vuelve a habilitar autoensamblado para la capa landuse.

Usaremos esta herramienta para dividir una esquina de Bontebok National Park.

• Selecciona la herramienta :Dividir objetos espaciales y haz clic en el vértice para empezar a dibujar una
línea. Haz clic en el vértice del lado opuesto de la esquina que quieras dividir y clic derecho para completar
la línea:

• En este punto, debería parecer como si nada hubiera pasado. Pero recuerda que tu simbología para la capa
landuse no tiene ningún borde, así que la nueva línea de división no se mostrará.

• Utiliza la herramienta Seleccionar objetos espaciales individuales para seleccionar la esquina que acabas
de dividir; el nuevo elemento estará destacado:
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6.2.8 Try Yourself Herramienta: Combinar Objetos Espaciales

Ahora juntaremos los elementos que acabas de crear al polígono original:

• Experimenta con las herramientas Combinar objetos espaciales seleccionados y Combinar los atributos de
los objetos espaciales seleccionados.

• Comprueba las diferencias.

Comprueba tus resultados

6.2.9 In Conclusion

La edición de la topología es una herramienta potente que te permite crear y modificar objetos rápida y fácilmente,
a la vez que asegurar que permanecen topológicamente correctos.

6.2.10 What’s Next?

Ahora sabes digitalizar fácilmente la forma de los objetos, ¡pero añadir los atributos todavía es un dolor de cabeza!
Después te enseñaremos a utilizar formularios para editar atributos de forma más simple y efectiva.

6.3 Lesson: Formulários

Cuando añades nuevos datos digitalizando, se te presenta un cuadro de diálogo que te permite rellenar los atributos
del elemento. Sin embargo, el cuadro de diálogo no es muy bonito a la vista. Esto puede causar algún problema,
especialmente si tienes que crear conjuntos de datos extensos, o si quieres que otra gente te ayude a digitalizar y
encuentran los formularios por defecto confusas.

Afortunadámente, QGIS te permite crear tus propios cuadros de diálogo para una capa. Esta lección te enseñará
cómo.
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El objetivo de esta lección: Crear un formulario para una capa.

6.3.1 Follow Along: Using QGIS’ Funcionalidad del Diseño de un Formula-
rio

• Selecciona la capa roads en la Lista de capas.

• Entra Modo de edición como antes.

• Abre su Tabla de atributos.

• Haz clic derecho en una celda de la tabla. Un menú pequeño aparecerá, siendo la única entrada Abrir
formulario.

• Haz clic en ella para ver el formulario que QGIS genera para esa capa.

Obviamente sería bonito poder hacerlo mientras miras el mapa, en lugar de buscar una calle específica en la Tabla
de Atributos cada vez.

• Ve al menú Configuración → Opciones.

• En el cuadro de diálogo que aparece, selecciona la pestaña Herramientas de mapa.

• Comprueba la casilla de verificación Abrir formulario de objetos espaciales ...:

• Haz clic en Aceptar.

• Selecciona la capa roads en la Lista de capas.

• Utilizando la herramienta Identificar, haz clic en cualquier calle del mapa.
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En lugar de el cuadro de diálogo normal Identificación, verás el formulario ya familiar:

6.3.2 Try Yourself Utilizando el Formulario para Editar Valores

Si estás en modo edición, puedes utilizar el formulario para editar los atributos de los elementos.

• Activa el modo edición (si no está ya activado).

• Utilizando la herramienta Identificar, haz clic en la calle principal que discurre a través de Swellendam:
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• Edita su valor highway a secondary.

• Guarda tu edición.

• Sal del modo edición.

• Abre la Tabla de Atributos y verás que los valores se han acutalizado en la tabla de atributos y por lo tanto
en la fuente de datos.

Nota: Si estás utilizando el conjunto de datos por defecto, encontrarás más de una calle en el mapa llamada
Voortrek Street.

6.3.3 Follow Along: Ajustando los Tipos de Campos del Formulario

Es bonito editar cosas utilizando un formulario, pero todavía tienes que introducirlo todo a mano. Afortunada-
mente, los formularios tienen diferentes tipos de los llamados widgets que te permiten editar datos de varias formas
diferentes.

• Abre la Propiedades de la capa de la capa roads.

• Cambia a la pestaña Campos. Verás esto:
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• Haz clic en el botón Edición de líneas en la misma fila que man_made y te dará un nuevo cuadro de diálogo.

• Selecciona Casilla de verificación en la lista de opciones:
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• Haz clic en Aceptar.

• Introduce el modo edición (si la capa roads no está ya en modo edición.

• Haz clic en la herramienta Identificar.

• Haz clic en la misma calle principal que escogiste antes.

Ahora verás que los atributos de man_made tiene una casilla de verificación junto a ella denotando True (mar-
cado) or False (sin marcar).

6.3.4 Try Yourself

Ajusta un formulario más apropiado para el campo highway.

Comprueba tus resultados

6.3.5 Try Yourself Creacion de Datos para Test

También puedes diseñar tu formulario personalizado desde cero

• Crea una capa de puntos simple llamada datos-test con dos atributos:

– Nombre (texto)

– Edad (texto)
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• Captura unos pocos puntos en tu nueva capa utilizando las herramientas de digitalización para tener pocos
datos con los que jugar. Debería presentarse un formulario QGIS de atributos capturados por defecto cada
vez que capturas un punto nuevo.

Nota: Puede que necesites desactivar Autoensamblado si todavía está acitvada de pasos anteriores.
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6.3.6 Follow Along: Creando un Nuevo Formulario

Ahora queremos crear nuestro propio formulario personalizado para la fase de captura de datos de atributo. Para
hacerlo, necesitas tener instalado Qt4 Designer (solo se necesita para crear los formularios). Debería ser propor-
cionado como parte de los materiales de tu curso, si estás utilizando Windows. Puede que necesites buscarlo si
estás utilizando otro SO. En Ubuntu, haz lo siguiente en el terminal:

Nota: En momento de escribir estos materiales, Qt5 es la última versión disponible. Sin embargo, el proceso
requiere específicamente Qt4 y no es necesariamente compatible con Qt5.

sudo consigue instalar qt4-designer

... y debería instalarse automáticamente. En caso contrario, búscalo en el Centro de Software.

• Inicia Designer abriendo su entrada en Menú Inicio de Windows (o cualquier acceso que sea apropiado en
tu SO).

• En el cuadro de diálogo que aparece, crea un nuevo cuadro de diálogo:
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• Busca Widget Box a la izquierda de tu pantalla (por defecto). Contiene un elemento llamado Line Edit.

• Haz clic y arrastra el elemento hasta tu formulario. Esto creará un nuevo Line Edit en el formulario.

• Con el nuevo elemento de edición de línea seleccionado, verás sus propiedades en un lado de tu pantalla (en
el lado derecho por defecto):
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• Ajusta su nombre a Name.

• Utilizando el mismo acceso, crea una nueva spinbox y ajusta su nombre a Age.

• Añade una Label con el texto Add a New Person con la fuente en negrita (busca en las propiedades
del objeto para ajustarlo así). Como alternativa, puede que quieras ajustar el título del cuadro de diálogo (en
lugar de añadir una etiqueta).

• Haz clic en cualquier parte de tu cuadro de diálogo.

• Encuentra el botón Lay Out Vertically (en la barra de herramientas en el borde superior de la pantalla, por
defecto). Esto establece tu cuadro de diálogo automáticamente.

• Ajusta el máximo tamaño de tu cuadro de diálogo (en sus propiedades) a 200 (width) por 100 (height).

• Guarda tu nuevo formulario como exercise_data/forms/add_people.ui.

• Cuando esté guardado, puedes cerrar el programa Qt4 Designer.

6.3.7 Follow Along: Asociando el Formulario con Tu Capa

• Vuelve al QGIS.

• Haz doble clic en la leyenda de la capa datos-test para acceder a sus propiedades.

• Haz clic en la pestaña Campos del cuadro de diálogo Propiedades de la capa.

• En el menú desplegable Disposición del editor de atributos, selecciona Proporcionar archivo UI.

• Haz clic en el botón de puntos suspensivos y elige el archivo add_people.ui que acabas de crear:
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• Haz clic en Aceptar del cuadro de diálogo Propiedades de la capa.

• Entra en el modo edición y captura un nuevo punto.

• Cuando lo hagas, se presentará un cuadro de diálogo personalizado (en lugar del genérico que el QGIS crea
normalmente).

• Si haces clic en uno de tus puntos utilizando la herramienta Identificar, puedes abrir el formulario con clic
derecho en las ventanas de resultados de identificación y eligiendo el formulario Formulario de vista de
objetos espaciales del menú contexto.

• Si estás en modo edición para esa capa, ese menú contextual te mostrará Formulario de edición de objetos
espaciales, y podrás ajustar los atributos en el nuevo formulario incluso después de la captura inicial.

6.3.8 In Conclusion

Utilizando formularios, puedes facilitarte la vida cuando creas o editas datos. Editando tipos de widgets o creando
nuevos desde cero, puedes controlar la experiencia de alguien que digitalice nuevos datos para esa capa, además
minimizas malentendidos y errores innecesarios.
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6.3.9 Further Reading

Si completaste la sección avanzada anterior y tienes conocimientos de Python, puede que quieras comprobar esta
entrada de blog sobre creación de formularios de personalización de elementos con lógica Python, que contiene
funciones avanzadas incluyendo validación de datos, autocompletado, etc.

6.3.10 What’s Next?

Abrir un formulario de identificación de un elemento es una de las acciones estándar que QGIS puede realizar.
Sin embargo, puedes dirigirlo a realizar acciones de personalización que tú definas. Este es el tema de la siguiente
lección.

6.4 Lesson: Ações

Ahora que has visto las acciones por defecto en la lección anterior, es hora de definir tus propias acciones. Una
acción es lo que ocurre cuando clicas en un elemento. Puedes añadir mucha funcionalidad extra a tu mapa,
permitiendote obtener información adicional sobre un objeto, por ejemplo. ¡Asignar acciones puede añadir una
nueva dimensión a tu mapa!

El objetivo de esta lección: Aprender como añadir acciones personalizadas.

6.4.1 Follow Along: Abrir una Imagen

Utiliza la capa propiedad_escolar que creaste anteriormente. Los materiales del curso incluyen fotos de cada
una de las tres propiedades que digitalizaste. Lo siguiente que vamos a hacer será asociar cada propiedad con su
imagen. Luego crearemos una acción que abra la imagen de una propiedad cuando se haga clic en la propiedad.

6.4.2 Follow Along: Añadir un Campo para Imágenes

La capa school_property todavía no tiene forma de asociar una imagen con una propiedad. Primero crearemos un
campo para este propósito.

• Abre el cuadro de diálogo Propiedades de la capa.

• Haz clic en la pestaña Campos.

• Conmuta el modo de edición:
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• Añade una nueva columna:
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• Introduce los valores siguientes:
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• Después de haber creado el campo, haz clic en el botón Edición de líneas junto al nuevo campo.

• Elije Nombre de archivo:
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• Haz clic en Aceptar en el cuadro de diálogo Propiedades de la capa.

• Utiliza la herramienta Identificar para clicar en uno de los tres elementos en la capa propiedad_escolar.

Como estás en el modo edición, el cuadro de diálogo debería estar activado y verse así:
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• Haz clic en el botón de búsqueda (the ... junto al campo imagen).

• Selecciona la ruta para tu imagen. Las imágenes están en
exercise_data/school_property_photos/ y se nombran como los elementos a los que
deberían estar asociadas.

• Haz clic en Aceptar.

• Asocia todas las imágenes con los elementos correctos utilizando este método.

• Guarda tu cambios y sal del modo edición.

6.4.3 Follow Along: Creando una Acción

• Abre el formulario Acciones de la capa propiedad_escolar.

• En el panel Propiedades de acciones, introduce las palabras Mostrar imagen en el campo
Nombre.
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Qué hacer luego depende del sistema operativo que estés usando, así que elige el curso adecuado a seguir:

Windows

• Haz clic en el menú desplegable Tipo y elige Abrir.

Ubuntu Linux

• En Acción, escribe eog para el Gnome Image Viewer, o escribe display para usar ImageMagick. ¡Re-
cuerda dejar un espacio después del comando!

MacOS

• Haz clic en el menú desplegable Tipo y elige Mac.

• Bajo Acción, escribir abrir. ¡Recuerde colocar un espacio después del comando!

Continúa escribiendo el comando

Quieres abrir la imagen y QGIS sabe dónde está. Todo lo que necesita es decirle a la Acción dónde está la imagen.
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• Selecciona imagen en la lista:

• Haz clic en el botón Insertar campo. QGIS añadirá la frase [% "imagen" %] en el campo Acción.

• Haz clic en el botón Añadir a la lista de acciones.

• Haz clic en Aceptar en el cuadro de diálogo Propiedades de la capa.

Ahora comprobaremos la nueva Acción:

• Haz clic en la capa propiedad_escolar en Lista de capas para que quede seleccionada.

• Encuentra el botón Ejecutar acción del objeto espacial (en la misma barra de herramientas que el botón
Abrir tabla de atributos):

• Haz clic en la flecha hacia abajo a la derecha del botón. Hay solo una acción definida para esta capa hasta
el momento, la que acabas de crear.

• Haz clic en el propio botón para activar la herramienta.

• Utilizando esta herramienta, haz clic en cualquiera de las propiedades de escuela.

• La imagen para esa propiedad se abrirá.

6.4.4 Follow Along: Buscando en Internet

Digamos que estas buscando un mapa y quieres saber más sobre el área en la que está la granja. Supón que no sabes
nada del área en cuestión y quieres encontrar información general sobre ella. Tu primer impulso, considerando
que estás utilizando el ordenador justo ahora, sería buscar el nombre del área en Google. ¡Así que digámosle a
QGIS que lo haga automáticamente por nosotros!

• Abre la tabla de atributos para la capa landuse.

Estaremos usando el campo name para cada área de usos del terreno para buscar en Google.

• Cierra la tabla de atributos.

• Vuelve a Acciones en Propiedades de la capa.

• En el campo Propiedades de acciones → Nombre, escribe Busqueda en Google.

Qué hacer luego depende del sistema operativo que estés usando, así que elige el curso adecuado a seguir:

Windows

• En Tipo, elige Abrir. Esto le dirá a Windows que abra una dirección de internet en tu buscador por defecto,
como Internet Explorer.
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Ubuntu Linux

• En Acción, escribe xdg-open. Esto le dirá a Ubuntu que abra una dirección de internet en tu buscador por
defecto, como Chrome o Firefox.

MacOS

• En Acción, escribe abrir. Esto le dirá a MacOS que abra una dirección de internet en tu buscador por
defecto, como Safari.

Continúa escribiendo el comando

Para cualquier comando que uses, necesitarás decirle qué dirección de internet abrir luego. Quieres ir a Google y
buscar la frase automáticamente.

Normalmente cuando usas Google, introduces tu frase a buscar en la barra de Búsqueda de Google. Pero
en este caso, quieres que tu ordenador lo haga por ti. Para decirle a Google que busque por algo
(si no quieres utilizar su barra de búsqueda directamente) se le da al Buscador de Internet la dirección
http://www.google.com/search?q=SEARCH_PHRASE, donde SEARCH_PHRASE es lo que tú quieres
buscar. Como no sabemos qué frase buscar todavía, solo introduciremos la primera parte (sin la frase de búsqueda).

• En el campo Acción, escribe http://www.google.com/search?q=. ¡Recuerda dejar un espacio
después de tu comando inicial antes de escribirlo!

Ahora quieres que QGIS le diga al buscador que busque en Google el valor de name para cualquier elemento en
el que quieras clicar.

• Selecciona el campo name.

• Haz clic en Insertar campo:
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Esto dirá a QGIS que añada la siguiente frase:

Lo que significa que QGIS abrirá el buscador y lo enviará a la dirección
http://www.google.com/search?q=[% "name" %]. Pero [% "name" %] dirá al QGIS que
use los contenidos del campo name como frase a buscar.

Así que si, por ejemplo, el área de usos del territorio en el que
cliques se llama Marloth Nature Reserve, QGIS enviará al buscador a
http://www.google.com/search?q=Marloth%20Nature%20Reserve, lo que hará que tu
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buscador vaya a Goolge para que busque “Marloth Nature Reserve”.

• Si no lo has hecho todavía, ajusta todo como se ha explicado anteriormente.

• Haz clic en el botón Añadir a la lista de acciones. La nueva acción aparecerá en la lista arriba.

• Haz clic en Aceptar en el cuadro de diálogo Propiedades de la capa.

Ahora para comprobar la nueva acción.

• Con la capa guilabel:landuse activa en Lista de capas, haz clic en el botón Ejecutar acción del objeto
espacial.

• Haz clic en cualquier área de usos del territorio que puedas ver en el mapa. Tu buscador se abrirá au-
tomáticamente y comenzará una búsqueda en Google de la ciudad que está escrita como el valor name del
área.

Nota: Si tu acción no funciona, comprueba que todo está correctamente introducido; ¡ Los errores tipográficos
son muy comunes en este tipo de trabajos!

6.4.5 Follow Along: Abrir una Página Web Directamente en QGIS

Anteriormente, has visto como abrir una página web en un buscador externo. Hay algunas desventajas con este
enfoque que añaden cierta dependencia desconocida –¿tendrá el usuario final el software requerido para ejecutar
la acción en su sistema? Como has visto, ni siquiera es probable que utilizen el mismo tipo de comandos base
para el mismo tipo de acción, si no sabes qué SO estarán utilizando. Con algunas versiones de SO, puede que los
comandos anteriores no funcionen en absoluto. Esto podría ser un problema insuperable.

Sin embargo, QGIS está construido sobre la base de la increíblemente potente y versátil librería de Qt4. ¡Además,
las acciones de QGIS pueden ser comandos Python arbitrarios, clasificados en tokens (es decir, utilizar informa-
ción variable basada en contenidos de atributo de un campo)!

Ahora verás cómo usar una acción python para mostrar una página web. Es la misma idea general que abrir una
página en un buscador externo, pero no requiere buscador en el sistema del usuario ya que utiliza la clase Qt4
QWebView (que es un widget html basado en un webkit) para visualizar el contenido en una ventana emergente.

En lugar de Google, utilicemos Wikipedia esta vez. Así la URL que solicites será así:

http://wikipedia.org/wiki/SEARCH_PHRASE

Para crear la acción de capa:

• Abre el cuadro de diálogo Propiedades de la capa y ve directamente a la pestaña Acciones.

• Configure una nueva acción utilizando las siguientes propiedades para la acción:

– Tipo: Python

– Nombre: Wikipedia

– Acción (todo en una línea): from PyQt4.QtCore import QUrl; from
PyQt4.QtWebKit import QWebView; myWV = QWebView(None);
myWV.load(QUrl(’http://wikipedia.org/wiki/[% "name" %]’));
myWV.show()
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Hay un par de cosas ocurriendo aquí:

• Todos los códigos python están en una sola línea con puntos y comas que separan los comandos (en lugar
de nuevas líneas, la forma normal de separar comandos Python).

• [% "name" %] será reemplazado por el valor atributo actual cuando la acción se invoque (como anteri-
ormente).

• El código simplemente crea una nueva instancia, ajusta su URL, y luego llama show() para hacerla visible
como una ventana en el escritorio del usuario.

Nota que este es de alguna forma un ejemplo inventado. Python trabaja con sangrías con significado semántico,
así que separar cosas con puntos y comas no es la mejor forma de escribirlo. Así, en el mundo real, sería más
probable importar la lógica de un módulo de Python y luego utilizar una función con un atributo de campo como
parámetro.

Podrías igualmente utilizar el enfoque para visualizar una imagen sin requerir que el usuario tenga un particular
visor de imágenes en su sistema.

• Prueba a utilizar los métodos descritos anteriormente para cargar una página de Wikipedia utilizando la
acción Wikipedia que acabas de crear.
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6.4.6 In Conclusion

Las acciones te permiten dar a tu mapa funcionalidades extra, siendo útiles para el usuario final, que verá el mismo
mapa en QGIS. Debido al hecho de que puedes utilizar comandos Shell para cualquier sistema operativo, a parte
de Python, ¡el cielo es el límite respecto a las funciones que podrías incorporar!

6.4.7 What’s Next?

Ahora que has creado todo tipo de datos vectoriales, aprenderás a analizar los datos para solucionar problemas.
Ese es el tema del módulo siguiente.
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CHAPTER 7

Lesson: Análisis Vectorial

Ahora que has editado algunos elementos, debes querer saber qué más se puede hacer con ellos. Tener elementos
con atributos está bien, pero cuando todo está dicho y hecho, esto no te dice realmente nada que un mapa normal
no-GIS no pueda.

La principal ventaja de un SIG es esta: un SIG puede responder preguntas.

En los próximos tres módulos, intentaremos responder una pregunta de investigación utilizando funciones SIG.
Por ejemplo, eres un agente del estado y estás buscando una propiedad residencial en Swellendam para clientes
que tienen los siguientes criterios:

1. Tiene que estar en Swellendam.

2. Debe estar en una distancia razonable en coche a una escuela (digamos 1km).

3. Debe tener un tamaño de más de 100m cuadrados.

4. A menos de 50m de una carretera principal.

5. A menos de 500m de un restaurante.

En los próximos módulos, emplearemos el poder de las herramientas de análisis SIG para localizar propiedades
agrarias para este nuevo proyecto residencial.

7.1 Lesson: Reproyectando y Transformando Datos

Hablemos sobre Sistemas de Referencia de Coordenadas (SRCs) de nuevo. Lo hemos visto brevemente antes,
pero no hemos discutido su significado práctico.

El objetivo de esta lección: Reproyectar y transformar conjuntos de datos vectoriales.

7.1.1 Follow Along: Proyecciones

El SRC en el que se encuentran todos los datos además del propio mapa en este momento se llama WGS84. Es un
Sistema Geográfico de Coordenadas (SGC) para la representación de datos. Pero como veremos, hay un problema.

• Guarda tu mapa actual.

• Luego abre el mapa del mundo que encontrarás en exercise_data/world/world.qgs.

• Amplia a Sudáfrica utilizando la herramienta Acercar zum.

• Intenta ajustar una escala en el campo Escala, que está en Barra de estado en la parte inferior de la pantalla.
Mientras estás en Sudáfrica, ajusta su valor a 1:5000000 (uno a cinco millones).

• Desplázate por el mapa echando un ojo en el campo Escala.
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¿Observas cómo cambia la escala? Esto ocurre porque te estás moviendo fuera del punto que ampliaste a
1:5000000, que estaba en el centro de tu pantalla. Alrededor de ese punto, la escala es diferente.

Para entender por qué, piensa en el Globo Terráqueo. Tiene lineas discurriendo de Norte a Sur. Estas líneas están
alejadas en el ecuador, pero se encuentran en los polos.

En un SGC, tú trabajas en esa esfera, pero tu pantalla es plana. Cuando intentas representar la esfera en una
superficie plana, hay distorsiones, de forma similar a si cortaras una pelota de tenis e intentaras aplanarla. Lo que
pasa en el mapa es que las líneas longitudinales se conservan a la misma distancia, incluso en los polos (donde se
supone que se conectan). Esto significa que, cuando te alejas del ecuador en tu mapa, la escala de los objetos que
tu ves se va agrandando. Lo que significa para nosotros es, prácticamente, ¡que no hay una escala constante en
nuestro mapa!

Para solucionar esto, utilicemos en su lugar un Sistema de Coordenadas Proyectado (SCP). Un SCP “proyecta” o
convierte los datos en una forma que permite a la escala cambiar y corregirse. Además, para mantener la escala
constante, deberiamos reproyectar nuestros datos a usar un SCP.

7.1.2 Follow Along: Reproyección “Al Vuelo”

QGIS te permite reproyectar datos “al vuelo”. Lo que significa es que aunque los propios datos estén en otro SRC,
QGIS puede proyectarlo como si estuviera en un SRC de tu elección.

• Para habilitar la transformación “al vuelo”, haz clic en el botón Estado del SRC en Barra de estado en la
parte inferior de la ventana de QGIS:

• En el cuadro de diálogo que aparece, comprueba la caja junto a Activar transformación del SRC al vuelo.

• Escribe la palabra global en el campo Filtrar. Un SRC (NSIDC EASE-Grid Global) debería aparecer en
la lista inferior.

• Haz clic en NSIDC EASE-Grid Global para seleccionarlo, luego clic en Aceptar.

• Observa cómo cambia la forma de Sudáfrica. Todas las proyecciones funcionan cambiando las formas
aparentes de los objetos de la Tierra.

• Vuelve a ampliar a una escala de 1:5000000 como antes.

• Desplázate sobre el mapa.

• ¡Observa cómo la escala permanece igual!

La transformación” al vuelo” también se usa para combinar conjuntos de datos que están en diferentes SRCs.

• Vuelve a desactivar la transformación “al vuelo”

– Vuelve a hacer clic en el botón Estado del SRC

– Quita la marca de la caja Activar transformación del SRC al vuelo.

– Clicando Aceptar.

• No QGIS 2.0, a reprojeção ‘on the fly’ é automaticamente ativada quando camadas com diferentes SRCs
são carregados no mapa. Para entender o que a reprojeção ‘on the fly’ faz, desative a setagem automática:

– Vá para Configurações → Opções...

– En el panel izquierdo del cuadro de diálogo, selecciona SRC.

– Desabilite Habilitar automaticamente a reprojeção ‘on the fly’ se as camadas tiverem diferentes SRCs

– Clique OK.

• Añade otra capa vectorial que solo tiene datos para Sudáfrica a tu mapa. La encontrarás como
exercise_data/world/RSA.shp.
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¿Qué observas?

¡La capa no es visible! Pero tiene fácil solucion, ¿no?

• Haz clic derecho en la capa RSA en la Lista de capas.

• Selecciona Zoom to Layer Extent.

De acuerdo, ahora podemos ver Sudáfrica... ¿pero dónde está el resto del mundo?

Resulta que podemos ampliar a esas dos capas, pero no conseguimos verlas al mismo tiempo. Esto es porque sus
Sistema de Referencia de Coordenadas son muy diferentes. El conjunto de datos continents está en grados, pero
el conjunto de datos RSA está en metros. Así que, digamos que un punto dado en Ciudad del Cabo en el conjunto
de datos RSA está a unos 4 100 000 metros del ecuador. Pero en el conjunto de datos continents, el mismo
punto está a unos 33.9 grados del ecuador.

Esta es la misma distancia - pero QGIS no lo sabe. No le has dicho que reproyecte los datos. Así según lo que
QGIS entiende, la versión de Sudáfrica que vemos en el conjunto de datos RSA tiene a Ciudad del Cabo a la
distancia correcta de 4 100 000 metros del ecuador. Pero en el conjunto de datos continents, ¡Ciudad del Cabo
está a tan solo 33.9 metros del ecuador! Ya puedes ver donde está problema.

QGIS no sabe donde se supone que está Ciudad del Cabo - por eso los datos deberían decirselo. Si los datos dicen
al QGIS que Ciudad del Cabo está a 34 metros del ecuador y que Sudáfrica solo tiene 12 metros de norte a sur,
eso lo que QGIS representará.

Para corrigir isso:

• Clique no botão SRC Status novamente e ative Habilita a transformação SRC ‘on the fly’

• Dê zoom na camada RSA.

Ahora, como se les obliga a proyectarse en el mismo SRC, los dos conjuntos de datos se ajustan perfectamente:

Cuando combinamos datos de diferentes fuentes, es importante recordar que puede que no estén el mismo SRC.
La reproyección “al vuelo” te ayuda a representarlos juntos.

Antes de continuar, puede que quieras que la reproyección ‘al vuelo’ se active automáticamente cuando abras
conjuntos de datos que tengan diferentes SRC.

• Vuelve a abrir Configuración → Opciones... y selecciona SRC.
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• Activa la reproyección Habilitar automaticamente la reproyección al vuelo si las capas tienen un SRC
diferente.

7.1.3 Follow Along: Guardando un Conjunto de Datos en Otro SRC

¿Recuerdas cuando calculaste las áreas de las construcciones en la lección Clasificación? Lo hiciste de forma que
podías clasificar las construcciones en función del área.

• Abre tu mapa habitual de nuevo (el que contiene los datos de Swellendam).

• Abre la tabla de atributos para la capa buildings.

• Desplázate hacia la derecha hasta que veas el campo AREA.

Obsera que las áreas son muy pequeñas; probablemente cero. Esto es porque esas áreas están dadas en grados -
los datos no estan proyectados en un Sistema de Coordenadas Proyectado. Para calcular el área de las granjas en
metros cuadrados, los datos también tienen que estar en metros cuadrados. Así que necesitamos reproyectarlo.

Pero utilizar la reproyección ‘al vuelo’ no nos ayudará. ‘Al vuelo’ hace lo que dice - no cambia los datos, solo
reproyecta capas al tiempo que aparecen en el mapa. Para reproyectar realmente los propios datos, necesitas
exportarlos a un nuevo archivo utilizando una nueva proyección.

• Haz clic derecho en la capa buildings en la Lista de capas.

• Selecciona Guardar como... en el menú que aparece. Verás el cuadro de diálogo Guardar capa vectorial
como....

• Haz clic en el botón Explorar junto al campo Guardar como.

• Navega hasta exercise_data/ y especifica el nombre de la nueva capa como
buildings_reprojected.shp.

• Deja Codificación sin cambiar.

• Cambia el valor del menú desplegable SRC de la capa a SRC seleccionado.

• Haz clic en el botón Explorar bajo el menú desplegable.

• El cuadro de diálogo Seleccionar SRC aparecerá.

• En su campo Filtrar, busca 34S.

• Escoge WGS 84 / UTM zone 34S de la lista.

• Deja Exportación de simbología sin cambiar.

El cuadro de diálogo Guardar capa vectorial como... tendrá este aspecto:
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• Clique OK.

• Inicia un nuevo mapa y carga la capa reproyectada que acabas de crear.

Refiérete a la lección anterior Clasificación para recordar como calculaste las áreas.

• Actualiza (o añade) el campo AREA ejecutando la misma expresión que antes:
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Esto añadirá un campo AREA con el tamaño de cada edificio en metros cuadrados

• Para calcular el área en otras unidades de medida, por ejemplo hectáreas, utiliza el campo AREA para crear
una segunda columna:
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Veja os novos valores na sua tabela de atributos. Isso é muito mais útil, já que as pessoas medem os edifícios em
metros e não em graus. Este é o motivo porque é uma boa ideia reprojetar seus dados, se necessário, antes de
calcular áreas, distâncias e outros valores que são dependentes de propriedades espaciais da camada.

7.1.4 Follow Along: Creando Tu Propia Proyección

Hay muchos más proyecciones que las incluidas en QGIS por defecto. Además, también puedes crear tus propias
proyecciones.

• Inicia un mapa nuevo.

• Carga el conjunto de datos world/oceans.shp.

• Ve a Configuración → SRC personalizado... y verás este cuadro de diálogo:
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• Haz clic en el botón Añadir nuevo SRC para crear un nueva proyección.

Una proyección interesante de usar se llama Van der Grinten I.

• Introduce su nombre en el campo Nombre.

Esta proyección representa la Tierra en un campo circular en lugar de una zona rectangular, como la mayoría de
proyecciones hacen.

• Para sus parámetros, utiliza la siguiente cadena:

+proj=vandg +lon_0=0 +x_0=0 +y_0=0 +R_A +a=6371000 +b=6371000 +units=m
+no_defs
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• Clique OK.

• Habilita la reproyección “al vuelo”

• Elige tu nueva proyección (búscala por su nombre en el campo Filtrar).

• Aplicando esta proyección, el mapa será reproyectado así:
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7.1.5 In Conclusion

Proyecciones diferentes son útiles para diferentes propósitos. Eligiendo la proyección correcta, puedes asegurarte
que los elementos de tu mapa se están representando de forma precisa.

7.1.6 Further Reading

Los materiales usados para la sección Avanzada de esta lección se tomaron de este artículo.

Más información sobre Sistemas de Referencia de Coordenadas está disponible aquí.

7.1.7 What’s Next?

En la siguiente lección aprenderás a analizar datos vectoriales utilizando varias herramientas de análisis vectorial
de QGIS.

7.2 Lesson: Análise Vetorial

Dados vetoriais também podem ser analisados para revelar como diferentes feições interagem entre si no espaço.
Há diferentes análises disponíveis nas funções do SIG, então, nós não iremos cobrir todas elas. Ao invés disso,
traremos uma questão e tentaremos solucioná-la usando ferramentas providas pelo QGIS.

O objetivo desta lição: Fazer uma pergunta e respondê-la usando ferramentas de análise.

7.2.1 O Processo SIG

Antes de começar, é importante conhecer de maneira geral os passos que devemos seguir para resolver qualquer
problema em SIG. O que devemos fazer é o seguinte:
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1. Definir o Problema

2. Coletar os Dados

3. Analisar o Problema

4. Demonstrar os Resultados

7.2.2 O problema

Comecemos o processo definindo o problema a ser solucionado. Por exemplo, você é um funcionário público e está
procurando por propriedades residenciais em Swellendam por clientes que se encaixam nos seguintes critérios:

1. É necessário estar em Swellendam.

2. É preciso haver uma escola há uma distância razoável, na qual acessaremos dirigindo (digamos 1 Km)

3. Deve ter um tamanho superior a 100 m quadrados.

4. Próximo no máximo 50m de uma via principal.

5. Um restaurante há no máximo 500m de distância.

7.2.3 Os Dados

Para responder a todas essas perguntas precisaremos dos seguintes dados:

1. Os imóveis residenciais (edifícios) na área.

2. As estradas dentro e ao redor da cidade.

3. A localização das escolas e restaurantes.

4. O tamanho dos edifícios.

Todos esses dados estão disponíveis no OSM e você perceberá que o conjunto de dados que você tem usado
ao longo desse manual também pode ser usado nesta lição. Entretanto, para termos certeza que temos os dados
completos, nós iremos dar o download novamente dos dados do OSM usando a ferramenta do QGIS para download
de OSM.

Nota: Aunque hay coherencia en los campos de datos que encontramos en las descargas de OSM, pueden variar
en su cobertura y detalle. Si ves, por ejemplo, que la región que has elegido no contiene información sobre
restaurantes, quizás necesitas elegir otra región.

7.2.4 Follow Along: Comienzar un projecto

• Comienza un nuevo proyecto QGIS.

• Use the OpenStreetMap data download tool found in the Vector -> OpenStreetMap menu to download the
data for your chosen region.

• Guarda los datos como osm_data.osm en tu carpeta exercise_data.

• Note that the osm format is a type of vector data. Add this data as a vector layer as usually Layer -> Add
vector layer..., browse to the new osm_data.osm file you just downloaded. You may need to select Show
All Files as the file format.

• Selecciona osm_data.osm y haz clic en Abrir

• En el cuadro de diálogo que aparece, selecciona todas las capas, excepto las capas other_relations y
multilinestrings:
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Esto hará que los datos OSM se importen en su mapa como capas separadas.

Los datos que acabas de descargar desde OSM se encuentran en un sistema de coordenadas, WGS84, que utiliza
coordenadas de latitud y longitud, como ya vimos en la lección anterior. Asimismo, también aprendiste que para
calcular distancias en metros, necesitamos trabajar con un sistema de coordenadas proyectado. Comienza por
establecer el sistema de coordenadas de tu proyecto en un SRC adecuado para tus datos, en el caso de Swellendam,
WGS 84 / UTM zone 34S:

• Abre el cuadro de diálogo Propiedades del Proyecto, selecciona SRC y filtre la lista para encontrar
WGS 84 / UTM zone 34S.

• Haz clic en OK.

Ahora necesitamos extraer la información que necesitamos del conjunto de datos OSM. Es necesario finalizar
con capas representando todas las casas, colegios, restaurantes y carreteras de la región. Esta información se
encuentra dentro de la capa multipolygons y se puede extraer utilizando la información en su Tabla de Atributos.
Empezaremos con la capa schools.

• Haga clic con el botón derecho del ratón en la capa multipolygons en la Lista de Capas y abre la Propiedades
de la Capa.

• Ve al menú General.

• Bajo Subconjunto de objetos espaciales haz clic en el botón [Constructor de consultas] para abrir el cuadro
de diálogo Constructor de consultas.

• Mira en la lista de Campos de la izquierda de este cuadro de diálogo hasta que veas el campo amenity.

• Haz clic sobre él una vez.

• Haz clic en el botón Todos que se encuentra bajo la lista Valores:

Ahora necesitamos comunicar a QGIS que solamente nos muestre aquellos polígonos donde el valor de amenity
es igual a school.

• Haga doble clic sobre la palabra servicios en la lista de Campos.

• Veja o que acontece no campo Provider specific filter expression abaixo:

162 Chapter 7. Lesson: Análisis Vectorial



QGIS Training Manual, Versão 2.8

La palabra "amenity" ha aparecido. Para crear el resto de la consulta:

• Haz clic en el botón = (bajo Operadores).

• Haz doble clic en el valor school en la lista de Valores.

• Haz clic en Aceptar dos veces.

Isso irá filtrar os layers multipolygons OSMs para mostrar somente as escolas na sua região. Agora você
pode:

• Cambiar el nombre de la capa filtrada de OSM al de schools e importar de nuevo la capa
multipolygons desde osm_data.osm, o

• Duplicar la capa filtrada, renombrar la copia, borrar la Query Builder y crea tu nueva consulta en e
l:guilabel:Constructor de consultas.

7.2.5 Try Yourself Extraer de Capas Requeridas de OSM

Usando la técnica anterior, utiliza la herramienta Constructor de consultas para extraer los datos que quedan de
OSM para crear las siguientes capas:

• carreteras ( de la capa de OSM lines)
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• restaurantes (desde la capa multipolygons de OSM)

• casas (desde la capa multipolygons de OSM)

Puede que quieras utilizar de nuevo la capa roads.shp que creaste en lecciones anteriores.

Comprueba tus resultados

• Salve seu mapa em exercise_data, como analysis.qgs (esse mapa será usado em módulos futuros).

• En el administrador de archivos de tu sistema operativo, crea una nueva carpeta en exercise_data y llamalá
desarrollo_urbano. Aquí es donde guardarás los conjuntos de datos que resultarán de las funciones
de análisis.

7.2.6 Try Yourself Encontrar carreteras importantes.

Algunas de las carreteras en los datos de OSM están listadas como unclassified, tracks, path y
footway. Queremos eliminarlas de nuestro conjunto de datos de carreteras.

• Abre el Constructor de Consultas para la capa roads, haz clic en Limpiear y crea la siguiente
consulta:

"highway" != ’NULL’ AND "highway" != ’unclassified’ AND "highway" !=
’track’ AND "highway" != ’path’ AND "highway" != ’footway’

Puedes, o bien utilizar la estrategia utilizada anteriormente, haciendo doble clic en los valores y clic en los botones,
o bien puedes copiar y pegar el comando que aparece arriba.

Esto debería reducir inmediatamente el número de carreteras en tu mapa:

7.2.7 Try Yourself Convertir el SRC de una Capa

Como vamos a estar midiendo distancias entre nuestras capas, necesitamos cambiar el SRC de las capas. Para ello,
necesitamos seleccionar las capas una por una, guardar la capa a un nuevo shapefile con nuestra nueva proyección
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y entonces añadir la nueva capa a nuestro mapa.

Nota: En este ejemplo, vamos a usar el SRC WGS 84 / UTM zone 34S, pero puedes utilizar un SRC UTM que
sea más apropiado para tu región.

• Haz clic derecho sobre la capa carreteras en el panel Capas.

• Haz clic en Guardar como...

• En el diálogo Guardar capa vectorial como..., elige las siguientes opciones y haz clic en Acep-
tar (asegurate de que seleccionas Añadir archivo guardado al mapa):
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El nuevo shapefile se creará y la capa resultante es añadida a tu mapa.

Nota: Se você não ativou Enable ‘on the fly’ CRS transformation ou Automatically enable ‘on the fly’ reprojection
if layers have different CRS (veja a lição anterior), é possível que você não veja os novos layers recém adicionados
ao mapa. Nesse caso, você pode focar o mapa em qualquer layer clicando com o botão direito em qualquer layer
e clicando em Zoom to layer extent ou simplesmente ative qualquer das opções ‘on the fly’ mencionadas.

• Elimina la capa carreteras vieja.
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Repite este proceso para cada capa, creando un nuevo shapefile y una nueva capa añadiendo el apendice “_34S”
al nombre original y eliminando cada una de las capas viejas.

Una vez que hayas completado el proceso para cada capa, haz clic derecho sobre cualquiera de las capas y clic en
Zum a la extensión de la capa para enfocar el mapa a la zona de interés.

Ahora que hemos convertido los datos OSM a una proyección UTM, podemos empezar nuestros cálculos.

7.2.8 Follow Along: Analizando el Problema: Distancias Desde Colegios y
Carreteras.

QGIS te permite calcular distancias desde cualquier objeto vectorial.

• Asegurate de que solamente las capas carreteras_34S y casas_34S son visibles, para simplificar el mapa
mientras trabajas.

• Haz clic en la herramienta Vectorial → Herramientas de geoproceso → Buffer(s):

Esto te da un nuevo cuadro de diálogo.

• Configúralo así:
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La Distancia de buffer es en metros porque nuestros datos de entradas están en un Sistema Proyectado de Coorde-
nadas que usa metros como su unidad básica de medida. Esta es la razón por la que necesitabamos utilizar datos
proyectados.

• Guarda la capa resultante en exercise_data/desarrollo_inmobiliario/ as
carreteras_buffer_50m.shp.

• Clic OK y el buffer se creará.

• Cuando te pregunte si debe “añadir resultado al TDC”, clic Aceptar. (“TDC” significa “Tabla de Con-
tenidos”, que es lo mismo que la Lista de capas).

• Cierra el cuadro de diálogo Buffer(s) .

Ahora tu mapa se parece un poco a esto:

Si tu nueva capa es la primera en la lista Capas, probablemente ocultará una gran parte de tu mapa, pero nos da
todas las áreas que están a dentro de una distancia de 50m de una carretera en tu región.

Sin embargo, verás que hay zonas distintas dentro de nuestro buffer, correspondiendo a cada una de las carreteras.
Para resolver este problema, elimina la capa y crea el buffer de nuevo utilizando las opciones mostradas aquí:
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• Toma nota de que ahora está activada la caja Disolver resultados de buffer.

• Guarda el resultado con el mismo nombre que utilizaste antes (clic Si cuando te pida permiso para reem-
plazar el antiguo).

• Haz clic en Aceptar y cierra el cuadro de diálogo Buffer(s) de nuevo.

Una vez que le añadas la capa a Layers list, se verá esto:
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Ahora no hay subdivisiones innecesarias.

7.2.9 Try Yourself Distancia desde colegios.

• Usa el mismo enfoque que anteriormente y crea un buffer para tus colegios.

Es necesario que sea 1 km en radios, y guardarlo en el directorio habitual como schools_buffer_1km.shp.

:ref:‘ Comprueba tus resultados <vector-analysis-basic-2>‘

7.2.10 Follow Along: Areas que se solapan.

Ahora tenemos áreas donde la carretera está a 50 metros y en la que hay un colegio en un espacio de 1 km ( en
línea recta, no por la carretera). Pero obviamente, sólo queremos aquellas áreas donde coincidan estos dos criterios
Para lo cual, necesitaremos utilizar la herramienta Intersect tool. La puedes encontrar en Vector → Geoprocessing
Tools → Intersect. Instalela de la siguiente manera:
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Las dos capas de entrada son los dos buffers; la ruta de guardado es la usual y el nombre del archivo es
road_school_buffers_intersect.shp. Una vez hecho esto, haga clic en OK y añada la capa a Layers
list cuando se le pida.

En la imagen inferior, las áreas en azul muestran donde ambos criterios de distancia coinciden
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Usted puede borrar las dos capas buffer y solo mantener la que muestra la superposición, dado que eso era lo que
queriamos conocer en primer lugar:

7.2.11 Follow Along: Seleccione las Construcciones

Ahora que usted conoce el área en que las construcciones se superponen. El proximo paso es seleccionar las
construcciones en dicha área.
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• Seleccione en el menu Vector → Research Tools → Select by location. Un dialogo aparecerá.

• Configúralo así:

• Selecione OK, em seguida Close.

• Probablemente encontrará que no mucho ha cambiado. De ser así, mueva la capa
school_roads_intersect a la parte más baja de la lista de capas y luego haga un zoom in:
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Los edificios destacados en amarillo son aquellos que cumplen nuestros criterios y están seleccionados, mientras
que los edificios en verde son los que no. Podemos ahora guardar los edificios seleccionados como una nueva
capa.

• Haz clic derecho en la capa houses_34S de la Layers list.

• Selecciona Guadar Selección como....

• Configura el diálogo emergente así:

• El nombre del archivo es well_located_houses.shp.
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• Haz clic en OK.

Ahora tienes la selección como una capa separada y puedes quitar la capa houses_34S.

7.2.12 Try Yourself Filtrado adicional de nuestros Edificios

Ahora tenemos una capa que nos muestra los edificios en un radio de 1km de una escuela y a menos de 50m de
una carretera. Ahora tenemos que reducir la selección para que sólo nos muestre los edificios que están a menos
de 500 metros de un restaurante.

Usando los procesos descritos anteriormente, crear una capa llamada houses_restaurants_500m aplicando
filtros adicionales a la capa well_located_houses para mostrar sólo aquellos que están a menos de 500
metros de un restaurante.

:ref:‘ Comprueba tus resultados <vector-analysis-basic-3>‘

7.2.13 Follow Along: Seleccione las Construcciones de Tamaño Adecuado

Para ver quais edifícios são do tamanho certo (mais de 100 metros quadrados), primeiro temos que calcular o
tamanho dos mesmos.

• Abra a tabela de atributos da camada houses_restaurants_500m.

• Entra en el modo de edición y abre la calculadora de campos.

• Configúralo así:
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• Si no puedes encontrar AREA en la lista, intenta crear un nuevo campo como hiciste en la lección previa de
este módulo.

• Haz clic en OK.

• Desplázate a la derecha de la tabla de atributos; tu campo AREA contiene ahora el área en metros cuadrados
de todos los edificios de la capa houses_restaurants_500m.

• Haga clic en el botón del modo de edición de nuevo para finalizar la edición y guarde los cambios cuando
se le pida.

• Construya una consulta como hizo anteriormente en esta lección.
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• Haga clic en Aceptar. Tu mapa debería mostrar aquellos edificios que cumplen los criterios iniciales y
aquellos de tamaño superior a 100 metros cuadrados.

7.2.14 Try Yourself

• Guarda la solución como una nueva capa usando la estrategia que aprendiste anteriormente. El archivo
debería ser guardado en el directorio usual con el nombre solution.shp.

7.2.15 In Conclusion

Usando la estrategia de resolución de problemas SIG junto con las herramientas de análisis vectorial de QGIS, has
sido capaz de resolver un problema con múltiples criterios rápida y fácilmente.

7.2.16 What’s Next?

Na lição seguinte, veremos como calculcar a distância mais curta entre um ponto e outro da via.
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7.3 Lesson: Análises de Redes

Calcular la distancia más corta entre dos puntos es un uso comunmente citado de un SIG. QGIS contiene esta
herramienta, pero no es visible por defecto. En esta breve lección, te enseñaremos lo que necesitas para empezar.

El objetivo de esta lección: Para activar, configura y usa el plugin Complemento de grafos de rutas.

7.3.1 Follow Along: Activar la Herramienta

QGIS tiene muchos plugins que se añaden a sus funciones básicas. Muchos de estos plugins son tan útiles que se
incluyen con el programa directamente. Sin embargo, se mantienen ocultos por defecto. Para usarlos, necesitas
activarlos primero.

Para activar el plugin Complemento de grafos de rutas:

• Inicia el Administrador de complementos clicando en el elemento Complementos → Administrar e instalar
complementos... del menú de la ventana principal del QGIS. Un cuadro de diálogo aparecerá.

• Selecciona el complemento así:

• Haz clic en Cerrar del cuadro de diálogo Administrador de complementos.

Nota: Se você não vê o complemento em sua interface, acesse Exibir → Paineis e assegure-se que Caminho mais
curto tem uma marca de seleção ao lado dele.

Este panel aparecerá en tu interfaz:
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7.3.2 Follow Along: Configurar la Herramienta

Tienes una capa en la que calcular, primero guarda tu mapa actual. Si no lo has hecho todavía, guarda tu capa
roads_34S en un archivo shape haciendo clic derecho en la capa y seleccionando Guardar como.... Crea un
mapa nuevo y carga la capa en él.

Como hay muchas configuraciones posibles cuando analizas redes, el complemento no asume nada hasta que lo
ajustes. Esto significa que no hará nada en absoluto a no ser que lo ajustes.

• Haz clic en el elemento del menú Vectorial → Grafo de rutas → Configuración. Un cuadro de diálogo
aparecerá.

• Asegúrate de que está ajustado como este (utiliza valores por defecto a no ser que estén especificados):
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• Unidad de tiempo: hora

• Unidad de distancia: kilómetro

• Capa: roads_34S

• Campo de velocidad: Utilizar siempre por defecto / km/h
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• Sentido: Doble sentido

• Velocidad: 60

7.3.3 Follow Along: Utiliza la Herramienta

Encuentra dos puntos, en calles de tu mapa. No tienen por qué tener ningún significado, pero deberían estar
conectadas por calles y separadas por una distancia razonable:
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• En el panel del plugin, haz clic en el botón Capturar punto junto al campo Inicio:
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• Haz clic en el punto de inicio que elegiste.

• Utiliza el botón Captuar punto junto al campo Final y captura el último punto que elegiste.

• Haz clic en el botón Calcular para ver la solución:
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7.3.4 Follow Along: Utilizando Criterios

Nota: Secao desenvolvida por Linfiniti e S Motala (Universidade Tecnológica da Península do Cabo)

• Añade tu capa restaurants_34S al mapa (extraela de tu mapa analisis si es necesario).

• Abre la tabla de atributos de la capa roads_34S y entra en modo edición.

• Adicione uma nova coluna com o nome SPEED, e dar-lhe o tipo: guilabel:‘ Número inteiro (inteiro)‘ com
uma largura de: kbd:3.

• En la ventana principal, activa la herramienta Seleccionar objetos espaciales por rectángulo:
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• Selecciona las calles principales en áreas urbanas - pero no residenciales -:

(Para seleccionar más de una calle, mantén pulsado ctrl y arrastra una caja sobre cada calle que quieras incluir
en la selección.)

• En la tabla de atributos, selecciona Mostrar objetos espaciales seleccionados.
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• Ajusta el valor SPEED para todas las calles seleccionadas a 60:

En contexto, esto significa que estás ajustando el límite de velocidad en esas calles a 60 km/h.

• Selecciona las autopistas o carreteras principales fuera de las zonas urbanas:
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• Ajusta el valor SPEED para todas las calles seleccionadas a 120.

• Cierra la tabla de atributos, guarda tu edición, y sal del modo edición.

• Comprueba Vectorial → Grafo de rutas → Configuración para asegurarte de que está ajustado como se
ha explicado anteriormente en esta lección, pero con el valor Velocidad ajustado al campo SPEED que has
creado.

• En el panel Ruta más corta, haz clic en el botón Inicio.

• Ajusta el punto inicial a una calle pequeña en la zona de Swellendam y el punto final a una calle mayor en
el otro lado de la ciudad:
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• En la lista desplegable Criterio del panel Ruta más corta, selecciona Longitud.

• Haz clic en Calcular. La ruta será calculada por distancia más corta:

Observa los valores de Longitud and Tiempo del panel Ruta más corta.

• Ajusta Criterio a Tiempo.

• Haz clic de nuevo en Calcular. La ruta será calculada por duración más corta:

188 Chapter 7. Lesson: Análisis Vectorial



QGIS Training Manual, Versão 2.8

Puedes alternar entre estos criterios, volver acalcular cada vez, y observar los cambios que Longitud y Tiempo
producen. Recuerda que la presunción de llegar a un tiempo dado para el viaje no tiene en cuenta la aceleración, y
asume que estarás viajando a la velocidad límite todo el tiempo. En situaciones reales, puede que quieras dividir
las calles en secciones más pequeñas y observar la velocidad esperada en cada sección, en lugar de la velocidad
límite.

Si cuando clicas Calcular, ves un error diciendo que la ruta no puedo ser encontrada, asegúrate de que las calles
que digitalizaste realmente se están conectadas. Si no se están tocándose, arréglalo modificando los elementos, o
ajustando la Tolerancia de topología en los ajustes del complemento. Si las calles pasan unas sobre otras pero no
hay intersección, utiliza la herramienta Dividir objetos espaciales para “dividir” calles en sus intersecciones:

¡Recuerda que la herramienta Dividir objetos espaciales solo funciona en modo edición y en elementos selec-
cionados!

También puede que encuentres que la ruta más corta es también la más rápida si recibes ese error.

7.3.5 In Conclusion

Ahora sabes como usar el complemento Grafo de rutas para solucionar los problemas con las rutas más cortas.

7.3.6 What’s Next?

Lo siguiente que verás será cómo ejecutar algoritmos espaciales estadísticos en conjuntos de datos vectoriales.

7.4 Lesson: Estadísticas Espaciales

Nota: Lección desarrollada por Linfiniti y S Motala (Universidad Tecnológica de Península del Cabo)
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Las estadísticas espaciales te permiten entender que está pasando en un conjunto de datos vectoriales dado. QGIS
incluye muchas herramientas estándar para análisis estadísticos que demuestran ser muy útiles para estas materias.

El objetivo de esta lección: Saber como utilizar las herramientas estadísticas espaciales de QGIS.

7.4.1 Follow Along: Crear un Conjunto de Datos de Prueba

Para obtener un conjunto de datos con el que trabajar, crearemos un conjunto de puntos al azar.

Para ello, necesitarás un conjunto de datos poligonal para definir la extensión del área en la que quieres crear los
puntos.

Utilizaremos el área cubierta por calles.

• Crea un mapa vacío nuevo.

• Añade tu capa roads_34S, así como el ráster srtm_41_19.tif (datos de elevaciones) que s encuentran
en exercise_data/raster/SRTM/.

Nota: Puedes encontrar que tu SRTM MDE tiene un SRC diferente que el de la capa de carreteras. En ese caso,
puedes reproyectar la capa de carreteras o la del MDE utilizando las técnicas aprendidas anteriormente en este
módulo.

• Utiliza la herramienta Envolvente(s) convexa(s) (disponible en Vectorial → Herramientas de geoproceso)
para generar un área conteniendo todas las calles:
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• Guárdalo como envolvente_carreteras.shp en exercise_data/spatial_statistics/.

• Add it to the TOC (Layers list) when prompted.

Creación de puntos al azar

• Crea puntos al azar en el área utilizando la herramienta en Vectorial → Herramientas de investigación →
Puntos aleatorios:
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• Guárdalo en exercise_data/spatial_statistics/ como puntos_aleatorios.shp.

• Add it to the TOC (Layers list) when prompted:
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Muestreo de los datos

• Para crear un conjunto de datos de muestreo desde el raster, necesitarás utilizar el plugin Point sampling
tool.

• Refiérete al módulo de complementos si es necesario.

• Busca la frase point sampling en el Complementos –> Administrar e instalar complementos... y
encontrarás el complemento.

• Tan pronto como la actives en el Administrador de complementos, encontrarás la herramienta en Comple-
mentos → Analyses → Point sampling tool:
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• Selecciona puntos_aleatorios como la capa contenedora de puntos de muestreo, y el SRTM raster como la
banda de la que se obtengan los valores.

• Asegúrate de que “Add created layer to the TOC” está habilitado.

• Guardalo en exercise_data/spatial_statistics/ como muestras_aleatorias.shp.

Ahora puedes comprobar los datos muestreados del archivo ráster en la tabla de atributos de la capa mues-
tras_aleatorias, estarán en una columna llamada srtm_41_19.tif.

Aquí tienes una posible capa de muestreo:
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Los puntos de muestreo están clasificados por su valor como los puntos oscuros lo son a baja altitud.

Utilizarás esta capa de datos de muestreo durante el resto de los ejercicios estadísticos.

7.4.2 Follow Along: Estadísticas Básicas

Ahora obtén lsa estadísticas básica de esta capa.

• Haz clic en la entrada del menú Vectorial → Herramientas de analisis → Estadísticas básicas.

• En el cuadro de diálogo que aparece, especifíca la capa muestras_aleatorias como fuente.

• Asegurate de que Campo objeto esta ajustado a srtm_41_19.tif que es el campo para el que calcularás
las estadísticas.

• Haz clic en Aceptar. Obtendrás resultados como estos:
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Nota: Puedes copiar y pegar los resultados en una hoja de cálculo. Los datos utilizan como separador (dos puntos
:).
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• Cierra el cuadro de diálogo del plugin cuando acabes.

Para entender las estadísticas anteriores, mira esta lista de definiciones:

Media La media (promedio) es simplemente la suma de los valores dividido por el número de valores.

Dev. Est. La desviación estándar. Da una indicación de cómo de cerca se agrupan los valores alrededor de la
media. Cuanto menor sea la desviación estándar, más cerca estarán los valores a la media.

Suma Todos los valores sumados.

Mín El valor mínimo

Máx El valor máximo.

N Número de muestras/valores.

CV La covarianza espacial covarianza del conjunto de datos.

Número de valores únicos El número de valores que son únicos en el conjunto de datos. Si hay 90 datos únicos
en un conjunto de datos con N=100, entonces los restantes 10 valores son iguales a uno o más de los otros.

Intervalo La diferencia entre los valores mínimo y máximo.

Mediana Si organizas todos los valores de menor a mayor, el valor en el medio (o la media de los dos valores en
el medio, si N es un número par) es la mediana de los valores.

7.4.3 Follow Along: Cálculo de una Matriz de Distancia

• Crea una nueva capa de puntos en la misma proyección que los demás conjuntos de datos (WGS 84 /
UTM 34S).

• Entra en el modo edición y digitaliza tres puntos en en algún lugar entre los otros puntos.

• Como alternativa, utiliza el mismo método de generación de punto al azar como antes, pero especifica sólo
tres puntos.

• Guarda tu nueva capa como puntos_distancia.shp.

Para generar una matriz de distancia utilizando esos puntos:

• Abre la herramienta Vectorial → Herramientas de análisis → Matriz de distancia.

• Selecciona la capa puntos_distancia como capa de entrada, y la capa muestras_aleatorias como capa de
destino.

• Ajústalo así:
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• Guarda el resultado como matriz_distancia.csv.

• Haz clic en Aceptar para generar la matriz de distancia.

• Abre un programa de hoja de cálculo para ver los resultados. Aquí tienes un ejemplo:
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7.4.4 Follow Along: Análisis del Vecinos más Próximos

Para hacer un análisis de vecinos más próximos:

• Haz clic en el elemento del menú Vectorial → Herramientas de análisis → Análisis de vecinos más próxi-
mos.

• En el cuadro de diálogo que aparece, selecciona la capa muestras_aleatorias y haz clic en Aceptar.

• Los resultados aparecerán en el cuadro de diálogo de la ventana de texto, por ejemplo:

Nota: Puedes copiar y pegar los resultados en una hoja de cálculo. Los datos utilizan como separador (dos puntos
:).
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7.4.5 Follow Along: Coordenadas Medias

Para obtener las coordenadas medias de un conjunto de datos:

• Haz clic en el elemento del menú Vectorial → Herramientas de análisis → Coordenada(s) media.

• En el cuadro de diálogo que aparece, especifica muestras_aleatorias como la capa de entrada, pero deja las
elecciones opcionales sin cambiar.

• Especifica la capa de destino como coord_medias.shp.

• Haz clic en Aceptar.

• Añade la capa a la Lista de capas cuando se solicite.

Compara estas con la coordenada central del polígono que fue utilizada para crear la muestra aleatoria.

• Haz clic en el elemento del menú Vectorial → Herramientas de geometría → Centroides de polígonos.

• En el cuadro de diálogo que aparece, selecciona envolvente_carreteras como la capa de entrada.

• Guarda el resultado como punto_central.

• Añadelo a la Lista de capas cuando se solicite.

Como puedes ver en el ejemplo siguiente, las coordenadas medias y el centro del área de estudio (en naranja) no
coinciden necesariamente:

7.4.6 Follow Along: Histogramas de Imagenes

El histograma de un conjunto de datos muestra la distribución de sus valores. La forma más simple de demostrarlo
en QGIS es a través de la histograma de imagen, disponible en el cuadro de diálogo Propieadades de la capa de
cualquier capa imagen.

• En tu Lista de capas, haz clic derecho en la capa SRTM DEM.

• Selecciona Propiedades.

• Elige la pestaña Histograma. Puede que necesites clicar en el botón Calcular Histograma para generar un
gráfico. Verás un gráfico describiendo la frecuencia de los valores en la imagen.
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• Puedes exportarlo como una imagen:

• Selecciona la pestaña Metadata, puedes ver información más detallada dentro de la caja Propiedades.

El valor medio es 332.8, ¡y el valor máximo es 1699! Pero esos valores no se muestran en el histograma. ¿Por
qué no? Porque hay muy pocos, comparado con la abundancia de píxels con valores por debajo de la media. Por
eso el histograma se extiende tan lejos hacia la derecha, incluso hay una línea no visible marcando la frecuencia
de valores mayores que 250.

Además, ten presente que el histograma te muestra la distribución de los valores, y no todos los valores son
necesariamente visibles en el gráfico.

• (Puedes cerrar ahora las Propiedades de la capa.)

7.4.7 Follow Along: Interpolación Espacial

Digamos que tienes una colección de puntos de muestra de los que te gustaría extrapolar datos. Por ejemplo,
puede que tengas acceso al conjunto de datos muestras_aleatorias que creaste antes, y quieres tener una idea de
que aspecto tiene el terreno.

Para empezar, inicia el Cuadrícula (Interpolación) clicando en el elemento del menú Ráster → Análisis→
Cuadrícula (Interpolación).

• En el campo Archivo de entrada, selecciona muestras_aleatorias.
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• Comprueba la caja Campo Z, y selecciona el campo srtm_41_19.

• Ajusta la situación de Archivo de salida a exercise_data/spatial_statistics/interpolacion.tif.

• Comprueba la caja Algoritmo y selecciona Distancia inversa a una potencia.

• Ajusta el Potencia a 5.0 y el Suavizado a 2.0. Deja los otros valores como están.

• Comprueba la caja Cargar en la vista del mapa cuando se termine y haz clic en Aceptar.

• Cuando esté hecho, haz clic en Aceptar en el cuadro de diálogo que dice Proceso completado, haz
clic en Aceptar en el diálogo que muestra la información de retorno (si ha aparecido), u haz clic en Cerrar
del cuadro de diálogo Cuadrícula (Interpolación).

Aquí se compara el conjunto de datos original (izquierda) y el construido por nuestros puntos de muestreo
(derecha). El tuyo puede parecer diferente debido a la forma aleatoria de situación y puntos de muestreo.

Como puedes ver, 100 puntos de muestreo no son realmente suficientes para tener una impresión detallada del
terreno. Te dan una idea muy general, pero también puede ser engañoso. Por ejemplo, en la imagen anterior, no
está claro que hay una montaña alta que discurre de este a oeste; sin embargo, la imagen parece mostrar un valle,
con puntos altos en el oeste. Simplemente utilizando una inspección visual, podemos ver que el conjunto de datos
de muestreo no es representativo del territorio.

7.4.8 Try Yourself

• Utiliza los procesos mostrados antes para crear un nuevo conjunto de datos aleatorios de 1000.

• Utiliza los puntos para muestrear el DEM original.

• Utiliza la herramienta Cuadrícula (Interpolación) en el nuevo conjunto de datos como antes.

• Nombra al archivo de salida interpolacion_1000.tif, con Potencia y Suavizado ajustado a 5.0 y
2.0, respectivamente.

Los resultados (dependiendo de la posición de tus puntos aleatorios) se verán más o menos como esto:
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El borde muestra la capa envolvente_carreteras (que representa los límites de puntos aleatorios de muestreo) para
explicar una repentina falta de detalle más allá de sus bordes. Esto es una representación mucho mejor del terreno,
debido a la mayor densidad de puntos de muestreo.

Aquí hay un ejemplo del aspecto con puntos de muestreo de 10 000:

Nota: No es recomendable que intentes hacer esto con 10 000 puntos de muestreo si no estás trabajando con
un ordenador rápido, ya que con ese tamaño de conjunto de datos de muestreo se requiere mucho más tiempo de
procesado.
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7.4.9 Follow Along: Herramientas Adicionales de Análisis Espacial

Originalmente un proyecto separado y luego accesible como complemento, el software SEXANTE se ha añadido
al QGIS como una función básica desde la versión 2.0. Puedes encontrarlo como un menú QGIS nuevo con su
nuevo nombre Procesado desde donde puedes acceder a una caja de herramientas rica en herramientas de análisis
espacial que te permiten acceder a varios complementos desde una simple interfaz.

• Ative este conjunto de ferramentas, permitindo a entrada do menu Processamento → Caixa de Ferramentas.
A caixa de ferramentas parece como essa:

Es probable que la veas anclada en QGIS en la parte derecha del mapa. Observa que las herramientas listadas
ahí son enlaces a las herramientas. Algunos de ellos son algoritmos propios de SEXTANTE y otros son enlaces
de herramientas a las que se accede desde aplicaciones externas como GRASS, SAGA o la caja de herramientas
Orfeo. Estas aplicaciones externas están instaladas con QGIS así que ya puedes utilizarlas. En caso de que
necesites cambiar la configuración de las herramientas de Procesado, o por ejemplo, necesites actualizar una
nueva versión de una de la aplicaciones externas, puedes acceder a sus ajustes desde Procesado → Opciones y
configuración.

7.4.10 Follow Along: Análisis de Patrones Espaciales de Puntos

Para una simple indicación de la distribución espacial de puntos en el conjunto de datos muestras_aleatorias,
podemos utilizar la herramienta de SAGA Spatial Point Pattern Analysis a través de la Caja de herramientas de
procesado que abriste antes.

• En Caja de herramientas de procesado, busca la herramienta Spatial Point Pattern Analysis.
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• Haz doble clic en él para abrir el cuadro de diálogo.

Instalando SAGA

Nota: Si SAGA no está instalado en tu sistema, el cuadro de diálogo del complemento te informará que la
dependencia no se encuentra. Si éste no es el caso, puedes saltarte estos pasos.

En Windows

Encontrarás una instalación de SAGA para Windows en los materiales del curso.

• Inicia el programa y sigue sus instrucciones para instalar SAGA en tu sistema de Windows. ¡Anota la ruta
en la que lo estás instalando!

Una vez instalado el SAGA, necesitarás configurar SEXTANTE para encontrar la ruta en el que estaba instalado.

• Haz clic en la entrada del menú Analysis → SAGA options and configuration.

• En el cuadro de diálogo que aparece, expande SAGA item and look for SAGA folder. Su valor estará en
blanco.

• En ese espacio, inserta la ruta donde instalaste el SAGA.

En Ubuntu

• Busca SAGA GIS en el Software Center, o introduce la frase sudo apt-get install saga-gis en
tu terminal. (Puede que necesites primero añadir un repositorio de SAGA en tus fuentes.)

• QGIS encontrará SAGA automáticamente, aunque puede que necesites reiniciar QGIS si no funciona direc-
tamente.

En Mac

Los usuarios Homebrew pueden instalar SAGA con este comando:

• instalación brew del saga básico

Si no utilizas Homebrew, sigue las instrucciones siguientes:

http://sourceforge.net/apps/trac/saga-gis/wiki/Compiling%20SAGA%20on%20Mac%20OS%20X

Después de instalar

Ahora que has instalado y configurado SAGA, sus funciones te serán accesibles.

Utilizando SAGA

• Abre un cuadro de diálogo del SAGA.

• SAGA produce tres salidas, así que requiere tres rutas de salida.

• Guarda esas tres salidas en exercise_data/spatial_statistics/, utilizando los nombres de
archivo que creas conveniente.
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La salida se verá así (la simbología se cambió para este ejemplo):
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El punto rojo es la media central; el gran círculo es la distancia estándar, que dá una indicación de cómo de cerca
estan distribuidos los puntos alrededor de la media central; y el rectángulo es la caja delimitadora, describiendo el
mínimo rectángulo posible que todavía incluye todos los puntos.

7.4.11 Follow Along: Análisis de la Distancia Mínima

A menudo, la salida de un algoritmo no es un archivo shape, sino una tabla resumen de las propiedades estadísticas
del conjunto de datos. Una de esas herramientas es Minimum Distance Analysis.

• Encontre esta ferramenta no Caixa de Ferramentas Processamento como Analise de Distância Mínima.

No requiere ninguna otra entrada a parte de especificar el conjunto de puntos vectoriales a ser analizado.

• Escoge el conjunto de datos puntos_aleatorios.

• Haz clic en Aceptar. Al finalizar, una tabla DBF aparecerá en la Lista de capas.

• Selecciónala, luego abre su tabla de atributos. Aunque algunas figuras puede que varíen, tus resultados
estarán en este formato:
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7.4.12 In Conclusion

QGIS permite muchas posibilidades para analizar las propiedades espaciales estadísticas de conjuntos de datos.

7.4.13 What’s Next?

Ahora que has cubierto los análisis vectoriales, ¿Por qué no ver qué se puede hacer con rasters? ¡Eso es lo que
haremos en el próximo módulo!
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Module: Rasters

Antes nós usamos rasters para a digitalização, mas os dados raster também podem ser utilizados diretamente.
Neste módulo, você vai ver como isto é realizado no QGIS.

8.1 Lesson: Trabajando con Datos Ráster

Los datos ráster son bastante diferentes de los datos vectoriales. Los datos vectoriales tienen elementos discretos
construidos a partir de vértices, y puede que conectados con líneas y/o áreas. Los datos ráster, sin embargo, son
como cualquier imagen. Aunque pueden describir propiedades de los objetos en el mundo real, esos objetos no
existen como objetos delimitados, en lugar de ello están representados utilizando píxeles de distintos valores de
color.

Durante este módulo utilizarás datos ráster para suplementar el análisis SIG que has hecho hasta ahora.

El objetivo de esta lección: Aprender como trabajar con datos ráster en el entorno del QGIS.

8.1.1 Follow Along: Cargando Datos Ráster

• Abra seu mapa analysis.qgs (que você deve ter criado e salvo durante o módulo anterior).

• Desactiva todas las capas excepto las capas solución y carreteras_importantes.

• Haz clic en el botón Load Raster Layer:

Se abrirá el cuadro de diálogo Añadir capa ráster. Los datos para ese proyecto estan en
exercise_data/raster.

• Cárgalos todos por separado, o mantén pulsado ctrl y selecciona a los cuatro a la vez, y ábrelos todos al
mismo tiempo.

La primera cosa que observarás es que nada parece estar pasando en tu mapa. ¿No se están cargando los ráster?
Bueno, están en Lista de capas, así que obviamente se cargaron. El problema es que no están en la misma
proyección. Afortunadamente, ya hemos visto qué hacer en esta situación.

• Selecciona Proyecto –> Propiedades del proyecto en el menú:

• Selecciona la pestaña SRC en el menú:

• Habilita la proyección “al vuelo”.

• Ajústala a la misma proyección que el resto de tus datos (WGS 84 / UTM zone 33S).

• Haz clic en Aceptar.
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Los ráster debería encajar bien:

Ahí lo tenemos - cuatro fotografías aéreas cubriendo toda nuestra área de estudio.

8.1.2 Follow Along: Creación de un Ráster Virtual

Ahora como puedes ver, tu capa de soluciones se encuentra sobre las cuatro fotografías. Lo que significa que vas a
trabajar con los cuatro ráster al mismo tiempo. Esto no es ideal; sería mejor tener un solo archivo por cada imagen
(composición), ¿No?

Afortunadamente, QGIS te permite hacer eso exactamente, y sin necesidad de crear un nuevo archivo ráster, que
podría ocupar mucho espacio. En su lugar, puedes crear un Ráster Virtual. Eso también se denomina un Catálogo,
lo que explica su función. No es realmente un ráster nuevo. Si no que és una forma de organizar tus ráster
existentes en un catálogo: un archivo de fácil acceso.

Para hacer un catálogo:

• Haz clic en el elemento del menú Ráster → Miscelánea → Construir ráster virtual (Catálogo).

• En el cuadro de diálogo que aparece, marca la caja junto a Usar capas ráster visibles para la entrada.

• Introduce exercise_data/residential_development como ubicación de salida.

• Introduce fotos_aereas.vrt como nombre de archivo.

• Comprueba el botón Cargar en la vista del mapa cuando se termine.
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Observa el campo de texto inferior. Lo que el cuadro de diálogo está haciendo es escribir ese texto por ti. Es un
comando largo que QGIS va a ejecutar por ti.

Nota: Ten presente que el comando de texto se puede editar, así que lo puedes personalizar si lo prefieres.
Busca en línea el comando inicial ( en este caso, gdalbuildvrt) para ayudarte en la síntesis.

• Haz clic en Aceptar para ejecutar el comando.

Puede que lleve un poco completarlo. Cuando esté hecho, te avisará con un cuadro de mensaje.

• Haz clic en Aceptar para quitar el mensaje.

• Haz clic en Cerrar en el cuadro de diálogo Construir ráster virtual (Catálogo). (No hagas clic en Aceptar
de nuevo, si lo haces se ejecutará el comando de nuevo.)
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• Ahora puedes borrar los cuatro ráster originales de la Lista de capas.

• Si es necesario, haz clic y arrastra el nuevo catálogo ráster fotos_aereas al final de la Lista de capas para
que las otras capas activas sean visibles.

8.1.3 Transformando Datos Ráster

Los métodos anteriores te permiten unir virtualmente conjuntos de datos utilizando un catálogo, y reproyectarlos
“al vuelo”. Sin embargo, si estás ajustando datos que utilizarás por mucho tiempo, puede ser más eficiente crear
un nuevo ráster que ya esté unido y reproyectado. Esto mejora el rendimiento cuando utilizas rásters en un mapa,
pero puede que lleve algún tiempo para ajustarlo inicialmente.

Reproyectando Ráster

• Haz clic en el elemento del menú Ráster → Proyecciones → Combar (Reproyectar).

Observa que esta herramienta incluye un útil opción para la reproyección por lotes de directorios completos.
También puedes reproyectar ráster visuales (catálogos), así como habilitar un modo de procesamiento múltiple.
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Uniendo rásters

• Haz clic en el elemento del menú Ráster → Miscelánea → Combinar.

Puedes elegir procesar directorios completos en lugar de archivos simples, lo que te da una útil capacidad de
procesado por lotes. Puedes especificar un ráster virtual como archivo de entrada, y todos los ráster de los que
consiste serán procesados.

También puedes añadir tus propias líneas de comandos utilizando la casilla de verificación y listado Opciones de
creación. Esto solo se aplica si tienes conocimientos de como funciona la librería GDAL.
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8.1.4 In Conclusion

QGIS facilita inlcuir datos ráster a tus proyectos ya existentes.

8.1.5 What’s Next?

Lo siguiente será utilizar datos ráster que no sean imágenes aéreas, y veremos cómo la simbología también es útil
en el caso de los rásters.

8.2 Lesson: Cambiando la Simbología Ráster

No todos los datos ráster consisten en fotografías aéreas. Hay muchas otras formas de datos ráster, y en muchos
de esos casos, es esencial simbolizar correctamente los datos para que sean fácilmente visibles y útiles.

El objetivo de esta lección: Cambiar la simbología de una capa ráster.

8.2.1 Try Yourself

• Comece com o mapa atual que você deve ter criado durante o exercício anterior: analysis.qgs.

• Utiliza el botón Añadir capa ráster para cargar el nuevo conjunto de datos ráster.

• Carga el conjunto de datos srtm_41_19.tif, que se encuentra en el directorio
exercise_data/raster/SRTM/.

• Una vez que haya aparecido en la Lista de capas, cámbiale el nombre a MDE.

• Aplica el zoom a la extensión de la capa con clic derecho en ella en la Lista de Capas y selecciona Zum a la
extensión de la capa.

Ese conjunto de datos es un Modelo Digital de Elevación (MDE). Es un mapa de la elevación (altitud) del terreno,
permitiendonos ver donde están las montañas y los valles, por ejemplo.

Una vez cargado, observarás que hay una representación básica en escala de grises del MDE. Se ve aquí con las
capas vectoriales por encima:
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QGIS ha aplicado automáticamente un estiramiento a la imagen para fines de visualización, y aprenderemos más
sobre cómo funciona esto mientras avanzamos.

8.2.2 Follow Along: Cambiando Simbología de la Capa Ráster

• Abre el cuadro de diálogo Propiedades de la capa para la capa SRTM con clic derecho en la capa en el árbol
de capas y selecciona la opción Propiedades.

• Cambia a la pestaña Estilo.
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Esos son los ajustes actuales que QGIS ha aplicado por defecto. Esto es solo una forma de ver el MDE, así que
exploremos otras.

• Cambia el Tipo de renderizador a Unibanda pseudocolor, y utiliza las opciones presentadas por defecto.

• Haz clic en el botón Clasificar para generar una clasificación por color nueva, y haz clic en Aceptar para
aplicar esta clasificación al MDE.
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Verás el ráster con este aspecto:
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Es un modo interesante para ver al MDE así, pero puede que no queramos simbolizarlo utilizando estos colores.

• Vuelve a abrir el cuadro de diálogo Propiedades de la capa.

• Vuelve a cambiar el Tipo de renderizador a Unibanda gris.

• Haz clic en Aceptar para aplicar los ajustes al ráster.

Ahora verás un rectangulo totalmente gris que no es útil en absoluto.
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Esto ocurre porque hemos perdido los ajustes por defecto que “estira” los valores del color para mostrarlos con-
trastados.

Digamos a QGIS que vuelva a “estirar” los valores del color basados en el rango de los datos del MDE. Esto hará
que QGIS use todos los colores disponibles (en Escala de grises, esto es negro, blanco y todos los tipos de gris
intermedios).

• Especifica los valores Mín and Máx como se muestran abajo.

• Ajusta el valor Mejora de contraste a Estirar a MinMax:

220 Chapter 8. Module: Rasters



QGIS Training Manual, Versão 2.8

Pero ¿Cuáles son los valores máximos y mínimos que deberían usarse en los ajustes? Aquellos que ya estan en
Mín y Máx son los mismos valores que nos dieron el rectángulo gris de antes. En lugar de ello, deberíamos utilizar
los valores mínimos y máximos que están realmente en la imagen, ¿verdad? Afortunadamente, puedes determinar
esos valores fácilmente cargando el valor mínimo y máximo del ráster.

• En Cargar valores min / max, selecciona la opción Min / Max.

• Haz clic en el botón Cargar.

Observa cómo los Los valores min / max han cambiado para relejar los valores reales de nuestro MDE:
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• Haz clic en Aceptar para aplicar estos ajustes a la imagen.

Verás que los valores del ráster vuelven a estar adecuadamente representados, con los colores oscuros represen-
tando valles, y los más claros montañas:
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Pero ¿No hay otra forma mejor o más fácil?

Si, la hay. Ahora que entiendes que se necesita hacer, te alegrará saber que hay una herramienta para hacer todo
eso fácilmente.

• Borra el MDE actual de la Lista de capas.

• Carga el ráster otra vez, vuelve a llamarlo MDE como antes. Ahí vuelve a estar el rectángulo gris...

• Activa la herramienta que necesitarás en Ver → Barras de herramientas → Ráster. Esos iconos aparecerán
en el interfaz:

El tercer botón por la izquierda Estiramiento de histograma local ajustará automáticamente los valores mínimos
y máximos para darte el mejor contraste en el área local a la que has ampliado. Es útil para conjuntos de datos
grandes. El botón de la izquierda Cortar estiramiento local acumulativo ... ajustará los valores mínimos y máxi-
mos a valores constantes en toda la imagen.

• Haz clic en el cuarto botón desde la izquierda (Estirar histograma a la extensión de todo el conjunto de
datos). Verás que los datos están ahora correctamente representados como antes.

Puedes probar los otros botones de esta barra de herramientas y ver cómo alteran los ajustes de la imagen cuando
amplías a áreas locales o cuando alejas el zum.
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8.2.3 In Conclusion

Estas son solo las funciones básicas para iniciarte con la simbología ráster. QGIS también te permite muchas
otras opciones, como simbolizar una capa utilizando desviaciones estándar, o representar diferentes bandas con
diferentes colores en una imagen multi espectral.

8.2.4 Referencia

El conjunto de datos SRTM fue obtenido de http://srtm.csi.cgiar.org/

8.2.5 What’s Next?

Ahora que podemos ver nuestros datos adecuadamente representados, investiguemos cómo podemos analizarlos
todavía mejor.

8.3 Lesson: Análisis del Terreno

Ciertos tipos de ráster te permiten obtener una visión más clara del terreno que representan. Los Modelos de Digi-
tal de Elevaciones (MDEs) son particularmente útiles para ello. En esta lección utilizaras herramientas de análisis
de terrenos para obtener más información sobre el área de estudio para la propuesta de desarrollo residencial
anterior.

El objetivo de esta lección: Utilizar herramientas de análisis del terreno para obtener más información sobre el
terreno.

8.3.1 Follow Along: Cálculo del Relieve Sombreado

El MDE que tienes en tu mapa ahora mismo te muestra la elevación del terreno, pero en ocasiones puede ser un
poco abstracto. Contiene toda la información 3D que necesitas sobre el terreno, pero no parece un objeto 3D. Para
tener una mejor visión del terreno, es posible calcular un sombreado del relieve, que es un ráster que utiliza la luz
y sombra del terreno para crear una imagen que aprenta ser 3D de este.

Para trabajar con MDEs, deberías utilizar la herramienta de análisis todo-en-uno del QGIS MDT (Modelos de
terreno)

• Haz clic en el elemento del menú Ráster → Análisis → MDT (Modelos de terreno).

• En el cuadro de diálogo que aparece, asegúrate que el Archivo de entrada file es la capa MDE.

• Ajusta el Archivo de salida a relieve_sombreado.tif en el directorio
exercise_data/residential_development.

• Asegúrate también de que la opción Modo tiene Mapa de sombras (Hillshade) seleccionada.

• Comprueba que la caja junto a Cargar en la vista del mapa cuando se termine esta seleccionada.

• Puedes dejar todas las demás opciones sin cambiar.

• Haz clic en Aceptar para generar el sombreado del relieve.

• Cuando te diga que el proceso se ha completado, haz clic en Aceptar en el mensaje para cerrarlo.

• Haz clic en Cerrar en el cuadro de diálogo principal MDT (Modelos del terreno).

Ahora tendrás una capa nueva llamada relieve_sombreado que tiene este aspecto:

224 Chapter 8. Module: Rasters

http://srtm.csi.cgiar.org/


QGIS Training Manual, Versão 2.8

Se ve bien en 3D, pero ¿podemos mejorarla? En sí mismo, el sombreado del relieve parece un molde de yeso.
¿No podríamos utilizarlo con nuestros otros ráster más coloridos de alguna manera? Por supuesto que podemos,
utilizando el sombreado del relieve como una capa sobrepuesta.

8.3.2 Follow Along: Utilizando un Sombreado del Relieve como Capa So-
brepuesta

Un sombreado del relieve puede proporcionar información muy útil sobre la luz solar en un momento dado del
día. Pero también puede ser utilizado para fines estéticos, para que el mapa tenga mejor aspecto. La clave en este
caso está en que el sombreado del relieve sea defina como mayormente transparente.

• Cambia la simbología del MDE original para utilizar el esquema Pseudocolor como en el ejercicio anterior.

• Oculta todas las capas excepto MDE y relieve_sombreado.

• Haz clic y arrastra la MDE hasta debajo de la capa relieve_sombreado en la Lista de capas.

• Ajusta la capa relieve_sombreado para ser transparente abriendo sus Propiedades de la capa y ve a la
pestaña Transparencia.

• Ajusta la Transparencia global a 50%:

• Haz clic en Aceptar en el cuadro de diálogo Propiedades de la capa. Obtendrás resultados como estos:
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• Activa y desactiva varias veces la capa relieve_sombeado en la Lista de capas para ver la diferencia que hay.

Utilizando el sombreado del relieve de esta forma, es posible enaltecer la topografía del paisaje. Si el efecto no
parece ser suficiente para ti, puedes cambiar la transparencia de la capa relieve_sombreado, pero por supuesto,
cuanto más brillante se vuelva el sombreado del relieve, peor se verán los colores bajo él. Necesitarás encontrar
un balance que funcione.

Recuerda guardar tu mapa cuando hayas terminado.

Nota: Para los siguientes dos ejercicios, por favor, usa un mapa nuevo. Carga solo el conjunto de
datos ráster MDE en el mapa (exercise_data/raster/SRTM/srtm_41_19.tif). Es para sim-
plificar la tarea mientras trabajas con la herramienta de análisis del ráster. Guarda el mapa como
exercise_data/raster_analysis.qgs.

8.3.3 Follow Along: Calculo de la Pendiente

Otra cosa útil a saber sobre el terreno es cómo de escarpado es. Si, por ejemplo, quieres construir casas en esas
tierras, entonces necesitarás un terreno relativamente plano.

Para hacer esto, necesitas utilizar la herramienta Pendiente mode of the MDT (Modelos de terreno).

• Abre la herramienta como antes.

• Selecciona la opción Pendiente dentro de Modo:
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• Ajusta la localización de guardado a exercise_data/residential_development/pendiente.tif

• Habilita la casilla de verificación Cargar en la vista....

• Haz clic en Aceptar y cierra el cuadro de diálogo cuando el proceso esté completo, y haz clic en Cerrar para
cerrar el cuadro de diálogo. Verás un nuevo ráster cargado en tu mapa.

• Con el nuevo ráster seleccionado en la Lista de capas, haz clic en el botón Estirar histograma a la extensión
de todo el conjunto de datos. Ahora verás la pendiente del terreno, con pixeles negros siendo terreno llano
y pixeles blancos siendo terreno escapado:

8.3.4 Try Yourself Cálculo del orientación

La orientación del terreno se refiere a la dirección en la que está orientado. Como el estudio se lleva a cabo en
el Hemisferio Sur, las propiedades deberían ser construidas idílicamente en una pendiente orientada al norte para
permanecer iluminadas.
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• Utiliza el modo Orientación de la herramienta MDT (Modelos de terreno) para calcular la orientación del
terreno.

Comprueba tus resultados

8.3.5 Follow Along: Utilizando la Calculadora Ráster

Piensa en el problema del agente inmobiliario anterior, que se abordó en la lección Análisis Vectorial. Imagina que
los compradores ahora quieren encontrar una construcción y construir una pequeña casa de campo en la propiedad.
En el Hemisferio Sur, sabemos que una parcela con un desarrollo ideal debe estar orientada al norte, y con una
pendiente de menos de cinco grados. Pero si la pendiente es menor a 2 grados, la orientación no importará.

Afortunadamente, ya tienes rásters mostrándote la pendiente además de la orientación, pero no tienes ninguna
forma de saber dónde se dan ambas condiciones a la vez. ¿Cómo se podría realizar este análisis?

La respuesta está en la Calculadora ráster.

• Haz clic en Ráster > Calculadora ráster... para iniciar la herramienta.

• Para utilizar el conjunto de datos orientación, doble clic en el elemento orientación@1 en la lista Bandas
ráster de la izquierda. Aparecerá en el campo de texto Expresión de la calculadora de campos más abajo.

El norte está a 0 (cero) grados, así que para un terreno orientado al norte, la orientación debe ser mayor de 270
grados y menor de 90.

• En el campo Expresión de la calculadora de campos, introduce esta expresión:

aspect@1 <= 90 OR aspect@1 >= 270

• Ajusta el archivo de salida a orientación_norte.tif en el directorio
exercise_data/residential_development/.

• Asegúrate de que la caja Añadir resultados al proyecto está seleccionada.

• Haz clic en Aceptar para empezar a procesar.
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Tu resultado será este:
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8.3.6 Try Yourself

Ahora que has hecho la orientación, crea dos nuevos análisis de la capa MDE.

• El primero será para identificar todas las áreas donde la pendiente es menor o igual a 2 grados.

• El segundo es similar, pero la pendiente debería ser menor o igual a 5 grados.

• Guárdalos en exercise_data/residential_development/ como pendiente_lte2.tif y
pendiente_lte5.tif.

Comprueba tus resultados

8.3.7 Follow Along: Combinando Resultados de Análisis Ráster

Ahora tienes tres nuevos análisis ráster de la capa MDE

• orientacion_norte: el terreno orientado al norte

• pendiente_lte2: la pendiente igual o menor a 2 grados

• pendiente_lte5: la pendiente igual o menor a 5 grados

Cuando las condiciones de esas tres capas coinciden, son iguales a 1. En cualquier otro punto, son iguales a 0.
Además, si multiplicas uno de esos ráster por otro, tendrás el área donde ambos son iguales a 1.

Las condiciones a cumplir son; a pendientes iguales o menores de 5 grados, el terreno debe estar orientado al
norte; pero a pendientes iguales o menores de 2 grados, la dirección a la que se orienta el terreno no importa.
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Por lo tanto, necesitas encontrar áreas donde la pendiente sea menor o igual a 5 grados Y el terreno está orientado
al norte; O la pendiente es menor o igual a 2 grados. Dicho terreno sería aceptable para el desarrollo.

Para calcular las áreas que cumplen esos criterios:

• Abre de nuevo tu Calculadora ráster.

• Utiliza la lista Bandas ráster, los botones Operadores, y tu teclado para construir esa expresión en el área
de texto Expresión de la calculadora de campos:

( aspect_north@1 = 1 AND slope_lte5@1 = 1 ) OR slope_lte2@1 = 1

• Guarda el resultado en exercise_data/residential_development/ como
todas_condiciones.tif.

• Haz clic en Aceptar en el Calculadora ráster. Tus resultados:

8.3.8 Follow Along: Simplificando el Ráster

Como puedes ver en la imagen superior, los análisis combinados nos dejan con muchas áreas pequeñas donde se
cumplen las condiciones. Pero esas no son realmente útiles para nuestro análisis, ya que son demasiado pequeñas
para construir. Vamos a deshacernos de todas esas áreas minúsculas.

• Abre la herramienta Sieve (Ráster → Análisis → Filtrado).

• Ajusta el Archivo de entrada a todas_condiciones, y el
Archivo de salida a todas_condiciones_filtrado.tif (en
exercise_data/residential_development/).

• Ajusta ambos valores Umbral y Conexiones de píxeles a 8, luego ejecuta la herramienta.
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Cuando el proceso esté terminado, la nueva capa se cargará en el mapa. Pero cuando intentes utilizar la herramienta
de estiramiento del histograma para ver los datos, ocurrirá esto:
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¿Qué está pasando? La respuesta se encuentra en los metadatos del nuevo archivo ráster.

• Mira los metadatos en la pestaña Metadatos del cuadro de diálogo Propiedades de la capa. Mira en la
sección inferior Propiedades.
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A pesar de que este ráster, al igual que el ráster de que se ha derivado, debería solo mostrar los valores 1 y 0, tiene
como valor de STATISTICS_MINIMUM un número negativo muy alto. La investigación de los datos muestran
que este número actua como valor nulo. Como solo buscamos áreas que no estaban filtradas, vamos a ajustar esos
valores nulos a cero.

• Abre de nuevo el Calculadora ráster, y construye esta expresion:

(todas_condiciones_filtrado@1 <= 0) = 0

Esto mantendrá los valores cero existentes, mientras cambiará los valores negativos a cero; lo que dejará a
todas las áreas con el valor 1 intacto.

• Guarda el resultado en exercise_data/residential_development/ como
todas_condiciones_simple.tif.

Tu resultado tiene este aspecto:
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Eso era lo que se esperaba: una versión simplificada de los resultados anteriores. Recuerda que si los resultados
que obtienes de una herramienta no son los que esperabas, comprobando los metadatos (y atributos vectoriales, si
es aplicable) puede ser esencial para solucionar el problema.

8.3.9 In Conclusion

Has visto cómo derivar todo tipo de análisis desde un MDE. Esto incluye cálculos de sombreado del relieve,
pendiente y orientaciones. También has visto cómo utilizar la calculadora ráster para analizar más profundamente
y combinar esos resultados.

8.3.10 What’s Next?

Ahora tienes dos análisis: el análisis vectorial que te muestra las parcelas potencialmente adecuadas, y el análisis
ráster que te muestra el terreno potencialmente adecuado. ¿Cómo se pueden combinar para llegar a un resultado
final para este problema? Ese es el tema de la siguiente lección, empezando en el módulo siguiente.
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CHAPTER 9

Module: Completando a Analise

Agora você tem duas metades de uma análise: a parte vetor e a raster. Neste módulo, você vai ver como combiná-
las. Você vai concluir a análise e apresentação dos resultados finais.

9.1 Lesson: Conversión de Ráster a Vectorial

Convertir entre formatos ráster y vectoriales te permite utilizar ambos tipos de datos cuando resuelves un problema
SIG, así como utilizar los diferentes métodos analíticos específicos de cada uno de los dos formatos de datos
geográficos. Esto incrementa la flexibilidad que tienes considerando fuentes de datos y métodos de procesado
para resolver problemas de SIG.

Para combinar análisis ráster y vectoriales, necesitas convertir uno de los tipos al otro. Vamos a convertir los
resultados ráster de la lección anterior a vectoriales.

El objetivo de esta lección: Convertir un resultado ráster a uno vectorial que pueda ser utilizado para completar
el análisis.

9.1.1 Follow Along: La Herramienta Ráster a vectorial

Comienza con el mapa del último módulo, raster_analysis.qgs. Ahí deberías encontrar
all_conditions_simple.tif calculado durante los ejercicios previos.

• Haz clic en Ráster → Conversión → Poligonizar (Ráster a vectorial Vector). El cuadro de diálogo de la
herramienta aparecerá.

• Ajustalo así:
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• Cambia el nombre del campo (describiendo los valores del ráster) a suitable.

• Guarda el archivo shape en exercise_data/residential_development como
all_terrain.shp.

Ahora tienes un archivo vectorial que contiene todos los valores del ráster, pero las únicas áreas en las que estás
interesado son aquellas que son adecuadas; es decir, aquellos polígonos donde el valor de suitable es 1. Puedes
cambiar el estilo de esa capa si quieres tener una visualización más clara.

9.1.2 Try Yourself

Refiérete al módulo de análisis vectorial.

• Crea un nuevo archivo vectorial que contenga solo los polígonos donde suitable tiene el valor 1.

• Guarda el nuevo archivo como exercise_data/residential_development/ como
suitable_terrain.shp.

Comprueba tus resultados

9.1.3 Follow Along: La Herramienta Vectorial a ráster

Aunque no es necesario para tu problema actual, es útil saber cómo hacer la conversión opuesta a la que has hecho
arriba. Convierte a ráster el archivo vectorial suitable_terrain.shp que has creado en el paso anterior.

• Haz clic en Ráster → Conversión → Rasterizar (Vectorial a raster) para iniciar la herramienta, luego
ajústalo como en la siguiente imagen:
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• Archivo de entrada is all_terrain;

• Archivo de salida... es exercise_data/residential_development/raster_conversion.tif;

• Anchura and Altura son 837 y 661, respectivamente.

Nota: El tamaño de la imagen de salida está especificado ahí para ser la misma que el ráster original que ha sigo
vectorizado. Para ver las dimensiones de una imagen, abre sus metadatos (la pestaña Metadatos en Propiedades
de la capa).

• Haz clic en Aceptar en el cuadro de diálogo para iniciar el proceso de conversión.

• Cuando esté completo, comprueba el resultado comparando el nuevo ráster con el original. Deberían coin-
cidir exactamente, píxel a píxel.

9.1.4 In Conclusion

Convertir entre formatos ráster y vectorial te permite ampliar la aplicabilidad de los datos, y no tiene por qué
conducir a la degradación de los datos.

9.1.5 What’s Next?

Ahora que tienes los resultados del análisis territorial disponibles en formato vectorial, pueden ser utilizados para
solucionar problemas respecto a qué construcciones deberiamos considerar para el desarrollo residencial.
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9.2 Lesson: Combinando los Análisis

Utilizar los resultados vectorizados del análisis ráster te permitirá seleccionar solo construcciones con terreno
adecuado.

El objetivo de esta lección: Utilizar los resultados de terreno vectorizado para seleccionar las parcelas adecuadas.

9.2.1 Try Yourself

• Guarda tu mapa actual (raster_analysis.qgs).

• Abra o mapa em que você criou durante a análise vetor anterior (você deve ter salvo o arquivo como
analysis.qgs).

• En la Lista de capas, habilita estas capas:

– hillshade,

– solution (o buildings_over_100)

• Además de esas capas, que deberían estar ya cargadas en el mapa de cuando trabajaste con ellas, añade el
conjunto de datos suitable_terrain.shp.

• Si te faltan algunas capas, deberías encontrarlas en exercise_data/residential_development/

• Use the Intersect tool (Vector -> Geoprocessing Tools) to create a new vector layer called
new_solution.shp which contains only those buildings which intersect the suitable_terrain
layer.

Ahora deberías tener una capa mostrando ciertas construcciones como tu solución, por ejemplo:

Nota: Si encuentras que la herramienta Intersección no produce ningún resultado, comprueba los ajustes SRC de
cada una de tus capas. El SRC debe ser el mismo para las capas que estás comparando. Puede que necesites re-
proyectar una capa guardando la capa como un nuevo archivo shape con el SRC requerido. En nuestro ejemplo, la
capa suitable_terrain se reproyectó a WGS 84 / UTM 34S y se nombró suitable_terrain_34S.
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9.2.2 Try Yourself Inspeccionando los Resultados

Mira cada una de las construcciones en tu capa new_solution. Compáralos con la capa suitable_terrain cambiando
la simbología para la capa new_solution para que solo tenga contornos. ¿Qué observas sobre algunas de las
construcciones? ¿Son adecuadas solo porque intersectan con la capa suitable_terrain? ¿O por qué no? ¿Cuáles
dirías que no son adecuadas?

Comprueba tus resultados

9.2.3 Try Yourself Refina el Análisis

Puedes ver en los resultados que algunas construcciones que estaban incluidas no eran realmente adecuadas, así
que ahora podemos refinar el análisis.

Queremos asegurarnos que nuestro análisis muestra solo aquellas construcciones que están completamente dentro
de la capa suitable_terrain. ¿Cómo lo harías? Utiliza una o más herramientas de Análisis Vectorial y
recuerda que nuestras construcciones tienen más de 100m cuadrados de tamaño.

Comprueba tus resultados

9.2.4 In Conclusion

Ahora has respondido a la pregunta original del estudio, y puedes ofrecer una opinión (con razonamientos respal-
dados en el análisis) para una recomendación respecto a que propiedad desarrollar.

9.2.5 What’s Next?

Lo siguiente será presentar esos resultados como parte de tu segundo ejercicio.

9.3 Exercício

Usando o compositor de impressão, crie um novo mapa representando os resultados de sua análise. Incluindo as
seguintes camadas?

• lugares (como legenda),

• Relevo sombreado,

• solução (ou nova_solução),

• rodovias e

• Uma aero_foto ou um DEM.

Escreva um pequeno texto explicativo para acompanhar. Incluindo nesse texto os critério que foram utilizados para
considerar a compra da casa e posteriores reformas, bem como explicar as suas recomendações para a adequação
dos edifícios.

9.4 Lesson: Ejercicio Suplementario

En esta lección, serás guiado a través de un análisis SIG completo en QGIS.

Nota: Lección desarrollada por Linfiniti y S Motala (Universidad Tecnológica de Península del Cabo)
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9.4.1 Planteamiento del Problema

Eres el encargado de encontrar áreas en Península del Cabo que sean adecuadas para el hábitat de especies de
plantas fynbos raras. La extensión de tu área de investigación en Península del Cabo es: Sur de Melkbosstrand,
Oeste de Strand. Botánicos te han proporcionado las preferencias exhibidas por las especies en cuestion:

• Crecen en pendientes orientadas al este.

• Crecen en pendientes con gradiente entre 15 y 60%.

• Crecen en áreas que tienen un total de precipitación anual de > 1200 mm.

• Solo se encuentran a al menos 250 m de distancia de los asentamientos humanos.

• El área de vegetación en la que ocurre debería ser de al menos 6000m2.

Como voluntario de Naturaleza del Cabo, has acordado buscar la planta en el terreno adecuado más cercano a tu
casa. Utiliza tus habilidades SIG para determinar dónde deberías ir a ver.

9.4.2 Esquema de la Solución

Para solucionar este problema, tendrás que utilizar los datos disponibles (disponibles en
exercise_data/more_analysis) para encontrar el área candidata que esté más cerca de tu casa.
Si no vives en Ciudad del Cabo (donde éste problema está basado) puedes elegir cualquier casa en la región de
Ciudad del Cabo. La solución implicará:

• análisis del MDE para encontrar las pendientes orientadas al este y las pendientes con el gradiente correcto;

• análisis del ráster de precipitación para encontrar las áreas con cantidad de precipitación correcta;

• análisis de las zonas de capa vectorial para encontrar áreas que tengan la distancia a enclaves humanos y
sean del tamaño correctos.

9.4.3 Preparando el Mapa

• Haz clic en el botón “estado SRC” en la esquina inferior derecha de la pantalla. En la pestaña SRC de la
pestaña que aparece, verás la casilla Sistema de referencia de coordenadas del mundo.

• En esta casilla, navega hasta Sistemas de coordenadas proyectadas → Universal Transverse Mercator
(UTM).

• Selecciona la entrada WGS 84 / UTM zone 33S (con el código EPSG 32733).

• Haz clic en Aceptar. El mapa está ahora en el Sistema de coordenadas de referencia UTM33S .

• Guarda el mapa clicando en el botón de la barra de herramientas Guardar proyecto como, o utiliza el
elemento del menú Proyecto → Guardar como....

• Guarda el mapa en un directorio llamado Rasterprac que deberías crear en algún lugar de tu ordenador.
También guardarás cualquiera de las capas que crees en este directorio.

9.4.4 Cargar Datos dentro del Mapa

Para procesar los datos, necesitarás cargar las capas necesarias (nombres de calles, zonas, precipitación, MDE) en
la vista del mapa.

Para vectoriales...

• Haz clic en el botón Añadir Capa Vectorial, o utiliza el elemento del menú Capa → Añadir Capa Vectorial...

• En el cuadro de diálogo que aparece, asegúrate de que el botón radial Archivo está selecionado.

• Haz clic en el botón Explorar.
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• En el cuadro de diálogo que aparece, abre el directorio exercise_data/more_analysis/streets.

• Selecciona el archivo Street_Names_UTM33S.shp.

• Haz clic en Abrir.

El cuadro de diálogo se cerrará y te mostrará el cuadro de diálogo original, con la ruta de archivo especificada en
el campo de texto junto al botón Explorar. Esto te permite asegurarte de que está seleccionado el archivo correcto.
También es posible introducir la ruta de archivo en este campo manualmente, si lo prefieres.

• Haz clic en Abrir. La capa vectorial se cargará en tu mapa. Su color está asignado automáticamente. Será
cambiado luego.

• Renombra la capa como Streets.

• Haz clic derecho en ella en la Lista de capas (por defecto, el panel a mano izquierda de la pantalla).

• Haz clic en Cambiar nombre en el cuadro de diálogo que aparece y renómbralo pulsando la tecla Enter
cuando acabes.

• Repite el proceso de añadir datos vectoriales, pero esta vez selecciona el archivo Gener-
alised_Zoning_Dissolve_UTM33S.shp del directorio Zoning.

• Renómbralo como Zoning.

Para rásters...

• Haz clic en el botón Añadir capa ráster, o utiliza el elemento del menú Capa → Añadir capa ráster...

• Navega hasta el archivo apropiado, selecciónalo y haz clic en Abrir.

• Haz esto para cada uno de los dos archivos ráster. Los archivos que quieres son DEM/reproject/DEM y
Rainfall/reprojected/rainfall.tif.

• Renombra el ráster de precipitaciónes como Precipitación (con la letra inicial en mayúsculas). Al
principio cuando los cargues, las imágenes serán rectángulos grises. No te preocupes, esto se cambiará
luego.

• Guarda el mapa.

Para ver correctamente qué está pasando, se necesita cambiar la simbología para las capas.

9.4.5 Cambio de simbología de capas vectoriales

• En Lista de capas, haz clic derecho en la capa Streets.

• Selecciona Propiedades del menú que aparece.

• Selecciona la pestaña Estilo del cuadro de diálogo que aparece.

• Click on the button labeled Change, with a square showing the current color of the Streets layer.

• Selecciona un color nuevo en el cuadro de diálogo que aparece.

• Haz clic en Aceptar.

• Vuelve a hacer clic en Aceptar en el cuadro de diálogo Propiedades de la capa. Esto cambiará el color de
la capa Streets.

• Sigue un proceso similar para la capa Zoning y elige un color adecuado para ella.

9.4.6 Cambio de simbología de capas ráster

La simbología de capas ráster es algo diferente.

• Abre el cuadro de diálogo Propiedades para el ráster Precipitación.
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• Cambia a la pestaña Estilo. Observarás que este cuadro de diálogo es muy diferente a la versión utilizada
para capas vectoriales.

• Asegúrate de que el botón Media +/- desviación estándar está seleccionado.

• Cambia el valor en la casilla asociada a 2.00 (debería estar ajustada a 1.00 por defecto).

• En el título Mejora de contraste, cambia el valor del menú desplegable a Estirar a MinMax.

• Haz clic en Aceptar. El ráster “Precipitación”, si está visible, debería cambiar de colores, permitiendote ver
diferentes valores de brillo para cada píxel.

• Repite este proceso para el MDE, pero ajusta las desviaciones estándar utilizadas a 4.00.

9.4.7 Cambio de orden de capas

• En Lista de capas, haz clic y arrastra las capas hacia arriba o abajo para cambiar el orden en el que aparecen
en el mapa.

• Nuevas versiones de QGIS puede que tengan una casilla de verificación Control del orden de renderizado
bajo la Lista de capas. Asegúrate de que está marcada.

Ahora que todos los datos están cargados y son adecuadamente visibles, el análisis puede comenzar. Es mejor si
las operaciones de recorte se hacen primero. Así no se malgasta potencia procesando áreas que no serían utilizadas
de todas formas.

9.4.8 Encuentra los Distritos Correctos

• Carga la capa vectorial admin_boundaries/Western_Cape_UTM33S.shp en tu mapa.

• Renómbrala como Districts.

• Haz clic derecho en la capa Districts en la Lista de capas.

• En el menú que aparece, selecciona el elemento del menú Filtrar.... El cuadro de diálogo Constructor de
Consultas aparecerá.

Ahora construirás una consulta para seleccionar solo la siguiente lista de distritos:

• Bellville,

• Cape,

• Goodwood,

• Kuils River,

• Mitchells Plain,

• Simons Town, y

• Wynberg.

• En la lista Campos, haz doble clic en el campo NAME_2. Aparece en el campo de texto inferior Expresión
de filtrado específica del proveedor.

• Haz clic en el botón =; un signo = se añadirá a la consulta SQL.

• Haz clic en el botón Todos bajo la lista Values (actualmente vacío). Después de una corta espera, se rellenará
la lista Values con los valores del campo seleccionado (NAME_2).

• Haz doble clic en el valor Bellville en la lista Values. Como antes, será añadido a la consulta SQL.

Para seleccionar más de un distrito, necesitarás utilizar el operador booleano O.

• Haz clic en el botón O y será añadido a la consulta SQL.

• Utilizando un proceso similar al anterior, añade lo siguiente a la consulta existente SQL:
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"NAME_2" = ’Cape’

• Añade otro operador O, luego trabaja con la lista de distritos anterior de forma similar.

• La consulta final debería ser

"NAME_2" = ’Bellville’ OR "NAME_2" = ’Cape’ OR "NAME_2" = ’Goodwood’ OR
"NAME_2" = ’Kuils River’ OR "NAME_2" = ’Mitchells Plain’ OR "NAME_2" =
’Simons Town’ OR "NAME_2" = ’Wynberg’

• Haz clic en Aceptar. Los distritos mostrados en tu mapa están limitados a los de la lista anterior.

9.4.9 Recorta los Ráster

Ahora que tienes un área de interés, puedes recortar los ráster a esa área.

• Asegúrate de que las únicas capas visibles son las de MDE, Rainfall y Districts.

• Los Districts deben estar en primer lugar para ser visibles.

• Abre el cuadro de diálogo para recortar seleccionando el elemento del menú Ráster → Extracción → Clip-
per.

• En la lista del menú desplegable Archivo de entrada (ráster), selecciona la capa MDE.

• Especifica una localización de salida en el campo de texto Archivo de salida clicando en el botón Selec-
cionar....

• Navega hasta el directorio Rasterprac.

• Introduce un nombre de archivo.

• Guarda el archivo. Deja la casilla de verificación Valor de sin datos vacía.

• Utiliza el modo de corte Extensión asegurándote que el botón radial correcto está seleccionado.

• Haz clic y arrastra un área en el mapa, de modo que el área que incluye los distritos esté seleccionada.

• Marca la casilla Cargar en la vista del mapa cuando se termine.

• Haz clic en Aceptar.

• Cuando la operación de corte se complete, NO CIERRES el cuadro de diálogo Clipper. (Cerrarlo te haría
perder el área a cortar que ya habías definido)

• Selecciona el ráster Precipitación en el menú desplegable Archivo de entrada (ráster) y elige un nombre de
archivo de salida diferente.

• No cambies ninguna otra opción. No alteres el área a cortar que has dibujado antes. Déjalo todo como
estaba y haz clic en Aceptar.

• Después de que la segunda operación de corte haya terminado, puedes cerrar el cuadro de diálogo Clipper.

• Guarda el mapa.

9.4.10 Limpia el mapa

• Borra las capas originales Precipitación y MDE de la Lista de capas.

• Haz clic derecho en esas capas y selecciona Eliminar.

– Esto no borrará los datos de tu dispositivo de almacenamiento, solamente lo quitará de tu mapa.

• Desactiva las etiquetas de la capa Streets.

– Haz clic en el botón Etiquetado.

– Quita la marca de la casilla Etiquetar esta capa con.
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– Haz clic en Aceptar.

• Muestra todas las Streets de nuevo:

– Haz clic derecho en la capa en la Lista de capas.

– Selecciona Filtrar.

• En el cuadro de diálogo que aparece, haz clic en el botón Limpiar, luego haz clic en Aceptar.

• Espera mientras se cargan los datos. Todas las calles serán visibles ahora.

• Cambia la simbología del ráster como antes (ver Cambio de simbología de capas ráster).

• Guarda el mapa.

• Ahora puedes ocultar las capas vectoriales quitando la marca de la casilla junto a ellas en la Lista de capas.
Esto hará que el mapa se dibuje más rápido y te ahorrará tiempo.

Para crear el sombreado de relieve, necesitarás utilizar un complemento que fue escrito para tal propósito.

9.4.11 Activa el plugin Análisis del terreno ráster.

Este complemento está incluido por defecto desde QGIS 1.8. Sin embargo, puede que no sea inmediatamente
visible. Para comprobar si es accesible en tu sistema:

• Haz clic en el elemento del menú complementos –> Administrar e instalar complementos....

• Asegúrate que la casilla junto a Complemento de análisis del terreno ráster está seleccionada.

• Haz clic en Aceptar.

Ahora tendrás acceso al complementoa través del elemento del menú Ráster → Análisis de terreno.

Recuerda que los plugins puede que dependan a veces de que ciertos módulos Python estén instalados en tu
sistema. Un plugin podría rechazar trabajar por falta de dependencias, pregunta a tu tutor para que te asista.

9.4.12 Crear el sombreado del relieve

• En la Lista de capas, asegúrate que MDE es la capa activa (es decir, es la seleccionada por haber clicado en
ella).

• Haz clic en el elemento del menú Ráster → Análisis de terreno → Mapa de sombras (Hillshade) para abrir
el cuadro de diálogo Mapa de sombras (Hillshade).

• Especifica una localización apropiada para la capa de salida y nómbrala hillshade.

• Selecciona la casilla Añadir resultados al proyecto.

• Haz clic en Aceptar.

• Espera a que termine de procesar.

La nueva capa hillshade a aparecido en tu Lista de capas.

• Haz clic derecho en la capa hillshade en tu Lista de capas y abre el cuadro de diálogo Propiedades.

• Haz clic en la pestaña Transparencia y ajusta el control de transparencia a 80%.

• Haz clic en Aceptar en el cuadro de diálogo.

• Observa el efecto cuando el sombreado de relieve transparente se sobre impone sobre el MDE recortado.
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9.4.13 Pendiente

• Haz clic en el elemento del menú Ráster → Análisis de terreno.

• Selecciona el tipo de análisis Pendiente, con el MDE acortado como la capa de entrada.

• Especifica un nombre de archivo y localización apropiados para propósitos de salida.

• Selecciona la casilla Añadir resultados al proyecto.

• Haz clic en Aceptar.

La imagen pendiente ha sido calculada y añadida al mapa. Sin embargo, como siempre, solo es un rectángulo gris.
Para ver adecuadamente qué está pasando, cambia la simbología como sigue.

• Abre el cuadro de diálogo Propiedades de la capa (como siempre, con el menú de clic derecho en la capa).

• Haz clic en la pestaña Estilo.

• Donde dice Unibanda gris (en el menú desplegable Tipo de renderizador), cámbialo a Unibanda pseudo-
color.

• Asegúrate de que el botón radial Media +/- desviación estándard está seleccionado.

9.4.14 Orientación

• Utiliza el mismo enfoque que para calcular la pendiente, pero selecciona Orientación en el cuadro de diálogo
inicial.

Recuerda guardar el mapa periódicamente.

9.4.15 Reclasificar rásters

• Haz clic en el elemento del menú Ráster → Calculadora ráster....

• Especifica tu directorio Rasterprac como localización para la capa de salida.

• Asegúrate de que la casilla Añadir resultados al proyecto está seleccionada.

En la lista de la izquierda Bandas ráster, verás todas las capas ráster de tu Lista de capas. Si tu capa de Pendiente
se llama slope, se listará como slope@1.

La pendiente necesita estar entre 15 y 60 grados. Cualquier cosa por debajo de 15 o encima de 60 debe estar
excluida.

• Utiliando la lista de elementos y botones en la interfaz, construye la siguiente expresión:

((slope@1 < 15) OR (slope@1 > 60)) = 0

• Ajusta el campo Capa de salida a un nombre y localización adecuados.

• Haz clic en Aceptar.

Ahora encuentra la orientación correcta (orientado al este, entre 45 y 135 grados) utilizando el mismo enfoque.

• Construye la siguiente expresión:

((aspect@1 < 45) OR (aspect@1 > 135)) = 0

• Encuentra la precipitación correcta (mayor de 1200mm) del mismo modo. Construye la siguiente expresión:

(rainfall@1 < 1200) = 0

Habiendo reclasificado todos los ráster, ahora los verás representados como rectángulos grises en tu mapa (asum-
iendo que se han añadido correctamente al mapa). Para representar los datos ráster correctamente en dos clases (1
y 0, significando verdadero o falso), necesitarás cambiar su simbología.
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9.4.16 Ajuste del estilo para capas reclasificadas

• Abre la pestaña Estilo en el cuadro de diálogo Propiedades de la capa como siempre.

• Bajo el título Cargar valores min / max, selecciona el botón radial Real (más lento).

• Haz clic en el botón Cargar.

Los campos valores Min / Max deberían estar ahora rellenos con 0 y 1, respectivamente. (Si no lo están, ha habido
un error con la reclasificación de tus datos, y necesitarás volver a esa parte.)

• En el título Mejora de contraste, ajusta la lista del menú desplegable Sin realce a Estirar a MinMax.

• Haz clic en Aceptar.

• Hazlo para los tres ráster reclasificados, ¡y recuerda guardar tu trabajo!

El único criterio que queda es que el área debe estar a 250m de las áreas urbanas. Satisfaremos este requisito
asegurándonos que las áreas que computamos están a 250m o más de los bordes de las zonas rurales. Por lo tanto,
necesitamos encontrar todas las áreas rurales primero.

9.4.17 Encontrar áreas rurales

• Oculta todas las capas de la Lista de capas.

• Haz visible la capa vectorial Zoning.

• Haz clic derecho en ella y abre el cuadro de diálogo Filtrar.

• Construye la siguiente consulta:

"Gen_Zoning" = ’Rural’

Mira antes las instrucciones para construir la consulta ara la capa Streets si te quedas atascado.

• Cuando hayas terminado, cierra el cuadro de diálogo Constructor de consultas.

Deberías ver una colección de polígonos de la capa Zoning. Necesitarás guardarlos en un nuevo archivo de capa.

• En el menú de clic derecho en Zoning, selecciona Guardar como....

• Guarda tu capa en el directorio Zoning.

• Nombra al archivo de salida rural.shp.

• Haz clic en Aceptar.

• Añade la capa a tu mapa.

• Haz clic en el elemento del menú Vectorial → Herramientas de geoproceso → Disolver.

• Selecciona la capa rural como tu capa vectorial de entrada, mientras dejas la casilla Usar sólo objetos
espaciales seleccionados sin marcar.

• En Campo para disolver, selecciona — Disolver todo —.

• Guarda tu capa en el directorio Zoning.

• Haz clic en Aceptar. Un cuadro de diálogo aparecerá preguntando si quieres añadir la capa nueva al TDC
(“Tabla De Contenidos”, refiriéndose a la:guilabel:Lista de capas).

• Haz clic en Sí.

• Cierra el cuadro de diálogo Disolver.

• Borra las capas rural y Zoning.

• Guarda el mapa.

Ahora necesitas excluir las áreas que estan a 250m del borde de las áreas rurales. Hazlo creando un buffer
negativo, como está explicado más abajo.
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9.4.18 Crear un buffer negativo

• Haz clic en el elemento del menú Vectorial → herramientas de geoproceso → Buffer(s).

• En el cuadro de diálogo que aparece, selecciona la capa rural_dissolve como tu capa vectorial de entrada
(Usar sólo objetos espaciales seleccionados no debería estar seleccionado).

• Selecciona el botón Distancia de buffer e introduce el valor -250 en el campo asociado; el valor negativo
significa que el buffer debe ser un buffer interno.

• Selecciona la casilla Disolver resultados de buffer.

• Ajusta el archivo de salida al mismo directorio que los otros archivos vectoriales rurales.

• Nombra al archivo de salida rural_buffer.shp.

• Haz clic en Guardar.

• Haz clic en Aceptar y espera a que se complete el proceso.

• Selecciona Sí en el cuadro de diálogo que aparece.

• Cierra el cuadro de diálogo Buffer.

• Borra la capa rural_dissolve.

• Guarda el mapa.

Para incorporar las zonas rurales al mismo análisis con los tres ráster existentes, será necesario rasterizarlo. Pero
para que los ráster sean compatibles para el análisis, necesitarán tener el mismo tamaño. Además, antes de
rasterizar, necesitarás recortar el vector a la misma área que los ráster. Un vector solo puede ser recortado por otro
vector, así que primero necesitaras crear un polígono de encuadre del mismo tamaño que los ráster.

9.4.19 Crear un encuadre vectorial

• Haz clic en el elemento del menú Capa –> Nueva –> Nueva capa de archivo shape....

• En el título Tipo, selecciona el botón Poligono.

• Haz clic en Especificar SRC y ajusta el sistema de coordenadas de referencia a WGS 84 / UTM zone
33S : EPSG:32733.

• Haz clic en Aceptar.

• Haz clic en Aceptar en el cuadro de diálogo Nueva capa vectorial.

• Guarda el vector en el directorio Zoning.

• Nombra al archivo de salida bbox.shp.

• Oculta todas las capas excepto la nueva capa bbox y uno de los ráster reclasificados.

• Asegúrate de que la capa bbox está seleccionada en la Lista de capas.

• Navega hasta el elemento del menú Ver → Barras de herramientas y asegúrate de que Digitalización está
seleccionado. Deberías ver en una barra de herramientas el icono de un lápiz o un koki. Es el botón
Conmutar edición.

• Haz clic en el botón Conmutar edición para entrar al modo edición. Esto te permite editar una capa vectorial.

• Haz clic en el botón Añadir objeto espacial, que debería estar cerca del botón Conmutar edición. Puede que
esté oculto tras un botón de flechas dobles; si lo está, haz clic en las flechas dobles para mostrar los botones
ocultos de la barra de herramientas Digitalización.

• Con la herramienta Añadir objeto espacial activada, haz clic izquierdo en las esquinas del ráster. Puede que
necesites ampliar el zum con la rueda del ratón para asegurarte que es exacto. Para desplazarte sobre el
mapa en este modo, haz clic y arrastra el mapa con el boton central o la rueda del ratón.

• Para el cuarto y último punto, haz clic derecho para finalizar la forma.
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• Introduce un número arbitrario para la forma ID.

• Haz clic en Aceptar.

• Haz clic en el botón Guardar cambios.

• Haz clic en el botón Conmutar edición para terminar tu sesión de edición.

• Guarda el mapa.

Ahora que tienes un cuadro delimitador, puedes utilizarlo para recortar la capa rural buffer.

9.4.20 Recortar una capa vectorial

• Asegúrate de que solo son visibles las capas bbox y rural_buffer, con el último por encima.

• Haz clic en el elemento del menú Vectorial → Herramientas de geoproceso > Cortar.

• En el cuadro de diálogo que aparece, ajusta la capa vectorial de entrada a rural_buffer y la capa para cortar
a bbox, con ambas casillas usar sólo objetos espaciales seleccionados sin marcar.

• Pon el archivo de salida en el directorio Zoning.

• Nombra al archivo de salida rural_clipped.

• Haz clic en Aceptar.

• Cuando se requiera añadir la capa al TDC, haz clic en Sí.

• Cierra el cuadro de diálogo.

• Compara los tres vectores y ve los resultados por ti mismo.

• Borra las capas bbox y rural_buffer, luego guarda tu mapa.

Ahora ya está lista para ser rasterizada.

9.4.21 Rasterizar una capa vectorial

Necesitarás especificar un tamaño de píxel para un nuevo ráster que crees, así que primero necesitarás saber el
tamaño de uno de los ráster existentes.

• Abre el cuadro de diálogo Propiedades de cualquiera de los tres ráster existentes.

• Cambia a la pestaña Metadatos.

• Anota los valores de X e Y en el título Dimensiones de la tabla de Metadatos.

• Cierra el cuadro de diálogo Propiedades.

• Haz clic en el elemento del menú Ráster → Conversión → Rasterizar. Puede que recibas una alerta sobre
conjunto de datos no soportado. Haz clic de todos modos he ignoralo.

• Selecciona rural_clipped como tu capa de entrada.

• Ajusta la localización de archivo de salida dentro del directorio Zoning.

• Nombra al archivo de salida rural_raster.tif.

• Marca la casilla Tamaño del ráster en píxeles y introduce los valores de Anchura y Altura que apuntaste
antes.

• Marca la casilla Cargar en la vista del mapa cuando se termine.

• Haz clic en el icono del lápiz junto al campo de texto que muestra los comandos que se van a ejecutar. Al
final del texto existente, añade un espacio y luego el texto -burn 1. Esto le dice a la función de Rasterizar
que “queme” el vector existente al nuevo ráster y dé a las áreas cubiertas por el vector el nuevo valor 1
(opuestamente al resto de la imagen, que cambiará automáticamente a 0).

• Haz clic en Aceptar.
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• El nuevo ráster se debería mostrar en tu mapa una vez se ha computado.

• El nuevo ráster se verá como un rectángulo gris - puedes cambiar el estilo de la presentación como hiciste
para reclasificar ráster.

• Guarda tu mapa.

Ahora que tienes los cuatro criterios en ráster separados, necesitas combinarlos para ver qué áreas satisfacen
todos los criterios. Para hacerlo, los ráster se multiplicarán entre ellos. Cuando esto ocurra, todos los píxeles
superpuestos con un valor de 1 conservarán el valor 1, pero si un pixel tiene el valor 0 en alguno de los cuatro
ráster, el resultado será 0. De esta forma, el resultado contendrá solo las áreas superpuestas con valor 1.

9.4.22 Combinación de rásters

• Haz clic en el elemento del menú Ráster → Calculadora ráster....

• Construye la siguiente expresión (con los nombres apropiados para tus capas, dependiendo de cómo las
llamaste)

[Rural raster] * [Reclassified aspect] * [Reclassified slope] *
[Reclassified rainfall]

• Ajusta la localización de salida al directorio Rasterprac.

• Llama al ráster de salida cross_product.tif.

• Asegúrate de que la casilla Añadir resultados al proyecto está marcada.

• Haz clic en Aceptar.

• Cambia la simbología del nuevo ráster del mismo modo que ajustaste el estilo para los otros rásters reclasi-
ficados. El nuevo ráster ahora representa adecuadamente las áreas donde todos los criterios se satisfacen.

Para obtener el resultado final, necesitas seleccionar las áreas que son mayores de 6000m^2. Sin embargo,
computar esas áreas exactamente solo es posible con una capa vectorial, así que necesitarás vectorizar el ráster.

9.4.23 Vectorizar el ráster

• Haz clic en el elemento del menú Ráster → Conversión → Poligonizar.

• Selecciona el ráster cross_product.

• Ajusta la localización de salida a Rasterprac.

• Llama al archivo candidate_areas.shp.

• Asegúrate de que Cargar en la vista del mapa cuando se termine está marcado.

• Haz clic en Aceptar.

• Cierra el cuadro de diálogo cuando el proceso esté completo.

Todas las áreas del ráster se han vectorizado, así que necesitas seleccionar solo las áreas que tienen el valor 1.

• Abre el cuadro de diálogo Query para el vector nuevo.

• Construye esta consulta:

"DN" = 1

• Haz clic en Aceptar.

• Crea un archivo vectorial nuevo a partir del resultado guardando el vector candidate_areas después de que
se complete la consulta (y solo las áreas con un valor 1 sean visibles). Utiliza la función Guardar como...
en el menú de la capa con clic derecho en ella.

• Guarda el archivo en el directorio Rasterprac.
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• Nombra al archivo candidate_areas_only.shp.

• Guarda tu mapa.

9.4.24 Cálgulo del área para cada polígono

• Abre el menú de la nueva capa vectorial con clic derecho.

• Seleccióna Abrir tabla de atributos.

• Haz clic en el botón Conmutar el modo edición en la parte inferior de la tabla, o pulsa Ctrl+E.

• Haz clic en el botón Abrir calculadora de campos en la parte inferior de la tabla, o pulsa Ctrl+M.

• En el título del cuadro de diálogo que aparece, introduce el nombre de campo area. El tipo de campo de
salida debería ser entero, y el ancho del campo debería ser 10.

• Em tipo Expressão calculadora de campo:

$area

Esto significa que la calculadora de campo calculará el área de cada polígono en la capa vectorial y creará
una columna nueva (llamada area) con el valor calculado.

• Haz clic en Aceptar.

• Faça a mesma coisa para um outro novo campo chamado id. Em tipo Expressão calculadora de campo:

$id

Eso asegura que cada polígono tiene una ID única para su identificación.

• Haz clic de nuevo en Conmutar el modo edición, y guarda tus ediciones si es requerido.

9.4.25 Selección de áreas para un tamaño dado

Ahora que las áreas son conocidas:

• Construye una consulta (como siempre) para seleccionar solo los polígonos más grandes de 6000m^2. La
consulta es:

"area" > 6000

• Guarda la seleción como una nueva capa vectorial llamada solution.shp.

Ahora tienes tus áreas para tu solución, de las que tendrás que elegir la más proxima a tu casa.

9.4.26 Digitaliza tu casa

• Crea una nueva capa vectorial como antes, pero esta vez, selecciona el valor Tipo como Punto.

• ¡Asegúrate de que es el SRC correcto!

• Nombra a la nueva capa house.shp.

• Acaba de crear la nueva capa.

• Entra en el modo de edición (mientras la capa nueva está seleccionada).

• Haz clic en el punto donde tu casa o otra residencia actual esté, utilizando las calles como guía. Puede que
tengas que abrir otras capas para ayudarte a encontrar tu casa. Si no vives cerca, haz clic en algún lugar
donde una casa podría ser concebible.

• Introduce un número arbitrario para la forma ID.

• Haz clic en Aceptar.
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• Guarda tu edición y sal del modo de edición.

• Guarda el mapa.

Necesitarás encontrar los centroides (“centros de masa”) para los polígonos solución para decidir cual está más
cerca de tu casa.

9.4.27 Calcula los centroides de los polígonos

• Haz clic en el elemento del menú Vectorial → Herramientas de geometría → Centroides de polígonos.

• Especifica la capa de entrada como solution.shp.

• Proporciona la localización de salida como Rasterprac.

• Llama al archivo de destino solution_centroids.shp.

• Haz clic en Aceptar y añade el resultado al TDC (Lista de capas), luego cierra el cuadro de diálogo.

• Arrastra la nueva capa al principio de la lista para poder verla.

9.4.28 Calcula qué centroide está más cerca de tu casa

• Haz clic en el elemento del menú Vectorial –> Herramientas de análisis –> Matriz de distancia.

• La capa de entrada debería ser tu casa, y la capa de destino solution_centroids. Ambas capas deberían
utilizar el campo id como su único campo de ID.

• El tipo de matriz de salida debería ser lineal.

• Ajusta una localización y nombre adecuadas para la salida.

• Haz clic en Aceptar.

• Abre el archivo en un editor de textos (o importalo a nuna hoja de cálculo). Observa qué ID está asociada
con la Distance más corta. Puede que haya más de una con la misma distancia.

• Construye una consulta en QGIS para seleccionar solo las áreas solución más cercanas a tu casa (selec-
cionala utilizando id field).

Esta es la respuesta final a la pregunta investigada.

Para tu presentación, incluye la capa semi transparente del relieve sombreado encima del ráster de tu elección
(como MDE o slope raster, por ejemplo). Incluye también el polígono del área(s) solución más cercano, así como
tu casa. Sigue las mejores prácticas de cartografía para crear tu mapa de salida.
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CHAPTER 10

Module: Complementos

Complementos permitem estender as ofertas de funcionalidade do QGIS. Neste módulo, iremos mostrar a você
como ativar e usar os complementos.

10.1 Lesson: Instalar y Manejar Complementos

Para comenzar a utilizar complementos, necesitas saber como descargarlos, instalarlos y activarlos. Para esto,
aprenderás cómo utilizar el Instalador de complementos y el Administrador de complementos.

El objetivo de esta lección: Entender el uso del sistema de complementos de QGIS.

10.1.1 Follow Along: Manejando Complementos

• Para abrir el Administrador de complementos, haz clic en el elemento del menú Complementos → Admin-
istrar e instalar complementos....

• En el cuadro de diálogo que se abre, encuentra el complemento Processing:

255



QGIS Training Manual, Versão 2.8

• Haz clic en la casilla junto a ese complemento y quítale la marca para desinstalarlo.

• Haz clic en Cerrar.

• Mira al menú, observarás que el menú Procesado se ha ido. ¡Esto significa que muchas de las funciones de
procesado que has estado utilizando antes han desaparecido! Esto ocurre porque son parte del complemento
Processing, que necesita ser activado para que puedas usarlo.

• Abre el Administrador de complementos de nuevo y reactiva el complemento Processing clicando en la
casilla de verificación junto a él y clica en Cerrar...

• El menú Procesado debería volver a estar disponible.

10.1.2 Follow Along: Instalación de Nuevos Complementos

La lista de complementos que puedes activar y desactivar se extrae de los comlementos que tienes instalados
actualmente.

• Para instalar complementos nuevos, selecciona la opción No instalado en el cuadro de diálogo Admin-
istrador de complementos. Los complementos disponibles para que los instales estarán listados ahí. Esta
lista variará dependiendo de tu configuración de sistema actual.

• Puedes encontrar información sobre cada complemento seleccionándolo en la lista de complementos
mostrada.
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• Un complemento puede ser instalado clicando en el botón Instalar complemento debajo el panel de infor-
mación del complemento.

10.1.3 Follow Along: Configuración Adicional de Repositorios de Comple-
mentos

Los complementos que están disponibles para instalar dependen de qué repositorios de complementos tienes
configurados para utilizar.

Los complementos de QGIS se guardan en repositorios online. Por defecto, solo los repositorios oficiales están
activos, esto significa que solo puedes acceder a complementos oficiales. Normalmente son los primeros comple-
mentos que quieres, porque se han testado cuidadosamente y a menudo se incluyen en QGIS por defecto.

Es posible, sin embargo, probar más complementos que los que están por defecto. Primero, necesitas configurar
repositorios adicionales. Para ello:

• Abre la pestaña Configuración del cuadro de diálogo Administrador de complementos:
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• Haz clic en Añadir para encontrar y añadir un nuevo repositorio.

• Proporciona un Nombre y URL para el nuevo repositorio que quieras configurar y asegúrate de que la casilla
de verificación Enabled está seleccionada.

• Ahora verás el nuevo complemento enumerado en la lista de los Repositorios de complementos configurada.
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• También puedes seleccionar la opción para visualizar Complementos experimentales seleccionando la
casilla de verificación Mostrar también los complementos experimentales.

• Si ahora cambias a la pestaña Nuevo, verás que los complementos adicionales son ahora visibles para su
instalación.

• Para instalar un complemento, simplemente haz clic en el en la lista y luego en el botón Instalar comple-
mento.

10.1.4 In Conclusion

¡Instalar complementos en QGIS es simple y efectivo!

10.1.5 What’s Next?

A continuación te introduciremos algunos complementos útiles con ejemplos.

10.2 Lesson: Útiles Complementos de QGIS

Ahora que puedes instalar, habilitar y deshabilitar complementos, veamos cómo pueden ayudarte en la práctica
mirando algunos útiles ejemplos de complementos.

El objetivo de esta lección: Familiarizarte con la interfaz de complementos y conocer algunos complementos
útiles.

10.2.1 Follow Along: Complemento de Análisis del Terreno Ráster

• Comienza un mapa nuevo con solo el conjunto de datos ráster srtm_41_19.tif en él (mira en
exercise_data/raster/SRTM).
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De la lección de análisis ráster, ya te has familiarizado con las funciones de análisis ráster. Utilizaste herramientas
GDAL (accesibles a través de Ráster –> Análisis) para ello. Sin embargo, deberías también saber sobre los
complementos de Análisis del Terreno Ráster. Este es estándar en la nuevas versiones, por lo que no necesitarás
instalarlo por separado.

• Abre el Administrador de complementos y comprueba que el complemento Análisis del Terreno Ráster está
habilitado:

• Abre el menú Ráster. Deberías ver un submenú Análisis de Terreno.

• Haz clic en Análisis del terreno → Relieve y introduce las opciones siguientes:

• Guarda el nuevo archivo en exercise_data/plugins/relief.tif (crea una carpeta nueva si es
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necesario).

• Deja el Formato de salida y Factor Z sin cambiar.

• Asegúrate de que la casilla Añadir resultados al proyecto está marcada.

• Haz clic en el botón Crear automáticamente. La lista inferior se rellenará:

Esos son los colores que el complemento utilizará para crear el relieve.

• Si lo prefieres, puedes cambiar esos colores haciendo doble clic en el color de cada fila. Por ejemplo:

• Haz clic en Aceptar y el relieve se creará:
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Esto consigue un efecto similar a cuando utilizaste el sombreado del relieve semitransparente como capa sobre-
puesta sobre otra capa ráster. La ventaja de este complemento es que crea este efecto utilizando solo una capa.

10.2.2 Follow Along: El Complemento Openlayers

• Comienza un mapa nuevo y añade la capa roads.shp.

• Amplia sobre el área Swellendam.

• Utiliza el Administrador de complementos, encuentra un complemento nuevo introduciendo la palabra
OpenLayers en el campo Buscar.

• Selecione o complemento OpenLayers da lista filtrada:
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• Haz clic en el botón Instalar complemento para instalarlo.

• Cuando esté hecho, cierra el Administrador de complementos.

Antes de utilizarlo, asegúrate de que el complemento y tu mapa están configurados correctamente.

• Abra as configurações do complemento clicando em Web → OpenLayers plugin → OpenLayers Overview.

• Utiliza el panel para elegir el tipo de mapa que quieres. En este ejemplo, utilizaremos el tipo de mapa
“Hybrid”, pero tú puedes elegir cualquier otro si quieres.

• Abre el cuadro de diálogo Propiedades del proyecto seleccionando Proyecto –> Propiedades del proyecto
en el menú.
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• Habilita la proyección “al vuelo” y utiliza la proyección de Google Mercator:

• Ahora utiliza el complemento para darte un mapa Google del área. Puedes hacer clic en Complementos →
OpenLayers Plugin → Add Google Hybrid Layer para añadirlo.

Esto cargará una nueva imagen ráster desde Google que puedes utilizar como fondo, o para ayudarte a averiguar
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donde estás en el mapa. Aquí está esa capa, con nuestra propia capa vectorial de calles superpuesta.

Nota: Puede que necesites arrastrar tu capa de calles por encima de la capa Google para hacerla visible por
encima de la capa de fondo. Puede ser necesario ampliar a la extensión de la capa de calles para centrar el mapa.

10.2.3 Follow Along: El Complemento GeoSearch

• Comienza un mapa nuevo sin conjuntos de datos.

• Abre el Administrador de complementos y filtra para el Complemento GeoSearch y haz clic en Instalar
complemento para instalarlo.
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• Cierra el Administrador de complementos.

• Ahora puedes utilizar el complemento GeoSearch para buscar nombres de sitios. Haz clic en Complementos
–> GeoSearch Plugin –> GeoSearch para abrir el cuadro de diálogo de GeoSearch.

• Busca Swellendam en el cuadro de diálogo de GeoSearch para localizarlo en tu mapa:
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10.2.4 In Conclusion

Hay muchos complementos útiles disponibles para QGIS. Utilizando las herramientas incluidas para instalar y
manejar esos complementos, puedes encontrar nuevos y realizar un uso óptimo de ellos.

10.2.5 What’s Next?

Lo siguiente será ver cómo utilizar capas que están alojadas en servicios remotos a tiempo real.
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CHAPTER 11

Module: Recursos Online

Ao considerar fontes de dados para um mapa, não há necessidade de ficar restrito aos dados que você salvou no
computador que está trabalhando. Existem fontes de dados on-line de onde você pode carregar os dados, enquanto
você estiver conectado à Internet.

Neste módulo, vamos cobrir dois tipos de serviços de SIG baseados na Web: Serviços de Mapeamento Web
(WMS) e Serviços de Feições Web (WFS).

11.1 Lesson: Servicios de Cartografía Web

Un Web Mapping Service (WMS) es un servicio alojado en un servidor remoto. Parecido a una página web, puedes
acceder a él siempre que tengas conexión a internet. Utilizando QGIS, puedes cargar un WMS directamente en tu
mapa existente.

De la lección sobre complementos, recordarás que es posible cargar una nueva imagen ráster desde Google. Sin
embargo, se trata de una sola acción, una vez has descargado la imagen, no cambiará. Un WMS se diferencia
porque es un servicio en vivo que actualizará automáticamente sus vistas si te desplazas o amplías en el mapa.

El objetivo de esta lección: Utilizar un WMS y entender sus limitaciones.

11.1.1 Follow Along: Cargar una Capa WMS

Para este ejercicio, puedes utilizar el mapa básico que hiciste al principio del curso, o empezar uno nuevo y cargar
alguna capa existente en él. Para este ejemplo, nosotros utilizamos un mapa nuevo cargado con las capas originales
places y landuse con la simbología ajustada.

269



QGIS Training Manual, Versão 2.8

• Carga esas capas en un mapa nuevo, o utiliza mapa original con solo esas capas visibles.

• Antes de añadir la capa WMS, desactiva la proyección “al vuelo”. Esto puede causar que las capas dejen de
solaparse propiamente, pero no te preocupes: lo arreglaremos luego.

• Para añadir capas WMS, haz clic en el botón Añadir capa WMS:

Recuerda cómo conectaste al conjunto de datos SpatiaLite al principio del curso. Las capas landuse, places, y
water están en esa base de datos. Para utilizar esas capas, primero necesitas conectarte a ese conjunto de datos.
Utilizar WMS es parecido, con la excepción de que esas capas están en un servidor remoto.

• Para crear una nueva conexión a WMS, haz clic en el botón Nuevo.

Necesitarás una dirección WMS para continuar. Hay muchos servidores gratuitos de WMS disponibles en internet.
Uno es terrestris, que utiliza el conjunto de datos OpenStreetMap.

• Para utilizar ese WMS, ajústalo en tu cuadro de diálogo actual, así:
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• El valor para el campo Nombre debería ser terrestris.

• El valor para el campo URL debería ser http://ows.terrestris.de/osm/service.

• Haz clic en Aceptar. Deberías ver el nuevo servidor WMS listado:
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• Haz clic en Conectar. En la lista inferior, deberías ver ahora esas nuevas entradas cargadas:

Todas esas capas se encuentran en el servidor WMS.
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• Haz clic una vez en la capa OSM-WMS. Esto presentará su Sistema de Coordenadas de Referencia:

Como no estamos utilizando WGS 84 para nuestro mapa, veamos todos los SRCs entre los que tenemos para
elegir.

• Haz clic en el botón Cambiar. Verás el cuadro de diálogo estándar Selector de sistema de referencia de
coordenadas.

• Queremos um SRC projetado, então vamos escolher: guilabel:WGS 84 / Pseudo Mercator.
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• Haz clic en Aceptar.

• Haz clic en Añadir y la capa nueva aparecerá en tu mapa como OSM-WMS.

• En la Lista de capas, haz clic y arrástrala al final de la lista.

Observarás que tus capas no se encuentran localizadas correctamente. Esto es porque la proyección “al vuelo”
está deshabilitada. Vamos a habilitarla de nuevo, pero utilizando la misma proyección que la capa OSM-WMS,
que es WGS 84 / Pseudo Mercator.

• Habilita la proyección “al vuelo”.

• En la pestaña SRC (cuadro de diálogo Propiedades del proyecto), introduce el valor pseudo en el campo
Filtrar:
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• Elige WGS 84 / Pseudo Mercator de la lista.

• Haz clic en Aceptar.

• Ahora haz clic derecho en una de tus propias capas en la Lista de capas y haz clic en Zum a la extensión de
la capa. Deberías ver el área Swellendam:
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Observa cómo las calles de la capa WMS y nuestras propias calles se solapan. ¡Eso es una buena noticia!

La naturaleza y limitaciones de WMS

Por ahora puedes haber observado que esta capa WMS tiene muchos elementos en ella. Tiene calles, rios, reservas
naturales, y mucho más. Además, apesar de que parece que está hecho de vectores, parece ser un mapa ráster, no
puedes cambiar su simbología. ¿Por qué?

Así es como trabaja un WMS: es un mapa, parecido a un mapa de papel normal, lo recibes como una imagen.
Lo que pasa habitualmente es que tienes capas vectoriales, que en QGIS se representan como un mapa. Pero
utilizando WMS, esas capas vectoriales están en el servidor WMS, que lo representa como un mapa y te lo envía
en forma de imagen. QGIS puede visualizar esa imagen, pero no puede cambiar su simbología, porque todo eso
es manejado por el servidor.

Eso tiene muchas ventajas, porque no necesitas preocuparte por la simbología. Ya está todo hecho, y debería
quedar bonito a la vista en cualquier WMS competente.

Por otra parte, no puedes cambiar la simbología si no te gusta, y si las cosas cambian en el servidor WMS, también
cambiarán en tu mapa. Por eso a veces puede que quieras utilizar en su lugar un Web Feature Service (WFS), que
te dá capas vectoriales por separado, y no como parte de un mapa de estilo WMS.

Eso será cubierto en la siguiente lección, sin embargo. Primero, añade otra capa WMS del servidor terrestris.

11.1.2 Try Yourself

• Oculta la capa OSM-WSM en la Lista de capas.

• Añade el servidor WMS “ZAF CGS 1M Bedrock Lithostratigraphy” de esta URL:
http://196.33.85.22/cgi-bin/ZAF_CGS_Bedrock_Geology/wms

• Carga la capa BEDROCKGEOLOGY en el mapa (utiliza el botón Añadir capa WMS como antes). ¡Recuerda
comprobar que está en la misma proyección WGS 84 / World Mercator que el resto de tu mapa!

• Puede que quieras ajustar su Codificación a JPEG y su opción Tamaño de tesela a 200 by 200, para que se
carge más rapido.
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Comprueba tus resultados

11.1.3 Try Yourself

• Oculta todas las otras capas WMS para prevenir que se representen innecesariamente en el fondo.

• Añade el servidor WMS “OGC” de esta URL: http://ogc.gbif.org:80/wms

• Añade la capa bluemarble.

Comprueba tus resultados

11.1.4 Try Yourself

Parte de la dificultad del uso de WMS es encontrar un servidor bueno (y gratuito).

• Find a new WMS at spatineo.com (or elsewhere online). It must not have associated fees or restrictions, and
must have coverage over the Swellendam study area.

Recuerda que lo que necesitas para utilizar un WMS solo es su URL (y preferiblemente algún tipo de
descripción).

Comprueba tus resultados

11.1.5 In Conclusion

Utilizando un WMS puedes añadir mapas inactivos como fondo para tu mapa de datos existente.

11.1.6 Further Reading

• spatineo.com

• Geopole.org

• Lista de servidores WMS de OpenStreetMap.org
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11.1.7 What’s Next?

Ahora que has añadido un mapa inactivo como fondo, te alegrará saber que también es posible añadir elementos
(como las otras capas vectoriales que añadiste antes). Añadir elementos de servidores remotos es posible utilizando
un Web Feature Service (WFS). Ese es el tema de la siguiente lección.

11.2 Lesson: Web Feature Services

Un Web Feature Services (WFS) proporciona a sus usuarios datos SIG en formatos que pueden ser cargados
directamente en QGIS. No como WMS, que te proporciona solo un mapa que no puedes editar, un WFS te dá
acceso a los propios elementos.

El objetivo de esta lección: Utilizar WFS y entender sus diferencias respecto a WMS.

11.2.1 Follow Along: Cargar una Capa WFS

• Comienza un mapa nuevo. Este es para fines de demostración y no será guardado.

• Asegúrate de que la reproyección “al vuelo” está deshabilitada.

• Haz clic en el botón Añadir capa WFS.

• Haz clic en el botón Nuevo

• En el cuadro de diálogo que aparece, introduce el Name como nsidc.org y la URL como
http://nsidc.org/cgi-bin/atlas_south?version=1.1.0.

• Haz clic en Aceptar, y la nueva conexión aparecerá en tu Conexiones de servidor.

• Haz clic en Conectar. Una lista de las capas disponibles aparecerá:
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• Encuentra la capa south_poles_wfs.

• Haz clic en la capa para seleccionarla:
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• Haz clic en Añadir.

Puede que cargar la capa lleve un tiempo. Cuando esté cargada, aparecerá en el mapa. Aqui está sobre los bordes
de la Antártida (disponible en el mismo servidor, y con el nombre antarctica_country_border):

¿Cómo se diferencia a tener una capa WMS? Se volverá obvio cuando veas los atributos de la capa.

• Abre la tabla de atributos de la capa south_poles_wfs. Deberías ver esto:

Como los puntos tienen atributos, podemos etiquetarlos, además de cambiar su simbología. Aquí tienes un ejem-
plo:
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• Añade etiquetas a tu capa para aprovechar la tabla de atributos de la capa.

Diferencias con capas WMS

Uma Web Feature Service retorna a própria camada, e não apenas um mapa renderizado a partir dele. Isto dá-lhe
acesso direto aos dados, o que significa que você pode mudar sua simbologia e execute funções de análise sobre
ele. No entanto, isto é à custa de muito mais dados a serem transmitidos. Isto será particularmente evidente se as
camadas que você está carregando têm formas complicadas, um monte de atributos, ou muitas feições; ou mesmo
se você está apenas carregar um monte de camadas. Camadas WFS geralmente levam muito tempo para carregar
por causa disso.

11.2.2 Follow Along: Consultas en Capas WFS

Aunque es posible consultar una capa WFS después de haberla cargado, a menudo es más eficiente contultarla
antes de cargarla. De esta forma, solo pides los elementos que quieres, lo que significa que utilizas menos ancho
de banda.

Por ejemplo, en el servidor WFS que estamos utilizando, hay una capa llamada countries (excluding Antarctica).
Digamos que queremos saber donde está Sudáfrica de forma relativa a la capa south_poles_wfs (y puede que
también la capa antarctica_country_border layer) que ya está cargada.

Hay dos formas de hacerlo. Puedes cargar la capa entera countries ..., y luego construir una consulta como siempre
una vez está cargada. Sin embargo, transmitir los datos para todos los países en el mundo y luego utilizar los datos
para Sudáfrica parece un despilfarro de ancho de banda. Dependiendo de tu conexión, este conjunto de datos
puede llevarte muchos minutos cargando.

La alternativa es construir una consulta como filtro incluso antes de cargar la capa desde el servidor.

• En el cuadro de diálogo Añadir capa WFS ..., conéctate al servidor que utilizamos antes y deberías ver la
lista de capas disponibles.

• Haz doble clic junto a la capa countries ... en el campo Filtrar, o haz clic en Contruir consulta:
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• En el cuadro de diálogo que aparece, construye la consulta "Countryeng" = ’South Africa’:
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• Aparecerá como el valor Filtrar:
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• Haz clic en Añadir con la capa countries seleccionada como arriba. Solo el país con el valor South
Africa en Countryeng se cargará de esta capa.

No tienes por qué, pero si pruebas ambos métodos, observarás que ¡este es mucho más rápido que cargar todos los
países antes de filtrarlos!

Notas de disponibilidad de WFS

Es raro encontrar un WFS con los elementos que necesitas, si tus necesidades son muy específicas. La razón por
la que el Web Feature Service es relativamente raro son las grandes cantidades de datos que deben ser transmitidas
para describir un elemento por completo. Por lo tanto no es muy rentable tener un WFS en lugar de un WMS, que
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solo envía imágenes.

El tipo más común de WFS que encontrarás será probablemente en una red local o incluso en tu propio ordenador,
en lugar de en internet.

11.2.3 In Conclusion

Las capas WFS son preferibles ante WMS si necesitas acceso a los atributos y geometrías de las capas. Sin
embargo, considerando la cantidad de datos que necesitan ser descargados (lo cual crea problemas de velocidad y
falta de servidores públicos WFS disponibles) no es siempre posible utilizar WFS en lugar de WMS.

11.2.4 What’s Next?

Próximamente, verás cómo utilizar QGIS como interfaz para el famoso GRASS GIS.
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CHAPTER 12

Module: GRASS

GRASS (Sistema de Suporte Análise de Recursos Geográficas) é um conhecido SIG de código aberto com uma
grande variedade de funções de SIG úteis. Foi lançado em 1984, e teve muitas melhorias e funcionalidades
adicionais desde então. O QGIS permite que você faça uso diretamente de poderosas ferramentas do SIG GRASS.

12.1 Lesson: Configuración de GRASS

Utilizar GRASS en QGIS requiere que pienses en la interfaz de un modo diferente. Recuerda que no estás traba-
jando en directamente en QGIS, si no que estás trabajando en GRASSS a través de QGIS.

El objetivo de esta lección: Comenzar un proyecto GRASS en QGIS.

12.1.1 Follow Along: Comienza un Nuevo Proyecto GRASS

Para iniciar GRASS dentro de QGIS, necesitas activarlo como cualquier otro complemento. Pimero, abre un
nuevo proyecto QGIS.

• En el Adiministrador de Complementos, activa GRASS en la lista:
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La barra de herramientas de GRASS aparecerá:

Antes de que puedas empezar a usar GRASS, necesitarás crear un directorio de mapas. GRASS siempre trabaja
en un entorno de base de datos, lo que significa que necesitas importar todos los datos que quieras usar a una base
de datos GRASS.

• Haz clic en el botón Nuevo directorio de mapas:

Verás un cuadro de diálogo explicando la estructura de un directorio de mapas GRASS..

• Crea un nuevo directorio llamado grass_db en exercise_data.

• Definelo como el directorio que será usado por GRASS para crear su base de datos:

288 Chapter 12. Module: GRASS



QGIS Training Manual, Versão 2.8

• Haz clic en Siguiente.

GRASS necesita crear una “localización”, que indica las extensiones máximas del área geográfica en la que
trabajarás.

• Llama South_Africa a la nueva locacización:
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• Haz clic en Siguiente.

• Trabajaremos con WGS 84, así busca este SRC y seleccionalo:

290 Chapter 12. Module: GRASS



QGIS Training Manual, Versão 2.8

• Haz clic en Siguiente.

• Ahora, selecciona la región South Africa del menú desplegable y haz clic en Establecer:
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• Haz clic en Siguiente.

• Crea un directorio de mapa, que el archivo de mapa con el que estarás trabajando.
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Cuando termines, verás un cuadro de dialogo pidiendote que confirmes que los ajustes mostrados son correctos.

• Clic Terminar.

• Haz clic en Aceptar en el diálogo de éxito.

12.1.2 Follow Along: Cargando datos vector en GRASS

Ahora tienes un mapa en blanco. Para cargar datos en GRASS, necesitas seguir un proceso de dos pasos:

• Carga datos en QGIS como siempre. Por ahora, utiliza el conjunto de datos roads.shp (que se encuentra
en exercise_data/epsg4326/).

• Tan pronto como cargue, haz clic on el botón Herramientas de GRASS:
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• En el nuevo diálogo, selecciona Lista de módulos.

• Encuentra la herramienta de importar vector insertando el término v.in.ogr.qgis en el campo de Filtro.

La v significa “vector”, in significa que es una función para importar data a la base de datos de GRASS, ogr es
la librería de software utilizada para leer los datos vector, y qgis significa que la herramienta buscará un vector
de entre los que ya estén cargados en QGIS.

• Cuando encuentres la herramienta, haz clic en ella para iniciarla:

• Ajusta la capa cargada a roads y el nombre de su versión GRASS a g_roads para evitar confusión.
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Nota: Nota las opciones de importación extra dentro de Advanced Options. Éstas incluyen la habilidad de
añadir expresiones WHERE para una consulta SQL utilizada al importar los datos.

• Haz clic en Ejecutar para comenzar la importación.

• Cuando termine, haz clic en el botón Ver salida para ver la capa recien importada a GRASS en el mapa.

• Fechar primeiro a ferramenta de importação (clique no botão Fechar imediatamente à direita de Ver saída),
em seguida, feche a janela : guilabel: Ferramentas GRASS.

• Elimina la capa original roads.

Ahora tienes solamente la capa importada de GRASS visible en tu mapa de QGIS.

12.1.3 Follow Along: Cargando Datos Ráster en GRASS

Recuerda que nuestro MDE está en el SRC UTM 33S / WGS 84, pero que nuestro proyecto GRASS está en el
SRC Geográfico WGS 84. Así que reproyectemos el MDE primero.

• Carga los datos srtm_41_19.tif (que se encuentran en exercise_data/raster/SRTM/) en el
mapa de QGIS como siempre, utilizando la herramienta Añadir capa ráster de QGIS.
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• Reproyectalo utilizando la herramienta GDAL Warp (Ráster → Proyecciones → Combar (Reproyectar)),

• Guarda el ráster en la misma carpeta que el origina, pero con el nombre DEM_WGS84.tif. Cuando
aparezca en tu mapa, elimina los datos srtm_41_19.tif de tu Lista de capas.

Ahora que está reproyectado, puedes cargarlo en tu base de datos de GRASS.

• Abre el diálogo Herramientas GRASS de nuevo.
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• Haz clic en la pestaña Lista de módulos.

• Busca r.in.gdal.qgis y haz doble clic en la herramienta para abrir su diálogo.

• Ajustala de modo que la capa de entrada sea DEM_WGS84 y la salida sea g_dem.

• Haz clic en Ejecutar.

• Cuando el proceso termine, haz clic en Ver salida.

• Haz clic en Cerrar para cerrar la pestaña, y entonces haz clic en Cerrar para cerrar el cuadro de diálogo
completo.
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• Puedes eliminar la capa original DEM_WGS84.

12.1.4 In Conclusion

La cadena de trabajo en GRASS para procesar datos es diferente del método que QGIS utiliza porque GRASS
carga sus datos en una estructura de base de datos espacial. Sin embargo, utilizando QGIS como interfaz, puedes
hacer los ajustes de un directorio de mapas de GRASS más fácilmente utilizando capas existentes en QGIS como
fuente de datos para GRASS.

12.1.5 What’s Next?

Ahora que los datos están importado a GRASS, podemos ver las operaciones de análisis avanzado que GRASS
ofrece.

12.2 Lesson: Ferramentas GRASS

Nesta lição iremos apresentar uma seleção de ferramentas para voce ter uma idéia da capacidade do GRASS.

12.2.1 Follow Along: Definir Cores Raster

• Abrindo a janela Ferramentas GRASS.

• Olhe o módulo r.colors.table para pesquisar pelo campo Filtro da aba Lista de Módulos.

• Abra a ferramenta e configure-a como esta:
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Quando você executar a ferramenta, ele irá colorir novamente o seu raster:
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12.2.2 Follow Along: Visualize dados em 3D

GRASS permite que você use um MDE para visualizar seus dados em três dimensões. A ferramenta que você vai
usar para esta operação na Região GRASS, que no momento está definida para toda a extensão da África do Sul,
como você configurou antes.

• Para redefinir a extensão da cobertura só o nosso conjunto de dados raster, clique neste botão:

Quando esta ferramenta é ativada, o cursor vai se transformar em uma cruz quando colocado sobre a tela do mapa
no QGIS.

• Usando esta ferramenta, clique e arraste um retângulo ao redor das bordas do raster GRASS.

• Clique OK no diálogo Configurar Região GRASS quando terminar.

• Procure pela ferramenta nviz:
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• Configurá-lo como mostrado:
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• Lembre-se de permitir que tanto botões Use região desta mapa à direita dos menus de seleção suspensas
dois raster. Isso permitirá que NVIZ para avaliar corretamente a resolução dos rasters.

• Clique no botão Rodar.

NVIZ vai criar um ambiente 3D usando o raster e vetor selecionado. Isso pode levar algum tempo, dependendo
do seu hardware. Quando ele será feito, você vai ver o mapa renderizado em 3D em uma nova janela:
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Experiência com as configurações Altura, exagero-z, e Método de Visualização para mudar seu ponto de visão dos
dados. Os métodos de navegação pode levar algum tempo para se acostumar.

Após experimentar, feiche a janela NVIZ.

12.2.3 Follow Along: A Ferramenta Mapcalc

• Abra o diálogo Ferramentas GRASS guia Lista de módulos e procurar calc.

• A partir da lista de módulos, selecione r.mapcalc (não r.mapcalculator, o que é mais básico).

• Iniciar a ferramenta.

O diálogo Mapcalc permite construir uma sequência de análises a serem realizadas em um raster, ou coleção de
rasters. Você vai usar essas ferramentas para fazê-lo:

Por ordem, são eles:

• Adicionar mapa: Adiciona um arquivo raster ao seu mapaset GRASS atual.

• Adicionar valor constante: Adicionar um valor constante para ser utilizada em funções.

• Adicionar operador ou função: Adicionar um operador ou função para ser conectado a entradas
e saídas.

• Adicionar conecção: Conectar elementos. Usando esta ferramenta, clique e arraste a partir do ponto
vermelho em um item para o ponto vermelho em outro item. Pontos que estão corretamente ligados a uma
linha de conexão ficarão cinza. Se a linha ou ponto estiver vermelho, não estão conectados corretamente!

• Selecionar item: Selecione um item e mova o item selecionado.
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• Delete o item selecionado: Remova o item selecionado a partir da planilha mapcalc atual, mas
não a partir do mapset (se for um raster existente).

Usando essas ferramentas:

• Construindo o seguinte algoritmo:

• Quando você clicar em: guilabel: Rodar, sua saída deve ser semelhante a esta:

304 Chapter 12. Module: GRASS



QGIS Training Manual, Versão 2.8

• Clique Ver saída para ver a saída na tela do seu mapa:

Isso mostra todas as áreas onde o terreno é mais baixo do que 500 metros ou superior a 1000 metros.
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12.2.4 In Conclusion

Nesta lição, nós mostramos apenas algumas das muitas ferramentas oferecidas pelo GRASS. Para explorar as
capacidades do GRASS para si mesmo, abrir o diálogo Ferramentas GRASS e role a Lista de Módulos. Ou para
uma abordagem mais estruturada, olhar sob a guia Árvore de módulos, que organiza ferramentas por tipo.
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CHAPTER 13

Module: Tarea de Evaluación

Utiliza tus propios datos para esta sección. Necesitarás:

• un conjunto de datos vectoriales tipo de puntos conteniendo puntos de interés, con nombres de puntos y
diversas categorías

• un conjunto vectorial lineal de calles

• un conjunto de datos poligonal de usos del territorio (utilizando límites de propiedades)

• una imagen del espectro visual (como una fotografía aérea)

• un MDE (descargable en esta URL si no tienes una propia)

13.1 Crea un mapa base

Antes de hacer cualquier análisis de datos, necesitarás un mapa base, que proporcionará contexto a los resultados
de tu análisis.

13.1.1 Añade la capa de puntos

• Añade la capa de puntos. Basándote en el nivel que estés haciendo del curso, haz solo lo que esté listado en
la sección apropiada abajo:

• Etiqueta los puntos de forma acorde al atributo único, como nombres de lugares. Utiliza una fuente pequeña
y mantén las etiquetas discretas. La información debería estar disponible, pero no debe ser un elemento
principal del mapa.

• Clasifica los puntos en diferentes colores basados en categorías. Por ejemplo, las categorías podrían incluir
“destinaciones turísticas”, “estaciones de policía”, y “centro de ciudad”.

• Haz lo mismo que en la sección .

• Clasifica los tamaños de punto por importancia: cuando más significativo sea un elemento, más grande será
el punto. Sin embargo, no excedas en 2.00 el tamaño.
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• Para elementos que no se localizan en un punto singular (por ejemplo, nombres provinciales/regionales, o
nombres de ciudades a gran escala), no les asignes ningún punto.

• No utilices símbolos de puntos para simbolizar la capa. En lugar de ello, utiliza etiquetas centradas sobre
los puntos; los símbolos de puntos no deberían tener ningún tamaño.

• Utiliza Ajustes definidos por los datos para dar estilo a las etiquetas según distintas categorías que tengan
sentido.

• Añade columnas apropiadas a los datos de atributo si es necesario. Cuando lo hagas, no crees datos ficticios
- en su lugar, utiliza Calculadora de campos para rellenar las columnas nuevas, basado en valores existentes
del conjunto de datos.

13.1.2 Añade la capa lineal

• Añade la capa de calles y cambia su simbología. No etiquetes las calles.

• Cambia la simbología de las calles a un color suave con un línea ancha. Hazla también un poco transparente.

• Crea un símbolo con múltiples capas de símbolos. El símbolo resultante debería parecer una calle real.
Puedes utilizar símbolos simples para eso; por ejemplo, una línea negra con una línea sólida blanca en el
centro. Puede ser más elaborado también, pero el mapa resultante no debe verse muy concurrido.

• Si tu conjunto de datos tiene una gran densidad de calles a la escala que quieres mostrar en el mapa, deberias
tener dos capas de calles: la elaborada con símbolos complejos que aparentan calles, y una con símbolos
más simples para escalas más pequeñas. (Utiliza visibilidad basada en escala para que cambien en las
escalas apropiadas.)

• Todos los símbolos deberían tener múltiples capas de símbolos. Utiliza simbolos para que se visualizen
correctamente.

• Haz lo mismo que en la sección anterior .

• Además, las calles deberían estar clasificadas. Cuando uses símbolos realísticos de calles, cada tipo de calle
deberia tener un símbolo apropiado; por ejemplo, una autopista debería tener dos carriles en cada dirección.

13.1.3 Añade la capa poligonal

• Añade la capa de usos del territorio y cambia su simbología.
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• Clasifica la capa de acuerdo con los usos del suelo. Utiliza colores sólidos.

• Clasifica la capa de acuerdo con el uso del territorio. Donde sea apropiado, incorpora capas de símbolos,
diferentes tipos de símbolos, etc. Mantén los resultados suaves y uniformes. ¡Ten en cuenta que será parte
del fondo!

• Utiliza la clasificación basada en reglas para clasificar los usos del territorio en categorías generales, como
“urbana”, “rural”, “reserva natural”, etc.

13.1.4 Crea el fondo ráster

• Crea el sombreado del relieve a partir del MDE, y utilízalo como capa superpuesta para la versión clasifi-
cada del mismo MDE. También podrías utilizar el complemento Relieve (como se mostró en la lección de
complementos).

13.1.5 Acaba el mapa base

• Usando os recursos acima, crie um mapa base usando algumas ou todas as camadas. O mapa deve in-
cluir todas as informações básicas necessárias para orientar o usuário, além de ser visualmente unificado /
“simples”.

13.2 Analiza los datos

• Estas buscando una propiedad que satisface ciertos criterios.

• Puedes decidir tus propios criterios, que deberás documentar.

• Hay algunas guias para esos criterios:

– la propiedad buscada debería ser de (un) cierto tipo(s) de uso del territorio

– debería estar a una distancia dada de las calles, o ser atravesada por una calle

– debería estar dentro de una distancia dada de alguna categoría de puntos, como por ejemplo un hospital

13.2.1 /

• Incluye análisis ráster en tus resultados. Considera al menos una propiedad derivada de ese ráster, como su
orientación o pendiente.
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13.3 Mapa Final

• Utiliza el Diseñador de Mapas para crear un mapa final, que incorpore los resultados de tu análisis.

• Inclua este mapa em um documento, juntamente com os seus critérios documentados. Se o mapa se tornou
visualmente demasiado ocupado devido à camada(s) adicional, marque as camadas que você acha ser é o
mínimo necessário.

• Tu mapa debe incluir un título y una leyenda.
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CHAPTER 14

Module: Aplicação Florestal

Nestes módulos 1 a 13, aparecem muitas coisas sobre o QGIS e como trabalhar com ele. Se estiver interessado
em aprender sobre algumas aplicações básicas de QGIS no âmbito florestal, completar este módulo lhe permitirá
aplicar o que foi aprendido e te mostrará algumas novas ferramentas de utilidade.

O desenvolvimento deste módulo foi patrocinado pela União Europeia.

14.1 Lesson: Presentación del Módulo Forestal

Siguiendo este módulo sobre aplicaciones forestales requiere el conocimiento adquirido durante los módulos 1 a
11 de este manual de capacitación. Los ejercicios en las lecciones siguientes asumen que ya eres capaz de realizar
muchas de las operaciones básicas en QGIS y solamente se presentará en mayor detalles herramientas que no han
sido vistas anteriormente.

Sin embargo el módulo sigue un nivel básico a traves de todas las lecciones, de modo que si tienes experiencia
previa con QGIS, es probable que puedas seguir las instrucciones sin ningún problema.

Observa que necesitarás descargar un paquete de datos adicionales para este módulo.

14.1.1 Datos de Muestra Forestales

Nota: The sample data used in this module is part of the training manual data set and can be downloaded here.
Download the zip file and extract the forestry\ folder into your exercise_data\ folder.

Los datos forestales de muestra (mapa y datos forestales) han sido provistos por la escuela politécnica forestal
EVO-HAMK forestry school. Los datos han sido modificados para adaptarlos a las necesidades de las lecciones.

Los datos de muestra generales (imágenes aéreas, datos LiDAR, mapas básicos) se han obtenido del servicio de
datos gratuitos del National Land Survey of Finland, y han sido adaptados según las intenciones de los ejercicios.
El servicio gratuido de descargas de datos puede accederse en inglés aquí.

Aviso: Del mismo modo que con el resto del manual de capacitación, este módulo incluye instrucciones sobre
como añadir, borrar y alterar conjuntos de datos GIS. Por ese motivo se incluyen conjuntos de datos sobre los
que practicar. Antes de utilizar las técnicas descritas con tus propios datos, asegúrate de que has hecho las
copias de seguridad correspondientes.
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14.2 Lesson: Georreferenciando un Mapa

Una tarea forestal común sería la acutalización de información de un área forestal. Es posible que la información
anterior para esa área date de muchos años atrás y fuera tomada analógicamente (es decir, en papel) o puede que
fuera digitalizada pero todo lo que queda sea la versión en papel del área inventariada.

Segúramente querrás utilizar esa información en tu SIG para, por ejemplo, comparar con los inventarios posteri-
ores. Esto implica que necesitarás digitalizar la información a mano en tu software SIG. Pero antes de que puedas
empezar a digitalizar, hay un importante primer paso para hacer, escanear y georreferenciar tu mapa de papel.

El objetivo de esta lección: Aprender a usar la herramienta de Georreferenciación en QGIS.

14.2.1 Escanear el mapa

La primera tarea que deberás hacer es escanear tu mapa, si el mapa es demasiado grande, puedes escanearlo en
partes diferentes pero teniendo en cuenta que tendrás que repetir las tareas de preprocesado y georreferenciación
para cada parte. Así que si es posible, escanea el mapa en el menor número de partes posible.

Si vas a utilizar diferentes mapas al proporcionado en este manual, utiliza tu propio escaner para escanear el mapa
como un archivo de imagen, una resolución de 300 DPI funcionará. Si tu mapa tiene colores, escanea la imagen
en color para luego utilizar esos colores para separar la información de tu mapa en diferentes capas (por ejemplo,
masas forestales, curvas de nivel, calles...).

Para este ejercicio utilizarás un mapa previamente escaneado, puedes encontrarlo como rautjarvi_map.tif
en la carpeta de datos exercise_data/forestry

14.2.2 Follow Along: Georreferenciar el mapa escaneado

Abre QGIS y ajusta el SRC del proyecto a ETRS89 / ETRS-TM35FIN en Project → Project Properties →
CRS, que es el SRC de uso actual en Finlandia. Asegúrate de que Enable ‘on the fly’ CRS transformation está
activado, ya que trabajaremos con datos antiguos que están en otro SRC.
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Guarda el proyecto QGIS como map_digitizing.qgs.

Utilizarás los complementos de georreferenciación del QGIS, los complementos ya están instalados en QGIS.
Activa los complementos utilizando el administrador de complementos como has hecho en módulos anteriores. El
complemento se llama Georeferencer GDAL.

Para georeferenciar el mapa:

• Abre la herramienta de georreferenciado, Raster → Georeferencer → Georeferencer.

• Adicione o arquivo de imagem de mapa,: kbd: rautjarvi_map.tif, como a imagem para georeferenciamento,
File → Open raster.

• Cuando se solicite encuentra y selecciona el SRC KKJ / Finland zone 2, es el SRC que fue utilizado
en Finlandia en 1994 cuando el mapa fue creado.

• Haz clic en OK.

Acontinuación deberás definir los ajustes de transformación para georreferenciar el mapa:

• Abre Settings → Transformation settings.

• Haz clic en el icono junto a la caja Output raster, ve a la carpeta y crea la carpeta
exercise_data\forestry\digitizing y nombra el archivo como rautjarvi_georef.tif.

• Ajusta el resto de los parámetros como se muestra abajo.
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• Haz clic en OK.

El mapa contiene muchas cruces que marcan las coordenadas en el mapa, las utilizaremos para georreferenciar
esa imagen. Puedes utilizar las herramientas de zoom y planificación como normalmente usas para inspeccionar
la imagen en la ventana del Georreferenciador.

• Aumente o zoom para o canto inferior esquerdo do mapa e note que há uma cruz com um par de coorde-
nadas, x e y, que como mencionado anteriormente está em :kbd: KKJ / Finland zone 2 CRS. Você vai usar
esse ponto como o primeiro ponto de controle de solo para o georreferenciamento seu mapa.

• Selecciona la herramienta Add point y haz clic en la intersección de la cruz (desplázate y haz zoom como
necesites).

• En el diálogo Enter map coordinates escribe las coordenadas que aparecen en el mapa (X: 2557000 e Y:
6786000).

• Haz clic en OK.

La primera coordenada de la georreferenciación ya está lista.

314 Chapter 14. Module: Aplicação Florestal



QGIS Training Manual, Versão 2.8

Busca otras cruces en las líneas negras de la imagen, están separadas 1000 metros entre ellas en dirección Norte y
Este. Deberías ser capaz de calcular las coordenadas de esos puntos en relación al primero.

Zoom menos na imagem e passe para a direita até encontrar outra forma de cruz, e estimar quantos quilômetros
você se moveu. Tente obter pontos de controle no terreno o mais longe possível uns dos outros. Digitalize,
pelo menos, mais três pontos de controle, da mesma forma que você fez o primeiro. Você deve acabar com algo
semelhante a isto:

Con los puntos de control ya digitalizados serás capaz de ver los errores de georreferenciación como una línea
roja saliendose de los puntos. El error en píxels puede ser visto también en GCP table en las columnas dX[pixels]
y dY[pixels]. El error en píxels no debería ser mayor de 10 píxels, si lo es deberías revisar los puntos que has
digitalizado y las coordenadas que has introducido para encontrar dónde está el problema. Puedes utilizar la
imagen anterior como guía.

Una vez que estés contento con tus puntos de control guárdalos, en el caso de que los necesites más tarde:

• File → Save GCP points as....
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• Na pasta exercise_data\forestry\digitizing, nome do arquivo
rautjarvi_map.tif.points.

Finalmente, georreferencia tu mapa:

• File → Start georeferencing.

• Observa que ya has nombrado tu archivo como rautjarvi_georef.tif cuando editaste los ajustes
del Georreferenciador.

Ahora puedes ver el mapa en el proyecto QGIS como un ráster georreferenciado. Observa que el ráster parece
estar ligeramente rotado, pero eso solo se debe a que los datos están en KKJ / Finland zone 2 y tu proyecto
está en ETRS89 / ETRS-TM35FIN.

Para verificar se os seus dados estão devidamente georreferenciados você pode abrir a imagem aérea na pasta:
kbd: exercise_data\forestry , com o nome: kbd:‘ rautjarvi_aerial.tif‘. Seu mapa e esta imagem devem sobrepor
muito bem. Defina a transparência mapa para 50% e compará-la com a imagem aérea.
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Guarda los cambios en tu proyecto QGIS, continuarás desde este punto en la siguiente lección.

14.2.3 In Conclusion

Como has visto, georreferenciar un mapa de papel es una operación relativamente sencilla.

14.2.4 What’s Next?

En la siguiente lección, digitalizarás las masas forestales en tu mapa como polígonos y les añadirás los datos de
inventario.
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14.3 Lesson: Digitalizando Massas Florestais

Ao menos que você venha a usar o seu mapa georreferenciado apenas como uma imagem de fundo, o próximo
passo natural será digitalizar elementos dele. Você já fez isso nos exercícios sobre criação de dados vetoriais em
Lesson: Creando un Nuevo Conjunto de Datos Vectoriales , quando você digitalizou os campos escolares. Nesta
lição, você irá digitalizar os limites das massas florestais, que aparecem no mapa como linhas verdes, mas ao invés
de fazer isso usando uma imagem aérea, você usará um mapa georreferenciado.

El objetivo de esta lección: Aprender una técnica para asistir la tarea de digitalización, digitalizar una masa
forestal y finalmente añadirle los datos de inventario.

14.3.1 Follow Along: Extrayendo los Bordes de las Masas Forestales

Abre el proyecto map_digitizing.qgs en QGIS, que guardaste en la lección anterior.

Una vez escaneado y georeferenciado tu mapa podría empezar a digitalizarse directamente mirando las imágenes
a modo de guía. Esa sería la forma más adecuada si la imagen desde la que vas a digitalizar es, por ejemplo, una
fotografía aérea.

Si lo que estás utilizando para digitalizar es un buen mapa, como en nuestro caso, es probable que la información
está claramente dispuesta en líneas de diferentes colores para cada tipo de elemento. Esos colores pueden ser
relativamente fáciles de extraer como imágenes individuales utilizando un software de procesado de imágenes
como GIMP. Estas imágenes separadas pueden ser utilizadas para asistir la digitalización, como verás abajo.

El primer paso será utilizar GIMP para obtener una imagen que contenga solo las masas forestales, es decir, todas
las líneas verdosas que podrías ver en el mapa original escaneado:

• Abre GIMP (si todavía no lo has instalado, descárgatelo de internet o pregunta a tu profesor).

• Abre la imagen del mapa original, File → Open, rautjarvi_map.tif en la carpeta
exercise_data/forestry. Observa que las masas forestales están representadas como líneas verdes
(con el número de la masa también en verde dentro de cada polígono).
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Agora você pode selecionar os pixels na imagem que formam os limites das massas florestais (os pixels esverdea-
dos):

• Abre la herramienta Select → By color.

• Con la herramienta activa, haz zum en la imagen (Ctrl + mouse wheel) para que las líneas de las masas
forestales estén suficientemente cerca para diferenciar los píxeles que forman la línea. Mira la imagen
inferior izquierda.

• Haz clic y arrastra el cursor del ratón en el medio de la línea para que la herramienta recolecte muchos
valores de color de píxel.

• Deja de clicar y espera unos segundos. Los píxeles que coincidan con los colores recogidos por la her-
ramienta serán seleccionados en toda la imagen.

• Aleja el zum para ver como los píxeles verdosos se han seleccionado en toda la imagen.

• Si no estas contento con tus resultados, repite la operación de clicado y arrastrar.

• Sua seleção de pixels deve ficar parecida com a imagem abaixo à direita.
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Una vez hayas terminado con la selección necesitas copiar la selección como una capa nueva y guardarla como un
archivo de imagen separado:

• Copia (Ctr+C) los píxeles seleccionados.

• Y pégalos directamente (Ctr+V), GIMP los presentará como una nueva capa temporal en el panel Layers -
Brushes como un Floating Selection (Pasted Layer).

• Haz clic derecho en la capa temporal y selecciona To New Layer.

• Haz clic en el icono “eye” junto a la capa original para desactivarlo, para que solo sea visible la Pasted
Layer:
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• Finalmente, selecciona File → Export..., ajusta Select File Type (By Extension) como una TIFF image, se-
lecciona la carpeta digitizing y nómbrala rautjarvi_map_green.tif. Selecciona no comprimir
cuando se pregunte.

Podrías hacer el mismo proceso con otros elementos de la imagen, por ejemplo para extraer las líneas negras que
representan calles o las marrones que representan las líneas de contorno del terreno. Pero para nosotros, con las
masas forestales es suficiente.

14.3.2 Try Yourself georeferenciar la Imagen de píxeles Verdes

Como hiciste en la lección anterior, necesitas georeferenciar esta nueva imagen para ser capaz de utilizarla con el
resto de tus datos.

Observa que no necesitas digitalizar los puntos de control base de nuevo porque esta imagen es básicamente la
misma imagen que la del mapa original, siempre y cuando la herramienta de georeferenciación esté conectada.
Aquí hay algunas cosas que deberías recordar:

• Esa imagen también está, por supuesto, en SRC KKJ / Finland zone 2.

• Deberías utilizar los puntos de control base que guardaste, File → Load GCP points.

• Lembre-se de rever Transformation settings.

• Nombra el ráster de salida como rautjarvi_green_georef.tif en la carpeta digitizing.

Comprueba que el nuevo ráster encaja bien en el mapa original.

14.3.3 Follow Along: Creando Puntos de Soporte para Digitalizar

Tendo em mente as ferramentas de digitalização do QGIS, você já pode ter pensado que seria útil ter o snap para
esses pixels verdes enquanto digitaliza. Isso é precisamente o que você vai fazer agora: criar pontos a partir
desses pixels para usá-los depois para ajudá-lo a seguir as fronteiras das florestas enquanto digitaliza, usando as
ferramentas de snap disponíveis no QGIS.
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• Utiliza la herramienta Raster → Conversion → Polygonize (Raster to Vector) para vectorizar tus líneas
verdes a polígonos. Si no recuerdas cómo, puedes repasarlo en el módulo 9.1.1.

• Guárdalo como rautjarvi_green_polygon.shp dentro de la carpeta digitizing.

Amplía el zum y observa como se ven los polígonos. Obtendrás algo como esto:

La siguiente opción para sacar los puntos de los polígonos es obtener sus centroides:

• Abre Vector → Geometry tools → Polygon centroids.

• Indique a camada polígono, que você acabou de criar, como o arquivo de entrada para a ferramenta.

• Nombra la salida como green_centroids.shp dentro de la carpeta digitizing.

• Comprueba Add result to canvas.

• Inicia la herramienta para calcular los centroides para los polígonos.
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Ahora puedes borrar la capa rautjarvi_green_polygon del TOC.

Cambia la simbología de la capa de centroides:

• Abre las Layer Properties para green_centroids.

• Ve a la pestaña Style.

• Ajusta Unit a Map unit.

• Ajusta Size a 1.

No es necesario diferenciar los puntos entre ellos, solo necesitas que estén ahí para que las herramientas de rotura
los utilicen. Puedes utilizar esos puntos ahora para seguir las líneas originales mucho más fácil que sin ellos.

14.3.4 Follow Along: Digitaliza las Masas Forestales

Ahora estás listo para empezar con el trabajo de digitalización. Empezarías creando un archivo vectorial de poly-
gon type, pero para este ejercicio, hay un archivo shape con parte del área de interés ya digitalizada. Terminarás
de digitalizar la mitad de las masas forestales que se ha dejado entre las calles principales (líneas anchas rosas) y
el lago:
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• Ve a la carpeta digitizing utilizando tu navegador del administrador de archivos.

• Arrastra y suelta el archivo vectorial forest_stands.shp a tu mapa.

Cambia la simbología de la nueva capa para que sea más fácil ver qué polígonos han sido ya digitalizados:

• El relleno de los polígonos a verde.

• Los bordes de los polígonos a 1mm.

• Ajusta la transparencia al 50%.

Ahora, si recuerdas los módulos anteriores, tenemos que ajustar y activar las opciones de rotura:

• Ve a Settings → Snapping options....
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• Activa la rotura de las capas green_centroids y forest_stands.

• Ajusta su Tolerance a 5 unidades de mapa.

• Activa la caja Avoid Int. para la capa forest_stands.

• Activa Enable topological editing.

• Haz clic en Apply.

Con esos ajustes de rotura, cuando quiera que estés digitalizando y te acerques lo suficiente a uno de ellos en la
capa de centroides o cualquier otro vértice de tus polígonos digitalizados, una cruz rosa aparecerá en el punto al
que se romperá.

Finalmente, desactiva la visibilidad de todas las capas excepto forest_stands y rautjarvi_georef.
Asegúrate de que la imagen del mapa deja de ser transparente.

Un par de cosas importantes a observar antes de empezar a digitalizar:

• No intentes ser demasiado preciso con la digitalización de los bordes.

• Si un borde es una línea recta, digitalízala con solo dos nodos. En general, digitaliza utilizando el menor
número de nodos posible.

• Amplía el zum a rangos cercanos solo si crees que necesitas ser preciso, por ejemplo, en algunas esquitas o
cuando quieres que un polígono conecte con otro en un cierto nodo.

• Utiliza el botón medio del ratón para amliar y reducir el zum y desplazarte mientras digitalizas.

• Digitaliza solo un polígono de cada vez

• Después de digitalizar un polígono, escribe la identidad de masa forestal que puedes ver en el mapa.

Ahora puedes empezar a digitalizar:

• Localiza la masa forestal número 357 en la ventana del mapa.

• Habilita la edición para la capa forest_stands.shp.

• Selecciona la herramienta Add feature.

• Comienza a digitalizar la masa 357 conectando algunos de los puntos.

• Observa las cruces rosas indicativas de rotura.
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• Cuando hayas terminado, haz clic derecho para terminar la digitalización de ese polígono.

• Introduce la id de la masa forestal (en este caso 357),

• Haz clic en OK.

Si no se pregunta por la id del polígono cuando acabes de digitalizarlo, ve a Settings → Options → Digitizing y
asegúrate que Suppress attribute form pop-up after feature creation no está marcado.

Tu polígono digitalizado se verá así:
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Agora, para o segundo polígono, pegue a massa florestal número 358. Tenha certeza que Avoid int. está marcado
para a camada forest_stands. Esta opção não permite interseção de polígonos na digitalização, então, se
você está digitalizando sobre um polígono existente, o novo polígono será recortado para coincidir com a borda
dos polígonos já existentes. Você pode usar esta funcionalidade para obter uma borda comum automaticamente.

• Comienza a digitalizar la masa 358 en una de las esquinas comunes con la masa 357.

• Continúa normalmente hasta que llegues a la otra esquina en común de ambas masas.

• Finalmente, digitalize alguns pontos dentro do polígono 357 assegurando-se que a borda comum não sofre
interseção. Veja a imagem abaixo a esquerda.

• Haz clic derecho para terminar de editar la masa forestal 358.

• Introduce la id como 358.

• Haz clic en OK, tu polígono nuevo debería mostrar un borde común con la masa 357 como puedes ver en la
imagen de la derecha.
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La parte del polígono que se estaba sobreponiendo al polígono existente se ha ajustado automáticamente y te ha
dejado un borde común, como tú querías.

14.3.5 Try Yourself Terminando la Digitalización de las Masas Forestales

Ahora tienes dos masas forestales diferentes preparadas. Y una buena idea de cómo proceder. Continúa digi-
talizando por tu cuenta hasta que hayas digitalizado todas las masas forestales que estén limitadas por la calle
principal y el lago.

Puede parecer mucho trabajo, pero pronto te acostumbrarás a digitalizar las masas forestales. Debería llevarte
unos 15 minutos.

Durante a digitalização você pode precisar editar ou deletar nós, separar ou juntar polígonos. Você aprendeu sobre
as ferramentas necessárias em Lesson: Topología de los Elementos, agora provavelmente é um bom momento para
voltar a lê-lo.

Recuerda que tener activa la Enable topological editing, te permite mover nodos comunes a dos polígonos para
que el borde común sea editado al mismo tiempo para ambos polígonos.

Tu resultado se parecerá a esto:
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14.3.6 Follow Along: Añadiendo Datos a las Masas Forestales

Es posible que los datos de inventario forestal que tienes en tu mapa también estén escritos en papel. En ese caso,
primero tendrías que haber escrito los datos en un archivo de texto o una hoja de cálculo. Para este ejercicio,
la información del inventario para 1994 (el mismo inventario que el mapa) está listo como un archivo de texto
separado por comas (csv).

Abra o arquivo rautjarvi_1994.csv da pasta rautjarvi_1994.csv em um editor de texto e observe
que o arquivo de dados de inventário tem um atributo chamado ID que tem os números das massas florestais.
Esses números ão os mesmos que os das identidades das massas florestais que você colocou para seus polígonos
e podem ser usados para ligar os dados do arquivo de texto com seu arquivo vetorial. Você pode ver os metadados
para esses dados de inventário no arquivo rautjarvi_1994_legend.txt na mesma pasta.

• Abre .csv en QGIS con la herramienta Layer → Add Delimited Text Layer.... En el diálogo, ajústalo como
sigue:
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Para añadir los datos desde el archivo .csv:

• Abre las Propiedades de Capa para la capa forest_stands.

• Ve a la pestaña Joins.

• Haz clic en el signo de suma de la parte inferior de la caja de diálogo.

• Selecciona rautjarvi_1994.csv como la Join layer y ID como el campo Join.

• Asegúrate de que el campo Target también está ajustado a id.

• Haz clic en OK dos veces.

Los datos del archivo de texto deberían estar enlazados ahora a tu archivo vectorial. Para ver qué ha ocurrido, abre
la tabla de atributos para la capa forest_stands. Puedes ver que todos los atributos del archivo de datos de
inventario están enlazados ahora a tu capa vectorial digitalizada.

14.3.7 Try Yourself Renombrando Nombres de Atributos y Añadiendo Área
y Perímetro

Los datos del archivo .csv se acaban de enlazar a tu archivo vectorial. Para hacer que el enlace sea permanente,
para que los datos se guarden al archivo vectorial necesitas guardar la capa forest_stands como un nuevo
archivo vectorial. Cierra la tabla de atributos y haz clic derecho a la capa forest_stands para guardarla como
forest_stands_1994.shp.

Abre tu nueva forest_stands_1994.shp en tu mapa si no la has añadido ya. Luego abre la tabla de
atributos. Notarás que los nombres de las columnas que acabas de añadir no son muy útiles. Para solucionarlo:
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• Añade el complemento Table Manager como has hecho con otros complementos antes.

• Assegure-se que o complemento está ativado.

• En TOC selecciona la capa forest_stands_1994.shp.

• Depois, vá para Vetor → Table Manager → Table manager.

• Utiliza la caja de diálogo para editar los nombres de las columnas para que coincidan a los del archivo
.csv.

• Clique em Save.

• Seleciona Yes para conservar el estilo de la capa.

• Cierra el diálogo Table Manager.

Para acabar de reunir la información relacionada con esas masas forestales, puedes calcular el área y perímetro
de las masas. Calculaste áreas para los polígonos en el Module 9.4.24., vuelve a esa lección si lo necesitas
y calcula las áreas para las masas forestales, nombra al nuevo atributo Area y asegúrate de que los valores
calculados están en hectáreas.

Ahora tu capa forest_stands_1994.shp está lista y equipada con toda la información disponible.

Guarda tu proyecto para mantener la presentación del mapa actual en caso de que necesites volver a él luego.
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14.3.8 In Conclusion

Ha llevado unos pocos clics de ratón pero ahora tienes tus viejos datos de inventario en formato digital y listos
para usar en QGIS.

14.3.9 What’s Next?

Podrías empezar haciendo diferentes análisis con tu nueva marca de conjuntos de datos, pero puede que estés más
interesado en relizar análisis en un conjunto de datos más actualizado. El tema de la siguiente lección será la
creación de masas forestales utilizando fotos aéreas actuales y la adición de información relevante a tu conjunto
de datos.

14.4 Lesson: Atualizando Massas Florestais

Ahora que has digitalizado la información de los viejos mapas de inventario y añadido la correspondiente infor-
mación a las masas forestales, el siguiente paso sería crear el inventario del estado actual del monte.

Digitalizarás nuevas masas forestales desde cero desde fotos aéreas de esa área forestal. El mapa forestal que
digitalizaste en la lección anterior fué creado desde una fotografía de infrarrojos aérea (CIR). Ese tipo de imágenes,
donde la luz infrarroja se registra en lugar de la azul, son ampliamente utilizadas para estudiar áreas de vegetación.
Utilizarás también una fotografía CIR en esta lección.

Después de digitalizar las masas forestales, añadirás información como nuevas restricciones dadas por las normas
de conservación.

El objetivo de esta lección: Digitalizar un nuevo conjunto de masas forestales desde una fotografía aérea CIR y
añadir información desde otros conjuntos de datos.

14.4.1 Comparar las viejas masas forestales con Fotografías Aéreas Ac-
tuales

El Estudio Nacional de Finlandia tiene una política de transparencia de datos que te permite descargar una variedad
de datos geográficos como imágenes aéreas, mapas topográficos tradicionales, DEM, datos LIDAR, etc. Se puede
acceder al servicio en Inglés aquí. La imagen aérea utilizada en este ejercicio ha sido creada desde dos imágenes
CIR ortoreferenciadas descargadas de ese servicio (M4134F_21062012 y M4143E_21062012).

• Abre QGIS y ajusta el SRC del proyecto a ETRS89 / ETRS-TM35FIN en Project → Project Properties
→ CRS.

• Asegúrate que Enable ‘on the fly’ CRS transformation está activado.

• Do: kbd: exercise_data \ florestal \ pasta, adicione a imagem CIR: kbd: rautjarvi_aerial.tif que está con-
tendo os lagos digitalizados.

• Luego guarda el proyecto QGIS como digitizing_2012.qgs.

As imagens do CIR são a partir de 2012. Você pode comparar os padrões que foram criados em 1994, com a
situação de quase 20 anos mais tarde.

• Añade tu capa forest_stands_1994.shp.

• Ajusta su estilo para poder ver a través de los polígonos.

• Repasa cómo las masas forestales antiguas siguen (o no) lo que puede que interpretes visualmente como un
monte homogéneo.

Amplía y desplázate sobre el área. Probablemente observarás que algunas de las masas forestales todavía se
correspondan con la imagen pero otras no.
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Eso es una situación normal, ya que han pasado unos 20 años y se han llevado a cabo diferentes operaciones
forestales (cosechados, aclareos..). También es posible que las masas forestales parecieran homogéneas en 1992
para la persona que los digitalizará pero como el tiempo ha pasado algunos montes han evolucionado de formas
diferentes. O simplemente las prioridades para el inventariado del monte fueron diferentes a las de hoy en dia.

A continuación, crearás nuevas masas forestales para esa imagen sin utilizar las antiguas. Luego puedes compara-
rlas para ver las diferencias.

14.4.2 Interpretando las Imágenes CIR

Vamos a digitalizar la misma área que cubría el viejo inventario, limitada por las calles y el lago. No tienes que
digitalizar el área completa, como en el ejercicio anterior puedes empezar con un archivo vectorial que ya contiene
la mayoría de las masas forestales.

• Borra la capa forest_stands_1994.shp.

• Añade la capa forest_stands_2012.shp, situada en la carpeta exercise_data\forestry\.

• Ajusta el estilo de esa capa para que los polígonos no tengan relleno y los bordes sean visibles.
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Puedes ver que todavía falta una región al Norte del área de inventario. Esa será tu tarea, digitalizar las masas
forestales que faltan.

Pero antes de empezar, toma algo de tiempo revisando las masas forestales que ya están digitalizadas y los montes
correspondientes en la imagen. Intenta hacerte una idea de cómo se ha elegido los bordes de las masas, eso te
ayudará a obtener algunos conocimientos forestales.

Algunas ideas sobre lo que podrías identificar en las imágenes:

• Que montes son de especies caducas (en Finlandia mayormente bosques de abedul) y cuales son de coníferas
(en esta región pinos o abetos). En imágenes CIR, las especies caducas vendrán normalmente en un rojo
brillante mientras las coníferas presentan un colores verde oscuro.

• Cuando la edad de una masa forestal cambia, mirando al tamaño de las copas de los árboles que puede ser
identificado en la imagen.

• Las diferentes densidades de las masas forestales, por ejemplo masas forestales donde una operación de
aclareo se ha llevado a cabo recientemente mostrarían claros espacios entre las copas de los árboles que los
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diferencien de otras masas forestales a su alrededor.

• Áreas azuladas indican terrenos áridos, calles y áreas urbanas, cultivos que todavía no han comenzado a
crecer etc.

• Não use zooms muito perto da imagem quando se tenta identificar povoamentos florestais. A escala entre
1: 3 000 e 1: 5 000 deve ser suficiente para esse imaginário. Veja a imagem abaixo (1: 4 000 escala):

14.4.3 Try Yourself Digitalizando Masas Forestales desde Imágenes CIR

Cuando digitalices masas forestales, deberías intentar obtener áreas forestales que sean tan homogéneas como
puedas en términos de especies de árboles, edad de la masa, densidad de pies... Tampoco seas demasiado detallado,
o acabarás haciendo cientos de pequeñas masas forestales que no serán útiles en absoluto. Deberías intentar
obtener masas que sean significativos en un contexto forestal, no demasiado pequeños (al menos 0.5 ha) pero
tampoco demasiado grandes (no más de 3 ha).

Con estas indicaciones en mente, ahora puedes digitalizar las masas forestales que quedan.

• Habilita la edición para forest_stands_2012.shp.

• Ajusta las opciones de topología y rotura como en la imagen.

• Recuerda hacer clic en Apply o OK.
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Comienza a digitalizar como hiciste en la lección anterior, con la única diferencia de que no tienes ninguna capa de
puntos a la que estás rompiendo. Para esa área deberías obtener alrededor de 14 masas forestales nuevas. Mientras
digitalices, rellena el campo Stand_id con números empezando desde 901.

Cuando hayas acabado tu capa debería parecerse a esto:

Ahora tienes un nuevo conjunto de polígonos definiendo diferentes masas forestales para la situación actual como
puede interpretarse de las imágenes CIR. Pero obviamente aún te faltan los datos del inventario forestal, ¿correcto?
Para ello todavía necesitarás visitar el monte y obtener algunos datos de muestra que utilizarás para estimar los
atributos del monte para cada una de las masas forestales. Verás cómo hacer esto en la siguiente lección.
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Por el momento, todavía puedes mejorar tu capa vectorial con alguna información extra que tengas sobre las
normas de conservación que deberían tomarse en cuenta para esa área.

14.4.4 Follow Along: Actualizando Masas Forestales con Información so-
bre Conservación

Para el área con la que estás trabajando, se ha investigado que las siguientes normas de conservación deben tenerse
en cuenta cuando se procede al planeamiento forestal:

• Se han identificado dos territorios de protección de una especie de ardilla voladora siberiana (Pteromys
volans). De acuerdo con las normas, un área de 15 metros alrededor de los puntos debe dejarse intacta.

• Un bosque de ribera de especial interés que crece a lo largo de un arroyo en el área debe ser protegido. En
una visita al campo, se concluyó que 20 metros a ambos lados del arroyo deben ser protegidos.

Tienes un archivo vectorial que contiene la información sobre la situación de las ardillas y otro que contiene el
arroyo digitalizado que recorre el área Norte hacia el lago. Desde la carpeta exercise_data\forestry\,
añade los archivos vectoriales squirrel.shp y stream.shp.

Para la protección de los terrenos de las ardillas, vas a añadir un nuevo atributo (columna) a tus nuevas masas
forestales que contendrá información sobre la situación de los puntos que deben ser protegidos. Esa información
estará luego disponible siempre que una operación forestal se planee, y el conjunto de campos será capaz de
señalar qué áreas deben dejarse intactas antes de comenzar las actividades.

• Abre la tabla de atributos para la capa squirrel.

• Puedes ver que hay dos localidades definidas como ardilla voladora siberiana, y que el área a ser protegida
está indicada por una distancia de 15 metros desde las localidades.

Para unir la información sobre las ardillas a tus masas forestales, puedes utilizar Join attributes by location:

• Aberto: menuselection: Vetor –> Ferramentas de Gerenciamento de Dados –> Juntar atributos por local-
ização.

• Defina a camada forest_stands_2012.shp como Camada vetorial anexada.

• Em Juntar camada vetorial selecione a camada de ponto squirrel.shp

• Nombra el archivo de salida como stands_squirrel.shp.

• Em Tabela de saída selecione Manter todos os registros (incluindo os registros alvo não correspondentes).
Assim você mantem todos os povoamentos florestais na camada, em vez de apenas manter aqueles que são
espacialmente relacionados com os locais de esquilo.

• Clique OK.

• Selecciona Yes cuando se solicite para añadir la capa al TOC.

• Cierra la caja de diálogo.
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Ahora tienes una nueva capa de masas forestales, stands_squirrel cuando hay nuevos atributos correspon-
dientes a la información de protección relacionada con la ardilla voladora siberiana.

Abra a tabela da nova camada e ordene-a de modo que a floresta com informações para o atributo Proteção estão
no topo. Você deve ter agora dois povoamentos florestais, onde o esquilo foi localizado:
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Aunque esa información puede ser suficiente, mira qué áreas relacionadas con las ardillas deberían ser protegidas.
Sabes que tienes que dejar un borde de 15 metros alrededor de las localizaciones con ardillas:

• Abre Vector → Geoprocessing Tools → Buffer.

• Crea un borde de 15 metros para la capa squirrel.

• Nombra al resultado squirrel_15m.shp.
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Observarás que si amplías el zum a la parte Norte del área, el borde se extiende hacia las masas vecinas. Eso
significa que siempre que se produzca una operación en esa masa, la localidad protegida también debería ser
tomada en cuenta.
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De tu análisis anterior, no obtuviste la información para registrar esas masas protegidas. Para solucionar ese
problema:

• Inicia la herramienta Join attributes by location de nuevo.

• Pero esta vez utiliza la capa squirrel_15m como capa de unión.

• Nombra el archivo de salida como stands_squirrel_15m.shp.
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Abre la tabla de atributos para la nueva capa y observa que ahora tienes tres masas forestales que tienen infor-
mación sobre las localidades a proteger. La información en los datos de las masas forestales indicarán al gestor
forestal que hay consideraciones de protección que deben tenerse en cuenta. Luego el o ella puede obtener la
localización en el conjunto de datos squirrel, y visitar el área para marcar el borde correspondiente alrededor
de las localizaciones para que los operadores de campo puedan evitar perturbar el entorno de las ardillas.

14.4.5 Try Yourself Actualizando Masas Forestales con Distancia al Arroyo

Siguiendo los mismos pasos que los indicados para las localidades protegidas de las ardillas ahora puedes actu-
alizar tus masas forestales con información de protección del arroyo identificado en el campo:

• Recuerda que el borde en este caso son 20 metros a su alrededor.
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• Quieres tener toda la información sobre protección en el mismo archivo vectorial, así que utiliza la capa
stands_squirrel_15m como objetivo.

• Nombra tu salida como forest_stands_2012_protect.shp.

Abre la tabla de atributos para la nueva capa vectorial y confirma que ahora tienes toda la información sobre
protección para las masas forestales que están bajo las medidas de protección del bosque de ribera asociado al
arroyo.

Guarda tu proyecto QGIS.

14.4.6 In Conclusion

Has visto cómo interpretar imágenes CIR para digitalizar masas forestales. Por supuesto debería llevar más prác-
tica el refinar las masas y utilizar otra información como mapas de suelos para obtener mejores resultados, pero
ahora sabes las bases para ese tipo de tarea. Y añadir información desde otros conjuntos de datos ha resultado ser
una tarea bastante trivial.

14.4.7 What’s Next?

Las masas forestales que digitalizaste se utilizarán para planear operaciones forestales en el futuro, pero todavía
necesitas obtener más información sobre el bosque. En la siguiente lección, verás cómo planear un conjunto de
parcelas de muestreo para inventariar el área forestal que acabas de digitalizar, y obtener una estimación global de
los parámetros forestales.

14.5 Lesson: Sistemática de Diseño de Muestreo

Você já digitalizou um conjunto de polígonos que representam a floresta padrão, mas você não tem informações
sobre a floresta ainda. Para esse efeito, você pode projetar uma pesquisa para o inventário da área de floresta e em
seguida, estimar seus parâmetros. Nesta lição, você vai criar um conjunto sistemático de pontos de amostragem.

Cuando comienzas a planear tu inventario forestal es importante definir claramente los objetivos, los tipos de
parcelas de muestreo que serán utilizados, y los datos que serán recolectados para conseguir los objetivos.
Para cada caso individual, dependerá del tipo de propósitos del manejo forestal y debería estar cuidadosamente
planeado por alguien con conocimientos forestales. En esta lección, implementarás un inventario teórico basado
en un sistema de diseño de muestreo.

El objetivo de esta lección: Crear un diseño de muestreo sistemático para examinar el área forestal y estimar los
parámetros forestales.

14.5.1 Inventariando el Bosque

Hay muchos métodos para inventariar Bosques, cada uno de ellos al servicio de distintos propósitos y condiciones.
Por ejemplo, uno muy preciso para inventariar un bosque sería visitarlo y hacer una lista de cada árbol y sus
características. Como puedes imaginar ese no es realmente aplicable excepto para aquellas áreas pequeñas o
alguna situación especial.

El tipo más común de conocer un bosque es muestrearlo, es decir, tomar medidas en diferentes localidades del
bosque y generalizar la información a la totalidad del bosque. Esas medidas normalmente normalmente están
hechas en parcelas de muestreo que son áreas más pequeñas de bosques que se pueden medir fácilmente. Las
parcelas de muestreo pueden ser de cualquier tamaño (por ejemplo. 50 m2, 0.5 ha) y forma (por ejemplo circu-
lar, rectangular, tamaño variable), y pueden estar situados de diferentes formas (por ejemplo de forma aleatoria,
sistemáticamente, en líneas). El tamaño, forma y localidad de las parcelas de muestreo se deciden normalmente
siguiendo estadísticas y consideraciones económicas y prácticas. Si no tienes conocimientos forestales, puedes
estar interesado en leer este artículo de wikipedia.
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14.5.2 Follow Along: Implementando un Diseño de Parcelas de Muestreo
Sistemático

Para el bosque con el que estás trabajando, el gestor ha decidido que el diseño de muestreo sistemático es lo más
apropiado para este bosque y ha decidido que una distancia fija de 80 metros entre las parcelas de muestreo y
las líneas de muestreo dará resultados fiables (+- 5% de error medio con una probabilidad del 68%). Parcelas de
tamaño variable han sido decididas como el método más efectivo para este inventario, para masas en crecimiento
y maduras, pero un radio fijo de 4 metros a las parcelas se utilizará para las masas de plántulas.

En la práctica, simplemente necesitas representar las parcelas de muestreo como puntos que serán utilizados luego
por los equipos de campo:

• Abre tu proyecto digitizing_2012.qgs de la lección anterior.

• Borra todas las capas excepto forest_stands_2012.

• Guarda ahora tu proyecto como forest_inventory.qgs.

Ahora necesitas crear una rejilla de puntos rectangular separados 70 metros:

• Abre Vector → Research Tools → Regular points.

• En las definiciones de Area selecciona Input Boundary Layer.

• Y como capa de entrada ajusta la capa forest_stands_2012.

• En los ajustes Grid Spacing, selecciona Use this piont spacing y ajústalo a 80.

• Guarda la salida como systematic_plots.shp en la carpeta forestry\sampling\.

• Habilita Add result to canvas.

• Haz clic en OK.

Nota: La herramienta sugerida, Regular points, crea los puntos sistemáticos comenzando en la esquina superior
izquierda de la extensión de la capa de polígonos seleccionada. Si quieres añadir un elemento de arbitrariedad a
estos puntos regulares, podrías utilizar un número calculado aleatoriamente entre 0 y 80 (80 es la distancia entre
nuestros puntos), y escribirla como el parámetro Initial inset from corner (LH side) el cuadro de diálogo de la
herramienta.

Notarás que la herramienta ha utilizado la extensión completa de tu capa de masas para generar una rejilla rect-
angular de puntos. Pero solo estás interesado en los puntos que están dentro de tu área forestal (mira la imagen
inferior):
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• Abre Vector → Geoprocessing Tools → Clip.

• Selecciona systematic_plots como Input vector layer.

• Ajusta forest_stands_2012 como la Clip layer.

• Guarda el resultado como systematic_plots_clip.shp.

• Habilita Add result to canvas.

• Haz clic en OK.

Ahora tienes los puntos que los equipos de campo utilizarán para navegar a las localidades designadas para las
parcelas de muestreo. Todavía puedes preparar esos puntos para que sean más útiles para el trabajo de campo.
Como mínimo tendrás que añadir nombres significativos para los puntos y exportarlos a un formato que pueda
ser utilizado por sus aparatos de GPS. Otra fuente útil en el campo son los mapas generales y detallados de la
localización de las parcelas de muestreo.

Empieza con en nombrado de las parcelas de muestreo. Si compruebas la Attribute table para tus parcelas dentro
del área forestal, puedes ver que tienes el campo id por defecto se generó automáticamente por la herramienta
Regular points. Etiqueta los puntos para ver si pudrías usar esos números como parte del nombrado de tus parcelas
de muestreo:

• Abre Layer Properties –> Labels para tu systematic_plots_clip.

• Habilita Label this layer with y selecciona el campo ID.

• Vá para opção :guilabel:’Bufer’ e clique em :guilabel:’Draw text buffer’, ajuste o :guilabel:’Size’ para
:kbd:‘1’

• Haz clic en OK.

Ahora mira las etiquetas en tu mapa. Puedes ver que los puntos se han creado y numerado de Oeste a Este y
luego de Norte a Sur. Si vuelves a mirar la tabla de atributos, observarás que el orden en la tabla también sigue
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un patrón. A menos que tengas una razón para nombrar a las parcelas de muestreo de otro modo, nombrarlos de
Oeste-Este/Norte-Sur sigue un orden lógico y es una buena opción.

Nota: Se você gostaria de pedir ou nomeá-los de uma maneira diferente , você pode usar uma planilha para ser
capaz de ordenar e combinar as linhas e colunas de alguma forma diferente.

Sin embargo, los números del campo id no son muy buenos. Sería mejor si el nombrado fuera algo como p_1,
p_2.... Puedes crear una nueva columna para la capa systematic_plots_clip:

• Ve a la Attribute table para systematic_plots_clip.

• Habilita el modo edición.

• Abra a Field calculator e o nome da nova coluna Plot_id.

• Ajusta Output field type a Text (string).

• En el campo Expression, escribe o copia esta fórmula concat(’P_’, $rownum ). Recuerda que
también puedes hacer doble clic en los elementos dentro de la Function list. La función concat puede
encontrarse en String y el parámetro $rownum puede encontrarse en Record.

• Haz clic en OK.

• Deshabilita el modo edición y guarda tus cambios.

Ahora tienes una nueva columna con nombres de las parcelas que son significativos para ti. Para la capa
systematic_plots_clip, cambia el campo utilizado para etiquetar a tu nuevo campo Plot_id.
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14.5.3 Follow Along: Exportando Parcelas de Muestreo a formato GPX

Los equipos de campos estarán utilizados probablemente dispositivos GPS para localizar las parcelas de muestreo
que planeaste. El siguiente paso es exportar los puntos que creaste a un formato que tu GPS pueda leer.
QGIS te permite guardar los datos vectoriales de puntos y líneas en un formato de intercambio de GPS (GPX)
<http://en.wikipedia.org/wiki/GPS_Exchange_Format>‘, que es un formato de datos GPS estándar que puede ser
leído por programas más especializados. Necesitas ser cuidadoso seleccionando el SRC cuando guardes tus datos:

• Haz clic derecho en systematic_plots_clip y selecciona Save as.

• En Format selecciona GPS eXchange Format [GPX].
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• Guarda la salida como plots_wgs84.gpx.

• En CRS selecciona Seleceted CRS.

• Procurar por WGS 84 (EPSG:4326).

El formato GPX Solo acepta ese SRC, si seleccionas uno diferente, QGIS no dará error pero obtendrá un archivo
vacío.

• Haz clic en OK.

• En el cuadro de diálogo que aparece, selecciona solo la capa waypoints (el resto de capas están vacías).

Las parcelas de muestreo de inventario están ahora en un formato estándar que puede ser manejado por la
mayoría de programas de GPS. Los equipos de campo pueden descargar las localidades de las parcelas de
muestreo a sus dispositivos. Eso estaría hecho utilizando los dispositivos específicos o programas y el archivo
plots_wgs84.gpx que acabas de crear. Otra opción seria utilizar el complemento GPS Tools pero muy prob-
ablemente requeriría ajustar la herramienta a trabajar con tu dispositivo específico de GPS. Si estás trabajando
con tus propios datos y quieres ver cómo trabaja la herramienta puedes encontrar más información en la sección
trabajando con datos GPS en el QGIS User Manual.

Guarda tu proyecto QGIS ahora.
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14.5.4 In Conclusion

Acabas de ver con qué facilidad puedes crear un diseño de muestreo sistemático para utilizar en inventario forestal.
Crear otros tipos de diseños de muestreo requerirá el uso de diferentes herramientas dentro del QGIS, hojas de
cálculo o encriptado para calcular las coordenadas de las parcelas de muestreo, pero la idea general sigue siendo
la misma.

14.5.5 What’s Next?

En la siguiente lección verás cómo usar las capacidades del Atlas en QGIS para generar automáticamente mapas
detallados que los equipos de campo utilizarán para navegar a las parcelas de muestreo asignadas a ellos.

14.6 Lesson: Creación de Mapas detallados con la herramienta
Atlas

El diseño de muestreo sistemático está listo y los equipos de campo han cargado las coordenadas GPS en sus
sistemas de navegación. También tienen un formulario de datos de campo donde colectarán la información medida
en cada parcela de muestreo. Para encontrár más fácilmente su camino a cada parcela de muestreo, ellos han
pedido un número de mapas detallados donde se puede ver claramente alguna información sobre el terreno junto
con un pequeño conjunto de parcelas de muestreo y otra información sobre el área del mapa. Puedes utilizar la
herramienta Atlas para generar automáticamente un número de mapas con un formato común.

El objetivo de esta lección: Aprender a utilizar la herramienta Atlas en QGIS para generar mapas detallados que
se puedan imprimir para asistir en el trabajo de inventario de campo.

14.6.1 Follow Along: Preparación del Compositor de Mapas

Antes de que podamos automatizar los mapas detallados de la mayoría del área forestal y nuestras parcelas de
muestreo, necesitamos crear una plantilla de mapa con todos los elementos que consideremos útiles para el trabajo
de campo. Por supuesto lo más importante será un un estilo apropiado, pero como has visto anteriormente, también
necesitarás añadir muchos otros elementos que completen el mapa impreso.

Abre el proyecto QGIS de la lección anterior forest_inventory.qgs. Deberías tener al menos las capas
siguientes:

• forest_stands_2012 (con una transparencia del 50%, relleno verde y líneas de los bordes verde os-
curo).

• systematic_plots_clip.

• rautjarvi_aerial.

Guarda el proyecto con un nuevo nombre, map_creation.qgs.

Para crear un mapa imprimible, recuerda que utilizas el Composer Manager:

• Abre Project → Composer Manager....

• En el cuadro de diálogo Composer manager.

• Haz clic en el botón Add y nombra a tu compositor forest_map.

• Haz clic en OK.

• Haz clic en el botón Show.

Ajusta las opciones de impresora para que tu página y márgenes del mapa se ajusten a un papel A4:

• Abre menuselection:Composer –> Page Setup.

• Size es A4 (217 x 297 mm).
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• Orientation es Landscape.

• Margins (milimeters) todos ajustados a 5.

En la ventana Print Composer, ve a la pestaña Composition (en el panel derecho) y asegúrate de que sus ajustes
de Paper and quality son los mismos que has definido para la impresora:

• Size: A4 (210x297mm).

• Orientation: Landscape.

• Quality: 300dpi.

Componer un mapa es más fácil si utilizas el lienzo en cuadrícula para posicionar los diferentes elementos. Revisa
los ajustes para la cuadrícula del compositor:

• En la pestaña Composition expande la región Grid.

• Comprueba que Spacing está ajustado a 10 mm.

• Y que Tolerance es 2 mm.

Necesitas activar el uso de la cuadrícula:

• Abre el menú View.

• Habilita Show grid.

• Habilita Snap to grid.

• Observa que las opciones para utilizar guides están habilitadas por defecto, lo que te permite ver líneas guía
rojas cuando estás moviendo elementos en el compositor.

Ahora puedes empezar a añadir elementos a tu lienzo del mapa. Añade primero un elemento del mapa para revisar
cómo se ve ya que estáras realizando cambios en la simbología de las capas:

• Click on the Add New Map button: .

• Haz clic y arrastra la caja en el lienzo para que el mapa ocupe la mayor parte.
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Observa cómo el cursor del ratón se ajústa al lienzo en cuadrícula. Utiliza esta función cuando añadas otros
elementos. Si quieres tener más precisión, cambia los ajustes de cuadrícula Spacing. Si por alguna razón no
quieres forzar el cursor a la cuadrícula en algún momento, siemper puedes habilitarlo o deshabilitarlo en el menú
View.

14.6.2 Follow Along: Adición de un Mapa de Fondo

Deja el compositor abierto pero vuelve al mapa. Vamos a añadir datos de fondo y a crear estilo para que el
contenido del mapa sea lo más claro posible.

• Añade la capa ráster de base basic_map.tif que puedes encontrar en la carpeta
exercise_data\forestry\.

• Cuando se requiera selecciona el SRC ETRS89 / ETRS-TM35FIN para la capa ráster.

Como puedes ver el mapa base ya está estilizado. Este tipo de rásters cartográficos listos para utililar es muy
común. Está creado a partir de datos vectoriales, estilizado en un formato estándar y guardado como un ráster para
que no tengas que dar estilo a muchas capas vectoriales y preocuparte de obtener un buen resultado.

• Ahora amplía tus parcelas de muestreo, para poder ver solo cuatro o cinco líneas de parcelas.

El estilo actual de las parcelas de muestreo no es el mejor, pero ¿cómo se ve en el compositor de mapas?:

Mientras que durante los últimos ejercicios, el amortiguador blanco estaba en OK sobre la imagen aérea, ahora
que la imagen de base es en su mayoria blanca difícilmente puedes ver las etiquetas. También puedes comprobar
cómo se ve en el compositor:

• Ve a la ventana Print Composer.

• Use the button to select the map element in the composer.

• Ve a la pestaña Item properties.

• En Extents haz clic en Set to map canvas extent.

• Si necesitas refrescar el elemento, en Main properties haz clic en Update preview.

Obviamente esto no es suficientemente bueno, tú quieres hacer los números de las parcelas tan claramente visibles
como se pueda para los equipos de campo.

14.6.3 Try Yourself Cambio de la Simbología de las Capas

O exemplo trabalhando em Module: Criando um Mapa Básico com simbologia em Module: Classificando Dados
Vetoriais com etiquetas. Retorna a este módulo sem necessitar referencia sobre algumas das opções e ferramentas
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disponíveis. Seu objetivo é conseguir que os locais das parcelas e os nomes sejam tão visiveis quanto possível,
pois sempre permitindo ver os elementos do mapa de fundo. Pode tomar alguma orientação nesta imagem:

Luego utilizarás el estilo verde para la capa forest_stands_2012. Para mantenerlo, y tener una visualización
que solo muestre los bordes de las masas:

• Haz clic derecho en forest_stands_2012 y selecciona Duplicate

• Obtendrás una capa nueva llamada forest_stands_2012 copy que puedes utilizar para definir un
estilo diferente, por ejemplo sin relleno y con bordes rojos.

Ahora tienes dos visualizaciones diferentes de las masas forestales y puedes decidir cual visualizar en tu mapa
detallado.

Vuelve a la ventana Print composer de vez en cuando para ver cómo se ve el mapa. Para el objetivo de crear mapas
detallados, estás buscando una simbología que se vea bien no solo en la escala de toda el área forestal (imagen
inferior izquierda) sino a una escala más pequeña (imagen inferior derecha). Recuerda utilizar Update preview y
Set to map canvas extent siempre que cambies el zoom en tu mapa o en el compositor.
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14.6.4 Try Yourself Creación de una Plantilla Básica del Mapa

Una vez tienes una simbología con la que estás contento, estás listo para añadir alguna otra información a tu mapa
imprimible. Añade al menos los elementos siguientes:

• Título.

• Una barra de escala.

• Una cuadrícula para tu mapa.

• Coordenadas en los bordes de la cuadrícula.

Ya has creado una composición parecida en Module: Criando Mapas. Vuelve a ese módulo si lo necesitas.

Exporta tu mapa como una imagen y revísalo.

• Composer → Export as Image.

• Utiliza el formato JPG format, por ejemplo.

Así es como se verá cuando esté impreso.

14.6.5 Follow Along: Añadiendo Más Elementos al Compositor

Como probablemente hayas observado en las imágenes sugeridas de plantilla de mapa, hay espacio de sobra en la
parte derecha del lienzo. Vamos a ver qué más podría haber ahí. Para los propósitos de nuestro mapa, una leyenda
no es realmente necesaria, pero un mapa resumen y algunas cajas de texto podrian añadir valor al mapa.

El mapa resumen ayudará a los equipos de campo a situar al mapa detallado dentro del área forestal general:

• Añade otro elemento del mapa al lienzo, justo bajo el texto del título.

• En la pestaña Item properties, abre el menú desplegable Overview.
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• Ajusta Overview frame a Map 0. Esto crea un rectángulo sombreado encima de un mapa más pequeño
representando la extensión visible del mapa grande.

• Habilita también la opción con color negro Frame y un Thickness de 0.30.

Observa que tu mapa resumen no da realmente un resumen del área forestal que es lo que tú quieres. Tú
quieres que el mapa represente el área forestal completa y quieres que muestre solo el mapa de fondo y la capa
forest_stands_2012, y no represente las parcelas de muestreo. También quieres bloquear esa vista para que
no vuelva a cambiar cuando quiera que cambies la visibilidad o el orden de las capas.

• Vuelve al mapa, pero no cierres el Print composer.

• Haz clic derecho en la capa forest_stands_2012 y haz clic en Zoom to Layer Extent.

• Desactiva todas las capas excepto basic_map y forest_stands_2012.

• Vuelve al Print composer.

• Con el mapa pequeño seleccionado, haz clic en Set to map canvas extent para ajustar su extensión a lo que
puedes ver en la ventana del mapa.

• Bloquea la vista para el mapa resumen habilitando Lock layers for map item en Main properties.

Ahora tu mapa resumen se parece más a lo que tú querías y no volverá a cambiar. Pero, por supuesto, ahora tu
mapa detallado ha dejado de mostrar los bordes de las masas ni las parcelas de muestreo. Vamos a solucionarlo:

• Vuelve a la ventana del mapa y selecciona las capas que quieres que sean visibles
(systematic_plots_clip, forest_stands_2012 copy y Basic_map).

• Vuelve a ampliar el zoom para tener visibles solo unas pocas líneas de parcelas de muestreo.

• Vuelve a la ventana del Print composer.

• Select the bigger map in your composer ( ).

• En Item properties haz clic en Update preview y Set to map canvas extent.
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Observa que solo el mapa grande se muestra en la vista actual del mapa, y el mapa resumen pequeño se mantiene
en la misma vista en que lo bloqueaste.

También observa que la visión general está mostrando una franja sombreada de la extensión mostrada en el mapa
detallado.

Tu plantilla está casi lista. Añade ahora dos cajas de texto bajo el mapa, una conteniendo el texto ‘Detailed map
zone: ‘ y la otra ‘Remarks: ‘. Sitúalas para que puedas verlas en la imágen superior.

También puedes añadir una flecha de Norte al mapa resumen:

• Use the Add image tool, .

• Haz clic en la esquina superior derecha del mapa resumen.

• En Item properties abre Search directories y busca la imagen de una flecha.

• En Image rotation, habilita Sync with map y selecciona Map 1 (el mapa resumen).

• Deshabilita Background.

• Ajusta el tamaño de la flecha para que quede bien en el mapa pequeño.

El compositor de mapa básico está listo, ahora quieres utilizar la herramienta Atlas para generar tantos mapas
detallados en ese formato como consideres necesario.

14.6.6 Follow Along: Creación de una Cubierta Atlas

A cobertura poderia ser uma camada existente, pois normalmente faz mais sentido criar uma para o propósito
específico. Vamos criar uma malha de polígonos cobertos na área florestal:
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La cubierta podría ser una capa existente, pero normalmente tiene más sentido crear una para el propósito especí-
fico. Vamos a crear una maya de polígonos cubriendo el área forestal:

• En la vista del mapa QGIS, abre Vector → Research Tools → Vector grid.

• Ajusta la herramienta como se muestra en la imagen:
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• Guarda el resultado como atlas_coverage.shp.

• Cambia el estilo de la capa kbd:atlas_coverage de modo que los polígonos no tengan relleno.

Os novos polígonos estão cobrindo toda a superfície florestal e lhe dão uma idéia de que cada mapa (criado a partir
de cada polígono) conterá.
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14.6.7 Follow Along: Configurar la Herramienta Atlas

El último paso es configurar la herramienta Atlas:

• Vuelve a Print Composer.

• En el panel de la derecha, ve a la pestaña Atlas generation.

• Configura las opciones como sigue:
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Eso le dice a la herramienta Atlas que utilice los elementos (polígonos) en atlas_coverage como foco para
cada mapa detallado. Eso obtendrá un mapa para cada elemento de la capa. La Hidden coverage layer le dice al
Atlas que no muestre los polígonos en los mapas de salida.

Una cosa más debe hacerse. Necesitas decirle a la herramienta Atlas qué elemento del mapa será actualizado para
cada mapa de salida. Por ahora, probablemente puedes suponer que el mapa a ser cambiado para cada elemento
es uno de los que has preparado para contener vistas detalladas de las parcelas de muestreo, que es el elemento
más grande del mapa de tu lienzo:

• Selecciona el elemento más grande del mapa.

• Ve a la pestaña Item properties.

• En la lista, habilita Controlled by atlas.

• Y ajusta Marging around feature a 10%. La extensión de la vista sera un 10% mayor que los polígonos, lo
que significa que tus mapas detallados tendrán un 10% superpuesto.
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Ahora puedes utilizar la herramienta de vista previa para los mapas Atlas para revisar que todos tus mapas se ven
así:

• Activate the Atlas previews using the button or if your Atlas toolbar is not visible, via Atlas → Preview
Atlas.

• Puedes utilizar las flechas de la barra del menú de la herramientas Atlas Atlas para moverte a través de los
mapas que serán creados.

Observa que algunos de ellos cubren áreas que no son interesantes. Vamos a hacer algo al respecto y salvaremos
algunos árboles al no imprimir mapas inútiles.

14.6.8 Follow Along: Edición de la Capa de Cobertura

En lugar de borrar los polígonos para esas áreas que no son interesantes, puedes también personalizar las etiquetas
de texto en tu mapa a generar con contenido de la Attribute table de tu capa de cobertura:

• Vuelve a la vista del mapa.
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• Habilita la edición de la capa atlas_coverage.

• Selecciona los polígonos que están seleccionados (en amarillo) en la imagen inferior.

• Borra los polígonos seleccionados.

• Guarda y deshabilita la edición.

Puedes volver a Print Composer y comprobar que las vistas previas del Atlas utiliza solo los polígonos que has
dejado en la capa.

La capa de cobertura que estás utilizando todavía no tiene información útil que podrías utilizar para personalizar
el contenido de las etiquetas en tu mapa. El primer paso es crearlas, puedes añadir por ejemplo un código de zona
para las áreas de los polígonos y un campo con algunas observaciones para que los equipos de campo tengan en
cuenta:

• Abre la Attribute table para la capa atlas_coverage.

• Habilita la edición.

• Use the calculator to create and populate the following two fields.

• Crea un campo llamado Zone y escribe Whole number (integer).

• En la caja Expression escribe/copia/construye $rownum.
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• Crea otro campo llamado Remarks, del tipo Text (string) y con un ancho de 255.

• En la caja Expression escribe ’No remarks.’. Esto ajustará todos los valores por defecto para todos los
polígonos.

El gestor forestal tendrá alguna información sobre el área que puede ser útil cuando visite el área. Por ejem-
plo, la existencia de un puente, un pantano o la presencia de especies protegidas. Probablemente la capa
atlas_coverage todavía está en modo edición, y el siguiente texto en el campo Remarks a los polígonos
correspondientes (haz doble clic en la celda para editarla):

• Para la Zone 2: Puente al norte de la parcela 19. Ardilla siberiana entre
p_13 y p_14..

• Para la Zone 6: Dificultad de tránsito en el pantano al norte del lago..

• Para la Zone 7: Ardilla siberiana al sureste de p_94..

• Desactiva y guarda la edición.

Casi listo, ahora tienes que decirle a la herramienta Atlas que quieres que algunas de las etiquetas de texto utilicen
la informacion de la tabla de atributos de la capa atlas_coverage:

• Vuelve a Print Composer.

• Selecciona la etiqueta de texto que contiene Detailed map....

• Ajusta el tamaño de Font a 12.

• Ajusta el cursor al final del texto en la etiqueta.

• En la pestaña Item properties, en Main properties haz clic en Insert an expression.

• En la Function list haz doble clic en el campo Zone under Field and Values.

• Haz clic en OK.

• O texto dentro da caixa no Propriedades do elemento deve mostrar Detalhe do mapa da zona
inventariada: [% "Zone" %]. Levem em conta a [% "Zone" %] será substituída pelo valor
do campo Zona para o objeto espacial correspondente da camada atlas_coverage.

Comprueba el contenido de la etiqueta mirando diferentes mapas de vista previa de Atlas.

Haz lo mismo para las etiquetas con Remarks: de texto utilizando el campo con la información de la zona.
Puedes dejar un salto de línea antes de introducir la expresión. Puedes ver el resultado para la vista previa de la
zona 2 en la imagen inferior:
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Utiliza la vista previa del Atlas para navegar a través de todos los mapas que crearás pronto, ¡y disfrútalo!

14.6.9 Follow Along: Impresión de los Mapas

Por último pero no menos importante, imprimir o exportar tus mapas a archivos de imagen o archivos PDF. Puedes
utilizar Atlas → Export Atlas as Images... o Atlas → Export Atlas as PDF.... Actualmente la exportación a formato
SGV y funciona correctamente y dará malos resultados.

Vamos a imprimir los mapas como un archivo PDF que puedes enviar a la oficina de campo para imprimir:

• Ve a la pestaña Atlas generation en el panel derecho.

• En Output activa Single file export when possible. Esto pondrá todos los mapas juntos en un archivo PDF,
si esta opción no está activada obtendrás un archivo para cada mapa.

• Abre Composer → Export as PDF....

• Guarda el archivo PDF como inventory_2012_maps.pdf en tu carpeta
exercise_data\forestry\samplig\map_creation\.

Abre el archivo PDF para comprobar que todo fué como esperabas.

Podrías crear imágenes para cada mapa así de fácil (recuerda desactivar la creación de archivos individuales), aquí
puedes ver las miniaturas de las imágenes que serían creadas:
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En Print Composer, guarda tu mapa como una plantilla compositora como forestry_atlas.qpt en tu car-
peta exercise_data\forestry\map_creation\. Utiliza Composer → Save as Template. Serás capaz
de utilizar esa plantilla una y otra vez.

Cierra Print Composer y guarda tu proyecto QGIS.

14.6.10 In Conclusion

Te las has arreglado para crear un mapa de plantilla que puede ser utilizado para generar automáticamente ma-
pas detallados para ser utilizados para ayudar a navegar hasta las diferentes parcelas. Como observaste, no fué
una tarea fácil pero el beneficio vendrá cuando necesites crear mapas similares para otras regiones utilizando la
plantilla que acabas de guardar.

14.6.11 What’s Next?

En la siguiente lección, verás cómo puedes utilizar datos LIDAR para crear un DEM y luego utilizarlo para ampliar
tus datos y la visibilidad del mapa.

14.7 Lesson: Cálculo de los Parámetros Forestales

Estimar los parámetros forestales es un objetivo del inventario forestal. Continuando el ejemplo de la lección
anterior, utilizarás la información de inventario recogida en el campo para calcular los parámetros forestales,
primero para la totalidad del monte, y luego para las masas que has digitalizado previamente.

El objetivo de esta lección: Calcular parámetros forestales a nivel general y de masas.

14.7.1 Follow Along: Adición de los Resultados de Inventario

Los equipos de campo visitaron el monte y con ayuda de la información que les proporcionaste, recogieron
información sobre el monte en cada parcela de muestreo.

Muy a menudo la información se recogerá en forma de papel en el campo, luego pasada a hojas de cálculo. La
información de las parcelas de muestreo se han comprimido en un archivo .csv que puede abrirse fácilmente en
QGIS.

Continua con el proyecto QGIS de la lección sobre el diseño de inventario, probablemente lo nombraste
forest_inventory.qgs.

Primero, añade las medidas de las parcelas de muestreo a tu proyecto QGIS:
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• Ve a Layer → Add Delimited Text Layer....

• Navega hasta el archivo systematic_inventory_results.csv localizado en
exercise_data\forestry\results\.

• Asegúrate que la opción Point coordinates está activada.

• Ajusta los campos para las coordenadas a los campos X y Y.

• Haz clic en OK.

• Cuando se requiera, selecciona ETRS89 / ETRS-TM35FIN como el SRC.

• Abre la Attribute table de la nueva capa y echa un vistazo a los datos.

Puedes leer el tipo de datos que está contenido en las medidas de las parcelas de muestreo
en el archivo de texto legend_2012_inventorydata.txt que se encuentra en la carpeta
exercise_data\forestry\results\.

La capa systematic_inventory_results que acabas de añadir es de hecho una representación virtual de
la información en texto del archivo .csv. Antes de continuar, convierte los resultados de inventario a un archivo
shape real:

• Haz clic derecho en la capa systematic_inventory_results.

• Navega hasta la carpeta exercise_data\forestry\results\.

• Nombra al archivo sample_plots_results.shp.

• Activa Add saved file to map.

• Elimina la capa systematic_inventory_results de tu proyecto.

14.7.2 Follow Along: Estimación de los Parámetros del Monte Entero

Puedes calcular las medias para el área forestal completa desde los resultados de inventario para algunos parámet-
ros interesantes, como el volumen y el número de pies por hectárea. Como las parcelas de muestreo sistemáticas
representan áreas iguales, puedes calcular directamente las medias de los volúmenes y número de pies por hectárea
desde la capa sample_plots_results.

Puedes calcular la media de un campo en la capa vectorial utilizando la herramienta Basic statistics:

• Abre Vector → Analysis Tools → Basic statistics.

• Selecciona sample_plots_results como la Input Vector Layer.

• Selecciona Vol como Target field.

• Haz clic en OK.

El volumen medio del monte es de 135.2 m3/ha.

Puedes calcular la media para el número de pies de la misma forma, 2745 stems/ha.
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14.7.3 Follow Along: stimación de los Parámetros por Masa

Puedes utilizar las mismas parcelas de muestreo sistemáticas para calcular estimaciones para diferentes masas
forestales que previamente has digitalizado. Algunas de las masas forestales no tuvieron ninguna parcela de
muestreo y para esas no obtendrás información. Podrías haber planeado algunas parcelas de muestreo extra
cuando planeaste el inventario sistemático, para que los equipos de campo hubieran medido unas pocas parcelas
de muestreo para ese propósito. O podrías enviar un equipo de campo luego para obtener la estimación de las
masas forestales que falten para completar el inventario de masas. No obstante, obtendrás información para un
buen número de masas simplemente utilizando las parcelas planeadas.

Lo que necesitas es obtener las medias de las medias de las parcelas que están incluidas dentro de cada masa
forestal. Cuando quieras combinar información basada en sus localidades relativas, realizarás una unión espacial:

• Abre la herramienta Vector → Data Management → Join attributes by location.

• Ajusta forest_stands_2012 como la Target vector layer. La capa para la que quieres los resultados.

• Ajusta sample_plots_results como la Join vector layer. La capa desde la que quieres calcular las
estimaciones.

• Activa Take summary of intersecting features.

• Activa solo el cálculo de Mean.

• Nombra al resultado forest_stands_2012_results.shp y guárdalo en la carpeta
exercise_data\forestry\results\.

• Finalmente selecciona Keep all records..., así luego podrás comprobar las masas que no obtuvieron infor-
mación.

• Haz clic en OK.

• Acepta añadir la nueva capa a tu proyecto cuando se requiera.

• Cierra la herramienta Join attributes by location.

Abre la Attribute table para forest_stands_2012_results y comprueba los resultados que has obtenido.
Observarás un número de masas forestales que tienen un valor NULL para los cálculos, esas son las que no tenían
parcelas de muestreo. Selecciónalas en la vista del mapa, son algunas de las parcelas más pequeñas:
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Vamos a calcular ahora las mismas medias para el monte entero como has hecho antes, pero esta vez utilizarás
las medias que obtuviste para las masas como las bases del cálculo. Recuerda que en la situación previa, cada
parcela de muestreo representaba una masa teórica de 80x80 m. Ahora tienes que considerar el área de cada
masa individualmente en su lugar. De este modo, de nuevo, los valores medios de los parámetros que están en,
por ejemplo, m3/ha para los volúmenes se convierten en volumen total para las masas.

Necesitas calcular primero las áreas para las masas y luego calcular volúmenes totales y número de pies para cada
una de ellas:

• Na Tabela de Atributos permita a edição.

• Abre el Field calculator.

• Crea un nuevo campo llamado area.
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• Deja el Output field type en Decimal number (real).

• Ajusta la Precision a 2.

• En la caja Expression, escribe $area / 10000. Esto calculará el área de las masas forestales en ha.

• Haz clic en OK.

Ahora calcula un campo con el volumen total y el número de pies estimados para cada masa:

• Nombra este campo s_vol and s_stem.

• Los campos pueden ser números enteros o también puedes utilizar números reales.

• Utiliza las expresiones "area" * "MEANVol" y "area" * "MEANStems" para volúmenes totales
y pies totales respectivamente.

• Guarda la edición cuando hayas terminado.

• Desactiva la edición.

En la situación anterior, las áreas representadas por cada parcela de muestreo era la misma, así que era suficiente
el cálculo de la media de las parcelas de muestreo. Ahora para calcular las estimaciones, necesitas dividir la suma
del volumen de las masas por la suma del área de las masas que contienen información.

• Na Tabela de Atributos para a camada forest_stands_2012_results, selecione todas as infor-
mações que contem por padrão.

• Abre Vector → Analysis Tools → Basic statistics.

• Selecciona forest_stands_2012_results como la Input Vector Layer.

• Selecciona area como el Target field.

• Activa Use only selected features

• Haz clic en OK.
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Como puedes ver, la suma total de las áreas de las masas es 66.04 ha. Observa que el área de las masas
forestales que faltan solo son alrededor de 7 ha.

Del mismo modo, puedes calcular que el volumen total de esas masas es 8908 m3/ha y el número total de pies
es 179594 stems.

Utilizando la información de las masas forestales, en lugar de utilizar directamente la de las parcelas de muestreo,
te da las siguientes estimaciones medias:

• 184.9 m3/ha and

• 2719 stems/ha.

Guarda tu proyecto QGIS, forest_inventory.qgs.

14.7.4 In Conclusion

Te las has arreglado para calcular las estimaciones forestales para el monte entero utilizando la información de
tus parcelas de muestreo sistemáticas, primero sin considerar las características del monte y luego utilizando la
interpretación de la imagen aérea de las masas forestales. También obtuviste alguna información valiosa sobre las
masas en particular, que podría ser utilizado para planear el manejo del monte en los próximos años.

14.7. Lesson: Cálculo de los Parámetros Forestales 369



QGIS Training Manual, Versão 2.8

14.7.5 What’s Next?

En la siguiente lección, la última de este módulo, primero crearás un fondo de sombreado del relieve desde un
conjunto de datos LiDAR que utilizarás para preparar un mapa de presentación con los resultados forestales que
acabas de calcular.

14.8 Lesson: DEM desde datos LiDAR

Puedes mejorar las vistas de tus mapas utilizando diferentes imágenes de fondo. Podrías utilizar el mápa básico o
la imágen aérea que has utilizado antes, pero un ráster del relieve sombreado del terreno se verá mejor en algunas
situaciones.

Utilizarás LAStools para extraer un DEM de un conjunto de datos LiDAR y luego crearás un ráster del sombreado
de relieve para utilizar en tu en tu presentación del mapa más tarde.

El objetivo de esta lección: Instalar LAStools y calcular un DEM desde datos LiDAR y un ráster de sombreado
de relieve.

14.8.1 Follow Along: Instalación de Lastools

El manejo de datos LiDAR dentro de QGIS es posible utilizando el Marco de procesado y los algoritmos provistos
por LAStools.

Você pode obter um modelo digital de elevação (DEM) a partir de uma nuvem de pontos LiDAR e, em seguida,
criar um raster sombreamento que é visualmente mais intuitivo para fins de apresentação. Primeiro você terá que
configurar as configurações de quadros Processamento para funcionar corretamente com LAStools:

• Si ya has iniciado QGIS, ciérralo.

• Una versión antigua del complemento lidar puede haberse instalado por defecto en tu sistema en la carpeta
C:/Program Files/QGIS Valmiera/apps/qgis/python/plugins/processing/.

• Si tienes una carpeta llamada lidar, bórrala. Esto puede ser necesario para algunas instalaciones de QGIS
2.2 y 2.4.
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• Ve a la carpeta exercise_data\forestry\lidar\, ahí puedes encontrar el archivo
QGIS_2_2_toolbox.zip. Ábrelo y extrae la carpeta lidar para reemplazar la que acabas de
borrar o renombrar.

• Si estás utilizando una versión diferente de QGIS, puedes ver más instrucciones sobre instalación en este
tutorial.

Anora necesitas instalar el LAStools en tu ordenador. Consigue la versión más nueva de lastools aquí y extrae
el contenido del archivo lastools.zip a una carpeta en tu sistema, por ejemplo, c:\lastools\. La ruta a
la carpeta lastools no puede contener espacios o carárcteres especiales.

Nota: Lee el archivo LICENSE.txt dentro de la carpeta lastools. Algunos de los LAStools son de código
abierto y otros son de código cerrado que requieren licencias para usos más comerciales y gubernamentales. Para
fines educativos y de evaluación puedes utilizar y probar LAStools tanto como necesites.

Los complementos y algoritmos actuales están instalados en tu ordenador y casi listos para su uso, solo necesitas
preparar el marco de procesado para empezar a utilizarlos:

• Abre un nuevo proyecto en QGIS.

• Ajusta el SRC del proyecto a ETRS89 / ETRS-TM35FIN.

• Guarda el proyecto como forest_lidar.qgs.

Para preparar el LAStools en QGIS:

• Ve a Processing → Options and configuration.

• En el cuadro de diálogo Processing options, ve a Providers y luego a Tools for LiDAR data.

• Habilita Activate.
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• Para LAStools folder ajusta c:\lastools\ (o la carpeta a la que extragiste LAStools).

14.8.2 Follow Along: Calculating a DEM with LAStools

Ya has utilizado la caja de herramientas Processing en el Módulo 7 para ejecutar algunos algoritmos. Ahora vas a
utilizarla para ejecutar programas de LAStools:

• Abre Processing → Toolbox.

• En el menú desplegable inferior, selecciona Advanced interface.

• Deberías ver la categoría Tools for LiDAR data.
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• Expándelo para ver las herramientas disponibles, expande también la categoría LAStools (el número de
algoritmos puede variar).

• Desplázate hacia abajo hasta encontrar el algoritmo lasview, hazle doble clic para abrirlo.

• Como Input LAS/LAZ file, navega hasta exercise_data\forestry\lidar\ y selecciona el archivo
rautjarvi_lidar.laz.
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• Haz clic en Run.

Ahora puedes ver los datos LiDAR en la ventana de diálogo:guilabel:just a little LAS and LAZ viewer.

Hay muchas cosas que puedes hacer en ese visor, pero por ahora puedes hacer clic y arrastrar en el visor para
desplazar la nube de puntos LiDAR y ver a qué se parece.

Nota: Si quieres saber información más detallada sobre cómo funciona el LAStools, puedes leer los archivos
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de texto README sobre cada una de las herramientas, en la carpeta C:\lastools\bin\. Tutoriales y otros
materiales están disponibles en Rapidlasso webpage.

• Cierra el visor cuando estés listo.

Crear un DEM con LAStools puede hacerse en dos pasos, primero clasificar la nube de puntos a puntos ground
y no ground y luego calcular un DEM utilizando solo los puntos ground.

• Vuelve a Processing Toolbox.

• Observa la caja Search..., escribe lasground.

• Haz doble clic para abrir la herramienta lasground y configúrala como se muestra en la figura:

• El archivo de salida está en la misma carpeta que rautjarvi_lidar.laz y se llama
rautjarvi_lidar_1.las.

Puedes abrirlo con lasview si quieres comprobarlo.
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Los puntos marrones son los puntos clasificados como suelo y los grises son el resto, puedes hacer clic
en la letra g para visualizar solo los puntos de tierra o la letra u‘para ver solo los puntos no
clasificados. Haz clic en la letra :kbd:‘a para ver todos los puntos de nuevo. Com-
prueba el arhivo lasview_README.txt para más comandos. Si estás interesado, también el tutorial
<http://www.rapidlasso.com/2014/03/02/tutorial-manual-lidar-editing/>‘_ sobre edición manual de puntos Li-
DAR te mostrará diversas operaciones dentro del visor.

• Vuelve a cerrar el visor.

• En la Processing Toolbox, busca las2dem.

• Abre la herramienta las2dem y configúrala como se muestra en la imagen:
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El resultado DEM se añade a tu mapa con el nombre genérico Output raster file, renombralo a
rautjarvi_dem.

Nota: Las herramientas lasground y las2dem requieren licencia. Puedes utilizar herramientas sin licencia como
se indica en el archivo licencia, pero obtendrás las diagonales que puedes apreciar en la imagen resultados.

14.8.3 Follow Along: Creación del Relieve Sombreado del Terreno

Por fines visuales, un sombreado de relieve generado desde un DEM da una mejor visualización del terreno:

• Abre Raster → Terrain analysis → Hillshade.

• Como la Capa de salida, navega hasta exercise_data\forestry\lidar\ y nombra al archivo
rautjarvi_hillshade.tif.

• Deja el resto de parámetros con los ajustes por defecto.
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• Selecciona ETRS89 / ETRS-TM35FIN como SRC cuando se requiera.

Aunque las líneas diagonales sigan en el resultado de sombreado de relieve ráster, puedes ver claramente un relieve
exacto del área. Puedes incluso ver los diferentes drenajes del suelo que se han abierto en el monte.
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14.8.4 In Conclusion

Utilizar datos LiDAR para obtener un DEM, especialmente en áreas forestales, da buenos resultados sin de-
masiados esfuerzos. También puedes utilizar listas LiDAR DEM derivados o de otras fuentes como SRTM 9m
resolution DEMs. De todas formas, puedes utilizarlos para crear un ráster de sombreado de relieve para utilizar
en tus presentaciones del mapa.

14.8.5 What’s Next?

A continuación, y lección final en este módulo, utilizarás el ráster de sombreado de relieve y los resultados fore-
stales del inventario para crear una presentación de los resultados del mapa.

14.9 Lesson: Apresentação do mapa

Nas lições anteriores você importou um antigo inventário de floresta como um projeto SIG, atualizou para a
situação atual, desenhou o inventário florestal, criou mapas para campos de trabalho e calculou parâmetros da
floresta a partir de medidas de campo.

A menudo es importante crear mapas con los resultados de un proyecto SIG. Una presentación de los resultados
del mapa del inventario forestal facilitará a cualquiera el tener una buena idea de cuales son los resultados a simple
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vista, sin mirar números específicos.

El objetivo de esta lección: Crear un mapa para presentar los resultados de inventario utilizando un ráster de
sombreado de relieve como fondo.

14.9.1 Follow Along: Prepación de los Datos del Mapa

Abre el proyecto QGIS desde la lección de cálculo de parámetros, forest_inventory.qgs. Mantén al
menos las capas siguientes:

• forest_stands_2012_results.

• basic_map.

• rautjarvi_aerial.

• lakes (si no la tienes, añádela desde la carpeta exercise_data\forestry\).

Vas a presentar los volúmenes medios de tus masas forestales en un mapa. Si abres la Attribute table para la
capa forest_stands_2012_results, podrás ver los valores NULL para las masas sin información. Para
incluir también esas masas en tu estilo deberías cambiar los valores NULL a, por ejemplo, -999, sabiendo que
esos números negativos significan que no hay datos para esos polígonos.

Para la capa forest_stands_2012_results:

• Abre la Attribute table y activa la edición.

• Selecciona los polígonos con valor NULL.

• Utiliza la calculadora para actualizar los valores del campo MEANVol a -999 solo para los elementos
seleccionados.

• Desactiva la edición y guarda los cambios.

Ahora puedes utilizar un estilo guardado para esa capa:

• Ve a la pestaña Style.

• Haz clic en Load Style.

• Selecciona forest_stands_2012_results.qml de la carpeta
exercise_data\forestry\results\.

• Haz clic en OK.
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Tu mapa se parecerá a este:
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14.9.2 Try Yourself Prueba Diferentes Modos de Mezclado

El estilo que has cargado:
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Está utilizando el modo Hard light para el Layer blending mode. Observa que los diferentes modos aplican
diferentes filtros combinando capas inferiores y superiores, en este caso se utilizan el ráster de sombreado de
relieve y tus masas forestales. Puedes leer sobre esos modos en User Guide.

Prueba modos diferentes y observa las diferencias en tu mapa. Luego elige el que más te guste para el mapa final.

14.9.3 Try Yourself Utilizar una Plantilla de Composición para Crear el Mapa
de Resultado

Utiliza una plantilla preparada para presentar los resultados. La plantilla forest_map.qpt que está en la car-
peta exercise_data\forestry\results\. Cárgalo utilizando el cuadro de diálogo Project → Composer
Manager....

14.9. Lesson: Apresentação do mapa 383

http://docs.qgis.org/2.2/en/docs/user_manual/working_with_vector/vector_properties.html


QGIS Training Manual, Versão 2.8

Abre el compositor de mapa y edita el mapa final para obtener un resultado con el que estés contento.

La plantilla de mapa que estás utilizando dará un mapa similar a este:
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Guarda tu proyecto QGIS para futuras referencias.
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14.9.4 In Conclusion

A través de este módulo has visto cómo un inventario forestal básico puede ser planificado y presentado con QGIS.
Muchos más análisis forestales son posibles con la variedad de herramientas a las que tienes acceso, pero afortu-
nadamente este manual te ha dado un buen punto de inicio para explorar cómo podrías conseguir los resultados
específicos que necesites.
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CHAPTER 15

Module: Conceitos de Base de Dados com PostgreSQL

Bancos de dados relacionais são uma parte importante de qualquer sistema SIG. Neste módulo, você aprenderá
conceitos sobre Sistema de Gerenciamento de Banco de Dados Relacionais (RDBMS) e vai usar o PostgreSQL
para criar um novo banco para armazenar dados, bem como aprender sobre outras funções típicas de RDBMS.

15.1 Lesson: Introdução às Bases de Dados

Antes de usarmos o PostgreSQL, vamos ficar mais seguros cobrindo a teoria geral de banco de dados. Você não
precisa entrar com nenhum código dos exemplos; eles estão lá somente com o propósito de ilustrar.

O objetivo desta lição: Compreender os conceitos fundamentais das bases de dados.

15.1.1 O que é um banco de dados?

Um banco de dados consiste em uma coleção organizada de dados para um ou mais usos, tipicamente na forma
digital. - Wikipedia

Um sistema gerenciador de banco de dados (SGBD) consiste em um software que opera bases de dados, propor-
cionando o armazenamento, acesso, segurança, backup e outras facilidades. - Wikipedia

15.1.2 Tabelas

Em bancos de dados relacionais e bases de dados em arquivos simples, uma tabela é um conjunto de elementos
de dados (valores) que estão organizados usando um modelo de colunas verticais (que são identificadas por seu
nome) e linhas horizontais. Uma tabela tem um número específico de colunas, mas pode ter um número qualquer
de linhas. Cada linha é identificada pelos valores que aparecem em um conjunto particular de colunas que tenham
sido identificadas como chaves candidatas. - Wikipedia

id | name | age
----+-------+-----

1 | Tim | 20
2 | Horst | 88

(2 rows)

Em bancos de dados SQL, uma tabela é também conhecida como uma relação.

15.1.3 Colunas / Campos

Uma coluna é um conjunto de valores de um tipo particular de dados, um para cada linha da tabela. As colunas
fornecem a estrutura com a qual as linhas são compostas. O termo “campo” é muitas vezes utilizado alternada-
mente com o termo “coluna”, embora muitos considerem mais correto usar campo (ou valor de campo) para se
referir especificamente a um simples item que exista na interseção entre uma linha e uma coluna. - Wikipedia
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Uma coluna:

| name |
+-------+
| Tim |
| Horst |

Um campo:

| Horst |

15.1.4 Registros

Um registro é a informação armazenada em uma linha da tabela. Cada registro terá um campo para cada coluna
na tabela.

2 | Horst | 88 <-- one record

15.1.5 Tipos de dados

Tipos de dados restringem o tipo de informação que pode ser armazenado em uma coluna. - Tim and Horst

Existem várias classes de tipos de dados. Vamos focar nas mais comuns:

• String - para armazenar dados textuais de forma livre

• Integer - para armazenar números inteiros

• Real - para armazenar números com casas decimais

• Date - para armazenar datas

• Boolean - para armazenar valores verdadeiro/falso simples

Você pode dizer ao banco de dados para permitir que você não armazene nada em um campo. Se não houver nada
em um campo, então o conteúdo do campo é referido como um valor ‘null’:

insert into person (age) values (40);

select * from person;

Resultados:

id | name | age
----+-------+-----
1 | Tim | 20
2 | Horst | 88
4 | | 40 <-- null for name

(3 rows)

Existem muito mais tipos de dados que você pode usar - verifique no manual do PostgreSQL!

15.1.6 Modelando um banco de dados de Endereços

Vamos usar um estudo de caso simples para ver como um banco de dados é construído. Queremos criar um banco
de dados de endereços.
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Try Yourself

Anote as propriedades que compõem um endereço simples e que gostariamos de armazenar em nosso banco de
dados.

Verifique seus resultados

Estrutura de endereço

As propriedades que descrevem um endereço são as colunas. O tipo das informações armazenadas em cada
coluna é o seu tipo de dado. Na próxima seção vamos analisar nossa tabela de endereços conceitual para ver como
podemos fazê-la melhor!

15.1.7 Teoria de banco de dados

O processo de criação de um banco de dados envolve a criação de um modelo do mundo real; tomando conceitos
do mundo real e representando-os no banco de dados como entidades.

15.1.8 Normalização

Uma das principais idéias em um banco de dados é evitar a duplicação de dados / redundância. O processo de
remoção de redundância de um banco de dados é chamado de Normalização.

A normalização é uma forma sistemática de garantir que a estrutura do banco de dados é adequada para uso geral
de consulta e isento de certas características indesejáveis - anomalias na inserção, atualização e exclusão - que
poderia levar a uma perda de integridade dos dados. * - * Wikipedia

Existem diferentes ‘formas’ de normalização.

Vejamos um exemplo simples:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-----------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address | phone_no
--+---------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Imagine que você tem muitos amigos com o mesmo nome de rua ou cidade. Cada vez que os dados são duplicados,
consome-se espaço. Pior ainda, se um nome de cidade muda, você tem que fazer um monte de trabalho para
atualizar seu banco de dados.
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15.1.9 Try Yourself

Redesenhando a tabela teórica people acima para reduzir a duplicação e para normalizar a estrutura de dados.

Você pode ler mais sobre normalização de banco de dados aqui

Verifique seus resultados

15.1.10 Índices

Um índice de banco de dados é uma estrutura de dados que aumenta a velocidade da operação de recuperação de
dados de uma tabela de banco de dados. * - * Wikipedia

Imagine que você está lendo um livro e procurando pela explicação de um conceito - e o livro não tem nenhum
índice! Você vai ter que começar a ler da capa e seguir através de todo o livro até encontrar a informação que
você precisa. O índice na parte de trás de um livro ajuda-o a saltar rapidamente para a página com as informações
relevantes:

create index person_name_idx on people (name);

Agora pesquisas com nome serão mais rápidas:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-----------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Sequencias

Uma sequência é um gerador de número único. É normalmente utilizado para criar um identificador único para
uma coluna na tabela.

Neste exemplo, id é uma sequencia - o número é incrementado cada vez que um registro é adicionado à tabela:

id | name | address | phone_no
---+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

15.1.12 Diagrama Entidade-relacionamento

Em um banco de dados normalizado, você normalmente tem muitas relações (tabelas). O diagrama de entidade-
relacionamento (Diagrama ER) é usado para projetar as dependências lógicas entre as relações. Considere a nossa
não-normalizada tabela people do início da lição:

select * from people;

id | name | address | phone_no
----+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
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2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122
(2 rows)

Com um pouco de esforço, podemos dividi-la em duas tabelas, eliminando a necessidade de repetir o nome da rua
para as pessoas que vivem na mesma rua:

select * from streets;

id | name
----+--------------
1 | Plein Street

(1 row)

e:

select * from people;

id | name | house_no | street_id | phone_no
----+--------------+----------+-----------+-------------

1 | Horst Duster | 4 | 1 | 072 121 122
(1 row)

Podemos, então, ligar as duas tabelas usando as “chaves”: kbd: streets.id e: kbd:‘ people.streets_id‘.

Se desenharmos um Diagrama ER para essas duas tabelas, será algo parecido com isto:

O Diagrama ER nos ajuda a expressar relacionamentos “um para muitos”. Neste caso, o símbolo de seta mostra
que uma rua pode ter muitas pessoas vivendo nela.

Try Yourself

Nosso modelo people ainda tem alguns problemas de normalização - veja se você consegue normalizá-lo ainda
mais e representá-lo por meio de um Diagrama ER.

Confira seus resultados

15.1.13 Restrições, Chaves Primárias e Chaves Estrangeiras

Uma restrição de banco de dados é utilizada para assegurar que os dados numa relação correspondam ao ponto
de vista do modelador de como que os dados devem ser armazenados. Por exemplo, uma restrição em seu código
postal poderia garantir que o número caia entre: kbd: 1000 e: kbd:‘ 9999‘.

Uma chave primária é composta de um ou mais valores de campo que tornam um registro único. Normalmente, a
chave primária é chamada id e é uma sequência.

Uma chave estrangeira é usada para se referir a um único registro em outra tabela (usando a chave primária dessa
outra tabela).

Em um diagrama ER, a ligação entre as tabelas é normalmente baseada em chaves estrangeiras que se ligam a
chaves primárias.

Se olharmos para o nosso exemplo “people”, a definição da tabela mostra que a coluna “street_id” é uma chave
estrangeira que referencia a chave primária na tabela “street”:
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Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

15.1.14 Transações

Ao adicionar, alterar ou excluir dados em um banco de dados, é sempre importante que o banco de dados possa
ser deixado em um estado bom se algo der errado. A maioria dos bancos de dados fornecem um recurso chamado
suporte a transações. Transações permitem que você crie uma posição de “rollback” podendo voltar a esse ponto
caso suas modificações ao banco de dados não ocorram conforme planejado.

Tome um cenário onde você tem um sistema de contabilidade. Você precisa transferir fundos de uma conta e
adicioná-los à outro. A sequência de etapas seria assim:

• remover R20 do Joe

• adicionar R20 para a Anne

Se algo der errado durante o processo (por exemplo, falha de energia), a transação será revertida.

15.1.15 In Conclusion

Bancos de dados permitem que você gerencie os dados de forma estruturada usando estruturas de código simples.

15.1.16 What’s Next?

Agora que já vimos como bancos de dados funcionam na teoria, vamos criar um novo banco de dados para
implementar a teoria que nós cobrimos.

15.2 Lesson: Implementando o Modelo de Dado

Agora que nós cobrimos toda a teoria, vamos criar um novo banco de dados. Esta base de dados será utilizada
para nossos exercícios para as aulas que seguirão depois.

A meta para esta lição: Instalar o software necessário e usá-lo para implementar o nosso banco de dados de
exemplo .

15.2.1 Instalar PostgreSQL

Nota: Embora fora do escopo deste documento , os usuários de Mac podem instalar PostgreSQL usando ‘
Homebrew <http://russbrooks.com/2010/11/25/install-postgresql-9-on-os-x> ‘ _ . Usuários do Windows podem
usar o instalador gráfico localizado aqui: ‘< http://www.postgresql.org/download/windows/ > ‘ _ . Por favor, note
que a documentação assumirá os usuários estão executando QGIS no Ubuntu .
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Nos termos do Ubuntu:

sudo apt-get install postgresql-9.1

Você deverá receber uma mensagem como esta:

[sudo] password for qgis:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
postgresql-client-9.1 postgresql-client-common postgresql-common
Suggested packages:
oidentd ident-server postgresql-doc-9.1
The following NEW packages will be installed:
postgresql-9.1 postgresql-client-9.1 postgresql-client-common postgresql-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.
Need to get 5,012kB of archives.
After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Pressione Y e Enter e aguarde o download e instalação terminar.

15.2.2 Ajuda

PostgreSQL tem muito boa documentação‘ on-line < http://www.postgresql.org/docs/9.1/static/index.html > ‘ .

15.2.3 Crie um usuário de banco de dados

Nos termos do Ubuntu:

Depois de concluída a instalação, execute este comando para tornar-se o usuário postgres e, em seguida, crie um
novo usuário do banco de dados:

sudo su - postgres

Digite o seu log normal e senha quando solicitado ( você precisa ter os direitos do sudo ) .

Agora, no prompt bash do usuário postgres , criar o usuário do banco de dados . Certifique-se o nome de usuário
corresponde ao seu nome de login unix : isto vai fazer a sua vida muito mais fácil, como postgres será automati-
camente autenticado quando você está logado como usuário

createuser -d -E -i -l -P -r -s qgis

Entre com a senha quando solicitado. Você deverá usar uma senha diferente para sua senha.

O que essas opções sugerem?

-d, --createdb role can create new databases
-E, --encrypted encrypt stored password
-i, --inherit role inherits privileges of roles it is a member of (default)
-l, --login role can login (default)
-P, --pwprompt assign a password to new role
-r, --createrole role can create new roles
-s, --superuser role will be superuser

Agora você deve deve deixar o ambiente do usuário postgres na tela de linha de comandos bash digitando

exit
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15.2.4 Verifique a nova conta

psql -l

Deve retornar algo como isso:

Name | Owner | Encoding | Collation | Ctype |
----------+----------+----------+------------+------------+
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
(3 rows)

Digite q para sair.

15.2.5 Criar um banco de dados

O comando createdb é usado para criar um novo banco de dados. Ele deve ser executado a partir do prompt
shell bash:

createdb address -O qgis

Você pode verificar a existência do seu novo banco de dados usando o seguinte comando:

psql -l

Que deve retornar algo como isso:

Name | Owner | Encoding | Collation | Ctype | Access privileges
----------+----------+----------+------------+------------+-----------------------
address | qgis | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres: postgres=CTc/postgres
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres: postgres=CTc/postgres
(4 rows)

Digite q para sair.

15.2.6 Iniciar uma sessão de tela de linha de comandos de banco de dados

Você pode conectar facilmente seu banco de dados desta forma:

psql address

Para sair da tela de linha de comando do psql, digite:

\q

Para ajuda no uso da tela de linha de comandos, digite:

\?

Para ajuda no uso dos comandos sql , digite:

\help

Para obter ajuda de um comando específico, digite (por exemplo):

\help create table

Veja também uma referência, em inglês, de Psql disponível online aqui.
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15.2.7 Faça tabelas em SQL

Vamos começar fazendo algumas tabelas! Nós usaremos nosso Diagrama ER como guia. Primeiro conecte-se ao
bd “address”:

psql address

Então crie uma tabela streets:

create table streets (id serial not null primary key, name varchar(50));

serial e varchar são tipos de dados. serial diz para o PostgreSQL iniciar uma sequência inteira (auto-
número) para preencher o id automaticamente para cada novo registro. :kbd:‘ varchar(50)‘ diz para o PostgreSQL
criar um campo de caracteres de 50 caracteres de comprimento.

Você vai notar que o comando termina com um ; - todos os comandos SQL devem ser encerrados desta forma.
Ao pressionar enter, o psql irá relatar algo como isto:

NOTICE: CREATE TABLE will create implicit sequence "streets_id_seq" for
serial column "streets.id"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index "streets_pkey"
for table "streets"

CREATE TABLE

Isto quer dizer que sua tabela foi criada com sucesso, com a chave primária streets_pkey usando
streets.id.

Nota: Se você apertar “enter” sem inserir ;, então você receberá um aviso como este: address-#. Isto porque
o PG está esperando que você digite mais. Digite ; para executar o seu comando .

Para ver o esquema da sua tabela, você pode fazer isso:

\d streets

Que deve mostrar algo como isso:

Table "public.streets"
Column | Type | Modifiers

--------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval(’streets_id_seq’::regclass)
name | character varying(50) |

Indexes:
"streets_pkey" PRIMARY KEY, btree (id)

Para visualizar o conteúdo de sua tabela, você deve fazer isso:

select * from streets;

Que deve mostrar algo como isso:

id | name
---+------
(0 rows)

Como você pode ver, sua tabela, no momento, está vazia.

Try Yourself

Use a abordagem mostrada acima para fazer uma tabela chamada people:

Adicione campos como número de telefone, endereço de casa, nome, etc (estes não são todos os nomes válidos:
troque para validá-los). Tenha certeza que pegou a tabela com ID coluna com o mesmo tipo de informação acima.

Check your results
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15.2.8 Crie chaves no SQL

O problema com a nossa solução acima é que o banco de dados não sabe que as pessoas e as ruas têm uma relação
lógica. Para expressar esta relação , temos que definir uma chave estrangeira que aponta para a chave primária da
tabela de ruas .

Existem duas formas de fazer isso:

• Adicione a chave após a tabela ser criada

• Defina uma chave no momento da criação da tabela

Nossa tabela foi criada, agora vamos fazer isso primeiramente:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

Que diz a tabela people que os seus campos street_id deve corresponder uma rua válida id da tabela
streets.

A forma mais usual de criar uma restrição é fazer isso quando você cria uma tebela:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int references streets(id) not null,
phone_no varchar null);

\d people

Após adicionar uma restrição, nosso esquema de tabela deve parecer com isso:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+---------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.9 Criar Índices em SQL

Queremos buscas relâmpago em nomes de pessoas. Para fornecer para isso, podemos criar um índice na coluna
nome da tabela pessoas

create index people_name_idx on people(name);

\d people

Que resulta em:
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Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-----------------------------------
id | integer | not null default nextval

| | (’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name) <-- new index added!

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.10 Descartando tabelas em SQL

Se você quiser se livrar de uma tabela você pode usar o comando drop:

drop table streets;

Nota: No nosso exemplo atual, o comando acima não iria funcionar. Por que não? : ref:Veja porque <database-
concepts-5>

Se você usou o mesmo comando:kbd:”drop table” na tabela ‘people’, isso deve dar certo:

drop table people;

Nota: Se você realmente entrou com esse comando e descartou a tabela people, agora seria um bom momento
para reconstruí-la, já que você vai precisar dela para os próximos exercícios.

15.2.11 Uma palavra sobre pgAdmin III

Estamos mostrando-lhe os comandos SQL do prompt de psql porque é uma forma muito útil para aprender so-
bre bancos de dados. No entanto, existem maneiras mais rápidas e mais fáceis de fazer muito do que estamos
mostrando. Instale pgAdmin III e você poderá criar, descartar, alterar etc, tabelas usando ‘apontar e clicar’ em
operações com uma GUI.

Sob o Ubuntu, você pode instalá-lo desta forma:

sudo apt-get install pgadmin3

O pgAdmin III será abordado em mais detalhes em outro módulo.

15.2.12 In Conclusion

Agora você já viu como criar um novo banco de dados, a partir do zero.

15.2.13 What’s Next?

Em seguida, você vai aprender como usar os DBMS para adicionar novos dados.
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15.3 Lesson: Agregar datos al Modelo

Los modelos que hemos creado ahora tendrá que ser llenado con los datos que están destinados a contener.

La meta para esta lección Para aprender cómo insertar nuevos datos al modelo de base de datos.

15.3.1 Insertar sentencia

¿Cómo añadir datos a una tabla? La sentencia sql INSERT proporciona la funcionalidad para esto:

insert into streets (name) values (’High street’);

Un par de cosas a tener en cuenta:

• Después el nombre de la tabla (streets), se enlistan los nombres de columnas que serán llenadas (en este
caso solo la columna name).

• Después de la palabra clave :kbd:’valores’, coloque la lista de valores del campo

• Las cadenas deben ser citadas utilizando comillas simples.

• Tome en cuenta que no insertamos un valor a la columna id; esto es porque es una secuencia y será
auntogenerada.

• Si establece manualmente el: kbd: id, puede causar serios problemas a la integridad de su base de datos.

Debe ver INSERT 0 1 si es exitoso.

Puede ver el resultado de la acción insertar al seleccionar todos los datos de la tabla:

select * from streets;

Resultados:

select * from streets;
id | name

----+-------------
1 | High street

(1 row)

Try Yourself

Use el comando INSERT para agregar una nueva calle a la tabla streets.

Verifique sus resultados

15.3.2 Secuencia de datos Adición Según Restricciones

15.3.3 Try Yourself

Intente añadir un objeto persona a la tabla people con los siguientes detalles:

Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21
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Nota: Recodemos que en este ejemplo, definimos números de teléfono como cadenas y no como números enteros.

En este punto, debe tener un reporte de error, si intentó hacerlo sin antes crear un registro para la Main Street en
la tabla de streets.

También debe haber notado que:

• No se puede añadir la calle utilizando su nombre

• No se puede añadir una calle utilizando un id de una calle antes , primero se crea el registro de la calle en
la tabla de streets

Recordar que nuestras tablas estan vinculadas por un par de llave primaria/foreana. Esto significa que ninguna
persona válida puede ser creado sin que exista también un récord calle correspondiente válida.

Usar el conocimiento previo, añadir la nueva persona a la base de datos.

Verifique sus resultados

15.3.4 Seleccionar datos

Se ha mostrado ya la sintaxis para seleccionar registros. Vamos a ver algunos ejemplos:

select name from streets;

select * from streets;

select * from streets where name=’Main Road’;

En sesiones posteriores, vamos a entrar en más detalle sobre como seleccionar y filtrar datos.

15.3.5 Actualizar datos

¿pasa si se quiere hacer un cambio en algunos de los datos existentes? Por ejemplo, un nombre de calle se cambia:

update streets set name=’New Main Road’ where name=’Main Road’;

Tenga mucho cuidado al utilizar este tipo de sentencias de actualización - si más de un registro coincide con su
cláusula WHERE, ¡todos serán actualizados!

Una mejor solución es usar la llave primaria de la tabla para referenciar el registro que se desea cambiar.

update streets set name=’New Main Road’ where id=2;

Debe regresar UPDATE 1.

Nota: El criterio de la cláusula WHERE distingue entre mayúsculas y minúsculas Main Road no es lo mismo
que Main road

15.3.6 Eliminar datos

Para eliminar un objeto de una tabla, utilice el comando DELETE:

delete from people where name = ’Joe Smith’;

Vamos a ver nuestra tabla de people ahora:
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address=# select * from people;

id | name | house_no | street_id | phone_no
----+------+----------+-----------+----------

(0 rows)

15.3.7 Try Yourself

Use las habilidades que ha aprendido para añadir algunos nuevos amigos a su base de datos:

name | house_no | street_id | phone_no
-----------------+----------+-----------+--------------
Joe Bloggs | 3 | 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones | 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

15.3.8 In Conclusion

Ahora que sabe como añadir nuevos datos a los modelos existentes que se crearon previamente. Recordar que si
se quiere añadir nuevos tipos de datos, es posible que se desee modificar y/o crear nuevos modelos para contener
los datos.

15.3.9 What’s Next?

Ahora que se han añadido algunos datos, aprenderá cómo utilizar las consultas para acceder a estos datos de
diferentes maneras.

15.4 Lesson: Consultas

Quando você escreve um comando SELECT ... é comumente conhecido como uma consulta - você está inter-
rogando o banco de dados para obter informações.

O objetivo dessa lição: Saber como criar consultas que retornam informações úteis.

Nota: Se você não o fez na lição anterior, adicione nos seguintes objetos pessoais para a sua tabela people.
Se você receber erros relacionados a restrições de chave estrangeira, você vai precisar adicionar o objeto ‘Main
Road’ para a sua mesa ruas primeira

insert into people (name,house_no, street_id, phone_no)
values (’Joe Bloggs’,3,2,’072 887 23 45’);

insert into people (name,house_no, street_id, phone_no)
values (’Jane Smith’,55,3,’072 837 33 35’);

insert into people (name,house_no, street_id, phone_no)
values (’Roger Jones’,33,1,’072 832 31 38’);

insert into people (name,house_no, street_id, phone_no)
values (’Sally Norman’,83,1,’072 932 31 32’);

15.4.1 Ordenando os resultados

Vamos recuperar uma lista de pessoas ordenadas pelos seus números de casa
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select name, house_no from people order by house_no;

Resultados:

name | house_no
--------------+----------
Joe Bloggs | 3
Roger Jones | 33
Jane Smith | 55
Sally Norman | 83

(4 rows)

Você pode classificar os resultados por os valores de mais de uma coluna:

select name, house_no from people order by name, house_no;

Resultados:

name | house_no
--------------+----------
Jane Smith | 55
Joe Bloggs | 3
Roger Jones | 33
Sally Norman | 83

(4 rows)

15.4.2 filtragem

Muitas vezes, você não vai querer ver cada registro único na base de dados - especialmente se existem milhares
de registros e você está interessado apenas em ver um ou dois.

Aqui está um exemplo de um filtro numérico que só retorna objetos cuja house_no é inferior a 50:

select name, house_no from people where house_no < 50;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Você pode combinar filtros (definida usando a cláusula WHERE) com a classificação (definido usando a cláusula
ORDER BY):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Você também pode filtrar com base em dados de texto:

select name, house_no from people where name like ’%s%’;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

15.4. Lesson: Consultas 401



QGIS Training Manual, Versão 2.8

Aqui usamos a cláusula LIKE para encontrar todos os nomes com um s neles. Você notará que esta consulta é
sensível ao caso, por isso a entrada Sally Norman não foi devolvida.

Se você quiser procurar por uma sequência de letras, independentemente do caso, você pode fazer um caso sensível
pesquisa usando a cláusula :kbd: ILIKE:

select name, house_no from people where name ilike ’%r%’;

name | house_no
--------------+----------
Roger Jones | 33
Sally Norman | 83
(2 rows)

Essa consulta retornou cada objeto people com um r ou R em seu nome.

15.4.3 Uniões

E se você quiser ver os detalhes da pessoa e nome de sua rua, em vez do ID? Para fazer isso, você precisa juntar
as duas tabelas em conjunto em uma única consulta. Vejamos um exemplo:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Nota: Estando unidas, você sempre irá indicar as duas tabelas que as informações sejam provenientes, neste caso,
as pessoas e as ruas. Você também precisa especificar quais duas chaves devem coincidir (chave estrangeira &
chave primária). Se você não especificar isso, você terá uma lista de todas as combinações possíveis de pessoas e
ruas, mas não há maneira de saber quem realmente vive em que rua!

Aqui está como a saída correta será parecida:

name | house_no | name
--------------+----------+-------------
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

Vamos revisitar a união como criar consultas mais complexas mais tarde. Apenas lembre-se que eles fornecem
uma maneira simples de combinar as informações a partir de duas ou mais tabelas.

15.4.4 Sub-Seleção

Sub-seleções permitem selecionar objetos de uma tabela com base nos dados de outra tabela que está ligada
através de uma relação de chave estrangeira. No nosso caso, queremos encontrar pessoas que vivem em uma rua
específica.

Em primeiro lugar, vamos fazer um pequeno ajuste em nossos dados:

insert into streets (name) values(’QGIS Road’);
insert into streets (name) values(’OGR Corner’);
insert into streets (name) values(’Goodle Square’);
update people set street_id = 2 where id=2;
update people set street_id = 3 where id=3;

Vamos dar uma rápida olhada em nossos dados após essas alterações: podemos reutilizar nossa consulta da seção
anterior:
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select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Resultados:

name | house_no | name
--------------+----------+-------------
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road
Joe Bloggs | 3 | Low Street

(4 rows)

Agora, vamos mostrar-lhe uma sub-seleção desses dados. Queremos mostrar apenas as pessoas que vivem no
número street_id 1:

select people.name
from people, (

select *
from streets
where id=1

) as streets_subset
where people.street_id = streets_subset.id;

Resultados:

name
--------------
Roger Jones
Sally Norman

(2 rows)

Embora este seja um exemplo muito simples e desnecessário com os nossos pequenos conjuntos de dados, ele
ilusta como sub-seleções úteis e importantes pode ser ao consultar conjuntos de dados grandes e complexos.

15.4.5 Consultas agregadas

Uma das características marcantes de uma base de dados é a sua capacidade para resumir os dados em suas tabelas.
Esses resumos são chamados de consultas agregadas. Aqui está um exemplo típico que nos diz quantos objetos
pessoas estão em nossa tabela pessoas

select count(*) from people;

Resultados:

count
-------

4
(1 row)

Se queremos que as contagens de seja resumida por nome de rua podemos fazer isso:

select count(name), street_id
from people
group by street_id;

Resultados:

count | street_id
-------+-----------

2 | 1
1 | 3
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1 | 2
(3 rows)

Nota: Porque nós não usamos uma cláusula ORDER BY, a ordem de seus resultados podem não coincidir com o
que é mostrado aqui.

Try Yourself

Resumir as pessoas pelo nome de rua e mostrar os nomes de ruas reais em vez das street_ids.

Confira seus resultados

15.4.6 In Conclusion

Você já viu como utilizar as consultas para retornar os dados em seu banco de dados de uma forma que lhe permite
extrair informações úteis a partir dele.

15.4.7 What’s Next?

Em seguida, você verá como criar visualização com as consultas que você escreveu.

15.5 Lesson: Vistas

Cuando se escribe una consulta, debe pasar mucho tiempo y esfuerzo para formularla. Con vistas, se puede
guardar la definición de una consulta SQL en una reutilizable ‘tabla virtual’

El objetivo de esta lección: Guardar una consulta como una vista.

15.5.1 Crear una vista

Se puede tratar una vista solo como una tabla, pero sus datos es de origen de una consulta. Vamos a hacer una
vista simple basado en lo anterior:

create view roads_count_v as
select count(people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;

Como puede ver Los cambios solo son en la parte Crea una vista roads_count_v as al inicio. Pode-
mos ahora seleccionar datos de esa vista:

select * from roads_count_v;

Resultado:

count | name
-------+-------------

1 | Main Road
2 | High street
1 | Low Street

(3 rows)
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15.5.2 Modificar una vista

Una vista no está fija, y no contiene ‘datos reales’. Esto significa que puede cambiar fácilmente sin impactar en
cualquier dato de la base de datos.

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count(people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;

(Este ejemplo muestra también la mejor practica de convención de la utilización UPPER CASE para todas la
palabras clave SQL.)

Verá que hemos añadido una cláusula ORDER BY para que las filas de nuestras vistas estén muy bien ordenados:

select * from roads_count_v;

count | name
-------+-------------

2 | High street
1 | Low Street
1 | Main Road

(3 rows)

15.5.3 Eliminar una Vista

Si ya no necesita una vista, puede eliminarlo con este:

drop view roads_count_v;

15.5.4 In Conclusion

Usar vistas, puede guardar una consulta y acceder a los resultados como si fuera una tabla.

15.5.5 What’s Next?

Algunas veces, cuando cambia datos, quiere que los cambios tengan efecto entre otra parte en la base de datos. La
siguiente lección mostrará cómo puede hacer esto.

15.6 Lesson: Regras

As regras permitem a “árvore de comando” de uma consulta de entrada para ser reescrito. Um uso comum é a
implementação de pontos de vista, incluindo visão atualizável. - Wikipedia

O objetivo dessa lição: Aprender a criar novas regras para o banco de dados.

15.6.1 Visualizações Materializadas (Visualizações baseada em regra)

Digamos que você queira registrar cada mudança de phone_no em sua tabela de pessoas em a uma tabela peo-
ple_log. Então você configurar uma nova tabela

create table people_log (name text, time timestamp default NOW());

No próximo passo, criar uma regra que registra todas as alterações de uma phone_no na tabela de pessoas na
tabela de people_log
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create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);

Para testar se a regra funciona, vamos modificar um número de telefone

update people set phone_no = ’082 555 1234’ where id = 2;

Verifique se pessoas tabela foi atualizado corretamente

select * from people where id=2;

id | name | house_no | street_id | phone_no
----+------------+----------+-----------+--------------

2 | Joe Bloggs | 3 | 2 | 082 555 1234
(1 row)

Agora, graças à regra que criamos, a tabela people_log será parecido com isto

select * from people_log;

name | time
------------+----------------------------
Joe Bloggs | 2014-01-11 14:15:11.953141

(1 row)

Nota: O valor do campo time vai depender da data e hora atual.

15.6.2 In Conclusion

As regras permitem que você automaticamente adicione ou altere dados em seu banco de dados para refletir
mudanças em outras partes do banco de dados.

15.6.3 What’s Next?

O próximo módulo irá apresentá-lo ao banco de dados espacial com PostGIS, que leva esses conceitos de banco
de dados e os aplica a dados GIS.
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CHAPTER 16

Module: Conceitos de Bases de Dados Espaciais com PostGIS

Base de datos espacial permite el almacenamiento de las geometrías de los registros dentro de una base de datos así
como proveer funcionalidades para consultar y recuperar registros que utilizan estas geometrías. En este modulo
nosotros usaremos PostGIS, una extensión de PostgreSQL, para aprender como instalar una base de datos espacial,
importar datos desde shapefiles a la base de datos y usar las funciones geográficas que PostGIS ofrece.

Mientras trabaja en esta sección, es posible que desee guardar la hoja de trucos de PostGIS
</static/training_manual/postgis/postgis_cheatsheet.pdf>‘_ disponible desde el grupo de usuarios Boston GIS
<http://www.bostongis.com/postgis_quickguide.bqg>_. Otro recurso útil es la documentación en línea de PostGIS
<http://postgis.net/docs/>‘.

También hay algunos tutoriales extensos sobre PostGIS y base de datos espaciales disponibles de Boundless Geo:

• Introducción a PostGIS <http://workshops.boundlessgeo.com/postgis-intro/>‘_

• Concejos y trucos de Base de datos espacial <http://workshops.boundlessgeo.com/postgis-spatialdbtips/>‘_

Ver también PostGIS en línea <http://postgisonline.org/>

16.1 Lesson: Configuração PostGIS

Configurando funções PostGIS lhe permitirá acessar as funções espaciais de dentro do PostgreSQL.

O objetivo desta lição: Instalar funções espaciais e demonstrar brevemente os seus efeitos.

Nota: Vamos assumir o uso de PostGIS versão 2.1 neste exercício. A instalação e configuração do banco de
dados são diferentes para versões mais antigas, mas o resto deste material neste módulo continuará a funcionar.
Consulte a documentação para a sua plataforma para ajudar com a instalação e configuração do banco de dados.

16.1.1 Instalando no Ubuntu

PostGIS é facilmente instalado a partir de apt.

$ sudo apt-get install postgis
$ sudo apt-get install postgresql-9.1-postgis

Realmente, não é assim tão fácil ...

Nota: Dependendo de qual versão do Ubuntu você está usando e quais repositórios você tiver configurado, esses
comandos irão instalar o PostGIS 1.5 ou o 2.x. Você pode encontrar a versão instalada emitindo uma consulta
select postgis_full_version(); com psql ou outra ferramenta.

Para instalar a versão mais recente do PostGIS, você pode usar os seguintes comandos:
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$ sudo apt-add-repository ppa:sharpie/for-science
$ sudo apt-add-repository ppa:sharpie/postgis-nightly
$ sudo apt-get update
$ sudo apt-get install postgresql-9.1-postgis-nightly

16.1.2 Instalando no Windows

Instalar no Windows é um pouco mais complicado, mas não é difícil. Note que você precisa estar on-line para
instalar o postgis.

Primeiro, visite a página de download.

Depois, siga este guia.

Mais informações sobre a instalação em Windows podem ser encontradas no website do PostGIS.

16.1.3 Instalando em outras plataformas

O site de download do PostGIS tem informações sobre a instalação em outras plataformas, incluindo MacOSX e
em outras distribuições linux.

16.1.4 Configurando Bancos de Dados para usar PostGIS

Uma vez que o PostGIS esteja instalado, você precisará configurar seu banco de dados para usar as extensões.
Se você tiver instalado o PostGIS versão > 2.0, bastará simplesmente emitir o seguinte comando, com o psql,
utilizando o banco de dados “address” do nosso exercício anterior:

$ psql -d address -c "CREATE EXTENSION postgis;"

Nota: Se você estiver usando o PostGIS 1.5 e uma versão do PostgreSQL inferior a 9.1, você terá que seguir
um conjunto diferente de medidas a fim de instalar as extensões PostGIS para o seu banco de dados. Por favor,
consulte a Documentação do PostGIS para obter instruções sobre como fazer isso. Há também algumas instruções
na versão anterior deste manual.

16.1.5 Olhando para as funções instaladas do PostGIS

O PostGIS pode ser visualizado como uma coleção de funções no banco de dados que ampliam as capacidades do
núcleo do PostgreSQL para que ele possa lidar com dados espaciais. Por ‘lidar com’, queremos dizer armazenar,
recuperar, consultar e manipular. A fim de fazer isso, um número de funções são instaladas no banco de dados.

Nosso banco de dados PostgreSQL address agora está geoespacialmente habilitado, graças ao PostGIS. Vamos
nos aprofundar muito mais nisso nas próximas seções, mas vamos dar-lhe um pouquinho do gosto. Vamos dizer
que queremos criar um ponto a partir de um texto. Primeiro, use o comando psql para encontrar funções rela-
cionadas a ponto. Se você ainda não estiver conectado ao banco de dados address, faça isso agora. Em seguida,
execute:

\df *point*

Este é o comando que estamos procurando: st_pointfromtext. Para percorrer a lista, use a seta para baixo,
em seguida, pressione q para sair e voltar ao shell do psql.

Tente executar este comando:

select st_pointfromtext(’POINT(1 1)’);

Resultados:
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st_pointfromtext
--------------------------------------------
0101000000000000000000F03F000000000000F03F
(1 row)

Três coisas a serem observadas:

• nós definimos um ponto na posição 1,1 (é assumido o EPSG:4326) usando POINT(1 1);

• executamos uma instrução SQL, sem nenhuma tabela, apenas com dados inseridos no prompt do SQL;

• o resultado não faz muito sentido.

O resultado está no formato OGC chamado ‘Well Known Binary’ (WKB). Nós veremos esse formato em detalhes
na próxima seção.

Para obter os resultados como texto, podemos fazer uma verificação rápida através da lista de funções para uma
que retorne texto:

\df *text

A função que estamos procurando agora é st_astext. Vamos combiná-la com a consulta anterior:

select st_astext(st_pointfromtext(’POINT(1 1)’));

Resultados:

st_astext
------------

POINT(1 1)
(1 row)

Aqui, entramos com a string POINT (1,1), transformada em um ponto usando ST_PointFromText (),
e transformada de volta para um formato legível com :kbd:‘ST_AsText () ‘, que nos deu de volta a nossa string
original.

Um último exemplo antes de realmente entrarmos em detalhes de como usar o PostGIS:

select st_astext(st_buffer(st_pointfromtext(’POINT(1 1)’),1.0));

O que isso faz? Ele cria um buffer de 1 grau em torno do nosso ponto e devolveu o resultado como texto.

16.1.6 Sistemas de referência espacial

Além das funções do PostGIS, a extensão contém uma coleção de definições de sistemas de referência espacial
(SRS), tal como definido pelo European Petroleum Survey Group (EPSG). Estes são utilizados durante as oper-
ações, tais como conversões entre sistemas de coordenadas de referência (SCR).

Nós podemos inspecionar estas definições de SRS no nosso banco de dados, já que as mesmas são armazenadas
em tabelas normais no banco.

Primeiro, vamos olhar para a estrutura da tabela, digitando o seguinte comando no prompt do psql:

\d spatial_ref_sys

O resultado deve ser esse:

Table "public.spatial_ref_sys"
Column | Type | Modifiers

-----------+-------------------------+-----------
srid | integer | not null
auth_name | character varying(256) |
auth_srid | integer |
srtext | character varying(2048) |
proj4text | character varying(2048) |
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Indexes:
"spatial_ref_sys_pkey" PRIMARY KEY, btree (srid)

Você pode usar consultas SQL padrão (como aprendemos com nossas seções introdutórias), para visualizar e
manipular essa tabela - embora não seja uma boa ideia atualizar ou excluir todos os registros, a menos que você
saiba o que está fazendo.

Um SRID que pode lhe interessar é o EPSG: 4326 - o sistema de referência geográfico / lat lon que usa o elipsóide
WGS 84. Vamos dar uma olhada nele:

select * from spatial_ref_sys where srid=4326;

Resultados:

srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS
84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],TOWGS84[0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]
proj4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

O srtext é a definição da projeção em WKT (você pode encontrá-la em arquivos .prj em uma coleção shapefile).

16.1.7 In Conclusion

Você agora tem funções PostGIS instaladas em sua cópia do PostgreSQL. Com isso, você vai ser capaz de fazer
uso de extensas funções espaciais PostGIS.

16.1.8 What’s Next?

Em seguida, você vai aprender como características espaciais são representados em um banco de dados.

16.2 Lesson: Modelo de Feição Simples

Como podemos armazenar e representar feições geográficas em um banco de dados? Nesta lição nós vamos cobrir
uma abordagem, o modelo de feição simples, tal como definido pela OGC.

O objetivo desta lição: saber o que é o Modelo SFS e como usá-lo.

16.2.1 O que é OGC

O Open Geospatial Consortium (OGC) é uma organização internacional voluntária de padrões de consenso, orig-
inada em 1994. Na OGC, mais do que 370 organizações comerciais, governamentais, sem fins lucrativos e de
pesquisa em todo o mundo colaboram em um processo de consenso aberto, encorajando o desenvolvimento e im-
plementação de padrões para conteúdos e serviços geoespaciais, processamento de dados SIG e compartilhamento
de dados. * - * Wikipedia

16.2.2 Qual é o modelo SFS

O modelo Simple Feature for SQL (SFS) é uma maneira não topológica de armazenar dados geoespaciais em um
banco de dados e define as funções para acesso, operação e construção desses dados.
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O modelo define dados geoespaciais dos tipos ponto, linha e polígono (e agregações deles para multi-objetos).

Para mais informações, dê uma olhada no padrão OGC Simple Feature for SQL.

16.2.3 Adicionar um campo de geometria para a tabela

Vamos adicionar um campo de ponto para a nossa tabela de pessoas

alter table people add column the_geom geometry;

16.2.4 Adicione uma restrição com base no tipo de geometria

Você vai notar que o tipo de campo geometria não especifica implicitamente qual o tipo de geometria para o campo
- para isso precisamos de uma restrição:

alter table people
add constraint people_geom_point_chk

check(st_geometrytype(the_geom) = ’ST_Point’::text OR the_geom IS NULL);

Isso adiciona uma restrição à tabela para que ela só aceite uma geometria do tipo ponto ou um valor nulo.

16.2.5 Try Yourself

Crie uma nova tabela chamada “cities” e crie algumas colunas apropriadas, incluindo um campo de geometria para
armazenar os polígonos (os limites da cidade). Certifique-se de que tenha uma restrição forçando as geometrias a
serem polígonos.

Verifique seus resultados

16.2.6 Preencher a tabela geometry_columns

Neste ponto, você deve inserir um registro na tabela geometry_columns:

insert into geometry_columns values
(’’,’public’,’people’,’the_geom’,2,4326,’POINT’);

16.2. Lesson: Modelo de Feição Simples 411

http://www.opengeospatial.org/standards/sfs


QGIS Training Manual, Versão 2.8

Por Quê? geometry_columns é usado em certas aplicações para se certificar que as tabelas no banco de dados
contém dados de geometria.

Nota: Se o comando INSERT acima causar um erro, execute essa consulta primeiro:

select * from geometry_columns;

If the column :kbd:‘f_table_name‘ contains the value :kbd:‘people‘, then
this table has already been registered and you don’t need to do anything
more.

O valor 2 refere-se ao número de dimensões; neste caso, duas: x e y.

O valor 4326 refere-se à projeção que estamos usando; neste caso, WGS 84, que é referido pelo número 4326
(ver discussão anterior sobre a EPSG).

Try Yourself

Insira um registro apropriado, para sua nova camada “cities”, em geometry_columns.

Verifique seus resultados

16.2.7 Adicionar registro geometria para a tabela usando SQL

Agora que as nossas tabelas estão geo-habilitadas, podemos armazenar geometrias nelas:

insert into people (name,house_no, street_id, phone_no, the_geom)
values (’Fault Towers’,

34,
3,
’072 812 31 28’,
’SRID=4326;POINT(33 -33)’);

Nota: Na nova entrada acima, você precisará especificar qual projeção (SRID) que deseja usar. Isso porque
você entrou com a geometria do novo ponto usando um texto simples, o que não adiciona automaticamente as
informações de projeção corretas. Obviamente, o novo ponto precisa usar o mesmo SRID que o conjunto de
dados que está sendo adicionado, então você precisa especificá-lo.

Se neste momento você estivesse usando uma interface gráfica, por exemplo, especificar a projeção para cada
ponto seria feito automaticamente. Em outras palavras, você geralmente não precisa se preocupar sobre como usar
a projeção correta para cada ponto que você deseja adicionar se você já tiver especificado-a para esse conjunto de
dados, como fizemos anteriormente.

Agora provavelmente é um bom momento para abrir o QGIS e tentar ver a sua tabela people. Além disso,
devemos tentar editar / adicionar / excluir registros e, em seguida, executar consultas ao banco de dados para ver
como os dados foram alterados.

Para colocar uma camada PostGIS no QGIS, utilize a opção de menu Camada → Adicionar camada PostGIS ou
o botão na barra de ferramentas:

A seguinte caixa de diálogo abrirá:
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Clique no botão Novo para abrir esta caixa de diálogo:
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Em seguida, defina uma nova conexão, por exemplo:

Name: myPG
Service:
Host: localhost
Port: 5432
Database: address
User:
Password:

Para ver se o QGIS encontrou o banco de dados address e se o seu nome de usuário e senha estão corretos,
clique em Testar Conexão. Se funcionar, marque as opções Salvar nome do usuário e Salvar Senha. Em seguida,
clique OK para criar esta conexão.
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Voltando à caixa de diálogo Adicionar tabela(s) PostGIS, clique em Conectar e adicione camadas ao seu projeto
como de costume.

Try Yourself

Formule uma consulta que mostre o nome da pessoa, o nome da rua e a posição (a partir da coluna the_geom)
como texto simples.

Verifique seus resultados

16.2.8 In Conclusion

Você já viu como adicionar objetos espaciais a seu banco de dados e exibi-los no software GIS.

16.2.9 What’s Next?

Em seguida, você vai ver como importar dados para o e dados de exportação de, seu banco de dados.

16.3 Lesson: Importação e Exportação

É claro que um banco de dados com nenhuma maneira fácil de migrar os dados para ele e para fora dele, não
teria de muita utilidade. Felizmente, há uma série de ferramentas que lhe permitem mover facilmente de dados de
dentro e de fora do PostGIS.

16.3.1 shp2pgsql

shp2pgsql é uma ferramenta de linha de comando para importar arquivos shape da ESRI para o banco de dados.
No Unix, você pode usar o seguinte comando para importar uma nova tabela PostGIS:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psql -d <databasename> -h <hostname> -U <username>

No Windows, você tem que executar o processo de importação em duas etapas:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sql
psql psql -d <databasename> -h <hostname> -U <username> -f import.sql

Você pode encontrar esse erro

ERROR: operator class "gist_geometry_ops" does not exist for access method
"gist"

Este é um problema conhecido sobre a criação in situ de um índice espacial para os dados que você está impor-
tando. Para evitar o erro, exclua o parâmetro :kbd: -i. Isto significa que nenhum índice espacial está sendo criado
diretamente, e você terá que criá-lo no banco de dados após os dados terem sido importados. (A criação de um
índice espacial será abordada na próxima lição.)

16.3.2 pgsql2shp

pgsql2shp é uma ferramenta de linha de comando para exportação de Tabelas PostGIS, Visualização ao seleção
de consultas SQL. Para fazer isso dentro do amiente Unix:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> <databasename> <table | view>
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Para exportar os dados usando uma consulta:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> "<query>"

16.3.3 ogr2ogr

ogr2ogr é uma ferramenta muito poderosa para converter dados de e para postgis a muitos formatos de dados.
ogr2ogr faz parte do GDAL / OGR e Software tem de ser instalada separadamente. Para exportar uma tabela do
PostGIS para GML, você pode usar este comando

ogr2ogr -f GML export.gml PG:’dbname=<databasename> user=<username>
host=<hostname>’ <Name of PostGIS-Table>

16.3.4 SPIT

SPIT é um complemento QGIS que vem junto com o QGIS. Você pode usar SPIT para fazer upload de arquivos
shape da ESRI para PostGIS.

Depois de adicionar o complemento SPIT via: guilabel: Gerenciador de Complementos, procure este botão:

Clicando em ou selecionando Base de dados –> Spit –> Importar Shapefiles para PostgreSQL no menu lhe dará
o diálogo SPIT: no menu lhe dará o diálogo SPIT:
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Você pode adicionar arquivos shapefiles para o banco de dados clicando no botão :guilabel: Adicionar, o que lhe
abrirá uma janela do navegador de arquivos.

16.3.5 DB Manager

Você deve ter notado uma outra opção no menu :guilabel: base de dados chamado: guilabel:Gestor de DB. Esta
é uma nova ferramenta no QGIS 2.0 que fornece uma interface unificada para interagir com bancos de dados
espaciais, incluindo PostGIS. Ele também permite a importação e exportação de bancos de dados para outros
formatos. Uma vez que o módulo seguinte é dedicado em grande parte para o uso desta ferramenta, vamos
mencionar apenas brevemente aqui.

16.3.6 In Conclusion

Importação e exportação de dados de e para o banco de dados pode ser feita de muitas maneiras diferentes.
Especialmente quando se utiliza diferentes fontes de dados, você provavelmente vai usar essas funções (ou outros
como eles) em uma base regular.

16.3.7 What’s Next?

Em seguida, vamos olhar para como consultar os dados que criamos antes.

16.4 Lesson: Consultas Espaciais

As consultas espaciais não são diferentes de outras consultas do banco de dados. Você pode usar a coluna de
geometria como qualquer outra coluna de banco de dados. Com a instalação do PostGIS em nosso banco de dados
tem funções adicionais para consultar nosso banco de dados.

A meta para esta lição: Para ver como as funções espaciais são implementados de forma semelhante a funções
não-espaciais “normais”.

16.4.1 Operadores Espaciais

Quando você quiser saber quais os pontos estão a uma distância de 2 graus até um ponto (X, Y), você pode fazer
isso com:

select *
from people
where st_distance(the_geom,’SRID=4326;POINT(33 -34)’) < 2;

Resultados:

id | name | house_no | street_id | phone_no | the_geom
----+--------------+----------+-----------+---------------+-----------------

6 | Fault Towers | 34 | 3 | 072 812 31 28 | 01010008040C0
(1 row)

Nota: valor the_geom acima foi truncado para o espaço nesta página. Se você quiser ver o ponto em coordenadas
legíveis, tentar algo parecido com o que você fez na seção “Ver um ponto como WKT”, acima.

Como sabemos que a consulta acima retorna todos os pontos dentro de 2 graus? Por que não 2 metros? Ou
qualquer outra unidade, que interesse?

Cheque seus resultados
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16.4.2 Índices espaciais

Também podemos definir índices espaciais. Um índice espacial faz com que suas consultas espaciais muito mais
rápido. Para criar um índice espacial na utilização coluna de geometria

CREATE INDEX people_geo_idx
ON people
USING gist
(the_geom);

\d people

Resultado:

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+----------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (the_geom) <-- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) = ’ST_Point’::text
OR the_geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

16.4.3 Try Yourself

Modificar a tabela de cidades de modo que sua coluna de geometria é espacialmente indexado.

Cheque seus resultados

16.4.4 PostGIS Espacial Funções Demonstração

A fim de demonstração de PostGIS funções espaciais, vamos criar um novo banco de dados que contém alguns
dados (fictícios).

Para iniciar, criaremos uma nova base de dados (feche primeiro a shell psql):

createdb postgis_demo

Lembre-se de instalar as extensões PostGIS:

psql -d postgis_demo -c "CREATE EXTENSION postgis;"

Em seguida, importe os dados fornecidos no diretório exercise_data/postgis/. Volte à lição anterior
para obter instruções, mas lembre-se que você vai precisar criar uma nova conexão PostGIS para o novo banco
de dados. Você pode importar a partir do terminal ou via SPIT. Importe os arquivos para as seguintes tabelas do
banco de dados:

• points.shp em edifícios

• lines.shp Em estradas
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• polygons.shp em regiões

Coloque essas três camadas de banco de dados para QGIS através do: guilabel: caixa de diálogo Adicionar
PostGIS Layers, como de costume. Quando você abre as suas tabelas de atributos, você vai notar que eles têm
tanto um: kbd: campo id e uma: kbd:‘ campo gid‘ criado pela importação PostGIS.

Agora que as tabelas foram importadas, podemos usar PostGIS para consultar os dados. Volte para o seu terminal
(linha de comando) e digite o prompt do psql executando

psql postgis_demo

Iremos demonstrar algumas dessas instruções selecionadas, criando visualizações a partir delas, para que você
possa abri-las no QGIS e ver os resultados.

Selecionar pela localização

Obter todos os edifícios na região de KwaZulu

SELECT a.id, a.name, st_astext(a.the_geom) as point
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’KwaZulu’;

Resultado:

id | name | point
----+------+------------------------------------------
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)

(5 rows)

Ou, se criarmos uma visão dele:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.the_geom
FROM building a, region b

WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’KwaZulu’;

Adicionar a vista como uma camada e exibi-lo no QGIS:
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Selecione os vizinhos

Mostrar uma lista de todos os nomes das regiões adjacentes a região de Hokkaido:

SELECT b.name
FROM region a, region b
WHERE st_touches(a.the_geom, b.the_geom)
AND a.name = ’Hokkaido’;

Resultado:

name
--------------
Missouri
Saskatchewan
Wales

(3 rows)

Como vista:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE TOUCHES(a.the_geom, b.the_geom)
AND a.name = ’Hokkaido’;

En QGIS:
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Observe a região em falta (Queensland). Isto pode ser devido a um erro de topologia. Artefatos como isso pode
nos alertar para possíveis problemas nos dados. Para resolver este enigma sem se envolver nas anomalias dos
dados pode ter, nós poderíamos usar um tampão se cruzam em vez

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(the_geom, 100) as the_geom
FROM region

WHERE name = ’Hokkaido’;

Isso cria um buffer de 100 metros ao redor da região de Hokkaido.

A área sombreada representa o buffer:
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Selecione usando o buffer:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.the_geom
FROM
(

SELECT * FROM
vw_hokkaido_buffer

) a,
region b
WHERE ST_INTERSECTS(a.the_geom, b.the_geom)
AND b.name != ’Hokkaido’;

Nesta consulta, a visão do buffer original é usada como qualquer outra tabela seria. É dado o apelido a, e seu
campo geometria, a.the_geom, é usado para selecionar qualquer polígono na tabela region (apelido b) que
ele intersecta. No entanto, a própria Hokkaido é excluído desta instrução SELECT, porque nós não queremos isso;
queremos apenas as regiões adjacentes.

En QGIS:
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É também possível selecionar todos os objetos dentro de uma determinada distância, sem a etapa adicional de
criar um buffer:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE ST_DISTANCE (a.the_geom, b.the_geom) < 100
AND a.name = ’Hokkaido’
AND b.name != ’Hokkaido’;

Isto atinge o mesmo resultado, sem necessidade de intercalar o passo de buffer:
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Selecione valores únicos

Mostrar uma lista de nomes de cidades únicas para todos os edifícios na região de Queensland:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’Queensland’;

Resultado:

name
---------
Beijing
Berlin
Atlanta

(3 rows)

Outros exemplos ...

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid, ST_ASTEXT(ST_SHORTESTLINE(a.the_geom, b.the_geom)) as
text, ST_SHORTESTLINE(a.the_geom, b.the_geom) AS the_geom
FROM road a, building b

WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid, ST_ASTEXT(ST_LONGESTLINE(a.the_geom, b.the_geom)) as
text, ST_LONGESTLINE(a.the_geom, b.the_geom) AS the_geom
FROM road a, building b

WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
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FROM road a
WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
FROM region a

WHERE a.name = ’Saskatchewan’;

SELECT ST_PERIMETER(a.the_geom)
FROM region a
WHERE a.name=’Queensland’;

SELECT ST_AREA(a.the_geom)
FROM region a
WHERE a.name=’Queensland’;

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(the_geom, 20) AS the_geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(the_geom, 50) AS the_geom
FROM road;

CREATE VIEW vw_convex_hull AS
SELECT
ROW_NUMBER() over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL(ST_COLLECT(a.the_geom)) AS the_geom
FROM building a
GROUP BY a.name;

16.4.5 In Conclusion

Você já viu como consultar objetos espaciais usando as novas funções de banco de dados do PostGIS.

16.4.6 What’s Next?

Em seguida vamos para investigar as estruturas de geometrias mais complexas e como criá-las usando o PostGIS.

16.5 geometria de construção

Nesta seção, vamos nos aprofundar um pouco mais em como as geometrias simples são construídas com SQL. Na
realidade, você provavelmente irá usar um GIS como QGIS para criar geometrias complexas, utilizando suas fer-
ramentas de digitalização; no entanto, compreender como elas são formuladas pode ser útil para escrever consultas
e entender como o banco de dados é montado.

O objetivo desta lição: entender melhor como criar entidades espaciais diretamente no PostgreSQL/PostGIS.

16.5.1 Criando linhas

Voltando ao nosso banco de dados address, vamos deixar a nossa tabela streets igual às outras; ou seja, tendo
uma restrição na geometria, um índice e uma entrada na tabela geometry_columns.
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16.5.2 Try Yourself

• Modifique a tabela streets para que ela tenha uma coluna geometria do tipo ST_LineString.

• Não se esqueça de fazer a atualização correspondente na tabela geometry_columns!

• Crie também uma restrição para evitar que quaisquer geometrias diferentes de LINESTRINGS ou nulo
sejam inseridas.

• Crie um índice espacial para a nova coluna do tipo geometry.

Verifique seus resultados

Agora vamos inserir uma linha em nossa tabela ‘streets’. Neste caso, vamos atualizar um registro existente em
‘streets’:

update streets set the_geom = ’SRID=4326;LINESTRING(20 -33, 21 -34, 24 -33)’
where streets.id=2;

Dê uma olhada nos resultados no QGIS. (Você pode precisar clicar com o botão direito sobre a camada street no
painel ‘Camadas’, e escolher a opção ‘Zoom para a camada’.)

Agora, crie mais alguns registros em ‘streets’ - alguns pelo QGIS e alguns pela linha de comando.

16.5.3 Criando poligonos

A criação de polígonos é muito fácil. Uma coisa a se lembrar é que, por definição, polígonos têm pelo menos
quatro vértices, sendo o último e o primeiro vértices na mesma localização:

insert into cities (name, the_geom)
values (’Tokyo’, ’SRID=4326;POLYGON((10 -10, 5 -32, 30 -27, 10 -10))’);

Nota: Um polígono requer colchetes duplos em torno de sua lista de coordenadas; isto serve para permitir que
você adicione polígonos complexos com múltiplas áreas não conectadas. Por exemplo:

insert into cities (name, the_geom)
values (’Tokyo Outer Wards’, ’SRID=4326;POLYGON((20 10, 20 20, 35 20, 20 10),

(-10 -30, -5 0, -15 -15, -10 -30))’);

Se você seguir esse passo, você poderá verificar o que ele faz carregando o DataSet ‘cities’ no QGIS, abrindo a
sua tabela de atributos, e selecionando o novo registro. Note como os dois novos polígonos comportam-se como
um único polígono.

16.5.4 Exercício: Ligando Cidades a Pessoas

Para este execício você deve fazer o seguinte:

• Delete todos os dados da tabela ‘people’.

• Adicione uma coluna de chave estrangeira na tabela ‘people’ que referencie a chave primária da tabela
‘cities’.

• Use QGIS para capturar algumas cidades.

• Use SQL para inserir alguns registros novos de pessoas, garantindo que cada um tenha uma rua e uma cidade
associados aos mesmos.

Seu esquema atualizado de ‘people’ deve estar parecido com isso:
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\d people

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+--------------------------------------------
id | integer | not null

| | default nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |
city_id | integer | not null

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) =

’ST_Point’::text OR the_geom IS NULL)
Foreign-key constraints:

"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities(id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

Verifique seus resultados

16.5.5 Verificando nosso esquema

Por enquanto, nosso esquema deve estar parecendo com isso:

16.5.6 Try Yourself

Crie limites de cidade computando o menor polígono que contenha todos os endereços para aquela cidade e crie
um buffer em torno dessa área.

16.5.7 Acessando Subobjetos

Com as funções do modelo SFS, você tem uma grande variedade de opções para acessar subobjetos de Geometrias
SFS. Quando você quiser selecionar o primeiro vértice de cada polígono na tabela myPolygonTable, você terá que
fazer dessa maneira:

• Transformando o limite do polígono em uma linha:
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select st_boundary(geometry) from myPolygonTable;

• Selecionando o primeiro vértice da linha resultante:

select st_startpoint(myGeometry)
from (

select st_boundary(geometry) as myGeometry
from myPolygonTable) as foo;

16.5.8 Processamento de dados

O PostGIS suporta todas as funções conformes do padrão OGC SFS/MM. Todas essas funções começam com
ST_.

16.5.9 Recortando

Para recortar uma parte de seus dados você pode usar a função ST_INTERSECT(). Para evitar geometrias vazias,
utilize:

where not st_isempty(st_intersection(a.the_geom, b.the_geom))

select st_intersection(a.the_geom, b.the_geom), b.*
from clip as a, road_lines as b
where not st_isempty(st_intersection(st_setsrid(a.the_geom,32734),

b.the_geom));
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16.5.10 Construindo Geometrias a partir de outras Geometrias

A partir de uma determinada tabela de pontos, você quer gerar uma linha. A ordem dos pontos é definida pelo
id. Outro método de ordenação poderia ser o horário, como quando você captura pontos em um caminho com
um receptor GPS.
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Para criar uma linha a partir de uma nova camada do tipo ponto chamada ‘points’, você pode executar o seguinte
comando:

select ST_LineFromMultiPoint(st_collect(the_geom)), 1 as id
from (

select the_geom
from points
order by id

) as foo;

Para ver como isso funciona sem criar uma nova camada, você também pode executar esse comando sobre a
camada ‘people’, embora, naturalmente, fizesse pouco sentido fazer isso no mundo real.
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16.5.11 Limpeza de Geometria

Você pode conseguir mais informações sobre este tópico nesse blog: <http://linfiniti.com/?s=cleangeometry>‘_.

16.5.12 As diferenças entre as tabelas

Para detectar diferenças entre duas tabelas com a mesma estrutura, você pode usar a palavra-chave do PostgreSQL
EXCEPT:

select * from table_a
except
select * from table_b;

Como resultado, você terá todos os registros de table_a que não estão presentes em table_b.

16.5.13 Tablespaces

Você pode definir onde o Postgres deverá armazenar seus dados no disco criando tablespaces:

CREATE TABLESPACE homespace LOCATION ’/home/pg’;

Quando você cria um banco de dados, você pode especificar qual tablespace usar. Por exemplo:
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createdb --tablespace=homespace t4a

16.5.14 In Conclusion

Você aprendeu como criar geometrias mais complexas usando declarações do PostGIS. Tenha em mente que isso
é principalmente para melhorar o seu conhecimento tácito ao trabalhar com bancos de dados geo-capacitados
através de uma interface GIS. Você normalmente não precisará entrar com essas declarações manualmente, mas
ter uma ideia geral de sua estrutura irá ajudá-lo quando for usar um SIG, especialmente se você encontrar erros
que de outra forma podem parecer enigmáticos.
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CHAPTER 17

O guia de processamento do QGIS

This module contributed by Victor Olaya.

Conteúdos:

17.1 Introducción

Esta guía describe como usar el marco de procesamiento de QGIS. Se asume que no se tiene ningún conocimiento
previo del marco de procesamiento o cualquiera de las aplicaciones de los que depende. Supone un conocimiento
básico de QGIS. Los capítulos sobre scripting asume que usted tiene algunos conocimientos básicos de Python y
tal vez la API de Python de QGIS.

La guía se diseño para el auto estudio o utilizarse para ejecutar un taller de procesamiento.

Examples in this guide use QGIS 2.0, with partil upgrades to 2.8. They might not work or not be available in
versions other than that ones.

Esta guía esta compuesta de un conjunto de pequeños ejercicios de complejidad progresiva. Si nunca ha usado el
marco de procesamiento, debe comenzar desde el principio. Si tiene alguna experiencia previa no dude de saltar
lecciones. Ellos son mas o menos independientes entre si y cada uno presenta un concepto nuevo o un nuevo
elemento, que se indica en el título del capítulo y la breve introducción al inicio de cada capítulo. Esto debería
hacer más fácil localizar lecciones que tratan de un tema en particular.

Para una descripción más sistemática de todos los componentes del marco y su uso, se recomienda revisar el
capítulo correspondiente en el manual de QGIS. Usarlo como un texto de ayuda a lo largo de esta guía.

Todos os exercícios deste guia de usam o conjunto de dados gratuito que pode ser baixado do site do QGIS. O
arquivo zip para download contém várias pastas correspondentes a cada uma das lições deste guia. Em cada um
deles você encontrará um arquivo de projeto QGIS. Basta abri-lo e você estará pronto para começar a lição.

Disfrutar!

17.2 Um aviso importante antes de começar

Assim como o manual de um processador de texto não ensina a escrever um romance ou um poema, ou um
tutorial CAD não mostra como calcular o tamanho de uma viga para um edifício, este guia não vai ensinar-
lhe análise espacial. Em vez disso, ele vai te mostrar como usar a estrutura de processamento de QGIS, uma
poderosa ferramenta para a realização de análise espacial, mas cabe a você aprender os conceitos necessários que
são necessários para compreender esse tipo de análise. Sem eles, não há como iniciar o uso da estrutura e seus
algoritmos, embora você possa tentar e experimentar.

Vamos mostrar isso mais claramente com um exemplo.

Dado um conjunto de pontos e um valor de um determinado valor da variável em cada ponto, você pode calcular
uma camada raster a partir deles usando o geoalgoritmo Krigagem. A caixa de diálogo parâmetros para esse
módulo é como a seguinte.
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É olhar complexo, certo?

Ao ler este manual, você vai aprender coisas como o modo de usar esse módulo, como executá-lo em um processo
em lote para criar camadas raster de centenas de pontos de camadas em uma única rodagem, ou o que acontece se
a camada de entrada tem alguns pontos selecionados. No entanto, os próprios parâmetros não são explicados. Um
analista experiente com um bom conhecimento da geoestatística não terá nenhum problema em entender esses
parâmetros. Se você não é um deles e sill, range, ou pepita não são conceitos familiares a você, então você não
deve usar o módulo Krigagem. Mais do que isso, você está longe de estar pronto para usar o módulo Krigagem,
uma vez que requer aprendizagem sobre conceitos como autocorrelação ou semivariogramas espaciais, o que
provavelmente você também não tenha ouvido antes, ou pelo menos não ter estudado o suficiente . Você deve
primeiro estudá-los e compreende-los, e depois voltar para QGIS para realmente executá-lo e realizar a análise.
Ignorando isso irá resultar em resultados errados e análise pobre (e provavelmente inútil).

Embora nem todos os algoritmos são tão complexos quanto krigagem (mas alguns deles são ainda mais com-
plexos!), Quase todos eles exigem a compreensão das idéias fundamentais de análise que se baseiam. Sem esse
conhecimento, utilizando-os provavelmente irá levar a maus resultados.
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Usando geoalgoritmos sem ter uma boa base de análise espacial é como tentar escrever um romance sem saber
nada sobre a gramática ou sintaxe, e não tendo nenhum conhecimento sobre narração. Você pode obter um
resultado, mas é provável que não têm valor algum. Por favor, não se engane em achar que depois de ler este
guia, você já será capaz de realizar análise espacial e obter bons resultados. Você precisa estudar análise espacial
também.

Aqui está uma boa referência que você pode ler para aprender mais sobre análise de dados espaciais.

Análise Geospatial (3a Edição): Um Guia Resumido com as Ferramentas Princípios, Técnicas e Programa
Michael John De Smith, Michael F. Goodchild, Paul A. Longley

Ele está disponível online aqui

17.3 Instauración de la caja de herramientas de procesado

Lo primero que debe hacerse antes de usar la caja de herramientas de procesado es para configurarlo. No hay
mucho que configurar, así que esta es una tarea fácil.

Más adelante vamos a mostrar como configurar las aplicaciones externas que se utilizan para ampliar la lista de
algoritmos disponibles, pero por ahora solo vamos a trabajar con el marco.

The processing framework is a core QGIS plugin, which means that, if you are running QGIS 2.0, it should
already be installed in your system, since it is included with QGIS. In case it is active, you should see a menu
called Processing in your menu bar. There you will find an access to all the framework components.

Si no puede encontrar el menú, debe habilitar el complemento, vaya al administrador de complementos y activelo.
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El principal elemento con el que vamos a trabajar en la caja de herramientas. Haga clic en la entrada del menú
correspondiente y verá la caja de herramientas acoplada del lado derecho de la ventana de QGIS.

The toolbox contains a list of all the available algorithms, divided in groups. There are two ways of displaying
and organizing those algorithms: the advanced mode and the simplified mode.

Por defecto, verá el modo simplificado, por grupo de algoritmos según el tipo de operación que realiza. Aunque
algunos de los algoritmos que verá en la caja de herramientas depende de aplicaciones externas (la mayoría de
ellos lo hacen, de hecho), no verá ninguna mención de esas aplicaciones. El origen de los algoritmos se oculta en
este modo, que es una fachada que simplifica el uso de algoritmos mediante el caja de herramientas de procesado.
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Examples in this guide only use the simplified mode. The advanced mode has some additional features and
algorithms, but it requires understanding the applications that are called, so they are a more advanced topic. Some
of these more advanced ideas are introduced in the final lessons of this book, but for the rest of them we will just
use the simplified interface.

You can change between the simplified and the advanced mode by using the selector on the bottom part of the
toolbox.

La caja de herramientas, cuando se utiliza en modo avanzado, se parece a esto.

Si ha llegado a este punto, ahora está listo para usar geoalgorithms. No hay necesidad de configurar alguna otra
cosa por ahora. Ya podemos ejecutar nuestro primer algoritmo, lo que haremos en la próxima lección.

17.4 Rodando o nosso primeiro algoritmo. A caixa de ferramentas

Nota: Nesta lição, vamos executar o nosso primeiro algoritmo e conseguir o nosso primeiro resultado a partir
disso.

Como já mencionado, a estrutura de processamento pode executar algoritmos de outras aplicações, mas também
contém algoritmos nativos que não precisam de software externo para serem executados. Para começar a explorar
a estrutura de processamento, nós iremos executar um desses algoritmos nativos. Em particular, vamos calcular
os centróides de um conjunto de polígonos.

Primeiro, abra o projeto QGIS correspondente a esta lição. Ele contém apenas uma única camada com dois
polígonos
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Agora vá para a caixa de texto na parte superior da caixa de ferramentas. Essa é a caixa de pesquisa, e se você
digitar um texto nela, ela irá filtrar a lista de algoritmos de modo que apenas aqueles contendo o texto digitado
serão exibidos. Escreva centroids e você deverá ver algo como isso:

A caixa de pesquisa é uma forma muito prática de encontrar o algoritmo que você está procurando.

Para executar um algoritmo, você só tem que clicar duas vezes em seu nome na caixa de ferramentas. Quando
você clicar duas vezes no algoritmo Centroids, você verá a seguinte caixa de diálogo:
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All algorithms have a similar interface, which basically contains input parameters that you have to fill, and outputs
that you have to select where to store. In this case, the only inputs we have are a vector layer with polygons and
a selector to select whether we want several centroids for a single feature in case it is a multipart feature, or the
algorithm should generate just one centroid for each feature.

Select the Polygons layer as input. The other field will have no effect at all, since the input layer has no multi-part
features.

The algorithm has a single output, which is the centroids layer. There are two options to define where a data output
is saved: enter a filepath or save it to a temporary filename

No caso de você querer definir um destino e não salvar o resultado em um arquivo temporário, o formato de
saída será definido pela extensão do arquivo. Para selecionar um formato, basta selecionar a extensão do arquivo
correspondente (ou adicioná-lo se você está digitando diretamente o caminho do arquivo em vez disso). Se a
extensão do arquivo que você digitou não corresponde a nenhum dos tipos suportados, uma extensão padrão
(geralmente .dbf para tabelas, .tif para camadas raster e .shp para vetores) será anexada ao caminho e o
formato de arquivo correspondente a essa extensão será usado para salvar a camada ou tabela.

Em todos os exercícios deste guia salvaremos os resultados em um arquivo temporário, já que não há necessidade
de guardá-los para uso posterior. Sinta-se livre para salvá-los para um local permanente se você quiser.

Notice that temporary files are deleted once you close QGIS. If you create a project with an output that was saved
as a temporary output, QGIS will complain when you try to open back the project later, since that output file will
not exist.

Uma vez que você tenha configurado as opções do algoritmo, pressione Run para executar o algoritmo.

Você terá o seguinte resultado:
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A saída tem o mesmo SRC que a entrada. Os Geoalgoritimos assumem que todas as camadas de entrada com-
partilham o mesmo SRC e não realiza nenhuma reprojeção. Exceto no caso de alguns algoritmos especiais (por
exemplo, os de reprojeção), as saídas também terão o mesmo SRC. Veremos mais sobre isso em breve.

Tente salvá-lo você mesmo usando diferentes formatos de arquivo (use, por exemplo, shp e geojson como
extensões). Além disso, se você não quer que a camada seja carregada no QGIS após ela ser gerada, você pode
desmarcar a caixa de verificação que se encontra abaixo do campo de camada de saída.

17.5 Mais algoritmos e tipos de dados

Nota: Nesta lição nós vamos executar mais três algoritmos, aprender como usar outros tipos de entrada e config-
urar saídas para serem salvas em uma determinada pasta automaticamente.

Para estas lições vamos precisar de uma tabela e uma camada de polígonos. Nós vamos criar uma camada de
pontos baseado em coordenadas na tabela e depois contar o número de pontos em cada polígono. Se você abrir
o projeto QGIS correspondente a esta lição, você encontrará uma tabela com coordenadas X e Y, mas você não
encontrará nenhuma camada de polígonos. Não se preocupe, nós a criaremos usando um processamento de geoal-
goritmo.

A primeira coisa que vamos fazer é criar uma camada de pontos a partir das coordenadas na tabela, usando o
algoritmo Points layer from table. Você já sabe como usar a caixa de pesquisa, por isso não deve ser difícil para
você encontrá-lo. Dê um duplo clique nele para executá-lo e obtenha a caixa de diálogo mais abaixo.

Esse algoritmo, como o da lição anterior, gera apenas uma única saída e tem três entradas:

• Camada de entrada: a camada ou tabela de entrada com as coordenadas. Você deve selecionar aqui a tabela
‘table’ dos dados da lição.

• Campos X e Y: estes dois parâmetros estão ligados ao primeiro. O seletor correspondente mostrará o nome
dos campos que estão disponíveis na tabela selecionada. Selecione o campo XCOORD para o parâmetro X
e o campo YCOORD para o parâmetro Y .

• SRC Destino: Se a camada de entrada for uma tabela, não será possível atribuir um SRC para a camada
de saída com base nela. Nesse caso, você pode selecionar manualmente o SRC no qual as coordenadas na
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tabela estão. Clique no botão do lado direito para abrir o seletor de SRC e selecione o EPSG:4326. Nós
estamos usando esse SRC porque as coordenadas na tabela estão nesse SRC.

Sua caixa de diálogo deve ser semelhante a essa:

Now press the Run button to get the following layer:

A próxima coisa que precisamos é da camada de polígono. Nós vamos criar uma grade regular de polígonos
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usando o algoritmo Create grid, o qual tem a seguinte caixa de diálogo de parâmetros:

Os dados necessários para criar a grade são todos números. Quando você tem que adicionar um valor numérico,
você tem duas opções: digitá-lo diretamente na caixa correspondente ou clicar no botão do lado direito da caixa e
usar uma caixa de diálogo similar a mostrada a seguir.
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A caixa de diálogo contém uma calculadora simples, assim você pode calcular expressões como 11 * 34.7
+ 4.6 e o resultado será computado e colocado na caixa de texto correspondente dentro da caixa de diálogo de
parâmetros. Além disso, a caixa de diálogo contém constantes que você pode usar e valores de outras camadas
disponíveis.

Neste caso, nós queremos criar uma grade que cubra a extensão dos pontos da camada de entrada, logo, nós
devemos usar estas coordenadas para calcular a coordenada do centro da grade e sua largura e altura, já que elas
são parâmetros que o algoritmo utiliza para criar a grade.

Selecione Rectangle (polygon) no campo Tipo de grade.

Como no caso do último algoritmo, nós temos que introduzir o SRC aqui também. Selecione o EPSG:4326 no
campo ‘Grid CRS’, como fizemos antes.

No final, você deve ter a caixa de diálogo de parâmetros parecida com isso:
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(Melhor adicionar um espaçamento entre a largura e a altura: Espaçamento horizontal: 0.0001, Espaçamento
vertical:0.0001, Largura: 0.001004, Altura: 0.000651, Centro X: -5.695674, Centro Y: 40.2477955). O caso do
centro X é um pouco complicado. veja: -5.696126+(( -5.695222+ 5.696126)/2)

Aviso: As opções são mais simples em versões mais recentes do QGIS: você só precisa entra com o min e o
max para X e Y (valores sugeridos: -5.696226,-5.695122,40.24742,40.248171).

Pressione Run e você obterá a camada da quadrícula.
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O último passo é contar os pontos em cada um dos retângulos da quadrícula. Usaremos o algoritmo Count points
in polygons.

Agora nós temos o resultado que estávamos procurando.

Antes de terminar esta lição, aqui está uma dica rápida para tornar sua vida mais fácil no caso de você querer
persistentemente salvar seus dados. Se você quiser todos os seus arquivos de saída salvos numa determinada
pasta, você não precisa digitar o nome da pasta todas as vezes. Ao invés disso, vá ao menu processar e selecione
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o item Opções.... Isto abrirá a janela de configuração.

Na entrada Pasta de saída que você encontrará no grupo Geral, digite o caminho para sua pasta de destino.
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Agora quando você executar um algoritmo, é só usar o nome do arquivo ao invés do caminho completo. Por
exemplo, com a configuração mostrada acima, se você digitar retícula.shp como o caminho de saída para o
algoritmo que acabamos de utilizar, o resultado será salvo em C:\processing_output\retícula.shp.
Você ainda pode entrar com um caminho completo, caso você queira que um resultado seja salvo em uma pasta
diferente.

Tente você mesmo o algoritmo Create grid com diferentes tamanhos e tipos de grades.

17.6 SRCs. Reprojetando

Nota: Nesta lição discutiremos como o processamento usa os Sistemas de Referências de coordenadas (SRCs).
Também veremos um algoritmo muito útil: reproject.

SRCs são uma grande fonte de confusão para os usuários do processamento QGIS, então aqui estão algumas regras
sobre como eles são manipulados por algoritmos quando criada uma nova camada.

• Se houver camadas de entrada, será usado o SRC da primeira camada. Este é considerado como o SRC
de todas as camadas de entrada, uma vez que todos devem ter o mesmo. Se você usar camadas com SRC
diferentes entre si o QGIS irá avisá-lo sobre isso. Observe que o SRC de camadas de entrada é mostrada
junto com o seu nome na caixa de diálogo de parâmetros.

• Se não houver nenhuma camada de entrada, ele irá usar o SRC do projeto, a menos que o algoritmo contenha
um campo CRS específico (como aconteceu na última lição com o algoritmo de quadrícula).

Abra o projeto correspondente a esta lição e você vai ver duas camadas nomeadas 23030 e 4326. Ambas contêm
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os mesmos pontos, mas em diferentes SRC (EPSG: 23030 e EPSG: 4326). Elas aparecem no mesmo lugar porque
o QGIS está reprojetando automaticamente para o CRS do projeto(EPSG: 4326), mas elas não são realmente a
mesma camada.

Abra o algoritmo Export/Add geometry columns.

Esse algoritmo adiciona novas colunas na tabela de atributos de uma camada vetorial. O conteúdo das colunas
depende do tipo de geometria da camada. No caso de pontos, ele adiciona novas colunas com as coordenadas X e
Y de cada ponto.

Na lista de camadas disponíveis que você vai encontrar no campo de camada de entrada, você verá cada um com
seu SRC correspondente. Isso significa que, apesar de aparecerem no mesmo lugar em sua tela, eles serão tratados
de forma diferente. Selecione a camada 4326.

O outro parâmetro permite definir a forma como o algoritmo usa coordenadas para calcular o novo valor que irá
adicionar às camadas resultantes. A maioria dos algoritmos não têm uma opção assim e só usam as coordenadas
diretamente. Selecione a opção Layer CRS para apenas usar coordenadas como coordenadas. Essa é a forma como
quase todos os geoalgoritmos trabalham.

Você deve obter uma nova camada com exatamente os mesmos pontos que as outras duas camadas. Se você
clicar com o botão direito sobre o nome da camada e abrir suas propriedades, você vai ver que ele compartilha o
mesmo SRC da camada de entrada, ou seja, o EPSG:4326. Quando a camada é carregado no QGIS, você não será
solicitado a inserir o SRC da camada, uma vez que QGIS já sabe qual é.

Se você abrir a tabela de atributos da nova camada, irá ver que ela contém dois novos campos com as coordenadas
X e Y de cada ponto.
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Os valores das coordenadas estão no SRC da camada, uma vez que nós escolhemos essa opção. No entanto,
mesmo se você escolher outra opção, o SRC da camada de saída será o mesmo, uma vez que o SRC da entrada
é usado para definir o SRC da camada de saída. Escolhendo uma outra opção fará com que os valores sejam
diferentes, mas não o ponto resultante e nem o SRC da camada de saída será diferente do SRC da de entrada.

Agora faça o mesmo cálculo usando a outra camada. Você deve encontrar a camada resultante renderizada exata-
mente no mesmo lugar das outras, e ela terá o SRC EPSG:23030, uma vez que era o da camada de entrada.

Se você for para a tabela de atributos da camada resultante, você verá valores diferentes dos da primeira camada
que criamos.

Isto é porque o dado original é diferente (utiliza um outro SRC) e essas coordenadas são geradas a partir dele.

O que você deve aprender com isso? A principal ideia por trás desses exemplos é que geoalgoritmos usam a
camada como ela é em sua fonte de dados original e ignoram completamente os reprojeções que o QGIS pode
estar fazendo antes da renderização. Em outras palavras, não confie no que você vê na tela e sempre tenha em
mente que os dados originais serão utilizados. Isso não é tão importante neste caso, uma vez que estamos usando
apenas uma única camada de cada vez, mas em um algoritmo que precisa de várias delas (como um algoritmo de
corte), camadas que parecem coincidir ou se sobrepor podem estar muito longe uma das outras, uma vez que elas
podem ter diferentes SRCs.

Algoritmos não executam nenhuma reprojeção (exceto o algoritmo reprojection que veremos a seguir), por isso
você é que deve certificar-se de que as camadas têm SRCs que combinem.

Um módulo interessante que lida com SRCs é o da reprojeção. Ele representa um caso particular, uma vez que
tem uma camada de entrada (que será reprojetada), mas não usará o SRC dela para a saída.
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Ara o algoritmo Reproject layer.

Selecione qualquer uma das camadas como entrada e selecione o EPSG: 23029 como o SRC de destino. Execute o
algoritmo e você terá uma nova camada, idêntica a da entrada, mas com outro SRC. Ela aparecerá na mesma região
da tela, como as outras, uma vez que o QGIS irá reprojetá-la dinamicamente, mas suas coordenadas originais serão
diferentes. Você pode ver isso executando o algoritmo Export/Add geometry columns usando essa nova camada
como entrada e verificando que as coordenadas adicionadas são diferentes das que estão nas tabelas de atributos
de ambas as camadas que havíamos processado anteriormente.

17.7 Seleção

Nota: Nesta lição vamos a ver como os algoritmos de processamento manejam seleções em camadas vetoriais
que utilizam como entrada, e como criar uma seleção através de um determinado tipo de algoritmo.

Ao contrário de outros plugins de análise do QGIS, você não vai encontrar nos geoalgoritmos de processamento
qualquer caixa de seleção “Usar somente as feições selecionadas” ou similares. O comportamento em relação à
seleção está definida para todo o plugin e todos os seus algoritmos, e não para cada execução do algoritmo. Os
Algoritmos seguem as seguintes regras simples quando utilizam uma camada vetorial:

• Se a camada tem uma seleção, só as feições selecionadas serão usadas.

• Se não houver nenhuma seleção, todos as feições serão utilizadas.

Please note that you can change this behaviour by ubselecting the relevant option in the Processing → Options →
General‘ menu.

Você pode testar selecionando alguns pontos em qualquer uma das camadas que usamos no último capítulo e
executar o algoritmo de reprojeção neles. A camada reprojetada que você obterá irá conter apenas os pontos que
foram selecionados, a menos que não tenha havido seleção, o que fará com que a camada resultante contenha
todos os pontos da camada original.
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Para fazer uma seleção, você pode usar qualquer um dos métodos e ferramentas disponíveis no QGIS. No entanto,
você também pode usar um geoalgoritmo. Os algoritmos para a criação de uma seleção encontram-se na caixa de
ferramentas sob Vector selection tools.

Abra o algoritmo de seleção aleatória Random selection.

Deixando os parâmetros sugeridos, serão selecionados 10 pontos da camada atual.
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Você perceberá que esse algoritmo não produz nenhuma saída, mas modifica a camada de entrada (não a camada
em si, mas sua seleção). Esse é um comportamento incomum, considerando que todos os outros algoritmos
produzirão novas camadas e não alterarão as camadas de entrada.

Desde que a seleção não faz parte dos dados em si, mas sim algo que só existem dentro do QGIS, esses algoritmos
de seleção somente devem ser utilizados para selecionar uma camada que está aberta no QGIS, e não com a opção
de seleção de arquivo que você pode encontrar no caixa de parâmetros correspondente.

A seleção que acabamos de fazer, como a maioria das criadas pelo resto dos algoritmos de seleção, também pode
ser feita manualmente pelo QGIS, assim, você pode estar se perguntando porque utilizar um algoritmo para isso.
Embora agora isso possa não fazer muito sentido para você, vamos ver mais tarde como criar modelos e scripts.
Se você quiser fazer uma seleção no meio de um modelo (que define um fluxo de trabalho de processamento),
apenas um geoalgoritmo pode ser adicionado a um modelo; outros elementos e operações QGIS não podem
ser adicionados. Essa é a razão porque alguns algoritmos de processamento duplicam uma funcionalidade que
também está disponível em outros elementos do QGIS.

Por hora, só recorde que as seleções podem ser feitas usando geoalgoritmos de processamento e que esses algorit-
mos só utilizarão os objetos espaciais selecionados se existir uma seleção, senão todos os objetos espaciais serão
utilizados.

17.8 Rodando um algoritmo externo

Nota: Nesta lição veremos como usar algoritmos que dependem de um aplicativo de terceiros, particularmente o
SAGA, que é um dos principais provedores de algoritmos.

Todos os algoritmos que temos estudado até agora são parte da estrutura de processamento do Qgis, ou seja,
eles são nativos, algoritmos implementados por meio de plugins rodam no QGIS assim como o plug-in em si. No
entanto, uma das maiores características do quadro de processamento é que ele pode usar algoritmos de aplicações
externas e ampliar as possibilidades de esses aplicativos. Esses algoritmos são envolvidos e incluídos na caixa de
ferramentas, para que você possa facilmente utilizá-las de QGIS, e usar QGIS para executá-los.

Alguns dos algoritmos que você vê na visão simplificada exigem aplicativos de terceiros para ser instalado em
seu sistema. Um provedor de algoritmo de especial interesse é o SAGA (Sistema Automatizado de Análise
Geoespacial). Primeiro, precisamos configurar tudo para que o QGIS pode chamar corretamente o SAGA. Isso
não é difícil, mas é importante entender como funciona. Cada aplicativo externo tem a sua própria configuração,
e mais tarde neste mesmo manual, vamos falar sobre alguns dos outros, mas o SAGA vai ser o nosso principal
exemplo, então vamos discutí-lo aqui.

Se você estiver no Windows, a melhor maneira de trabalhar com algoritmos externos é instalar QGIS usando o
instalador independente. Ele vai cuidar de instalar todas as dependências necessárias, incluindo o SAGA, por
isso, se você tê-lo usado, não há mais nada a fazer. Você pode abrir a janela de configurações e vá para o grupo
Providers/SAGA.
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O caminho do SAGA já deve estar configurado e apontando para a pasta onde o SAGA está instalado.

If you have installed QGIS not using the standalone installer, then you must enter the path to your SAGA installa-
tion (which you must have installed separately) there. The required version is SAGA 2.1

In case you are using Linux, you do not have to set the path to your SAGA installation in the processing configu-
ration. Instead, you must install SAGA and make sure that the SAGA folder is in PATH, so it can be called from
the console (just open a console and type saga_cmd to check it). Under Linux, the target version for SAGA is
also 2.1, but in some installations (such as the OSGeo Live DVD) you might have just 2.0.8 available. There are
some 2.1 packages available, but they are not commonly installed and might have some issues, so if you prefer to
use the more common and stable 2.0.8, you can do it by enabling 2.0.8 compatibility in the configuration dialog,
under the SAGA group
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Uma vez que o SAGA está instalado, você pode iniciar um algoritmo do SAGA dando duplo clique sobre seu
nome, como com qualquer outro algoritmo. Desde que nós estamos usando a interface simplificada, você não
saberá quais algoritmos são baseados noSAGA ou em outro aplicativo externo, mas se der duplo clique em um
deles e o aplicativo correspondente não estiver instalado, você vai ver algo como isto.

No nosso caso, observamos que o SAGA está corretamente instalado e configurado, e por isso você não deve ver
esta janela, e vai chegar a caixa de parâmetros em vez desta janela.

Vamos tentar abrir um algoritmo baseado no SAGA, o chamado Split shapes layer randomly / divisão das formas
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de uma camada aleatoreamente.

Use a camada de pontos no projeto correspondente a esta lição como entrada, e os valores de parâmetros padrão,
e você terá algo como isto (a divisão é aleatória, para que o seu resultado possa ser diferente).

A camada de entrada foi dividida em duas camadas, cada uma com o mesmo número de pontos. Esse resultado
foi calculado pela SAGA, e posteriormente executado pelo QGIS e adicionado ao projeto do QGIS.

Se tudo correr bem, você não vai notar nenhuma diferença entre este algoritmo do SAGA e um dos outros que
temos executado anteriormente. No entanto, o SAGA pode, por alguma razão, não ser capaz de produzir um
resultado e não gerar o arquivo que o QGIS está esperando. Nesse caso, não haverá problemas em adicionar o
resultado para o projecto QGIS, e uma mensagem de erro como esta será mostrada.
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Estes tipos de problemas podem acontecer, mesmo se o SAGA (ou qualquer outra aplicação que estamos
chamando a partir da estrutura de processamento) está instalado corretamente, e é importante saber como lidar
com eles. Vamos produzir uma daquelas mensagens de erro.

Abra o algoritmo Create graticule / Criar retícula e usar os seguintes valores.

Nós estamos usando de largura e altura valores que são maior do que na medida especificada, assim o SAGA
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não pode produzir qualquer saída. Em outras palavras, os valores dos parâmetros estão errados, mas eles não são
verificadas até o SAGA recebe-los e tentar criar a retícula. Uma vez que não pode criá-lo, ele não vai produzir a
camada esperado, e você verá a mensagem de erro mostrada acima.

Entender esse tipo de problema vai ajudá-lo a resolvê-los e encontrar uma explicação para o que está acontecendo.
Como você pode ver na mensagem de erro, é executado um teste para verificar se a conexão com o SAGA está
funcionando corretamente, o que indica que pode haver um problema na forma como o algoritmo foi executado.
Isso se aplica não só para o SAGA, mas também para outras aplicações externas.

Na próxima lição, vamos introduzir o registo de processamento, onde as informações sobre os comandos execu-
tados pelos geoalgorítimos são mantidas, e você vai ver como obter mais detalhes quando questões como esta
aparecer.

17.9 O log do processamento

Nota: Esta lição descreve o log de processamento.

All the analysis performed with the processing framework is logged in its own logging system. This allows you
to know more about what has been done with the processing tools, to solve problems when they happen, and also
to re–run previous operations, since the logging system also implements some interactivity.

To open the log, select the corresponding entry in the processing menu. You will see the following dialog.

It contains four blocks of information: Info, Error, Warnings and Algorithms. Here is a description of all of them.

• Info. Some algorithms might leave here information about their execution. For instance, those algorithms
that call an external application usually log the console output of that application to this entry. If you have
a look at it, you will see that the output of the SAGA algorithm that we just run (and that fail to execute
because input data was not correct) is stored here.
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Isso é útil para entender o que está acontecendo. Os usuários avançados serão capazes de analisar a saída para
descobrir por que o algoritmo falhou. Se você não for um usuário avançado, isso vai ser útil para outras pessoas
para ajudá-lo a diagnosticar o problema que você tem, que pode ser um problema na instalação do software externo
ou um problema com os dados que você forneceu.

• Warnings. Even if the algorithm could be executed, some algorithms might leave warnings in case the result
might not be right. For instance, when executing an interpolation algorithm with a very small amount of
points, the algorithm can run and will produce a result, but it is likely that it will not be correct, since more
points should be used. It’s a good idea to regularly check for this type of warnings if you are not sure about
some aspect of a given algorithm.

• Error. Errors that appear and are not directly related to external applications are logged in this section.

• Algorithms. All algorithms that are executed, even if they are executed from the GUI and not from the
console (which will be explained later in this manual) are stored in this part of the log as a console call.
That means that everytime you run an algorithm, a console command is added to the log, and you have the
full history of your working session. Here is how that history looks like:
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Isto pode ser muito útil quando começar a trabalhar com a console, para aprender sobre a sintaxe dos algoritmos.
Vamos usá-lo quando discutirmos como executar comandos de análise a partir da console.

A história também é interativa e você pode reexecutar qualquer algoritmo anterior apenas com um duplo clique
em sua entrada. Esta é uma maneira fácil de replicar o trabalho que fizemos antes.

Por exemplo, tente o seguinte: abra os dados correspondentes ao primeiro capítulo deste manual e execute o al-
goritmo explicado lá; agora vá para a janela de log e localize o último algoritmo na lista, que corresponde ao
algoritmo que acabou de ser executado; dê um duplo clique sobre ele e um um novo resultado deve ser pro-
duzido, assim como quando você executou-o usando a caixa de diálogo normal e chamando-o a partir da caixa de
ferramentas.

17.9.1 Avançado

You can also modify the algorithm. Just copy it, open the Plugins → Python console, click on Import class → Im-
port Processing class, then paste it to re-run the analysis; change the text at will. To display the resulting file, type
iface.addVectorLayer(’/path/filename.shp’, ’Layer name in legend’, ’ogr’).

17.10 A calculadora raster. Sem valores de dado

Nota: Nesta lição veremos como usar a calculadora raster para executar algumas operações em camadas raster.
Nós também iremos explicar o que é ‘sem valores de dados’ e como a calculadora e outros algoritmos de lidam
com eles.
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A calculadora raster é um dos algoritmos mais poderosos que você vai encontrar. É um algoritmo muito flexível e
versátil que pode ser usado para muitos cálculos diferentes e que em breve se tornará uma parte importante de sua
caixa de ferramentas.

Nesta lição, realizaremos alguns cálculos com a calculadora raster, a maioria deles bastante simples. Isso vai
deixar-nos ver como ela é usada e como ela lida com algumas situações particulares que poderia-se encontrar.
Entender isso é importante para mais tarde obter os resultados esperados quando utilizar a calculadora e também
para compreender certas técnicas que são comumente aplicadas com ela.

Abra o projeto QGIS correspondente a esta lição e você vai ver que ele contém várias camadas raster.

Abra Raster → Calculadora Raster....

Nota: A interface é diferente em versões recentes.

A janela contém vários parâmetros.

• Bandas Raster: com um duplo clique, você seleciona uma camada para ser usada na calculadora.

• Operadores: os operadores que podem ser usados nas operações.

Aviso: A calculadora diferencia minúsculas de maiúsculas.

Para começar, vamos mudar as unidades do ‘dem25’ de metros para pés. A fórmula que precisaremos é a seguinte:

h’ = h * 3.28084

Selecione a camada dem25, em Bandas Raster, com um duplo clique e digite, em seguida, ‘‘ * 3.28084‘‘ no campo
de expressão raster.

Aviso: Use sempre ”.” e não ”,” para a casa decimal.
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Dê um nome para a camada de saída e clique OK para executar o algoritmo. Você vai ter uma camada que tem
a mesma aparência da camada de entrada, mas com valores diferentes. A camada de entrada que usamos tem
valores válidos em todas as suas células, de modo que o último parâmetro não tem nenhum efeito.

Vamos agora realizar um outro cálculo, desta vez sobre a camada accflow. Essa camada contém valores de fluxo
acumulado, um parâmetro hidrológico. Ela contém esses valores apenas dentro da área de uma dada bacia, sem
valores fora da mesma. Como você pode ver, a renderização não é muito informativa, devido à forma como os
valores estão distribuídos. Usando o logaritmo dessa acumulação de fluxo irá produzir uma representação muito
mais informativa. Podemos calcular isso com o uso da calculadora raster.

Abra a janela novamente, selecione a camada accflow na banda raster e insira a seguinte fórmula:
sqtr(sqtr("accflow@1")).

Você deverá ter uma camada resultante parecida com essa:

Se você selecionar a ferramenta Identificar feições para saber o valor de uma camada em um determinado ponto,
selecionar a camada que acabou de criar e clicar em um ponto fora da bacia, você verá que ele não tem valor.
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Para o próximo exercício vamos usar duas camadas, em vez de uma, e iremos obter um MDE com valores de
elevação válidos apenas dentro da bacia definida na segunda camada. Abra a calculadora raster e insira a seguinte
fórmula no campo de expressão: "accflow@1" / "accflow@1" * "dem25@1". Ou para versões anteri-
ores:

a/a * b

a, ou accflow, refere-se à camada de fluxo acumulado e b, ou dem25, refere-se ao MDE. O que estamos
fazendo na primeira parte da fórmula é dividindo a camada de fluxo acumulada por ela mesma, o que irá resultar
em um valor de 1 no interior da bacia, e nenhum valor fora da mesma. Depois multiplicamos pelo MDE, para
obter o valor de elevação das células no interior da bacia (MDE * 1 = MDE) e o sem-valor para os dados fora
dela (MDE * sem_valor = sem_valor)

Eis a camada resultante:

Esta técnica é utilizada com frequência para mascarar valores em uma camada raster e é útil sempre que você
quiser executar cálculos para uma região diferente da retangular arbitrária que é usada pela camada raster. Por
exemplo, um histograma de elevação de uma camada raster não tem muito significado. Se em vez disso o mesmo
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é calculado utilizando apenas os valores correspondentes a uma bacia (como no caso acima), o resultado que se
obtém é significativo e realmente dá informações sobre a configuração da bacia.

Existem outras coisas interessantes sobre esse algoritmo que acabamos de executar, além dos dados sem valor e de
como eles são tratados. Se você der uma olhada nas extensões das camadas que multiplicamos (você pode fazê-lo
dando um duplo clique em seus nomes na tabela de conteúdo e olhando para as suas propriedades), você vai ver
que não são iguais, dado que a extensão coberta pela camada de acumulação de fluxo é menor do que a extensão
total do MDE.

Isso significa que aquelas camadas não se encaixam e que não podem ser multiplicadas diretamente sem homo-
geneizar os tamanhos e extensões por meio do redimensionamento de uma ou de ambas as camadas. No entanto,
não fizemos nada. O QGIS cuida dessa situação e automaticamente redimensiona as camadas de entrada, quando
necessário. A extensão de saída é a menor extensão de cobertura, calculada a partir das camadas de entrada, e o
tamanho de célula o menor dos tamanhos de célula.

Neste caso (e na maioria dos casos), isto produz os resultados desejados, mas você deve sempre estar ciente das
operações adicionais que estão ocorrendo, uma vez que elas podem afetar o resultado. Nos casos em que esse
comportamento pode não ser o desejado, o redimensionamento manual deve ser aplicado com antecedência. Nos
próximos capítulos, veremos mais sobre o comportamento dos algoritmos ao usar várias camadas raster.

Vamos terminar esta lição com outro exercício de mascaramento. Vamos calcular a inclinação em todas as áreas
com uma altitude entre 1000 e 1500 metros.

Neste caso, não temos uma camada para usar como máscara, mas podemos criá-la usando a calculadora.

Execute a calculadora utilizando o MDE como única camada de entrada e a seguinte fórmula:

ifelse(abs(a-1250) < 250, 1, 0/0)

Como você pode ver, nós podemos usar a calculadora não só para fazer operações algébricas simples, mas também
para executar cálculos mais complexos que envolvam sentenças condicionais, como a descrita acima.

O resultado tem um valor de 1 dentro da faixa com a qual queremos trabalhar e sem valor em células fora dela.

O “sem valor” vem da expressão 0/0. Uma vez que é um valor indeterminado, irá somar um valor NaN (não é um
número), o qual é realmente tratado como um “sem valor”. Com este pequeno truque você pode definir um “sem
valor” sem a necessidade de saber qual é o “sem valor” da célula de dados.

Agora você só tem que multiplicá-lo pela camada de inclinação incluída no projeto e você vai obter o resultado
desejado.

Tudo isso pode ser feito numa única operação, com a calculadora. Nós deixamos isso como um exercício para o
leitor.
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17.11 Calculadora vetorial

Nota: Nesta lição, veremos como adicionar novos atributos a uma camada vetorial baseado em uma expressão
matemática, usando a calculadora vetorial.

We already know how to use the raster calculator to create new raster layers using mathematical expressions. A
similar algorithm is available for vector layers, and generates a new layer with the same attributes of the input
layer, plus an additional one with the result of the expression entered. The algorithm is called Field calculator and
has the following parameters dialog.

Nota: In newer versions of Processing the interface has changed considerably, it’s more powerful and easier to
use.

Here are a couple of examples of using that algorithm.

First, let’s calculate the population density of white people in each polygon, which represents a census. We have
two fields in the attributes table that we can use for that, namely WHITE and SHAPE_AREA. We just have to
divide them and multiply by one million (to have density per square km), so we can use the following formula in
the corresponding field

( WHITE / SHAPE_AREA ) * 1000000

The parameters dialog should be filled as shown below.

This will generate a new field named WHITE_DENS

Agora vamos calcular a proporção entre os campos “MASCULINOS” e “FEMININOS” para criar um novo que
indique que a população masculina é numericamente predominante sobre a população feminina.

Entre a fórmula seguinte
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"MALES" / "FEMALES"

This time the parameters window should look like this before pressing the OK button.
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In earlier version, since both fields are of type integer, the result would be truncated to an integer. In this case the
formula should be: 1.0 * "MALES" / "FEMALES", to indicate that we want floating point number a result.

We can use conditional functions to have a new field with male or female text strings instead of those ratio
value, using the following formula:

CASE WHEN "MALES" > "FEMALES" THEN ’male’ ELSE ’female’ END

The parameters window should look like this.
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Uma calculadora de campo python está disponível em Calculadora de campo avançada Python,que não será
detalhada aqui.
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17.12 Definindo as medidas

Nota: Nesta lição, verificaremos como definir as medidas, que são necessárias em alguns algoritmos, especial-
mente uma imagem.

Alguns algoritmos requerem uma medida para definir a área a ser coberta pela análise, que desempenham geral-
mente para definir a extensão da camada resultante.

Quando a medida for necessária, ela pode ser definida manualmente, digitando os quatro valores que definem (X
mínimo, Y mínimo, X máximo, Y máximo), mas existem outros mais práticos e formas mais interessantes de
fazer. Vamos ver todos nesta lição.

First, let’s open an algorithm that requires an extent to be defined. Open the Shapes to grid algorithm, which
creates a raster layer from a vector layer.
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All the parameters, except for the last two ones, are used to define which layer is to be rasterized, and configure
how the rasterization process should work. The two last parameters, on the other hand, define the characteristics
of the output layer. That means that they define the area that is covered (which is not necesarily the same area
covered by the input vector layer), and the resolution/cellsize (which cannot be infered from the vector layer, since
vector layers do not have a cellsize).

Primeiro você pode operar o tipo 4 definindo os valores explicados antes, separados por vírgulas.

Não necessita de mais explicações. Enquanto esta é a opção mais flexível, é também o menos prático em alguns
casos, é por isso que outras opções sejam implementadas. Para acessá-las, você dá um clique no botão direito–lado
a lado da medida na caixa de texto.

Verificar o que cada um deles faz.

A primeira opção é * Use a camada/ tela de medida*, que irá mostrar a caixa de diálogo de seleção, exibida abaixo,
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Aqui você pode selecionar a medida da tela (a memida abrangida pelo zoom atual), ou a extensão dos níveis
disponíveis. Selecione-o e cliquem em OK, e a caixa de texto será preenchida automaticamente com os valores
correspondentes.

A segunda opção é Selecione medida em tela. Neste caso, o algoritmo de diálogo desaparecerá e você pode clicar
e arrastar sobre a tela QGIS para definir a medida desejada.

Assim que você soltar o botão do mouse, a caixa de diálogo aparecerá e a caixa de texto terá os valores correspon-
dentes à medida.

A última opção é Usar o mínimo abrindo a parte da entrada das camadas, que á a opção padrão. Este irá calcular
a parte mínima cobrindo todas as camadas usadas para executar o algoritmo, e não há necessidade de digitar
qualquer valor na caixa de texto. No caso de uma entrada na única camada, como no algoritmo que estamos
trabalhando, a mesma medida pode ser obtida na entrada pela seleção na mesma camada na Use a camada/medida
da tela que já exibimos. No entanto, quando existem várias camadas, a entrada mínima da medida não corresponde
a qualquer camada de entrada, uma vez que é calculado a partir de todos em conjunto.

Verificar e utilizar este método para executar o nosso algoritmo ou uma rasterização.

Preencha a caixa de diálogo dos parâmetros como mostra ao lado, e pressione OK.
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Nota: In this case, better use an Integer (1 byte) instead of a Floating point (4 byte), since the ID is an integer
with maximum value=63. This will result in a smaller file size and faster computations.

Você apresentará uma camada rasterizada, que cobre exatamente a área coberta pela camada vetorial original.
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Em alguns casos, a última opção, pode não está disponível Usar o mínimo cobrindo a parte da camada de entrada.
O que irá acontecer com os algoritmos que não tem camada de entrada, mas apenas os outros tipos de parâmetros.
Neste caso, você terá que inserir o valor manualmente ou usar qualquer uma das outras opções.

Observe que, quando existe uma seleção, é que a medida do nível de todo conjunto de recursos, não é usada a
seleção para calcular a medida, mesmo que a rasterização é somente executada os itens selecionados. Nesse caso,
você pode criar uma nova camada, e querer a partir da seleção, e em seguida, usá-lo como entrada.

17.13 Saídas HTML

Nota: Nesta lição aprendemos como manipular saídas em formato HTML no QGIS, que são usadas para produzir
saídas de texto e gráficos.

Todas as saídas que produzimos até agora eram camadas (se raster ou vetor). No entanto, alguns algoritmos de
geração de saídas na forma de texto e gráficos. Todas estas saídas são realizadas em arquivos HTML e exibidas
no modo – chamado Visualização dos Resultados, que é outro elemento da estrutura de processamento.

Vamos ver um desses algoritmos para entender como eles funcionam.

Abra o projeto com os dados a serem utilizados nesta lição e abra o algoritmo estatísticas básicas para campos
numéricos.
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O algoritmo é bastante simples, e você só tem que selecionar a camada para uso e um de seus campos (numéricos).
A saída é do tipo HTML, mas a caixa correspondente funciona exatamente como o que você pode encontrar no
caso de uma saída de raster ou vector. Você pode inserir um caminho de arquivo, ou deixar em branco para salvar
em um arquivo temporário. Neste caso, no entanto, apenas o html e extensões htm são permitidas, então não há
nenhuma maneira de alterar o formato de saída, usando um diferente.

Execute o algoritmo de seleção em uma única camada do projeto como entrada, e o campo POP2000, e uma nova
caixa de diálogo como a mostrada ao lado aparecerá uma vez que o algoritmo é executado e a caixa de diálogo
parâmetros é fechado.

17.13. Saídas HTML 473



QGIS Training Manual, Versão 2.8

Este é o Visualizador de Resultados. Ele mantém todo o resultado HTML gerado durante a sessão atual, de fácil
acesso, para que você possa vê-los rapidamente sempre que você precisar. Como acontece com camadas, se você
salvou a saída para um arquivo temporário, ele será excluído depois de fechar o QGIS. Se tiver salvo em um
caminho não-temporário, o arquivo permanecerá, mas não aparece no Visualizador de Resultados da próxima vez
que você abrir o QGIS.

Alguns algoritmos geram textos que não podem ser divididos em outras saídas mais detalhadas. Tal é o caso se,
por exemplo, o algoritmo capturar a saída de texto a partir de um processo externo. Em outros casos, o resultado é
apresentado como texto, mas internamente é dividido em várias saídas menores, geralmente sob a forma de valores
numéricos. O algoritmo que acabamos de executado é um deles. Cada um destes valores é tratada como uma única
saída, e armazenados numa variável. Isso não tem nenhuma importância em tudo agora, mas quando passamos
para o modelador gráfico, você vai ver que ele vai nos permitir usar esses valores como entradas numéricas para
outros algoritmos.

17.14 Primeiro exemplo de análise

Nota: Nesta lição vamos fazer uma análise real utilizando apenas a caixa de ferramentas para que possa ter mais
familiaridade com os elementos da área de trabalho de processamento.

Now that everything is configured and we can use external algorithms, we have a very powerful tool to perform
spatial analysis. It is time to work out a larger exercise with some real–world data.

We will be using the well-known dataset that John Snow used in 1854, in his groundbreaking work
(http://en.wikipedia.org/wiki/John_Snow_%28physician%29), and we will get some interesting results. The anal-
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ysis of this dataset is pretty obvious and there is no need for sofisticated GIS techniques to end up with good
results and conclusions, but it is a good way of showing how these spatial problems can be analyzed and solved
by using different processing tools.

The dataset contains shapefiles with cholera deaths and pump locations, and an OSM rendered map in TIFF
format. Open the corresponding QGIS project for this lesson.

The first thing to do is to calculting the Voronoi diagram (a.k.a. Thyessen polygons) of the pumps layer, to get the
influence zone of each pump. The Voronoi Diagram algorithm can be used for that.
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Muito fácil, porém ele nos dará informação interessantes.
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Claramente, muitos casos estão dentro de um dos polígonos

To get a more quantitative result, we can count the number of deaths in each polygon. Since each point represents
a building where deaths occured, and the number of deaths is stored in an attribute, we cannot just count the points.
We need a weighted count, so we will use the Count points in polygon (weighted) tool.
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The new field will be called DEATHS, and we use the COUNT field as weighting field. The resulting table clearly
reflects that the number of deaths in the polygon corresponding to the first pump is much larger than the other
ones.
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Another good way of visualizing the dependence of each point in the Cholera_deaths layer with a point in
the Pumps layer is to draw a line to the closest one. This can be done with the Distance to closest hub tool, and
using the configuration shown next.
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O resultado se parece com isso:
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Although the number of lines is larger in the case of the central pump, do not forget that this does not represent the
number of deaths, but the number of locations where cholera cases were found. It is a representative parameter,
but it is not considering that some locations might have more cases than other.

A density layer will also give us a very clear view of what is happening. We can create it with the Kernel density
algorithm. Using the Cholera_deaths layer, its COUNT field as weight field, with a radius of 100, the extent and
cellsize of the streets raster layer, we get something like this.
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Lembre-se que, para obter a extensão de saída, você não precisa digitá-lo. Clique no botão no lado direito e
selecione Use camada/extensão da área do mapa.

482 Chapter 17. O guia de processamento do QGIS



QGIS Training Manual, Versão 2.8

Seleccione la capa de calles ráster y su extensión automáticamente se añadirá al campo de texto. Debe hacer lo
mismo con el tamaño de celda, seleccionando el tamaño de celda de esa capa también.

La combinación con la capa de bombas, vemos que hay una bomba claramente en el punto de acceso donde se
encuentra la máxima densidad de los casos de muerte.

17.15 Recortar e mesclar camadas raster

Nota: Nesta lição veremos outro exemplo de preparação de dados espaciais, para continuar usando geoalgorítmos
em cenários reais.

Para esta lição, vamos calcular uma camada de inclinação para uma área em torno de uma área da cidade, que
é dado em uma camada vetorial com um único polígono. O DEM base é dividido em duas camadas raster que,
em conjunto, cobrem uma área muito maior do que o entorno da cidade que queremos trabalhar. Se você abrir o
projeto correspondente a esta lição, você vai ver algo como isto
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Essas camadas têm dois problemas:

• Eles cobrem uma área que é muito grande para o que queremos (nós estamos interessados em uma região
menor ao redor do centro da cidade)

• They are in two different files (the city limits fall into just one single raster layer, but, as it’s been said, we
want some extra area around it).

Ambos são facilmente solucionáveis com os geoalgoritmos adequados.

Primeiro. Nós criamos um retângulo definindo a área que nós queremos. Para fazer isto, nós criamos uma camada
contendo a caixa delimitadora da camada com os limites da área da cidade, e então lhe aplicamos um buffer, de
modo a ter uma camada raster que cobre um pouco mais do que o estritamente necessário.

Para calcular a caixa delimitadora, nós podemos usar o algoritmo Polígono a partir da extensão da camada
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Para aplicar o buffer, nós usamos o Buffer de distância fixa, com os seguintes valores de parâmetros.

Aqui está a caixa delimitadora obtida usando os parâmetros acima
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É uma caixa arredondada, mas podemos facilmente chegar a caixa equivalente com ângulos retos, executando o
algoritmo Polígono a partir da extensão da camada nele. Poderíamos ter aplicado um buffer dos limites da cidade
em primeiro lugar, e depois calcular a extensão retângulo, economizando uma etapa.

Você vai notar que os rasters tem uma projeção diferente do vetor. Devemos, portanto, reprojetá-los antes de
prosseguir, usando a ferramenta Deformar (reprojeção).
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Nota: Recent versions have a more complex interface. Select at least one compression method.

With this layer that contains the bounding box of the raster layer that we want to obtain, we can crop both of the
raster layers, using the Clip grid with polygon algorithm.
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Uma vez que as camadas foram cortadas, eles podem ser mescladas usando o algoritmo GDAL Merge.
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Aviso: The following paragraph is obsolete.

A cellsize is needed for the merged layer. We will use the same one of the input ones. You do not need to know it
in advance before calling the algorithm. Just click on the button in the right–hand size of the text field and you will
have a dialog to enter small mathematical formulas, and a list of frequently used values, among them the cellsizes
and bounding coordinates of all available layers.

Nota: You can save time merging first and then cropping, and you will avoid calling the clipping algorithm twice.
However, if there are several layers to merge and they have a rather big size, you will end up with a large layer
than it can later be difficult to process. In that case, you might have to call the clipping algorithm several times,
which might be time consuming, but don’t worry, we will soon see that there are some additional tools to automate
that operation. In this example, we just have two layers, so you shouldn’t worry about that now.

Com isso, temos o DEM final que queremos.

Agora é hora de calcular a camada de declividade.

A camada de inclinação pode ser calculado com o algoritmo Slope, Aspect, Curvature, mas o DEM obtido na
última etapa não é adequado como entrada, uma vez que valores de elevação estão em metros, mas o tamanho
da célula não é expresso em metros (a camada usa um CRS com coordenadas geográficas). É necessária uma
reprojeção. Para reprojetar uma camada raster, o algoritmo *Deformar (reprojetar) * pode ser usado novamente.
Nós reprojetamos em um CRS com medidores como unidades (por exemplo, 3857), para que possamos, então,
calcular correctamente a declividade, tanto com SAGA ou GDAL.

Here is the reprojected DEM.
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Com o novo DEM, a declividade pode ser agora calculada.
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E aqui está a camada resultante de declividade.
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The slope produced by the Slope, Aspect, Curvature algorithm is expressed in radians, but degrees are a more
practical and common unit. The Metric conversions algorithm will help us to do the conversion (but in case you
didn’t know that algorithm existed, you could use the raster calculator that we have already used).
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Reprojetando a camada de declividade convertida novamente com o Reprojetar camada raster, temos a camada
final que queríamos.

Aviso: todo: Adicionar imagem

The reprojection processes have caused the final layer to contain data outside the bounding box that we calculated
in one of the first steps. This can be solved by clipping it again, as we did to obtain the base DEM.

17.16 Análise hidrológica

Nota: En esta lección vamos a realizar algunos análisis hidrológicos. Este análisis será utilizado en algunas de las
siguientes lecciones, como se constituye un muy buen ejemplo de un flujo de trabajo de análisis, y lo utilizaremos
para mostrar algunas características avanzadas.

En esta lección, vamos a hacer algunos analisis hidrológicos. A partir de un MDT, vamos a extraer una red de
canales, delimitar las cuencas hidrográficas y calcular algunas estadísticas.

Lo primero es cargar el proyecto con los datos de la lección, que solo contiene un MDT.
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The first module to execute is Catchment area. You can use anyone of the others named Catchment area. They
have different algorithms underneath, but the results are basically the same.

Seleccione el MDT en el campo Elevación, y deje los valores por defecto para el resto de los parámetros.
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Algunos algoritmos calculan muchas capas, pero la Zona de captación es la única que utilizaremos.

Puede deshacerse de los otros si lo desea.

El renderizado de la capa no es muy informativa.

Para saber por qué, se puede echar un vistazo el histograma y verá que los valores no se distribuyen de manera
uniforme (hay algunas celdas con un valor muy alto, esos corresponden a la red de canales). Calcule el logaritmo
del valor de área de captación que produce una capa que transmite mucha más información (se puede hacer uso
de la calculadora ráster).
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El área de captación (también conocido como acumulación de flujo) se puede utilizar para establecer un limite
para la iniciación de canal. Esto se puede hacer utilizando el algoritmo Red de canales. Así es como hay que
configurarlo (tome nota de Umbral de iniciación Mas grande que 10.000.000).
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Utilice la capa de zona de captación original, no el logaritmo uno. Que uno era sólo para fines de renderizado.

Si se incrementa el valor de Umbral de iniciación, obtendrá una red de canales más escasa. Si la disminuye,
obtendrá una más densa. Con el valor propuesto, esto es lo que tendrá.
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La imagen de arriba solo muestra la capa vectorial resultante y el MDT, pero también debe ser un ráster con la
misma red de canales. Ese ráster será, de hecho, una que utilizaremos.

Ahora, vamos a utilizar el algoritmo Cuencas hidrográficas para delinear las subcuencas correspondientes a la red
de canales, utilizando como puntos de salida de todas las uniones en ella. Así es cómo tiene que establecer el
diálogo de parámetros correspondiente.
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Y esto es lo que obtendrá.

Este es un resultado ráster. Se puede vectorizar utilizando el algoritmo Vectorizando clases de cuadrícula.
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Ahora, vamos a tratar de calcular estadísticas sobre los valores de elevación en una de las subcuencas. La idea es
tener una capa que simplemente represente la elevación dentro de esa subcuenca y luego pasarla al módulo que
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calcula estas estadísticas.

First, let’s clip the original DEM with the polygon representing a subbasin. We will use the Clip grid with polygon
algorithm. If we select a single subbasin polygon and then call the clipping algorithm, we can clip the DEM to the
area covered by that polygon, since the algorithm is aware of the selection.

Selecionar um polígono,

e chama o algoritmo de corte com os seguintes parâmetros:
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O elemento selecionado no campo de entrada é, por suposto, o MDT que desejamos cortar.

Obteremos algo como isto.
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Esta camada esta listada para ser utilizada no algoritmo Estatísticas de camada raster.

As estatísticas resultantes são as seguintes.

Vamos a utilizar tanto el procedimiento de cálculo de cuenca y el cálculo de las estadísticas en otras lecciones,
para averiguar cómo otros elementos pueden ayudar a automatizar ambos y trabajar más eficazmente.
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17.17 Iniciando com o modelador gráfico

Nota: Nesta lição usaremos o modelador gráfico, um poderoso componente que podemos usar para definir um
fluxo de trabalho e executar uma cadeia de algoritmos.

Uma sessão normal com as ferramentas de processamento incluem mais do que rodar um único algoritmo. Nor-
malmente, vários deles são executados para se obter um resultado, e as saídas de alguns destes códigos são usados
como entrada para outros.

Usando o modelador gráfico, o fluxo de trabalho pode ser colocado em um modelo, que rodará todos os algoritmos
necessários em uma única execução, simplificando, assim, todo o processo e o automatizando.

Para iniciar esta lição, vamos calcular um parâmetro denominado Índice de Umidade Topográfico. O algoritmo
que computa é chamado Índice de Umidade Topográfico (iut)

Como você pode ver, existem duas entradas obrigatórias: Slope e Área de Captação. Há também uma entrada
opcional, porém você não poderá usá-la, então ignore-a.

Los datos para esta lección contienen sólo un MDT, así que no tenemos ninguna de las entradas requeridas. Sin
embargo, conocemos cómo calcular ambos a partir de ese MDT, como ya hemos visto los algoritmos para calcular
pendiente y zona de captación. Así que lo primero que podemos calcular son esas capas y entonces utilizarlos
para el algoritmo TWI.

Aquí esta el diálogo de parámetros que debería utilizar para calcular las capas intermedias.
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Y esto es cómo tener que establecer el diálogo de parámetros del algoritmo TWI.
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Este es el resultado que obtendremos (La paleta invertida de una sola capa de psudocolor se ha utilizado para la
representación). Se puede utilizar el estilo proporcionado twi.qml.

Lo que vamos a tratar de hacer ahora es crear un algoritmo que calcule el TWI de un MDT en sólo un paso. Eso
nos ahorrará trabajo en caso de que después tengamos que calcular una capa TWI de otro MDT, como necesitamos
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sólo un simple paso para hacerlo en lugar de los 3 anteriores. Todos los procesos que necesitamos encontrar en la
caja de herramientas, así que lo tenemos que hacer es definir el flujo de trabajo para envolverlos. Esto es donde el
modelador gráfico entra.

Abra el modelador seleccionando su entrada de menú en el menú procesamiento.

Dos cosas son necesarias para crear un modelo: establecer las entradas que necesita y definir el algoritmo que este
contiene. Ambos se hacen al añadir elementos de las dos pestañas del lado izquierdo de la ventana modelador
entrado y Algoritmos.

Vamos a empezar con las entradas. En este caso no tenemos mucho que añadir. Sólo necesitamos una capa ráster
con el MDT y que serán nuestros únicos datos de entrada.

Haga doble clic sobre la entrada Capa Ráster y verá el siguiente diálogo.

Aquí tendremos que definir la entrada que desee. Como esperamos que esta capa ráster sea un MDT, lo llamaremos
MDT. Ese es el nombre que el usuario del modelo verá cuando se ejecute. Puesto que necesitamos esa capa para
trabajar, vamos a definirlo como una capa obligatoria.

Aquí esta cómo el diálogo debería ser configurado.
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Haga clic en Aceptar y la entrada aparecerá en el lienzo del modelador.

Ahora vamos a mover a la pestaña Algoritmos. El primer algoritmo que tenemos que ejecutar es Pendiente,
aspecto, curvatura. Localicelo en la lista de algoritmos, haga doble clic sobre él y verá el diálogo que se muestra
a continuación.
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Este diálogo es muy similar a uno que puede encontrar cuando ejecuta el algoritmo desde la caja de herramientas,
pero el elemento que se puede utilizar como valores de parámetros no se toman del actual proyecto QGIS, sino
del modelo en si. Eso significa que, en este caso, no tendrá todas las capas ráster de nuestro proyecto disponible
para el campo Elevación, pero sólo los que se definen en nuestro modelo. Puesto que hemos añadido sólo una
entrada ráster llamada DEM, que será la única capa de ráster que veremos en la lista correspondiente al parámetro
Elevación.

La salida generada por un algoritmo es manejada un poco diferente cuando el algoritmo se utiliza como parte de
un modelo. En lugar de seleccionar la ruta de archivo donde desee guardar cada salida, sólo tiene que especificar
si esa salida es una capa intermedia (y no desea que se conserve después de que el modelo ha sido ejecutado), o es
una final. En este caso, todas las capas producidas por este algoritmo son intermedias. Nosotros sólo utilizaremos
una de ellas (la capa de pendiente), pero no queremos mantenerlo, puesto que sólo lo necesitamos para calcular la
capa TWI, que es el resultado final que deseamos obtener.

Cuando las capas no son un resultado final, sólo debe dejar el campo correspondiente. De lo contrario, se tiene que
introducir un nombre que se utilizará para identificar la capa en el diálogo de parámetros que se mostrará cuando
ejecute el modelo posterior.

No hay mucho para seleccionar en este primer diálogo, puesto que no tenemos una sola capa en o modelo (El
MDT de entrada que creamos). En realidad, la configuración predeterminada del diálogo es la correcta en este
caso, así sólo tiene que presionar Aceptar. Esto es lo que ahora tendrá en el lienzo del modelador.
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El segundo algoritmo tenemos que añadir a nuestro modelo esta el algoritmo de zona de captación. Nosotros
utilizamos el algoritmo llamado Zona de captación (Paralelo). Utilizaremos la capa MDT de nuevo como en-
trada, y ninguno de los resultados producidos son finales, así que aquí es cómo se tiene que llenar el diálogo
correspondiente.
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Agora o seu modelo deve estar semelhante a este.
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El último paso es para añadir el algoritmo Índice humedad topográfica, con la siguiente configuración.

En este caso, estaremos utilizando el MDT como entrada, pero en su lugar, utilizaremos la capa de pendiente y
zona de captación que están calculadas por el algoritmo que previamente añadimos. A medida que agrega nuevos
algoritmos, las salidas que producen estén disponibles para otros algoritmos, y su uso se vincula a los algoritmos,
creando el flujo de trabajo.
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En este caso, la capa de salida TWI es una capa final, as{i tenemos que indicarlo. En la caja de texto correspondi-
ente, ingresar el nombre que desee para ser mostrado en esta salida.

Ahora nuestro modelo esta terminada y debería tener este aspecto.

Ingrese un nombre y un nombre de grupo en la parte superior de la ventana del modelo, y a continuación guárdelo
haciendo clic sobre el botón Guardar.

Se puede guardar donde sea que desee y abrirlo después, pero si se guarda en la carpeta de modelos (que es la
carpeta que verá cuando el diálogo del archivo guardado aparece), el modelo también estará disponible en la caja
de herramientas. Así permanece en la carpeta y guarda el modelo con el nombre de archivo que prefiera.

Ahora cierre el diálogo del modelador y vaya a la caja de herramientas. En la entrada Modelos encontrará su
modelo.

Se puede ejecutar como cualquier algoritmo normal, haga doble clic sobre él.
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Como se puede ver, el diálogo de parámetros, contiene la entrada que se añadió al modelo, junto con las salidas
que se establecieron como finales al agregar los algoritmos correspondientes.

Ejecútelo utilizando el MDT como entrada y se obtendrá la capa TWI en solo un paso.

17.18 Modelos más complejos

Nota: En esta lección vamos a trabajar con un modelo más complejo en el modelador gráfico.

El primer modelo que hemos creado en el capítulo anterior era muy simple, con una sola entrada y 3 algoritmos.
Los modelos más complejos se pueden crear, con diferentes tipos de entradas y contienen más pasos. Para este
capítulo trabajaremos con un modelo que crea una capa vectorial con las cuencas hidrográficas, en base a un DEM
y un valor de umbral. Eso será muy útil para el cálculo de varias capas vectoriales correspondientes a diferentes
umbrales, sin tener que repetir cada paso sencillo cada vez.

Esta lección no contiene instrucciones sobre cómo crear su modelo. Ya conoce los pasos necesarios (los vimos
en una lección anterior) y ya ha visto las ideas básicas sobre el modelador, por lo que debe hacerlo por sí mismo.
Dedique unos minutos para tratar de crear su modelo, y no se preocupe por cometer errores. Recuerde: agregar
primero las entradas y después agregar los algoritmos que los usan para crear el flujo de trabajo.

En caso de que no pudiera crear el modelo completo usted mismo y necesitará un poco de ayuda extra, la carpeta
de datos correspondiente a esta lección contiene una versión ‘casi’ terminada de la misma. Abra el modelador y a
continuación abra el archivo del modelo que encontrará en la carpeta de datos. Debería ver algo como esto.
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Este modelo contiene todos los pasos necesarios para completar los cálculos, sin embargo solo tiene una entrada:
el DEM. Eso significa que el umbral para la definición del canal utiliza un valor fijo, lo que hace el modelo no sea
tan útil como podría ser. Eso no es un problema, ya que podemos editar el modelo. y eso es exactamente lo que
haremos.

En primer lugar, vamos a añadir una entrada numérica. Eso le preguntará al usuario por una entrada numérica
que podemos utilizar cuando un valor sea necesario en cualquiera de los algoritmos incluidos en nuestro modelo.
Haga clic en la entrada *Número * en el árbol de los insumos, y verá el diálogo correspondiente. Rellene con los
valores que se muestran a continuación.

Ahora su modelo debería tener este aspecto.
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La entrada que acabamos de añadir no se utiliza, por lo que el modelo no ha cambiado realmente. Tenemos que
enlazar a el algoritmo que lo utiliza, en ese caso un Canal de red. Para editar un algoritmo ya existente en el
modelador, solo haga clic en el icono del lápiz en la caja correspondiente en el lienzo. Si hace clic en el algoritmo
Canal de red, verá algo como esto.

El diálogo se llena con los valores actuales utilizados por el algoritmo. Se puede ver que el parámetro umbral
tiene un valor fijo de 1.000.000 (esto también es el valor por defecto del algoritmo, pero cualquier otro valor
podría poner ahí). Sin embargo, es posible que note que el parámetro no se introduce en un cuadro de texto
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común, sino en un menú de opciones. Si desdoblarla, verá algo como esto.

La entrada que hemos añadido esta allí y podemos seleccionarlo. Cada vez que un algoritmo en un modelo
requiere un valor numérico, que puede codificar y directamente escribirla, o puede usar cualquiera de las entradas
disponibles y los valores (recuerde que algunos algoritmos generan valores numéricos sencillos.Veremos más
sobre esto pronto). En el caso de un parámetro de texto, también se verá entradas de texto y se podrá seleccionar
una de ellos o escribir el valor fijo deseado.

Seleccione la entrada Umbral en el parámetro Umbral y haga clic en Aceptar para aplicar los cambios a su modelo.
Ahora el diseño del modelo debería tener este aspecto.
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El modelo ahora está completo. Trate de ejecutarlo mediante el DEM que hemos usado en lecciones anteriores,
y con diferentes valores de umbral. Aquí tienes un ejemplo del resultado obtenido para diferentes valores. Puede
comparar con el resultado por el valor por defecto, que es el que hemos obtenido en la lección análisis hidrológico.

Umbral = 100,000
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Umbral = 1,0000,000

17.19 Cálculos numéricos no modelador

Aviso: Precaução! este capítulo no foi testado, por favor informe qualquer problema, as imagens faltam.

Nota: Nesta lição veremos como usar saídas numéricas no modelador

Para esta lição, vamos modificar o modelo hidrológico que criamos no último capítulo (abra o modelo antes de
começar), de tal forma que vamos automatizar o calculo de um valor limite válido e não temos de pedir ao usuário
para que o entre. Já que esse valor refere-se a uma variável na camada raster válida, vamos extrair o valor de essa
camada usando uma análise estatística simples.

Começando com o modelo acima mencionado, vamos fazer as seguintes alterações:

Em primeiro lugar, calculamos as estatísticas acumuladas da camada, usando o algoritmo Estatísticas da camada
raster.
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isto vai gerar um conjunto de valores estatísticos que ficarão disponíveis para todos os campos numéricos em
outros algoritmos.

If you double click on the Channel network algorithm to modify it, as we did in the last lesson, you will see now
that you have other options apart from the numeric input that you added.
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Porém, nenhum destes valores é adequado para usar como límite válido, desde que resultam em redes que não são
muito reais. Podemos, ao contrário, tirar algum novo parâmetro com base neles, para obter melhores resultados.
Por exemplo, podemos usar uma média mais 2 vezes o desvio padrão.

Para adicionar essa operação aritmética, podemos usar a calculadores que encontraremos no grupo
Geoalgoritmos/modelador/modelador-ferramentas. Este grupo inclui algoritmos que não são muito úteis fora
do modelador, mas que fornecem algumas funcionalidades úteis quando criamos um modelo.

O diálogo de parâmetros do calculador de algoritmos aparece como:
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Como você pode ver, o diálogo é diferente dos outros que já vimos, mas você tem aí as mesmas variáveis que
estavam disponíveis no campo Limiar no algoritmo Rede de Drenagem . Digite a fórmula acima e clique em OK
para adicionar o algoritmo.

Se abrimos a entrada de resultados, como mostrado acima, veremos que o modelo está conectado a dois valores,
estes são a média e o desvio padrão, os quais são os que temos usado na fórmula.

Adicionando este novo algoritmo, teremos um novo valor numérico. Indo novamente no algoritmo Channel
network , podemos selecionar agora esse valor no parâmetro Limite.
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Clique OK e o seu modelo vai aparecer assim.

Não estamos usando a entrada numérica que incluímos no modelo, assim sendo podemos retirá-la. Clique com
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botão direito sobre ela e selecione Apagar

Aviso: todo: Adicione imagem

Nosso modelo está agora terminado.

17.20 Um modelo de um modelo

Aviso: Atente que este capítulo não foi completamente testado, por favor informe qualquer problema; as
imagens estão faltando

Nota: Nesta lição veremos como usar um modelo contido dentro de um modelo maior.

We have already created a few models, and in this lesson we are going to see how we can combine them on a
single bigger one. A model behaves like any other algorithm, which means that you can add a model that you have
already created as part of another one that you create after that.

In this case, we are going to expand our hydrological model, by adding the mean TWI value in each of the basins
that it generates as result. To do that, we need to calculate the TWI, and to compute the statistics. Since we have
already created a model to calculate TWI from a DEM, it is a good idea to reuse that model instead of adding the
algorithms it contains individually.

Vamos começar com o modelo que usamos como ponto de partida na lição passada.

Aviso: todo: Add image

First, we will add the TWI model. For it to be available, it should have been saved on the models folder, since
otherwise it will not be shown in the toolbox or the algorithms list in the modeler. Make sure you have it available.

Add it to the current model and use the input DEM as its input. The output is a temporary one, since we just want
the TWI layer to compute the statistics. The only output of this model we are creating will still be the vector layer
with the watersheds.

Here is the corresponding parameters dialog:

Aviso: todo: Add image

Now we have a TWI layer that we can use along with the watersheds vector layer, to generate a new one which
contains the values of the TWI corresponding to each watershed.

This calculation is done using the Grid statistics in polygons algorithm. Use the layers mentioned above as input,
to create the final result.

Aviso: todo: Add image

The output of the Vectorize grid classes algorithm was originally our final output, but now we just want it as an
intermediate result. To change that, we have to edit the algorithm. Just double–click on it to see its parameters
dialog, and delete the name of the output. That will make it a temporary output, as it is by default.

Aviso: todo: Add image

This is how the final model should look like:

Aviso: todo: Add image
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As you see, using a model in another model is nothing special, and you can add it just like you add another
algorithm, as long as the model is saved in the models folder and is available in the toolbox.

17.21 Interpolação

Nota: Este capítulo mostra como interpolar dados de pontos e mostrará outro exemplo real de análise espacial.

Nesta lição iremos interpolar dados de pontos para obter uma camada raster. Antes disso, iremos realizar a
preparação dos dados, e depois de interpolar faremos outros processamentos para modificar a camada resultante,
para termos então uma rotina completa de análise.

Abra os dados de exemplo para esta lição, que deve ser semelhante a este.

The data correspond to crop yield data, as produced by a modern harvester, and we will use it to get a raster layer
of crop yield. We do not plan to do any further analysis with that layer, but just to use it as a background layer for
easily identifying the most productive areas and also those where productivity can be improved.

The first thing to do is to clean–up the layer, since it contains redundant points. These are caused by the movement
of the harvester, in places where it has to do a turn or it changes its speed for some reason. The Points filter
algorithm will be useful for this. We will use it twice, to remove points that can be considered outliers both in the
upper and lower part of the distribution.

For the first execution, use the following parameter values.
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Now for the next one, use the configuration shown below.
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Notice that we are not using the original layer as input, but the output of the previous run instead.

The final filter layer, with a reduced set of points, should look similar to the original one, but it contains a smaller
number of points. You can check that by comparing their attribute tables.

Now let’s rasterize the layer using the Shapes to grid algorithm.
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The Filtered points layer refers to the resulting one of the second filter. It has the same name as the one produced
by the first filter, since the name is assigned by the algorithm, but you should not use the first one. Since we will
not be using it for anything else, you can safely remove it from your project to avoid confusion, and leave just the
last filtered layer.

A camada raster resultante se parece com isso.

17.21. Interpolação 529



QGIS Training Manual, Versão 2.8

It is already a raster layer, but it is missing data in some of its cells. It only contain valid values in those cells that
contained a point from the vector layer that we have just rasterized, and a no–data value in all the other ones. To
fill the missing values, we can use the Close gaps algorithm.
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The layer without no–data values looks like this.
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To restrict the area covered by the data to just the region where crop yield was measured, we can clip the raster
layer with the provided limits layer.
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And for a smoother result (less accurate but better for rendering in the background as a support layer), we can
apply a Gaussian filter to the layer.
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With the above parameters you will get the following result

17.22 Mais interpolação

Nota: Este capítulo mostra outro caso onde algoritmos de interpolação são usados.

Interpolation is a common technique, and it can be used to demonstrate several techniques that can be applied using
the QGIS processing framework. This lesson uses some interpolation algorithms that were already introduced, but
has a different approach.

Os dados para esta lição contém também uma camada de pontos, neste caso com dados de elevação. Nós estamos
indo para interpolar-se muito da mesma maneira como fizemos na lição anterior, mas desta vez, vamos salvar parte
dos dados originais para usá-lo para avaliar a qualidade do processo de interpolação.

First, we have to rasterize the points layer and fill the resulting no–data cells, but using just a fraction of the points
in the layer. We will save 10% of the points for a later check, so we need to have 90% of the points ready for the
interpolation. To do so, we could use the Split shapes layer randomly algorithm, which we have already used in a
previous lesson, but there is a better way to do that, without having to create any new intermediate layer. Instead
of that, we can just select the points we want to use for the interpolation (the 90% fraction), and then run the
algorithm. As we have already seen, the rasterizing algorithm will use only those selected points and ignore the
rest. The selection can be done using the Random selection algorithm. Run it with the following parameters.
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That will select 90% of the points in the layer to rasterize

The selection is random, so your selection might differ from the selection shown in the above image.

Now run the Shapes to grid algorithm to get the first raster layer, and then run the Close gaps algorithm to fill the
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no–data cells [Cell resolution: 100 m].

Para checar a qualidade da interpolação, nós agora podemos usar os pontos que não estão selecionados. Neste
ponto, nós sabemos a elevação real (o valor na camada de pontos) e a elevação de interpolação (o valor na camada
raster interpolada). Podemos comparar as duas, computando as diferenças entre os valores.

Como iremos usar os pontos que não estão selecionados, vamos inverter a seleção.

The points contain the original values, but not the interpolated ones. To add them in a new field, we can use the
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Add grid values to points algorithm

The raster layer to select (the algorithm supports multiple raster, but we just need one) is the resulting one from
the interpolation. We have renamed it to interpolate and that layer name is the one that will be used for the name
of the field to add.

Agora temos uma camada vetorial que contém ambos valores, com pontos que não foram usados para a interpo-
lação.
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Agora, usaremos a calculadora de campo para esta tarefa. Abra o algoritmo Calculadora de campo e execute-a
com os seguintes parâmetros.
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If your field with the values from the raster layer has a different name, you should modify the above formula
accordingly. Running this algorithm, you will get a new layer with just the points that we haven’t used for the
interpolation, each of them containing the difference between the two elevation values.

Representing that layer according to that value will give us a first idea of where the largest discrepancies are found.

Interpolating that layer will get you a raster layer with the estimated error in all points of the interpolated area.
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You can also get the same information (difference between original point values and interpolated ones) directly
with GRASS → v.sample.

Your results might differ from these ones, since there is a random component introduced when running the random
selection, at the beginning of this lesson.

17.23 Ejecución iterativa de algoritmos

Nota: Esta lección muestra una forma diferente de ejecutar algoritmos que usan capas vectoriales, al ejecutarlos
repetidamente, iterar sobre las entidades de una capa vectorial de entrada

We already know the graphical modeler, which is one way of automating processing tasks. However, in some
situations, the modeler might not be what we need to automate a given task. Let’s see one of those situations and
how to easily solve it using a different functionality: the iterative execution of algorithms.

Abra los datos correspondientes de este capitulo. Debe tener un aspecto como este.
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Usted reconocerá nuestro DEM conocido de los capítulos anteriores y un conjunto de cuencas extraídos de ella.
Imagine que usted necesita cortar el DEM en varias capas más pequeñas, cada una de ellas contiene sólo los datos
de elevación correspondientes a una sola cuenca. Eso será útil si más adelante desea calcular algunos parámetros
relacionados con cada cuenca, como su elevación media o curva hipsográfica.

Esta puede ser una tarea larga y extensa, especialmente si el numero de cuencas es grande. Sin embargo, es una
tarea que se puede automatizar fácilmente, como veremos más adelante.

The algorithm to use for clipping a raster layer with a polygon layer is called Clip grid with polygons, and has the
following parameters dialog.
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You can run it using the watersheds layer and the DEM as input, and you will get the following result.

Como puede ver, se utiliza el área cubierta por todos los polígonos de cuenca.

Puede tener el DEM recortado con sólo una sola cuenca, seleccionando la cuenca deseada y luego ejecutar el
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algoritmo como lo hicimos antes.

Dado que solo se utilizan las entidades seleccionadas, sólo el polígono seleccionado se utilizará para recortar la
capa ráster.

Hacer esto para todas las cuencas producirá el resultado que estamos buscando, pero no se ve como una forma
practica de hacerlo. En su lugar, vamos a ver cómo automatizar esta rutina seleccionar y cortar.

First of all, remove the previous selection, so all polygons will be used again. Now open the Clip grid with polygon
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algorithm and select the same inputs as before, but this time click on the button that you will find in the right–hand
side of the vector layer input where you have selected the watersheds layer.

Este botón hará que la capa de entrada seleccionada para ser dividida en tantas capas como entidades se encuentran
en ella, cada uno de ellos contiene un solo polígono. Con eso, el algoritmo se llama varias veces, una para cada
una de esas capas de un solo polígono. El resultado, en lugar de sólo una capa de trama en el caso de este
algoritmo, será un conjunto de capas de mapa de bits, cada uno de ellos correspondiente a una de las ejecuciones
del algoritmo.

Aquí esta el resultado que se obtendrá si se ejecuta el algoritmo de recorte como se ha explicado.
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Para cada capa, la paleta de color blanco y negro, (o cualquier paleta que este utilizando), se ajusta de manera
diferente, desde valores un mínimo a sus valores máximos. Esa es a razón por el cual se pueden ver las diferentes
piezas y los colores no parecen coincidir en la frontera entre las capas.Los valores, sin embargo, hacen juego.

Si introduce un nombre de archivo de salida, los archivos resultantes serán nombrados utilizando ese nombre de
archivo y un número correspondiente para cada iteración como sufijo

17.24 Mais execução interativa de algoritmos

Nota: This lesson shows how to combine the iterative execution of algorithms with the modeler to get more
automation.

The iterative execution of algorithms is available not just for built-in algorithms, but also for the algorithms that
you can create yourself, such as models. We are going to see how to combine a model and the iterative execution
of algorithms, so we can obtain more complex results with ease.

The data the we are going to use for this lesson is the same one that we already used for the last one. In this
case, instead of just clipping the DEM with each watershed polygon, we will add some extra steps and calculate a
hypsometric curve for each of them, to study how elevation is distributed within the watershed.

Since we have a workflow that involves several steps (clipping + computing the hypsometric curve), we should go
to the modeler and create the corresponding model for that workflow.

You can find the model already created in the data folder for this lesson, but it would be good if you first try to
create it yourself. The clipped layer is not a final result in this case, since we are just interested in the curves, so
this model will not generated any layers, but just a table with the curve data.

O modelo deve ser semelhante a este:
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Adicione o modelo de pasta da modelos, para que esteja disponível na caixa de ferramentas, e agora execute-o.

Select the DEM and watersheds basins, and do not forget to toggle the button that indicates that the algorithm has
to be run iteratively.

O algoritmo será executado várias vezes, e as tabelas correspondentes serão criadas e abertas no seu projeto QGIS.
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We can make this example more complex by extending the model and computing some slope statistics. Add the
Slope, aspect, curvature algorithm to the model, and then the Raster statistics algorithm, which should use the
slope output as its only input.

If you now run the model, apart from the tables you will get a set of pages with statistics. These pages will be
available in the results dialog.

17.25 A interface de processamento em lote

Nota: This lesson introduces the batch processing interface, which allows to execute a single algorithm with a
set of different input values.

Algumas vezes um dado algoritmo tem que ser executado repetidamente com diferentes entradas. Isto é, por
exemplo, o caso quando um conjunto de arquivos de entrada tem que ser convertidos de um formato para outro,
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ou quando varias camadas em uma projeção dada devem ser convertidas numa outra.

Nesse caso, o algoritmo de chamada repetindo sobre a caixa de ferramentas não é a melhor opção. Em vez disso, a
interface de processamento em lote deve ser usada, o que muito simplifica a realização de uma execução múltipla
de um determinado algoritmo. Para executar um algoritmo como um processo em lote, encontrá-lo na caixa de
ferramentas, e em vez de duplo - clique sobre ele, clique - direito sobre ele e selecione Executar como processo
em lote.

Para este exemplo, utilizaremos o Algoritmo de reprojeção, assim que encontrado deve fazer como se descreveu
anteriormente. Obterá o seguinte diálogo.

If you have a look at the data for this lesson, you will see that it contains a set of three shapefiles, but no QGIS
project file. This is because, when an algorithm is run as a batch process, layer inputs can be selected either
from the current QGIS project or from files. That makes it easier to process large amounts of layers, such as, for
instance, all the layers in a given folder.

Cada linha da tabela do diálogo de processo por lotes representa somente uma execução do algoritmo. As células
de uma linha correspondem a parâmetros necessários para o algoritmo, que não é organizado um encima do outro,
como em um diálogo normal de solo–execução, pois horizontalmente nesta linha.

Definir o processo por lotes para executar por enchimento a tabela com os valores correspondentes, e o diálogo
em sí contem varias ferramentas para fazer esta tarefa mais fácil.

Vamos a começar preenchendo os campos um a um. A primeira coluna para anotar é a Camada de entrada. No
lugar de introduzir os nomes de cada uma das camadas que queremos processar, pode selecionar todas elas as que
desejar que o diálogo põe uma em cada linha. Clique no botão da célula superior esquerda e, no quadro de diálogo
de seleção de arquivos que emerge, selecione os três arquivos para reprojetar. Dado que só um deles é necessário
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para cada linha, as restantes se utilizarão para preencher as linhas de baixo.

O número predeterminado de linhas é 3, que é exatamente o número de camadas que temos que converter, para
assim selecionamos mais camadas, novas linhas se acrescentaram automaticamente. Se deste preenchimento as
entradas manualmente, se pode acrescentar mais e mais linhas utilizando o botão Acrescentar linha.

Vamos converter todas estas camadas para SRC EPSG:23029, assim temos que selecionar este SRC no segundo
campo. Queremos o mesmo em todas as linhas, pois não temos que fazer para cada linha individual. Em seu lugar,
estabelesemos o SRC para a primeira linha (a que está na parte superior) com o botão da célula correspondente e
dando duplo clique no cabeçalho da coluna. Isso fará com que todas as células da coluna seja preenchidas com o
valor da célula superior.
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Finally, we have to select an output file for each execution, which will contain the corresponding reprojected layer.
Once again, let’s do it just for the first row. Click on the button in the upper cell and, in a folder where you want
to put your output files, enter a filename (for instance, reprojected.shp).

Agora, quando dermos o clique em Aceitar o diálogo de seleção de arquivo, o arquivo não se escreve automatica-
mente na célula, pois um quadro de entrada como o seguinte irá surgir em seu lugar.

Se seleciona na primeira opção, somente a célula atual será preenchida. Se somente seleciona qualquer outra,
todas as células inferiores serão preenchidas com um padrão pré-determinado. Neste caso, vamos seleccionar a
opção*Preencher com o valor do parâmetro*, e o valor Camada de entrada no menu em cascata mais abaixo. Isso
fará com qie o valor da Camada de entrada (é dizer, o nome da camada) que será adicionada ao nome do arquivo
que iremos adicionar, colocando cada nome de arquivo de saída diferente. A tabela de processamento por lotes
agora deveria ter este aspecto.
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A última coluna estabelece se deseja ou não adicionar as camadas resultantes no projeto QGIS atual. Deixe o
valor da opção predeterminada Sim, assim voce poderá ver o resultado deste caso na tela do qgis.

Dê um clique em Aceitar e o processo por lote será executado. Se todo ocorrem bem, todas as camadas serão
processadas e serão criados 3 novas camadas.

17.26 Modelos da interface de processamento em lote

Aviso: Tenha cuidado, este capítulo não esta bem testado, por favor reporte qualquer problema; imagens estão
faltando

Nota: Esta lição mostra outro exemplo de interface de processamento em lote, mas desta vez usando um modelo
em lugar de um algoritmo integrado

Modelos são como qualquer outro algoritmo, e eles podem ser usados na interface de processamento em lote.
Para demonstrar isso, aqui está um breve exemplo que podemos fazer usando o nosso modelo hidrológico já bem
conhecido.

Certifique-se que voce tem um modelo adicionado na caixa de ferramentas, e em seguida execute pelo modo em
lote. Este é um diálogo de processamento em lote deve ser semelhante.

Aviso: todo: Adicionar imagem

Para adicionar registros basta um total de 5. Selecione o arquivo DEM correspondente a este lição como a entrada
para todos eles. Em seguida, introduza 5 valores de limiar diferentes, como mostrado na continuação.

Aviso: todo: Adicionar imagem

Como se pode ver a interface de processamento em lote pode ser executada não só para execução do mesmo
processo em diferentes bases de dados, mas também no mesmo conjunto de dados com parâmetros diferentes.
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CLique OK e deve obter 5 novas camadas com bacias correspondentes aos 5 valores especificados no limiar.

17.27 Outros programas

Módulo elaborado por Paolo Cavallini - Faunalia

Nota: Este capítulo mostra como usar programas adicionais de dentro do Processing. Para completá-lo, você
deve ter instalado, com as ferramentas de seu sistema operacional, os pacotes relevantes.

17.27.1 GRASS

GRASS is a free and open source GIS software suite for geospatial data management and analysis, image process-
ing, graphics and maps production, spatial modeling, and visualization.

It is installed by default on Windows through the OSGeo4W standalone installer (32 and 64 bit), and it is packaged
for all major Linux distributions.

17.27.2 R

R is a free and open source software environment for statistical computing and graphics.

It has to be installed separately, together with a few necessary libraries (LIST).

The beauty of Processing implementation is that you can add your own scripts, simple or complex ones, and they
may then be used as any other module, piped into more complex workflows, etc.

Teste algum dos exemplos pré instalados, se você já possui R instalado (lembre-se de ativar os módulos R das
configurações gerais de processamento)

17.27.3 OTB

OTB (also known as Orfeo ToolBox) is a free and open source library of image processing algorithms. It is
installed by deafult on Windows through the OSGeo4W standalone installer (32 bit). Paths should be configured
in Processing.

In a standard OSgeo4W Windows installation, the paths will be:

OTB application folder C:\OSGeo4W\apps\orfeotoolbox\applications
OTB command line tools folder C:\OSGeo4W\bin

On Debian and derivatives, it will be /usr/bin

17.27.4 Outros

TauDEM is a suite of Digital Elevation Model (DEM) tools for the extraction and analysis of hydrologic informa-
tion. Availability in various operating system varies.

LASTools is a set of mixed, free and proprietary commands to process and analyze LiDAR data. Availability in
various operating system varies.

Mais ferramentas estão disponíveis através de plugins adicionais, e.g.:

• LecoS: a suite for land cover statistics and landscape ecology

• lwgeom: formerly part of PostGIS, this library brings a few useful tools for geometry cleanup

• Animove: tools to analyse the home range of animals.

More will come.
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17.27.5 Comparison among backends

Buffers and distances

Let’s load points.shp and type buf in the filter of the Toolbox, then double click on:

• Fixed distance buffer: Distance 10000

• Variable distance buffer: Distance field SIZE

• v.buffer.distance: distance 10000

• v.buffer.column: bufcolumn SIZE

• Shapes Buffer: fixed value 10000 (dissolve and not), attribute field (with scaling)

See how speed is quite different, and different options are available.

Exercise for the reader: find the differences in geometry output between different methods.

Now, raster buffers and distances:

• first, load and rasterize the vector rivers.shp with GRASS → v.to.rast.value; beware: cell size must be
set to 100 m, otherwise the computation time will be enormous; resulting map will have 1 and NULLs

• same, with SAGA → Shapes to Grid → COUNT (resulting map: 6 to 60)

• then, proximity (value= 1 for GRASS, a list of rivers ID for SAGA), r.buffer with parameters
1000,2000,3000, r.grow.distance (the first of the two maps).

Dissolver

Dissolve feições baseado em atributos comuns:

• GRASS → v.dissolve municipalities.shp on PROVINCIA

• QGIS → Dissolve municipalities.shp on PROVINCIA

• SAGA → Polygon Dissolve municipalities.shp on PROVINCIA (NB: Keep inner boundaries must
be unselected)

Aviso: O último é quebrado no SAGA <=2.10

Exercise for the reader: find the differences (geometry and attributes) between different methods.

17.28 Interpolação e curvas de contorno

Contribuição deste módulo por Paolo Cavallini - Faunalia

Nota: Este capítulo mostra como usar diferentes formas de calcular diferentes interpolações.

17.28.1 Interpolação

O projeto mostra um gradiente de precipitação de chuva, do sul para o norte. Usaremos diferentes métodos para a
interpolação, todas baseadas na camada vectorial pontos.shp e o parâmetro CHUVA:

Aviso: Set cell size to 500 for all analyses.

• GRASS → v.surf.rst

• SAGA → Interpolacao Multinivel B-Spline
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• SAGA → Inverse Distance Weighted [Power: 4; Search range: Global]

• GDAL → Malha (Inverso da Distancia a potencia) [Potencia:4]

• GDAL → Malha (Média móvil) [Radio1&2: 50000]

Em seguida, medir a variação entre os métodos e correlacioná-la com distância de pontos:

• GRASS → r.series [Propagação NULLs não selecionada, Operação agregar: stddev]

• GRASS → v.to.rast.value on points.shp

• GDAL → Proximidade

• GRASS → r.covar to show the correlation matrix; check the significance of the correlation e.g. with
http://vassarstats.net/rsig.html.

Assim, áreas distantes dos pontos terá interpolação menos precisa.

17.28.2 Contorno

Varios metodos de desenhar linhas de contorno [always step= 10] em stddev raster:

• GRASS → r.contour.step

• GDAL → Contorno

• :menuselection:‘SAGA –> Linhas de contorno para grade ‘[NB: saída shp não é válida, bug desconhecido]

17.29 Simplificación y suavizado vectorial

Modulo contribuido por Paolo Cavallini - Faunalia

Nota: Este capítulo muestra como simplificar vectores, y suavizar las esquinas agudas.

Algunas veces necesitamos una versión simplificada de un vector, para tener un tamaño de archivo más pequeño
y deshacerse de detalles innecesarios. Muchas herramientas hacen esto de una manera muy general, y pierde la
adyacencia y a veces la corrección topólogica de polígonos. GRASS es la herramienta ideal para esto: ser un SIG
topológico, adyacencia y la corrección se conservan incluso a niveles muy altos de simplificación. En nuestro
caso, tenemos un vector resultante de una trama, lo cual demuestra un patrón de “sierra” en las fronteras. Aplicar
un resultado de simplificación en línea recta:

• GRASS → v.generalizar [Valor de máxima tolerancia: 30 m]

Podemos hacer a la inversa, y hacer una capa mas compleja, suavizando las esquinas agudas:

• GRASS → v.generalizar [método: chaiken]

Trate de aplicar el segundo comando, tanto para el vector original y para el primer análisis, y vea la diferencia.
Tenga en cuenta que la adyacencia no se pierde.

Esta segunda opción se puede aplicar e.j. a las curvas de nivel que resulten de una ráster grueso, de GPS pistas
con vértices dispersos, etc

17.30 Planejando uma fazenda solar

Módulo aportado por Paolo Cavallini - Faunalia

Nota: Este capítulo mostra como usar vários critérios para localizar as áreas adequadas para a instalação de uma
central fotovoltaica

Primeiro de tudo, criar um mapa aspecto do MDE:
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• GRASS → r.aspect [Tipo de dado: int; tamanho de célula:100]

No Grass, aspecto é calculado em graus , sentido anti-horário a partir do leste . Para extrair apenas Sul inverta a
face ( 270 graus + - 45) , que pode reclassificá-la:

• GRASS → r.reclass

con las siguientes reglas:

225 thru 315 = 1 south

* = NULL

Você pode usar o arquivo de texto reclass_south.txt fornecido. Observe que, com esses arquivos de texto
simples que podemos criar também reclassificações muito complexas.

Queremos construir una granja grande, por lo que seleccionamos sólo grandes áreas contiguas (> 100 ha):

• GRASS → r.reclass.greater

Por último, convertemos para um vetor:

• GRASS → r.to.vect [Tipo de objeto espacial: área; Esquinas lisas: si]

** Exercício para o leitor**: repetir a análise , substituindo comandos Grass com análogo de outros programas.
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CHAPTER 18

Module: Usando Base de dados espaciais no QGIS

Neste módulo você vai aprender sobre como usar bancos de dados espaciais com QGIS para gerenciar, exibir
e manipular dados no banco de dados, bem como a realização de análises por meio de consulta. Usaremos
principalmente PostgreSQL e PostGIS (que foram abordados em seções anteriores), mas os mesmos conceitos são
aplicáveis a outras implementações de banco de dados espaciais, incluindo SpatiaLite.

18.1 Lesson: Trabalhar com bancos de dados no Navegador QGIS

Nos 2 módulos anteriores examinamos os conceitos, características e funções dos bancos de dados relacionais
básicos, bem como extensões que nos permitem armazenar, gerenciar, consultar e manipular dados espaciais em
um banco de dados relacional. Esta seção vai mergulhar mais fundo como usar eficazmente bancos de dados
espaciais no QGIS.

A meta para esta lição: Para aprender a interagir com bancos de dados espaciais utilizando a interface de naveg-
ação QGIS Browser.

18.1.1 Follow Along: Adicionando tabelas de banco de dados para o QGIS
usando o Navegador

Já olhou rapidamente como adicionar tabelas a partir de um banco de dados como camadas QGIS, agora vamos
olhar para isso em um pouco mais de detalhes e olhar para as diferentes maneiras que isto pode ser feito no QGIS.
Vamos começar por olhar para a nova interface do navegador.

• Iniciar um novo mapa vazio no QGIS.

• Abra o navegador, clicando na guia Browser na parte inferior do Painel da camada

• Abra a parte PostGIS da árvore e você deve encontrar sua conexão configurada anteriormente disponível
(pode ser necessário clicar no botão Atualizar na parte superior da janela do navegador).
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• Clicando duas vezes sobre qualquer tabela/camadas listadas aqui vai adicioná-la para a tela do mapa.

• Clicando com o botão direito sobre uma tabela/camada nessa visão lhe dará algumas opções. Clique no
item Propriedades olhe para as propriedades da camada.
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Nota: É claro que você também pode usar essa interface para conectar-se a bancos de dados PostGIS hospedados
em um servidor externo a sua estação de trabalho. Botão direito do mouse sobre a entrada PostGIS na árvore
permitirá que você especifique parâmetros de conexão para uma nova conexão.

18.1.2 Follow Along: Adicionando um conjunto filtrado de registros de uma
camada

Agora que vimos como adicionar uma tabela inteira como uma camada QGIS que poderia ser bom para apren-
der como adicionar um conjunto filtrado de registros de uma tabela como uma camada usando consultas que
aprendemos nas seções anteriores.

• Iniciar um novo mapa vazio sem camadas

• Clique no botão Adicionar Camada PostGIS ou selecione Camada –> Adicionar Camada PostGIS a partir
do menu.

• No diálogo Adicionar tabela(s) PostGIS que surge, conectar-se à conexão postgis_demo.

• Expanda o Esquema público e você deve encontrar as três tabelas que estávamos trabalhando anterior-
mente.

• Clique na camada Linhas para selecioná-la, mas em vez de adicioná-la, clique no botão Definir Filtro para
abrir o diaĺogo Construtor de Consulta.

• Construa a seguinte expressão usando os botões ou inserindo-a diretamente:

"roadtype" = ’major’

18.1. Lesson: Trabalhar com bancos de dados no Navegador QGIS 559



QGIS Training Manual, Versão 2.8

• Clique: guilabel: OK para completar a edição do filtro e clique em: guilabel:‘ Adicionar‘ para adicionar a
camada filtrada para seu mapa.

• Renomeie a camada Linhas na árvore para roads_primary.

Você vai notar que apenas as estradas primárias foram adicionadas ao seu mapa, em vez de toda a camada.

18.1.3 In Conclusion

Você já viu como interagir com bancos de dados espaciais utilizando o QGIS Browser e como adicionar camadas
ao seu mapa com base em um filtro de consulta.

18.1.4 What’s Next?

Em seguida, você vai ver como trabalhar com a interface do Gerenciador DB no QGIS para um conjunto mais
completo de tarefas de gerenciamento de banco de dados.
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18.2 Lesson: Usando o Gerenciador BD para trabalhar com ban-
cos de dados espaciais no QGIS

Já vimos como realizar muitas operações de banco de dados com o QGIS, bem como com outras ferramentas, mas
agora é hora de olhar para a ferramenta Gerenciador BD que fornece grande parte destas mesmas funcionalidades,
bem como mais ferramentas de gestão orientadas.

A meta para esta lição: Aprender como interagir com bancos de dados espaciais usando o Gerenciador BD do
QGIS.

18.2.1 Follow Along: Gerenciando Base de dados PostGIS com Gerenci-
ador BD

Você deve primeiro abrir a interface do Gerenciador BD selecionando Base de Dados –> Gerenciador BD –>
Gerenciador BD no menu ou selecionando o ícone Gerenciador BD na barra de ferramentas.

Você também deverá ver as conexões anteriores que nós configuramos e ser capaz de expandir a seção myPG e seu
esquema public para ver as tabelas com as quais trabalhamos na seção anterior.

A primeira coisa que irá notar é que agora você pode ver os metadados dos esquemas contidos em sua base de
dados.

Esquema é uma forma de agrupar tabelas de dados e outros objetos em um baco de dados PostgreSQL e servir
como um recipiente para permissões e restrições. Administrar esquemas PostgreSQL está além do escopo deste
manual, mas você pode encontrar mais informações sobre o assunto em PostgreSQL documentation on Schemas.
Você pode usar o Gerenciador BD para criar novos Esquemas, mas precisará usar uma ferramenta como o pgAd-
min III ou a interface de linha de comando para gerenciá-los de forma efetiva.

18.2. Lesson: Usando o Gerenciador BD para trabalhar com bancos de dados espaciais no
QGIS
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O Gerenciador BD pode também ser usado para gerenciar tabelas do seu banco de dados. Nós já vimos várias
maneiras de criar e manipular tabelas na linha de comando, mas agora vamos ver como fazer isso usando o
Gerenciador BD.

Para começar, é interessante dar uma olhada nos metadados da tabela clicando no nome da mesma na árvore e
verificando a guia Info.

Neste painel você pode ver as Informações gerais sobre a tabelas bem como as informações que a extensão
PostGIS mantém sobre a geometria e o sistema de referencia espacial.

Se você rolar para baixo a guia Info, poderá ver mais informações sobre Campos, Restrições e Índices relacionados
a tabela selecionada.
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Também é muito útil usar o Gerenciador BD simplesmente para ver os registros no banco de dados de maneira
parecida com que pode-se ver a tabela de atributos de uma camada na Árvore de Camadas. Você pode navegar
pelos dados selecionando a guia Tabela.

18.2. Lesson: Usando o Gerenciador BD para trabalhar com bancos de dados espaciais no
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Há também a guia Pré-visualizar que mostra a camada em uma pré-visualização de um mapa.

Clicando com o botão direito em uma camada da árvore e selecionando Adicionar à tela irá adicionar essa camada
ao mapa.

Hasta ahora sólo hemos visto los esquemas, tablas y sus metadatos de la base de datos, pero lo que si queríamos
era modificar la tabla para añadir una columna más, tal vez? El Administrador de BBDD le permite hacer esto
directamente.

• Seleccione la tabla que desee editar en el árbol

• Seleccione Tabla –> Editar Tabla del menú para abrir el diálogo Propiedades de la tabla.

Se puede utilizar este diálogo para añadir columnas, añadir columnas de geometría, editar columnas existentes o
eliminar una columna completamente.

Utilice la pestaña Restricciones, se puede administra que campos se utilizan como clave primaria o para borrar
una restricción existente.
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La pestaña Índices se puede utilizar para añadir y borrar ambos índices espacial y normal.

18.2. Lesson: Usando o Gerenciador BD para trabalhar com bancos de dados espaciais no
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18.2.2 Follow Along: Crear una nueva tabla

Ahora que hemos pasado por el proceso de trabajar con tablas existentes en nuestra base de datos, vamos a usar el
Administrador de BBDD para crear una nueva tabla.

• Si ya no abre, obra la ventana del Administrador de BBDD, y expanda el árbol hasta que vea la lista de
tablas que ya están en su base de datos.

• Desde el menú, seleccione Tabla–> Crear Tabla para mostrar el diálogo Crear Tabla.

• Utilice el esquema predeterminado Public y llame a la tabla places.

• Añada los campos id, place_name, y elevation como se muestran abajo

• Compruebe que campo id esta establecido como clave primaria.

• Haga clic en la casilla para Crear una columna geométrica y asegúrese de que se establece en un tipo
POINT y deje el nombre geom y especifique 4326 como el SRID.

• Haga clic en la casilla Crear índice espacial y haga clic Crear para crear la tabla.
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• Descarte el diálogo que conoce que la tabla fue creada y haga clic en Cerrar para cerrar el diálogo Crear
Tabla.

Ahora puede examinar su tabla en el Administrador de BBDD y por supuesto encontrará que no hay datos en él.
Desde aquí se puede Conmutar edición sobre el menú Capa e iniciar a añadir sitios a su tabla.

18.2.3 Follow Along: Administración de base de datos básica

El Administrador de BBDD también le deja hacer algunas tareas de Administración de base de datos. Esto no es
por supuesto un sustituto de una herramienta más completa de Administración de base de datos, pero proporciona
algunas funciones que se pueden utilizar para mantener su base de datos.

Las tablas de base de datos a menudo pueden llegar a ser bastante grandes y las tablas que están modificando
frecuentemente puede dejar botado al resto de registros que no son necesarios por PostgreSQL. El comando
VACUUM se encarga de hacer una especie de recolección de basura para compactar y analizar opcional sus tablas
para mejorar el rendimiento.

Vamos a echar un vistazo a cómo se puede realizar un comando VACUUM ANALYZE desde dentro del Admin-
istrador BBDD.

• Seleccione una de sus tablas en el árbol del Administrador de BBDD.

• Seleccione Tabla–> Ejecutar Análisis Vacuum desde el menú.

Eso es! PostgreSQL realizará la operación. Dependiendo de que tan grande es su tabla, esto puede tardar cierto
tiempo en completarse.

18.2. Lesson: Usando o Gerenciador BD para trabalhar com bancos de dados espaciais no
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Se puede encontrar más información sobre el proceso de VACUUM ANALIZE en la Documentación PostgreSQL
sobre VACUUM ANALYZE

18.2.4 Follow Along: Ejecutar consultas SQL Queries con el Administrador
de BBDD

El Administrador de BBDD también proporciona una forma para que pueda escribir consultas en las tablas de
base de datos y los resultados a vistas. Ya hemos visto este tipo de funciones en el panel Explorar, pero vamos de
nuevo aquí con el Administrador de BBDD.

• Seleccione la tabla lines en el árbol.

• Seleccione el botón Ventana SQL en la barra de herramientas del Administrador de BBDD.

• Componga la siguiente Consulta SQL en el espacio proporcionado:

select * from lines where roadtype = ’major’;

• Haga clic en el botón Ejecutar (F5) para ejecutar la consulta.

• Ahora se debe ver el registro que coinciden en el panel Resultado

• Haga clic en la casilla Cargar como nueva capa para añadir el resultado a su mapa.

• Seleccione la columna id como la Columna con el valor entero único y la columna geom como la Columna
de geometría.
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• Introduzca roads_primary como la Nombre de la capa (prefix).

• Haga clic ¡Cargar ahora! para cargar los resultados como una nueva capa en su mapa.

La capa que corresponde a su consulta ahora se despliega sobre su mapa. Se puede por supuesto utilizar esta
herramienta de consulta para ejecutar cualquier comando SQL arbitrario incluyendo muchos de los que vimos en
los módulos y secciones anteriores.

18.2.5 Importar datos en una base de datos con el Administrador de BBDD

Ya hemos visto cómo importar datos a una base de datos espacial utilizando las herramientas de lineas de co-
mandos y también vimos cómo utilizar el complemento SPIT, por lo que ahora vamos a aprender cómo utilizar el
Administrador de BBDD para hacer las importaciones.

• Haga clic en botón Importar capa/archivo en la barra de herramientas en el diálogo del Administrador de
BBDD.

• Seleccione el archivo urban_33S.shp de exercise_data/projected_data como el conjunto
de datos de entrada.

• Haga clic en el botón Actualizar Opciones para pre-llenar algunos de los valores del formulario.

• Asegúrese que la opción Crear nueva tabla esta seleccionada.

• Especificar el SRID de origen como 32722 y el SRID de destino como 4326.

• Habilitar la casilla a Crear índice espacial

18.2. Lesson: Usando o Gerenciador BD para trabalhar com bancos de dados espaciais no
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• Haga clic Aceptar para realizar la importación.

• Cerrar el diálogo que sabe que la importación fue exitosa.

• Haga clic en el botón Actualizar sobre la barra de herramientas del Administrador de BBDD.

Ahora se puede examinar la tabla en su base de datos haciendo clic sobre él en el árbol. Verificar que los datos
han sido reproyectados comprobando que la Ref. espacial: este listado como WGS 84 (4326)
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Haga clic derecho sobre la tabla en el árbol y una selección Añadir al lienzo se añadirá la tabla como capa en su
mapa.

18.2.6 Exportando datos desde una base de datos con el Administrador de
BBDD

Por supuesto el Administrador de BBDD también puede ser utilizado para exportar datos desde su base de datos
espacial, por lo que vamos a echar un vistazo a cómo se hace.

• Seleccione la capa lines en el árbol y haga clic en el botón Exportar a archivo en la barra de herramientas
para abrir el diálogo Exportar a archivo vectorial.

• Haga clic en el botón ... para seleccionar el Archivo de salida y guarde los datos en su directorio
exercise_data como urban_4326.

• Establezca el SRID de destino como 4326.

• Haga clic en Aceptar para inicializar la exportación.

18.2. Lesson: Usando o Gerenciador BD para trabalhar com bancos de dados espaciais no
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• Cierre el diálogo que le permite saber que la exportación fue exitosa y cierre el administrador de BBDD.

Ahora se puede examinar el archivo shape que creó con el panel de Explorador.
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18.2.7 In Conclusion

Ahora ha visto cómo utilizar la interfaz del Administrador de BBDD en QGIS para gestionar su base de datos,
para ejecutar las consultas sql en los datos y cómo importar y exportarlos.

18.2.8 What’s Next?

A continuación, vamos a ver cómo utilizar muchas de estas mismas técnicas con la base de datos spatialite.

18.3 Lesson: Trabajar con base de datos spatialite en QGIS

Mientras PostGIS es utilizado generalmente con un servidor para proporcionar capacidades de base de datos
espaciales a múltiples usuarios al mismo tiempo. QGIS también soporta el uso de un formato de archivo llamado
spatialite que es ligero, una forma portable de almacenar una base de datos espacial entera en un solo archivo.
Obviamente, estos 2 tipos de base de datos espacial debería ser utilizado para diferentes propósitos, pero los
mismos principios básicos y técnicos aplican a ambos. Vamos a crear una nueva base de datos spatialite y explorar
la funcionalidad proporcionada para trabajar con esta base de datos en QGIS.

El objetivo de esta lección: Aprender como interactuar con bases de datos spatialite usando el interfaz de QGIS
Browser.

18.3.1 Follow Along: Crear una base de datos Spatialite con el explorador

Utilizando el panel Browser podemos crear una nueva base de datos spatialite y poder configurarla para su uso en
QGIS.

• Hacer clic derecho en la entrada Spatialite en el árbol del explorador y seleccionar Crear Base de datos.

• Especifique en qué lugar del sistema de archivos desea almacenar el archivo y dele un nombre
qgis-sl.db.

• De nuevo hacer clic derecho en la entrada Spatialite en el árbol del navegador y ahora seleccionar el ele-
mento Nueva conexión. Buscar el archivo que creo en el paso anterior y abrirlo.

Ahora que ha configurado su nueva base de datos, encontrará que la entrada en el árbol del navegador no tiene
nada debajo y lo único que se puede hacer en este momento es eliminar la conexión. Esto es, por supuesto porque
no hemos agregado ninguna tabla a la base de datos. Vamos a seguir adelante y hacer eso.

• Busque el botón para crear una nueva capa y utilice la lista desplegable para crear una nueva capa Spatialite,
o seleccione Capa –> Nuevo –> Nueva capa Spatialite.

• Seleccionar la base de datos que hemos creado en los pasos anteriores en el menú desplegable.

• Asignar el nombre a la capa places.

• Marque la casilla de verificación junto a Crear una clave primaria autonumérica.

• Añadir 2 atributos como se muestra a continuación

• Haga clic en Aceptar para crear la tabla.
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• Haga clic en el botón Actualizar en la parte superior del Explorador y ahora debería ver su tabla places
listada.
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Puede hacer clic en la tabla y ver sus propiedades como hicimos en el ejercicio anterior.

Desde aquí se puede iniciar una sesión de edición y empezar a añadir datos a su nueva base de datos directamente.

También aprendimos acerca de cómo importar datos dentro de una base de datos utilizando el DB Manager y
puede utilizar esta misma técnica para importar datos dentro de su nueva BD de spatialite.

18.3.2 In Conclusion

Ha visto cómo crear base de datos spatialite y añadir tablas a ellos y para usar estas tablas como capas en QGIS.
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CHAPTER 19

Apéndice: Cómo Contribuir a este Manual

Para añadir materiales a este curso, debes seguir las guías de este Apéndice. No debes alterar las condiciones de
este Apéndice salvo para clarificaciones. Todo esto es para asegurar que la calidad y consistencia del manual se
mantiene.

19.1 Descarga de Recursos

Los recursos de este documento están disponibles en GitHub. Consulta en GitHub.com para obtener instrucciones
sobre cómo utilizar el sistema de control de versiones git.

19.2 Formato del Manual

Este manual está escrito utilizando Sphinx, un generador de documentos Python que utiliza el lenguage de marcas
reStructuredText.

19.3 Adición de un Módulo

• Para añadir un módulo nuevo, primero crea un directorio nuevo (directamente en el nivel superior del direc-
torio qgis-training-manual) con el nombre del módulo nuevo.

• En el nuevo directorio, crea un archivo llamado index.rst. Deja el archivo en blanco de momento.

• Abre el archivo index.rst en el nivel superior del directorio. Sus primeras líneas son:

.. toctree::
:maxdepth: 2

foreword/index
introduction/index

Observarás que es una lista de directorios, seguido del nombre index. Esto dirige el nivel superior del archivo
índice a cada directorio. El orden en el que están listados determina el orden que tendrán en el documento.

• Añade el nombre de tu nuevo módulo (es decir, el nombre que le has dado al nuevo directorio), seguido de
/index, a esa lista, donde quieras que aparezca tu módulo.

• Recuerda mantener el orden de los módulos de forma lógica, de forma que los módulos finales se basen en
el conocimiento presentado por los iniciales.

• Abre el archivo índice de tu propio módulo ([module name]/index.rst).

• Na parte superior da página, escreva uma linha de 80 asteriscos (*). Isso representa um título de módulo.
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• Síguelo con una línea conteniendo la frase marcada |MOD| (que significa “módulo”), seguido del nombre
de tu módulo.

• Termínalo con otra línea de 80 asteriscos.

• Deja una línea abierta por debajo.

• Escribe un párrafo corto explicando el propósito y contenido del módulo.

• Deja una línea abierta, luego añade el texto siguiente:

.. toctree::
:maxdepth: 2

lesson1
lesson2

... donde lesson1, lesson2, etc., son los nombres de tus lecciones planeadas.

El archivo índice del nivel del módulo tendrá este aspecto:

*******************************************************************************
|MOD| Module Name

*******************************************************************************

Short paragraph describing the module.

.. toctree::
:maxdepth: 2

lesson1
lesson2

19.4 Adición de una Lección

Para añadir una lección a un módulo existente:

• Abre el directorio del módulo.

• Abre el archivo index.rst (creado antes en el caso de módulos nuevos).

• Asegúrate de que el nombre de la lección planeada está listada bajo la directriz toctree, como se muestra
arriba.

• Crea un archivo nuevo en el directorio del módulo.

• Nombra ese archivo exactamente igual al nombre del archivo index.rst del módulo, y añade la extensión
.rst.

Nota: Para propósitos de edición, un archivo .rst funciona exactamente igual a un archivo de texto (.txt).

• Para empezar a escribir la lección, escribe la frase |LS|, seguido del nombre de la lección.

• En la siguiente línea, escribe una línea de 80 signos de igual (=).

• Deja una línea abierta después de eso.

• Escribe una corta descripción del propósito de la lección.

• Incluye una introducción general del tema. Mira lecciones existentes como ejemplos.

• Debajo, comienza un nuevo párrafo, comenzando con esta frase:
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**The goal for this lesson:**

• Explica brevemente el resultado previsto a completar en esta lección.

• Si no puedes describir el objetivo de la lección en una o dos frases, considera dividir el tema en varias
lecciones.

Cada lección estará subdividida en varias secciones, que se abordarán luego.

19.5 Añadir una Lección

Hay dos tipos de secciones: “sigue los pasos” y “prueba tú mismo”.

• Una sección “sigue los pasos” detalla un conjunto de direcciones para enseñar al lector cómo utilizar un
aspecto dado del QGIS. Esto se hace dando direcciones clic por clic tan claramente como sea posible,
intercaladas con capturas de pantalla.

• La sección “prueba tú mismo” le da al lector un ejercicio corto para ponerse a prueba. Se asocia normal-
mente con una hoja de respuestas al final de la documentación, que demuestra o explica cómo completar el
ejercicio, y mostrará los resultados esperados si es posible.

Cada sección viene con un nivel de dificultad. Una sección fácil se designa por |basic|, moderada por
|moderate|, y avanzada por |hard|.

19.5.1 Añadir una sección “sique los pasos”

• Para comenzar esta lección, escribe la frase de marcado de la dificultad del nivel (como se muestra arriba).

• Deja un espacio y escribe |FA| (para “sigue los pasos”).

• Deja otro espacio y escribe el nombre de la lección (utiliza solo una inicial en mayúsculas, así como las
mayúsculas para nombres propios).

• En la línea siguiente, escribe una línea de 80 menos/guiones (-). Asegúrate de que tu editor de textos no
reemplaza los carácteres menos/guiones a guión largo o otro carácter por defecto.

• Escribe una introducción corta a la sección, explicando sus objetivos. Luego dá instrucciones detalladas
(clic por clic) al procedimiento a ser demostrado.

• En cada sección, incluye enlaces internos y externos y capturas de pantalla según se necesiten.

• Intenta acabar cada sección con un párrafo corto que concluya y abra paso a la siguiente sección de forma
natural, si es posible.

19.5.2 Añadir una sección “prueba tú mismo”

• Para comenzar esta lección, escribe la frase de marcado de la dificultad del nivel (como se muestra arriba).

• Deja un espacio y escribe |TY| (para “prueba tú mismo”).

• En la línea siguiente, escribe una línea de 80 menos/guiones (-). Asegúrate de que tu editor de textos no
reemplaza los carácteres menos/guiones a guión largo o otro carácter por defecto.

• Explica el ejercicio que quieres que el lector complete. Refiérete a las secciones, lecciones o módulos
anteriores si es necesario.

• Incluye capturas de pantalla para clarificar los requisitos si alguna descripción textual no está clara.

En la mayoría de los casos, querrás dar una respuesta a cómo completar el ejercicio dado en la lección. Para
hacerlo, necesitarás añadir una entrada en la hoja de respuestas.

• Primero, decide un único nombre para la respuesta. Idealmente, el nombre incluirá el nombre de la lección
y un número que vaya incrementando.
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• Crea un enlace para la respuesta:

:ref:‘Check your results <answer-name>‘

• Abre la hoja de respuestas (answers/answers.rst).

• Crea un enlace para la sección “prueba tú mismo” escribiendo esta línea:

.. _answer-name:

• Escribe las instrucciones sobre cómo completar el ejercicio, utilizando enlaces e imágenes donde lo nece-
sites.

• Para acabar, inluye un enlace de vuelta a la sección “prueba tú mismo” escribiendo esta línea:

:ref:‘Back to text <backlink-answer-name>‘

• Para hacer que esta línea funcione, añade la siguiente linea encima del titulo de la sección “prueba tú
mismo”:

.. _backlink-answer-name:

Recuerda que cada una de esas líneas mostradas arriba deben tener una línea en blanco sobre y bajo ellas, de otra
forma se podría causar errores en la creación del documento.

19.6 Añadir una Conclusión

• Para terminar una lección, escribe la frase |IC| para “en conclusión”, seguida de una línea nueva de 80
menos/guiones (-). Escribe una conclusión para la lección, explicando qué conceptos ha cubierto la lección.

19.7 Añadir una Sección de Lectura Adicional

• Esta sección es opcional.

• Escribe la frase FR para “lectura adicional”, seguido por una línea nueva de 80 menos/guiones (-).

• Incluye enlaces a webs externas apropiadas.

19.8 Añade un Cuál es la Próxima Sección

• Escribe la frase |WN| para “qué es lo siguiente”, seguido por una línea nueva de 80 menos/guines (-).

• Explica cómo esta lección ha preparado a los estudiantes para las secciones o módulos siguientes.

• Recuerda cambiar la sección “qué es lo siguiente” de la lección anterior si es necesario, para que se refiera
a tu nueva lección. Esto será necesario si has insertado una lección entre lecciones existentes, o después de
una lección existente.

19.9 Utilizar el Marcado

Para acoplarte a los estándares de este documento, necesitarás añadir marcadores estándares a tu texto.
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19.9.1 Nuevos conceptos

• Si estás explicando un nuevo concepto, necesitaras escribir el nombre del nuevo concepto en itálicas es-
cribiéndolo entre asteriscos (*).

This sample text shows how to introduce a *new concept*.

19.9.2 Énfasis

• Para enfatizar un término crucial que no es un concepto nuevo, escribe el término en negrita escribiendolo
entre dobles asteriscos (**).

• ¡Úsalo moderadamente! Si lo usas demasiado, puede parecer que estás gritando o siendo condescendiente.

This sample text shows how to use **emphasis** in a sentence. Include the
punctuation mark if it is followed by a **comma,** or at the **end of the
sentence.**

19.9.3 Imágenes

• Cuando añades una imagen, guárdala a la carpeta _static/lesson_name/.

• Inclúyela en el documento de esta forma:

.. image:: /static/training_manual/lesson_name/image_file.extension
:align: center

• Recuerda dejar una línea abierta sobre y bajo el marcador de la imagen.

19.9.4 Enlaces internos

• Para anclar un enlace, escribe la línea siguiente sobre la posición donde quieras que el enlace señale:

.. _link-name:

• Para crear un enlace, añade esta línea:

:ref:‘Descriptive link text <link-name>‘

• Recuerda dejar una línea abierta sobre y bajo esta línea.

19.9.5 Enlaces externos

• Para crear un enlace externo, escribelo así:

‘Descriptive link text <link-url>‘_

• Recuerda dejar una línea abierta sobre y bajo esta línea.

19.9.6 Utilizar el texto monoespaciado

• Cuando estás escribiendo texto que el usuario tiene que introducir, un nombre de ruta, o el nombre del
elemento de un conjunto de datos como una tabla o nombre de una columna, debes escribirlo en texto
monoespaciado. por ejemplo:

Enter the following path in the text box: :kbd:‘path/to/file‘.
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19.9.7 Etiquetado de elementos GUI

• Si te refieres a un elemento GUI, como un botón, debes escribir su nombre en the GUI label format.Por
ejemplo:

To access this tool, click on the :guilabel:‘Tool Name‘ button.

• Esto también se aplica si estás mencionando el nombre de una herramienta sin que requiera que el usuario
haga clic en un botón.

19.9.8 Selecciones del menú

• Si estás guiando al usuario a través de los menús, debes utilizar el menú → selección → formato. Por
ejemplo:

To use the :guilabel:‘Tool Name‘ tool, go to :menuselection:‘Plugins -->
Tool Type --> Tool Name‘.

19.9.9 Añadir notas

• Puede que necesites una nota en el texto, que explique detalles extra que no se pueden añadir fácilmente al
flujo de la lección. Este es el marcador:

[Normal paragraph.]

.. note:: Note text.
New line within note.

New paragraph within note.

[Unindented text resumes normal paragraph.]

19.9.10 Añadir una nota de patrocinio/autoría

Si estás escribiendo un módulo, lección o sección nuevos, en nombre de un patrocinador, debes incluir un mensaje
corto de su elección. Éste debe notificar al lector el nombre del patrocinador y debe aparecer bajo el título del
módulo, lección o sección que han patrocinado. Sin embargo, puede ser un anuncios de su empresa.

Si has escrito un módulo, lección o sección voluntariamente, sin ningún patrocinador, puedes incluir una
autoría bajo el título del módulo, lección o sección que hayas creado. Esto debe tener la forma Este
[módulo/lección/sección] aportado por [nombre del autor]. No añadas más texto, de-
talles de contacto, etc. Esos detalles se tienen que añadir a la sección “Contribuidores”del prefacio, con el nom-
bre(s) de la parte(s) que has añadido. Si solo has hecho mejoras, correcciones y/o adiciones, alístate como editor.

19.10 ¡Gracias!

¡Gracias por tu aportación a este proyecto! Haciendolo, estás mejorando la accesibilidad del QGIS a usuarios y
añades valor al proyecto QGIS en su conjunto.
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CHAPTER 20

Folha de respostas

20.1 Results For Añadiendo Tu Primera Capa

20.1.1 Preparación

Deberías ver muchas líneas que representan carreteras. Todas estas líneas están en la capa vectorial que acabas de
cargar para crear el mapa básico.

Volver al texto

20.2 Results For Un resumen de la Interfaz

20.2.1 Resumen (Parte 1)

Refiérase a la imagen que muestra el diseño de la interfaz y comprobar que recuerdas los nombres y las funciones
de los elementos de la pantalla.

Volver al texto

20.2.2 Resumen (Parte 2)

1. Guardar como

2. Zoom a la capa

3. Ayuda

4. Renderizado on/off

5. Línea de medida

Volver al texto

20.3 Results For Trabajando con Datos Vector

20.3.1 Ficheros Shape

Debería haber cinco capas en tu mapa:
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• lugares

• agua

• edificios

• ríos y

• carreteras.

Volver al texto

20.3.2 Bases de Datos

Todas las capas vectoriales deberían cargarse en el mapa. Probablemente todavía no tendrá buen aspecto (ar-
reglaremos los colores feos más adelante).

Volver al texto

20.4 Results For Simbología

20.4.1 Colores

• Comprueba que los colores están cambiando como esperas que cambien.

• Por ahora es suficiente cambiar sólo la capa agua. Debajo hay un ejemplo, pero puede tener diferente
aspecto dependiendo del color que elijas.

Nota: Si quieres trabajar en una sola capa a la vez y no quieres otras capas que te distraigan, puedes ocultar una
capa, haga clic en la casilla de verificación que esta junto a su nombre en la lista de capas. Si la casilla está en
blanco, entonces la capa está oculta.

584 Chapter 20. Folha de respostas



QGIS Training Manual, Versão 2.8

Volver al texto

20.4.2 Estructura de símbolos

Ahora tu mapa debería aparecer así:

Si tu eres un usuario principiante, puede detenerse aquí.

• Use el método anterior para cambiar los colores y estilos a todas las capas restantes.

• Trata de usar colores naturales para los objetos. Por ejemplo, una carretera no debería ser roja o azul, pero
si puede ser gris o negro.

• También sientete libre de experimentar con diferentes Estilos de Relleno´ y :guilabel:‘Estilos de borde
ajustados para polígonos.

Volver al texto

20.4.3 Capas de símbolos

• Personaliza tu construcciones capa como gustes, pero recuerda que tiene que ser fácil de contar las diferentes
partes del mapa.

He aquí un ejemplo:
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Volver al texto

20.4.4 Niveles de símbolo

para hacer el símbolo requerido, necesitas dos capas de símbolo:
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La capa de símbolo mas bajo es amplio, línea solida color amarilla. Encima hay una línea solida mas ligera color
gris.

• Si sus capas de símbolos se parece a los anteriores, pero no obtendrá el resultado que desea, asegurarse que
sus niveles de símbolos se vean como esto:

20.4. Results For Simbología 587



QGIS Training Manual, Versão 2.8

• Ahora tu mapa debería tener este aspecto:
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Volver al texto

20.4.5 Niveles de símbolo

• Ajustar tus niveles de símbolo a estos valores:

• Probar con diferentes valores para dar diferentes resultados.

• Abrir de nuevo su mapa original antes de continuar con el siguiente ejercicio.

Volver al texto

20.5 Results For Atributo de dato

20.5.1 * Atributo de dato*

El campo NAME es el más útil para presentarlo como etiqueta. Esto es porque todos los valores son únicos para
cada objeto y es muy poco probable que contengan valores NULL. Si tus datos tienen algunos valores NULL, no
te preocupes siempre y cuando sus lugares tengan nombre.
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Volver al texto

20.6 Results For La herramienta de etiqueta

20.6.1 Personalizarción de Etiqueta (Parte 1)

Su mapa ahora debe presentar los puntos del marcador y las etiquetas deben compensarse por :kbd::2.0 mm: El
estilo de los marcadores y etiquetas debe permitir que sean claramente visibles en el mapa:

Volver al texto

20.6.2 Personalizarción de Etiqueta (Parte 2)

Una posible solución tiene este producto final:
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Para llegar a este resultado:

• Use un tamaño de fuente de 10, un :guialabel::Distancia de etiqueta de 1,5 mm, :guialabel:‘Ancho de
símbolo‘ and :guialabel:‘Tamaño de símbolo‘ de 3.0 mm.

• Además, este ejemplo usa el Etiqueta envuelta en caracteres opción:
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• Introduzca un _kbd:espacio en este campo y clic en Aplicar para lograr el mismo efecto. En nuestro caso,
algunos de los nombres de lugares son muy largos, resultando en nombres con múltiples líneas que no sera
muy fácil de usar. Usted puede encontrar un ajuste que sea mas apropiado a su mapa.

Volver al texto

20.6.3 Utilización de la configuración de definición de datos

• Aún en modo edición, establecer los valores de FONT_SIZE a cualquiera que prefiera. El ejemplo usa 16
para ciudades, 14 para suburbios, 12 para localidades y 10 para haldeas.

• Recuerda guardar cambios y salir del modo edición.

• Regresar a Texto opción de formato de la capa lugares y selecciona Tamaño de fuente en el Campo de
atributos de el tamaño de fuente de datos desplegable:
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Sus resultados, si usó los valores antes mencionados, debería ser esto:

Volver al texto
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20.7 Results For Clasificación

20.7.1 Refinar la clasificación

• Usa el nombre del método como en el primer ejercicio de la lección para deshacerse de los límites:

Los ajustes utilizados pueden no ser los mismos, pero con los valores Clases = 6 y Modo = Natural Breaks(Jenks)
(y usando los mismos colores, por supuesto), el mapa se verá así:
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Volver al texto

20.8 Results For Creando un nuevo conjunto de datos vector

20.8.1 Digitalizar

La simbología no importa, pero los resultados deberían verse más o menos como esto:

Volver al texto

20.8.2 Topología: Herramienta de agregar anillo

La forma exacta no importa, pero debería estar recibiendo un agujero en medio de su rasgo, como la siguiente:
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• Deshacer su edición antes de continuar con el ejercicio con la siguiente herramienta.

Volver al texto

20.8.3 Topología: Herramienta de agregar parte

• Primero selecciona el Bontebok National Park:
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• Ahora agregar su nueva parte:

• Deshacer su edición antes de continuar con el ejercicio con la siguiente herramienta.

Volver al texto

20.8.4 Unir objetos espaciales

• Use la herramienta Merge Selected Features, para estar seguro, primero seleccione los poligonos que desee
unir.

• Use el rasgo con el OGC_FID de 1 como la fuente de sus atributos (clic en la entrada correspondiente de la
ventana de dialogo, después clic en el botón Tomar los atributos del rasgo seleccionado):

Nota:
Si estas usando diferente conjunto de datos, es altamente probable que su Polígono original OGC_FID no

será 1. Solo tiene que elegir el rasgo que tiene un OGC_FID.
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Nota: Usando la herramienta Unir atributos de los rasgos seleccionados mantendrá las distintas geometrías, pero
les dará los mismo atributos.

Volver al texto

20.8.5 Formas

Para el TIPO, hay obviamente un cantidad límite de tipos que una carretera puede tener, si revisa la tabla de
atributos de la capa, verá que están predefinidos.

• Establecer el widget a Valor del mapa y clic Cargar datos de la capa.

• Seleccionar Carreteras in el Etiqueta desplegable y autopista para ambos las opciones de Valor y Descrip-
ción:
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• Clic tres veces en Ok.

• Si usa la herramienta Identificación en una calle mientras esta activo el modo edición, la ventana de dialogo
que deberías ver será como esto:

Volver al texto

20.9 Results For Análisis Vector

20.9.1 Extraer sus capas de los datos de OSM

Para propositos de este ejercicio, las capas de OSM que estamos interesados son multipolígonos y líneas. La capa
multipolígono contiene los datos que necesitamos para presentar las capas de casas, escuelas y restaurantes. La
capa líneas contiene el conjunto de carreteras.

La Constructor de consultas se encuentra en las propiedades de la capa:

20.9. Results For Análisis Vector 599



QGIS Training Manual, Versão 2.8

Usando o Ferramenta de Consulta para a camada multipolígonos, crie as seguintes consultas para as camadas
casas, escolas, restaurantes e residencial:
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Uma vez que tenha entrado com cada consulta, clique em OK. O mapa será atualizado mostrando somente os dados
que selecionou. Considerando que será necessário usar novamente os dados multipolígonos do conjunto de
dados OSM, nesse momento, você poderá usar um dos seguintes métodos:

• Cambiar el nombre de la capa OSM filtrada y reimportar la capa de osm_data.osm, O

• Duplicar la capa filtrada, cambiar el nombre a la copia, limpiar la consulta y crear su nueva consulta en el
Constructor de consultas.

Nota: Aunque el campo de OSM building tiene el valor house, la cobertura en su zona - como en la nuestra
- puede no ser completa. En nuestra región de prueba es por tanto más preciso excluir todos los edificios definidos
como cualquier cosa distinta de house. Puede decidir simplemente incluir los edificios que estén definidos como
house y todos los demás valores sin un significado claro como:kbd:yes.

Para crear la capa carreteras, construya la consulta contra la capa líneas de OSM:
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Debería terminar con un mapa parecido al siguiente:

Volver al texto
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20.9.2 Distancia desde institutos

• Su diálogo de buffer debería parecerse a esto:

La Distancia de buffer es 1000 metros (esto es, 1 kilómetro).

• O valor de Segmentos para aproximar é definido para 20. Isso é opcional mas recomendado uma vez que
torna os buffers de saída mais suaves. Compare isso:
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Com isso:

La primera imagen muestra el buffer con el valor Segmentos para aproximar se establece en 5 y la segunda
muestra el valor se establece en 20. En nuestro ejemplo, la diferencia es sutil, pero se puede ver que los bordes
del buffer son más suaves con el valor más alto.

Volver al texto
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20.9.3 Distancia de restaurantes

Para crear la nueva capa houses_restaurants_500m, pasamos por un proceso de dos pasos:

• Primero, crear un buffer de 500m alrededor de los restaurantes y agregar la capa al mapa:
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• Siguiente, seleccionar los edificios dentro del área del buffer:

• Ahora guardar esa selección como nuestra nueva capa houses_restaurants_500m:
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Su mapa debe mostrar solo aquellos edificios que estén a menos de 50m de la carretera, 1 km de la escuela y 500m
de un restaurante:
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Volver al texto

20.10 Results For Análisis Raster

20.10.1 Calcular Aspect

• Establezca su dialogo DEM (Análisis del terreno) como esto:
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20.10. Results For Análisis Raster 611
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Su resultado:

Volver al texto

20.10.2 Calcular pendiente (menos de 2 y 5 grados)

• Establezca su dialogo Calculadora Raster como esto:
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• Para la versión de 5 grados, remplazar 2 en la expresión y el nombre del archivo con 5.

Sus resultados:

• 2 grados:
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• 5 grados:
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Volver al texto

20.11 Results For Completando el Análisis

20.11.1 de Raster a Vector

• Abrir el Constructor de consultas con clic derecho sobre la capa todo_terreno in la Lista de capas, selec-
cionar la pestaña General.

• Después construir la consulta "suitable" = 1.

• Clic OK para filtrar todos los polígonos que no cumplan con esa condición.

Cuando vea el raster original, el área debe sobreponerse perfectamente:
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• Puede guardar esta capa, clic derecho sobre la capa todo_terreno en el La lista de capas y elegir Guardar
como..., después continua según las instrucciones.

Volver al texto

20.11.2 Revisando los resultados

Podrá notar que algunos de los edificios en su capa nueva_solución han sido “cortados” por la herramienta
Intersectar. Esto muestra que sólo parte del edificio -y por lo tanto solamente parte de la propiedad- se ubica en
un terreno adecuado. Podemos entonces con seguridad eliminar esos edificios de nuestro Conjunto de datos.

Volver al texto

20.11.3 Afinando el Análisis

Por el momento, su análisis deberá verse más o menos así:
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Considera un área circular, con 100 metros a la redonda

Si es más grande que 100 metros de radio, entonces extraer 100 metros de su tamaño (en todas las direcciones)
resultará en que una parte de el quede sobrante en el medio.

20.11. Results For Completando el Análisis 617



QGIS Training Manual, Versão 2.8

Por lo tanto, puede ejecutar un buffer interior de 100 metros en su capa vectorial existente terreno_apto. En el
resultado de la aplicación de la función buffer, lo que sea que quede en la capa original representará áreas en donde
hay terreno apto más allá de los 100.

Para demostrar:

• Ir a Vector → Herramientas de Geoprocesamiento → Buffer(s) para abrir el diálogo de Buffer(s).

• Configúralo así:
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• Use la capa terreno_apto con 10 segmentos y una distancia de buffer de -100. (La distancia es automáti-
camente reconocida en metros debido a que su mapa está usando un SRC proyectado).

• Guarda la capa resultante en datos_ejercicio/desarrollo_residencial/ como
terreno_apto_continuos100m.shp.

• Si es necesario, mueva la nueva capa encima de su capa original terreno_apto.

Sus resultados se verán más o menos así:
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• Ahora utilice la herramienta Selección por ubicación (Vector → Herramientas de investigación → Selección
por ubicación).

• Configurar de la siguiente manera:
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• Seleccione elementos en nueva_solución que intersecte elementos de terreno_apto_continuos100m.shp.

Este es el resultado:

Los edificios en color amarillo están seleccionados. Aunque algunos de los edificios caen parcialmente afuera de
la nueva capa terreno_apto_continuos100m.shp, caen bien dentro de la capa original terreno_apto
y por lo tanto cumplen con todos nuestros requerimientos.

• Guarde la selección en datos_ejercicio/desarrollo_residencial/ con el nombre
respuesta_final.shp.

Volver al texto

20.12 Results For WMS

20.12.1 Follow Along: Cargar otra Capa WMS

Su mapa debería verse así (puede que necesite re-ordenar las capas):
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Volver al texto

20.12.2 Agregando un Nuevo Servidor WMS

• Utilice el mismo método que antes para agregar el nuevo servidor y la capa adecuada según como se en-
cuentre alojada en el servidor:
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• Si realiza un acercamiento en el área Swellendam, notará que este conjunto de datos tiene una baja resolu-
ción.

Por lo tanto, es mejor no usar este dato para el mapa actual. El dato de Blue Marble es más apropiado para las
escalas nacionales y globales.

Volver al texto
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20.12.3 Agregando un Nuevo Servidor WMS

Usted podrá notar que muchos servidores WMS no siempre están disponibles. A veces esto es temporal, a veces
es permanente. Un ejemplo de un servidor WMS que funcionaba en el momento de escribir este manual es
el: guilabel: Depósitos Minerales Mundial WMS en: kbd: ‘http://apps1.gdr.nrcan.gc.ca/cgi-bin/worldmin_en-
ca_ows ‘. El cual no requiere cargos ni tiene restricciones de acceso, y es además de cobertura global. Por lo
tanto, cumple con los requisitos. Tenga en cuenta, sin embargo, que esto no es más que un ejemplo. Hay muchos
otros servidores WMS para elegir.

Volver al texto

20.13 Results For Conceptos de Bases de Datos

20.13.1 Propiedades de la Tabla de Direcciones

Para nuestra tabla de direcciones teórica, podríamos querer almacenar las siguientes propiedades:

House Number
Street Name
Suburb Name
City Name
Postcode
Country

Al crear la tabla para representar un objeto de dirección, crearemos columnas para representar cada una de estas
propiedades y les estaríamos asignando nombres compatibles con SQL y posiblemente nombres cortos

house_number
street_name
suburb
city
postcode
country

Volver al texto

20.13.2 Normalizando la Tabla de Personas

El mayor problema con la capa de gente es que hay solo un campo de dirección que contiene los datos de domicilio
de las personas. Pensando en nuestra tabla teórica direccion anteriormente en esta lección, sabemos que una
dirección esta compuesta por varias propiedades. Mediante el almacenamiento de todas estas propiedades en un
solo campo, con esto haremos mucho mas difícil la actualización y la consulta de nuestros datos. Por lo tanto
tenemos que dividir el campo de dirección en varias propiedades. Esto nos daría una tabla que tenga las siguiente
estructura:

id | name | house_no | street_name | city | phone_no
--+---------------+----------+----------------+------------+-----------------
1 | Tim Sutton | 3 | Buirski Plein | Swellendam | 071 123 123
2 | Horst Duester | 4 | Avenue du Roix | Geneva | 072 121 122

Nota: En la siguiente sección, aprenderemos acerca de relaciones de llave foránea, que podrán ser usados en este
ejemplo para mejorar aún más la estructura de nuestra base de datos.

Volver al texto
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20.13.3 Además normalización de la tabla de Personas

Actualmente nuestra tabla de personas se ve así:

id | name | house_no | street_id | phone_no
---+--------------+----------+-----------+-------------
1 | Horst Duster | 4 | 1 | 072 121 122

La columna street_id representa una relacion ‘uno a muchos’ entre el objeto personas y el objeto relacionado
calle, que esta en la tabla de calles.

Una forma para normalizar aún más la tabla es dividir el nombre del campo en nombre y apellido:

id | first_name | last_name | house_no | street_id | phone_no
---+------------+------------+----------+-----------+------------
1 | Horst | Duster | 4 | 1 | 072 121 122

Podemos crear también tablas independientes para nombre pueblo o ciudad y país, enlazándolos a nuestra tabla
de personas a través de una relación de ‘uno a muchos’:

id | first_name | last_name | house_no | street_id | town_id | country_id
---+------------+-----------+----------+-----------+---------+------------
1 | Horst | Duster | 4 | 1 | 2 | 1

Un diagrama de ER para representar esto sería así:

Volver al texto

20.13.4 Crear una tabla de Personas

El SQL necesario para crear la tabla correcta de personas es:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
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street_id int not null,
phone_no varchar null );

O esquema para a tabela (digite \d people) será parecido com o seguinte:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

Nota: Para fines de ilustración, hemos omitido a propósito la restricción del fkey.

Volver al texto

20.13.5 El comando DROP

El motivo del comando DROP no funcionaría en este caso, porque la tabla personas tiene un restricción de llave
foránea para la tabla calles. Esto significa que dropping (o eliminar) la tabla de calles dejaría a la tabla de personas
con las referencias a calles de datos no existentes.

Nota: Es posible para ‘fuerza’ la tabla de calles para ser eliminado mediante el uso del comando CASCADE,
pero también se eliminaría la tabla de personas y alguna otra que tenga relación con la tabla calles. ¡Utilizar con
precaución!

Volver al texto

20.13.6 Insertar una nueva calle

El comando SQL, que debe usar se ve así (puede reemplazar el nombre de la calle con uno de su elección):

insert into streets (name) values (’Low Road’);

Volver al texto

20.13.7 Agregar una nueva persona con relación de llave foránea

Aquí esta la sentencia SQL correcta:

insert into streets (name) values(’Main Road’);
insert into people (name,house_no, street_id, phone_no)

values (’Joe Smith’,55,2,’072 882 33 21’);

Si se fija en la tabla de calles nuevamente (utilizando una sentencia select como antes), vera que el id de la entidad
Carretera Principal es 2.

Eso es por qué podríamos solo introducir el numero 2 arriba. Aunque no estemos viendo Carretera
principal escrito completamente en la entrada de arriba, la base de datos podrá estar asociada a street_id
con el valor de 2.
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Nota: Se você já adicionou um novo objeto Estrada, você pode achar que o novo Estrada Principal
tem o ID 3 não 2.

Volver al texto

20.13.8 Regresar Nombre de calles

Aquí esta la sentencia SQL correcta que debe usar:

select count(people.name), streets.name
from people, streets
where people.street_id=streets.id
group by streets.name;

Resultado:

count | name
------+-------------

1 | Low Street
2 | High street
1 | Main Road

(3 rows)

Nota: Você vai notar que temos prefixado nomes dos campos com nomes de tabela (por exemplo pessoas.name
e streets.name). Isso precisa ser feito sempre que o nome do campo (ou seja, não exclusivo em todas as tabelas no
banco de dados) for ambíguo.

Volver al texto

20.14 Results For Consultas Espaciales

20.14.1 Las unidades usadas en Consultas Espaciales

Las unidades usadas para el ejemplo de consulta son grados, porque el SRC que la capa esta usando es WGS84.
Este es un SRC Geografico, que significa que las unidades están en grados. Un proyecto SRC, como la proyección
UTM que esta en metros.

Recuerde que cuando escriba la consulta, necesita saber en que unidades esta el SRC de la capa. Esto te permitirá
escribir una consulta que regrese los resultados que tu esperas.

Volver al texto

20.14.2 Creando un índice espacial

CREATE INDEX cities_geo_idx
ON cities
USING gist (the_geom);

Volver al texto
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20.15 Results For Construcion de geometría

20.15.1 Creando linestrings

alter table streets add column the_geom geometry;
alter table streets add constraint streets_geom_point_chk check

(st_geometrytype(the_geom) = ’ST_LineString’::text OR the_geom IS NULL);
insert into geometry_columns values (’’,’public’,’streets’,’the_geom’,2,4326,

’LINESTRING’);
create index streets_geo_idx

on streets
using gist
(the_geom);

Volver al texto

20.15.2 “Enlazando tablas”

delete from people;
alter table people add column city_id int not null references cities(id);

(capturar ciudades en QGIS)

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’Faulty Towers’,

34,
3,
’072 812 31 28’,
1,
’SRID=4326;POINT(33 33)’);

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’IP Knightly’,

32,
1,
’071 812 31 28’,
1,F
’SRID=4326;POINT(32 -34)’);

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’Rusty Bedsprings’,

39,
1,
’071 822 31 28’,
1,
’SRID=4326;POINT(34 -34)’);

Si recibe el siguiente mensaje de error:

ERROR: insert or update on table "people" violates foreign key constraint
"people_city_id_fkey"

DETAIL: Key (city_id)=(1) is not present in table "cities".

entonces significa que mientras experimentaba con la creación de polígonos para la tabla de ciudades, debe haber
eliminado algunos de ellos y empezar de nuevo. Vea las entradas de su tabla de ciudades y use cualquier id que
exista.

Volver al texto
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20.16 Results For Modelo de características simples

20.16.1 Llenar tablas

create table cities (id serial not null primary key,
name varchar(50),
the_geom geometry not null);

alter table cities
add constraint cities_geom_point_chk
check (st_geometrytype(the_geom) = ’ST_Polygon’::text );

Volver al texto

20.16.2 Llenar la tabla Geometria_Columnas

insert into geometry_columns values
(’’,’public’,’cities’,’the_geom’,2,4326,’POLYGON’);

Volver al texto

20.16.3 Agregar geometría

select people.name,
streets.name as street_name,
st_astext(people.the_geom) as geometry

from streets, people
where people.street_id=streets.id;

Resultado:

name | street_name | geometry
--------------+-------------+---------------
Roger Jones | High street |
Sally Norman | High street |
Jane Smith | Main Road |
Joe Bloggs | Low Street |
Fault Towers | Main Road | POINT(33 -33)

(5 rows)

Como puede ver, nuestra limitación permite agregar nulos en la base de datos.

Volver al texto
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Tabelas e índices

• genindice

• modindice

• pesquisa

631


	Introdução ao Curso
	Prefácio
	Preparando os Dados dos Exercícios

	Module: A Interface
	Lesson: Uma Breve Introdução
	Lesson: Adicionando sua primeira camada
	Lesson: Uma visão geral da interface

	Module: Criando um Mapa Básico
	Lesson: Trabalhando com Dados Vetoriais
	Lesson: Simbologia

	Module: Classificando Dados Vetoriais
	Lesson: Atributos
	Lesson: A Ferramenta de Rótulo
	Lesson: Clasificação

	Module: Criando Mapas
	Lesson: Utilización del Compositor de Mapas
	Exercício 1

	Module: Criação de Dados Vetoriais
	Lesson: Creando un Nuevo Conjunto de Datos Vectoriales
	Lesson: Topología de los Elementos
	Lesson: Formulários
	Lesson: Ações

	Lesson: Análisis Vectorial
	Lesson: Reproyectando y Transformando Datos
	Lesson: Análise Vetorial
	Lesson: Análises de Redes
	Lesson: Estadísticas Espaciales

	Module: Rasters
	Lesson: Trabajando con Datos Ráster
	Lesson: Cambiando la Simbología Ráster
	Lesson: Análisis del Terreno

	Module: Completando a Analise
	Lesson: Conversión de Ráster a Vectorial
	Lesson: Combinando los Análisis
	Exercício
	Lesson: Ejercicio Suplementario

	Module: Complementos
	Lesson: Instalar y Manejar Complementos
	Lesson: Útiles Complementos de QGIS

	Module: Recursos Online
	Lesson: Servicios de Cartografía Web
	Lesson: Web Feature Services

	Module: GRASS
	Lesson: Configuración de GRASS
	Lesson: Ferramentas GRASS

	Module: Tarea de Evaluación
	Crea un mapa base
	Analiza los datos
	Mapa Final

	Module: Aplicação Florestal
	Lesson: Presentación del Módulo Forestal
	Lesson: Georreferenciando un Mapa
	Lesson: Digitalizando Massas Florestais
	Lesson: Atualizando Massas Florestais
	Lesson: Sistemática de Diseño de Muestreo
	Lesson: Creación de Mapas detallados con la herramienta Atlas
	Lesson: Cálculo de los Parámetros Forestales
	Lesson: DEM desde datos LiDAR
	Lesson: Apresentação do mapa

	Module: Conceitos de Base de Dados com PostgreSQL
	Lesson: Introdução às Bases de Dados
	Lesson: Implementando o Modelo de Dado
	Lesson: Agregar datos al Modelo
	Lesson: Consultas
	Lesson: Vistas
	Lesson: Regras

	Module: Conceitos de Bases de Dados Espaciais com PostGIS
	Lesson: Configuração PostGIS
	Lesson: Modelo de Feição Simples
	Lesson: Importação e Exportação
	Lesson: Consultas Espaciais
	geometria de construção

	O guia de processamento do QGIS
	Introducción
	Um aviso importante antes de começar
	Instauración de la caja de herramientas de procesado
	Rodando o nosso primeiro algoritmo. A caixa de ferramentas
	Mais algoritmos e tipos de dados
	SRCs. Reprojetando
	Seleção
	Rodando um algoritmo externo
	O log do processamento
	A calculadora raster. Sem valores de dado
	Calculadora vetorial
	Definindo as medidas
	Saídas HTML
	Primeiro exemplo de análise
	Recortar e mesclar camadas raster
	Análise hidrológica
	Iniciando com o modelador gráfico
	Modelos más complejos
	Cálculos numéricos no modelador
	Um modelo de um modelo
	Interpolação
	Mais interpolação
	Ejecución iterativa de algoritmos
	Mais execução interativa de algoritmos
	A interface de processamento em lote
	Modelos da interface de processamento em lote
	Outros programas
	Interpolação e curvas de contorno
	Simplificación y suavizado vectorial
	Planejando uma fazenda solar

	Module: Usando Base de dados espaciais no QGIS
	Lesson: Trabalhar com bancos de dados no Navegador QGIS
	Lesson: Usando o Gerenciador BD para trabalhar com bancos de dados espaciais no QGIS
	Lesson: Trabajar con base de datos spatialite en QGIS

	Apéndice: Cómo Contribuir a este Manual
	Descarga de Recursos
	Formato del Manual
	Adición de un Módulo
	Adición de una Lección
	Añadir una Lección
	Añadir una Conclusión
	Añadir una Sección de Lectura Adicional
	Añade un Cuál es la Próxima Sección
	Utilizar el Marcado
	¡Gracias!

	Folha de respostas
	Results For Añadiendo Tu Primera Capa
	Results For Un resumen de la Interfaz
	Results For Trabajando con Datos Vector
	Results For Simbología
	Results For Atributo de dato
	Results For La herramienta de etiqueta
	Results For Clasificación
	Results For Creando un nuevo conjunto de datos vector
	Results For Análisis Vector
	Results For Análisis Raster
	Results For Completando el Análisis
	Results For WMS
	Results For Conceptos de Bases de Datos
	Results For Consultas Espaciales
	Results For Construcion de geometría
	Results For Modelo de características simples

	Tabelas e índices

